Contents

Using This Book ................................................................. xi
What's New in SAS Strategy Management 5.5 .......................... xiii
Accessibility Features of SAS Strategy Management 5.5 ................. xvii

PART 1 Introduction to SAS Strategy Management 1

Chapter 1 / About SAS Strategy Management .......................... 3
What Is a Performance Management Framework? ....................... 3
Why Use a Performance Management Framework? ..................... 4
Benefits of Using SAS Strategy Management ............................ 4
Why Use SAS Strategy Management? ..................................... 5
SAS Strategy Management Users .......................................... 5
SAS Strategy Management Features ....................................... 6
Accessing Help and Documentation for SAS Strategy Management .... 7

Chapter 2 / How Do You Describe a Strategy? ......................... 9
The Parts of a Strategy ....................................................... 9
Templates ........................................................................... 10
Projects ............................................................................. 12
Scorecards .......................................................................... 13
Elements and Attributes ....................................................... 15
Ranges ............................................................................... 17
Column Selections .............................................................. 18
Forms ................................................................................. 18

Chapter 3 / What Is a View? .................................................. 19
Overview ............................................................................ 19
Table .................................................................................. 20
Aggregate ........................................................................... 21
Association ......................................................................... 21
Diagram ............................................................................. 22
Gauge (Also Called Dashboard) .............................................. 22
Trend Analysis ..................................................................... 23

PART 2 Describing and Building Your Strategy 27

Chapter 4 / Starting SAS Strategy Management Builder ............ 29
Starting SAS Strategy Management Builder Using a Link ............ 29
Starting SAS Strategy Management Builder from a Portlet .......... 30
Using SAS Strategy Management Builder and SAS Visual Analytics 35
Log Off from SAS Strategy Management Builder .................... 35
<table>
<thead>
<tr>
<th>Chapter 5 / The SAS Strategy Management Builder Interface</th>
<th>37</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your First Look at the Strategy Management Builder</td>
<td>37</td>
</tr>
<tr>
<td>About the Banner</td>
<td>38</td>
</tr>
<tr>
<td>About the Toolbar</td>
<td>38</td>
</tr>
<tr>
<td>About the Navigation Pane</td>
<td>40</td>
</tr>
<tr>
<td>About the Content Pane</td>
<td>40</td>
</tr>
<tr>
<td>Chapter 6 / Working with Templates</td>
<td>41</td>
</tr>
<tr>
<td>Overview</td>
<td>42</td>
</tr>
<tr>
<td>List Templates</td>
<td>42</td>
</tr>
<tr>
<td>Create a Template</td>
<td>42</td>
</tr>
<tr>
<td>Open a Template</td>
<td>45</td>
</tr>
<tr>
<td>Working with Project Elements</td>
<td>45</td>
</tr>
<tr>
<td>Working with Scorecard Element Types</td>
<td>49</td>
</tr>
<tr>
<td>Working with Metric Attributes</td>
<td>52</td>
</tr>
<tr>
<td>Working with Language Settings</td>
<td>53</td>
</tr>
<tr>
<td>List Associated Projects</td>
<td>55</td>
</tr>
<tr>
<td>Edit User-Defined Template Properties</td>
<td>55</td>
</tr>
<tr>
<td>Edit Predefined Template Properties</td>
<td>57</td>
</tr>
<tr>
<td>Copy a Template</td>
<td>58</td>
</tr>
<tr>
<td>Delete a Template</td>
<td>58</td>
</tr>
<tr>
<td>Manage Time Periods</td>
<td>58</td>
</tr>
<tr>
<td>View Audit Records</td>
<td>58</td>
</tr>
<tr>
<td>Manage Mobile Applications</td>
<td>58</td>
</tr>
<tr>
<td>Chapter 7 / Working with Projects</td>
<td>59</td>
</tr>
<tr>
<td>Overview</td>
<td>60</td>
</tr>
<tr>
<td>Create a Project</td>
<td>60</td>
</tr>
<tr>
<td>Open a Project</td>
<td>61</td>
</tr>
<tr>
<td>Register a Project</td>
<td>61</td>
</tr>
<tr>
<td>Edit Project Properties</td>
<td>62</td>
</tr>
<tr>
<td>Suggest a New Element to Be Added to a Project</td>
<td>63</td>
</tr>
<tr>
<td>Manage Suggested New Elements for a Project</td>
<td>64</td>
</tr>
<tr>
<td>Customize Project Content Displayed by Default</td>
<td>65</td>
</tr>
<tr>
<td>Copy a Project</td>
<td>71</td>
</tr>
<tr>
<td>Add a Project to a Classic-Style Portlet</td>
<td>72</td>
</tr>
<tr>
<td>Delete a Project</td>
<td>73</td>
</tr>
<tr>
<td>Managing Link Definitions</td>
<td>74</td>
</tr>
<tr>
<td>Chapter 8 / Working with Scorecards</td>
<td>83</td>
</tr>
<tr>
<td>Overview</td>
<td>83</td>
</tr>
<tr>
<td>Create a Scorecard</td>
<td>83</td>
</tr>
<tr>
<td>Open a Scorecard</td>
<td>84</td>
</tr>
<tr>
<td>Calculate a Scorecard</td>
<td>84</td>
</tr>
<tr>
<td>Save a Scorecard as a SAS Information Map</td>
<td>85</td>
</tr>
<tr>
<td>Change the Order of Scorecards</td>
<td>86</td>
</tr>
<tr>
<td>Edit Scorecard Properties</td>
<td>86</td>
</tr>
<tr>
<td>Add a Scorecard to a Classic-Style Portlet</td>
<td>88</td>
</tr>
<tr>
<td>Move a Scorecard</td>
<td>89</td>
</tr>
<tr>
<td>Copy a Scorecard</td>
<td>89</td>
</tr>
<tr>
<td>Delete a Scorecard</td>
<td>91</td>
</tr>
<tr>
<td>Set Default Scorecard Preferences</td>
<td>91</td>
</tr>
<tr>
<td>Chapter 9 / Working with Elements and Element Attributes</td>
<td>93</td>
</tr>
<tr>
<td>Overview</td>
<td>93</td>
</tr>
<tr>
<td>Create an Element</td>
<td>93</td>
</tr>
</tbody>
</table>
Chapter 10 / Defining Rules ......................................................... 119
  Overview of Rules ............................................................... 119
  Define a Rule .................................................................... 120
  Edit or View the Properties of a Rule ................................. 121
  Copy a Rule ..................................................................... 122
  Delete a Rule ................................................................... 122

Chapter 11 / Working with Formulas ............................................. 123
  Apply a Formula to a Column ............................................... 123
  Creating a Formula ............................................................. 125

Chapter 12 / Calculating a Project .................................................. 129
  Overview ......................................................................... 129
  Calculate a Project ............................................................. 129

Chapter 13 / Working with Ranges .................................................. 131
  Overview ......................................................................... 131
  List Ranges .................................................................. 131
  Create a Range ................................................................ 132
  Edit a Range .................................................................. 134
  View Range Properties ....................................................... 134
  Copy a Range .................................................................. 134
  Delete a Range ................................................................ 135
  Apply a Range to a Column ................................................ 135

Chapter 14 / Working with Column Selections ................................. 137
  Overview ......................................................................... 137
  List Column Selections ....................................................... 137
  Create a Column Selection ................................................ 138
  Edit Column Selection Properties ...................................... 139
  View Column Selection Properties ..................................... 140
  Copy a Column Selection ................................................... 140
  Delete a Column Selection ................................................ 140
  Apply a Column Selection to a Table or Aggregate Table .... 140
  Apply a Column Selection to an Association ......................... 141
  Create a Column Selection for Use in a Data-Entry Form ....... 141

Chapter 15 / Common Tasks ............................................................... 143
  Display the Template and Project Manager Page .................. 143
  Select the Owner of a Template, Project, Scorecard, or Element 143
  Add Users and User Groups .................................................. 144
### Chapter 21 / Creating and Editing Gauge (Also Called Dashboard) Views
Creating and Editing Gauge Views .................................................. 229

### Chapter 22 / Creating and Editing Trend Analysis Views
Overview .................................................................................. 231
Access Trend Analysis from a Table ............................................. 231
Select the Metric Attributes to Analyze ....................................... 232
Customize the Display of a Metric Attribute ................................. 234
Navigate a Trend Analysis .............................................................. 234
Customize the Trend Analysis ......................................................... 235

### Chapter 23 / Managing Views
Specify a Default View ................................................................. 237
Set Default Options for a View ..................................................... 237
Save a View to a Portlet ................................................................. 238
Set the Default Date for Views ..................................................... 239
Print a View ............................................................................... 239
Link to a View Using a Web Address ............................................ 239
Linking to Information from Within a Scorecard ......................... 240

---

### PART 4 Creating Portlet Views for Business Users 243

### Chapter 24 / Overview of Portlet Types
Portlet Types ............................................................................... 245

### Chapter 25 / Creating a Portlet
Overview .................................................................................. 247
Create a Portlet ........................................................................... 247
Change the Layout of Portlets .................................................... 249
Delete a Portlet ........................................................................... 251

### Chapter 26 / The Strategy Management Enhanced Portlet Interface
Your First Look at the SAS Strategy Management Enhanced Portlet Interface .............................................. 253
The Toolbar ............................................................................. 254
Your First Look at a Tile ............................................................... 254
The Tile Control Panel ................................................................. 255

### Chapter 27 / Editing a Strategy Management Enhanced Portlet and Its Tiles
Edit the SAS Strategy Management Enhanced Portlet .................. 257
Edit Tiles for the SAS Strategy Management Enhanced Portlet .... 260
Configure the Tile Layout in the Enhanced Portlet ....................... 276
Delete a Tile ............................................................................. 277

### Chapter 28 / Editing Classic-Style Portlets
Overview .................................................................................. 279
Edit a Performance Table Portlet .................................................. 279
Edit a Performance Aggregate Table Portlet ............................... 282
Edit a Performance Association Portlet ........................................ 285
Edit a Performance Dashboard Portlet ......................................... 287
Edit a Performance Data-Entry Portlet ......................................... 291
Edit a Performance Diagram Portlet .......................................... 293
### PART 5  Viewing and Navigating Content in Portlets  295

#### Chapter 29  Access Your Strategy Management Portlets  297
- Log On to the SAS Information Delivery Portal  297
- Log Off from the SAS Information Delivery Portal  298

#### Chapter 30  Navigating and Viewing the Strategy Management Enhanced Portlet and Its Tiles  299
- Your First Look at the SAS Strategy Management Enhanced Portlet  300
- Access Help  302
- Change the Layout of the Tiles  302
- Open and Close the Tile Control Panel  303
- Print a Tile  303
- Reset Tile Data  304
- Suggest a New Element to Add to the Strategy  304
- Change the Date  304
- Change the Element Type  305
- Change the Column Selection  305
- Change the Association  305
- View the Scorecard in Strategy Management Builder  305
- Sort Columns  306
- Rearrange Columns  306
- Synchronize Tile Data with the Scorecard Hierarchy Tile  306
- View Threshold Conditions  307
- View and Create Comments  307
- Reply to a Comment  309
- Search Comments  309
- Display a Trend Chart  309
- Select Data for a Trend Analysis  310
- Remove Data from a Trend Analysis  310
- Reset the Data  310
- Save the Trend Analysis as an Image  310
- Change Trend Analysis Property Settings  310
- View and Filter Gauges  312
- View Information Provided for a Gauge  312
- View Details about an Element in a Diagram  312
- Change the Diagram to View  312
- Reset the Zoom for a Diagram  312
- Save the Portlet as a SAS Mobile BI Report  312

#### Chapter 31  Navigating and Viewing Classic-Style Portlets  315
- Overview  315
- Link to Other Documents, Web Addresses, or Views  315
- View a Trend Analysis  315
- Viewing and Making Comments  316
- View Threshold Data  316
- View Underlying Data (Dashboard View Only)  317

### PART 6  Entering Data into Projects  319

#### Chapter 32  Overview of Data Entry Methods  321
- Data-Entry Methods  321
Chapter 33 / Creating and Managing Forms ................................................................. 323
   Forms and Workflow .................................................................................. 323
   Create a Form and Workflow .................................................................. 324
   Edit or View the Properties of a Form ...................................................... 329
   Copy a Form ............................................................................................... 329
   Delete a Form ............................................................................................. 329
   Start a Workflow ....................................................................................... 330
   Set the Workflow to Stop After the Cycle Completes ................................ 330
   Immediately Stop the Workflow and Delete All Work ............................ 330
   Create and Edit a Performance Data-Entry Portlet ................................. 331

Chapter 34 / Entering Data Manually ................................................................. 333
   Data-Entry Form Considerations ............................................................... 333
   Enter Data in a Form without a Workflow ................................................ 333
   Enter Data in a Form with a Defined Workflow ......................................... 334
   Approve Data ............................................................................................. 334
   Reject Data ............................................................................................... 335

Chapter 35 / Importing Data into a Strategy Management Project ............... 337
   Importing Data by Using the Import Wizard .............................................. 337
   Registering Source Data Files .................................................................... 339
   Local Microsoft Excel Files and Shared Directories .................................. 339
   Source Data Organization ........................................................................... 339
   Define How to Import Data from a Source File ....................................... 344
   Define How to Import a Hierarchy from a Source File ............................. 349
   Open an Import Configuration ................................................................... 352
   Run an Import Configuration ..................................................................... 352
   View the Import Configuration Error Log ................................................. 352
   Copy an Import Configuration ................................................................... 352
   Delete an Import Configuration ................................................................. 353

PART 7 Creating Reports 355

Chapter 36 / Creating Reports Using SAS Information Maps .................... 357
   Creating Reports Using SAS Information Maps ....................................... 357

Chapter 37 / Viewing Strategy Management Reports in Microsoft Office ..... 359
   Overview .................................................................................................... 359
   Creating a SAS Strategy Management Report ......................................... 359
   Viewing a SAS Strategy Management Report .......................................... 360
   Enable Colors for Ranges ......................................................................... 360

Chapter 38 / Accessing Strategy Management Data from Microsoft Excel .... 361
   Accessing Strategy Management Data from Microsoft Excel .................. 361

PART 8 Appendix 363

Appendix 1 / Strategy Management Function Dictionary .......................... 365
   Functions for Use in Formulas ................................................................. 365
Using This Book

Audience

SAS Strategy Management is designed for the following users:

Scorecard modeler

Business user and analyst
   Navigates through and views strategy content and information.

   Business users should read “Part 5. Viewing and Navigating Content in Portlets.” Depending on the business user's organization, “Part 7. Creating Reports” might be of interest.

Data entry user
   Enters strategy data and other information into a SAS Strategy Management project.

   Data entry users should read “Part 6. Entering Data.”
What's New in SAS Strategy Management 5.5

Overview

SAS Strategy Management 5.5 provides the following changes and improvements:

- Integration with the SAS Visual Analytics home page
- Improvements to the Managed Link Definition feature
- Improvements to the Diagram Editor and Diagram Viewer features
- Improvements to the Data-Entry Forms feature
- Improvements to the Project Options feature
- Named Links support in the Import wizard feature
- Chrome web browser support
- Improvements to the Trend Chart tile
- Improvements to the mobile tablet feature

Integration with the SAS Visual Analytics Home Page

The SAS Strategy Management installation now includes the SAS Visual Analytics home page. From the home page, you can navigate to the SAS Strategy Management Builder or to a specific SAS Strategy Management project located in the Builder.
Improvements to the Managed Link Definition Feature

SAS Strategy Management provides the following improvements:

- **filter by named link**: In the Managed Link Definition feature, you can filter named link definitions by selecting a link type.

- **more project preferences**: SAS Strategy Management project is a link type in the Managed Link Definition feature. The SAS Strategy Management project type now includes options to specify detailed information about the project so that a user can navigate to the expected view in the SAS Strategy Management Builder.

- **element details link type**: The Managed Link Definition feature now provides a new report type for element details that you can use to customize the display. By reusing column selections, you have full control over which metrics are displayed, as well as the order in which they appear.

Improvements to the Diagram Editor and Diagram Viewer Features

SAS Strategy Management provides new ways to link information from diagram nodes and shapes, as well as other improvements:

- **disable element details report**: You can restrict navigation to the element details report to prevent users from seeing strategy content that is protected.

- **link from element nodes**: You can choose to display element details, a named link, or use a link associated with a strategy object, such as Actual or Target, when you define linked navigation. Also, a diagram node can be configured to have no link.

- **element details report**: Linking to the element details report is now optional. When this type of link is selected, you can navigate to the traditional view of this report, which includes all metrics associated with the element.

- **link from shapes**: You can choose to disable links, manually enter a hyperlink, or select a named link when you define link navigation for shapes.

- **size images and retain their aspect ratio**: Images can be sized while keeping their aspect ratio.

- **Adobe SVG viewer is no longer required**: When you view diagrams that use the SVG format, SAS Strategy Management now uses the SVG support provided by the Microsoft Internet Explorer, Firefox, and Chrome web browsers.
Improvements to the Data-Entry Forms Feature

SAS Strategy Management provides the following improvements:

- **user names are alphabetized for quick identification**: On the Workflow tab, SAS Strategy Management now displays the Data-entry user and Approver lists in alphabetical order so that you can easily find the right person.

- **approver names can be reordered**: You can now reorder approver names in the selection list by dragging and dropping the approver names into the preferred order.

- **updated behavior for rejection workflow**: When a form is rejected but has been approved by some approvers, the form is sent to all approvers again so that they are aware of updates to the form.

Improvements to the Project Options Feature

The Project Options feature now provides an option to make system changes for all users at once.

Named Rules Support in the Import Wizard Feature

The Import wizard feature now provides support for importing named rules that are associated with cells. For the import to succeed, the named rule must already be present in the SAS Strategy Management project.

Chrome Web Browser Support

SAS Strategy Management expands its browser options with support for the Chrome web browser.
Improvements to the Trend Chart Tile

The SAS Strategy Management enhanced portlet has improved the way it sizes and centers trend chart tiles.

Improvements to the Mobile Tablet Feature

SAS Strategy Management provides the following improvements:

- **Android tablet support**: The mobile tablet feature now provides support for Android tablets.

- **auto-update of mobile reports**: SAS Mobile BI reports are automatically updated when changes are made in SAS Strategy Management. You can view report updates by resubscribing to the report. You no longer must return to the web application and republish the report.
Accessibility Features of SAS Strategy Management 5.5

Overview

SAS Strategy Management 5.5 has been tested with assistive technology tools. It includes accessibility and compatibility features that improve the usability of the product for users with disabilities. (Some accessibility issues remain and are noted below.) These features are related to accessibility standards for electronic information technology that were adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973 (2008 draft proposal initiative update). Applications are also tested against Web Content Accessibility Guidelines (WCAG) 2.0, part of the Web Accessibility Initiative (WAI) of the Worldwide Web Consortium (W3C). For detailed information about the accessibility of this product, send e-mail to accessibility@sas.com or call SAS Technical Support.

Documentation Format

Please contact accessibility@sas.com if you need this document in an alternative digital format.

User Interface Layout

SAS Strategy Management provides a way to describe and build strategies. SAS Strategy Management also provides different ways to view the strategies. The application window contains three main sections:

- The top of the window contains the menu and toolbar.
- The left side of the window contains the navigation pane. The pane contains a tree of objects. You can open these objects (one at a time) into the content pane next to the navigation pane.
- The right side of the window contains the content pane. You can view lists of available content or a view of the currently selected content.
For more information about the layout and features of the Builder user interface, see Chapter 5, “The SAS Strategy Management Builder Interface,” on page 37.

For more information about the different types of views, see Chapter 3, “What Is a View?,” on page 19. For information about classic-style portlets, see Chapter 31, “Navigating and Viewing Classic-Style Portlets,” on page 315. For information about enhanced portlet layout and features, see “Your First Look at the SAS Strategy Management Enhanced Portlet” on page 300.

Exceptions to Accessibility Standards

Note: The JAWS issues occur when JAWS is used with Internet Explorer. Other browsers were not tested with JAWS, unless noted.

Exceptions to accessibility standards are documented in the following table. These exceptions apply to the following features of SAS Strategy Management:

- SAS Strategy Management Builder
- Advanced Formula Editor
- Diagram Editor
- SAS Strategy Management classic-style portlets

<table>
<thead>
<tr>
<th>Accessibility Issue</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAWS cannot access the Advanced Formula Editor.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>You cannot open the Color dialog box.</td>
<td>Use Alt+down arrow to open the Color dialog box.</td>
</tr>
<tr>
<td>Buttons do not have accelerator keys.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS cannot navigate the template hierarchy tree in the New Project wizard.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>When you open the Selected Scorecards page from the Edit Elements page, the focus</td>
<td>Use Tab only to navigate around the frame of the page. Doing so avoids using the arrow keys.</td>
</tr>
<tr>
<td>does not move correctly when you tab through the controls. Instead, the focus</td>
<td></td>
</tr>
<tr>
<td>moves with the arrow keys.</td>
<td></td>
</tr>
<tr>
<td>On newly opened or refreshed pages, the focus resets to the toolbar.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS cannot read some controls on the Trend Analysis page in the SAS Strategy</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Management Builder.</td>
<td></td>
</tr>
<tr>
<td>JAWS cannot read the labels on some controls.</td>
<td>No workaround is available.</td>
</tr>
</tbody>
</table>
### Accessibility Issue

<table>
<thead>
<tr>
<th>Issue Description</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using JAWS to expand and collapse a node in a tree, an error occurs. After this error, JAWS re-enables the virtual PC cursor.</td>
<td>Every time this error occurs, you must disable the virtual PC cursor in JAWS.</td>
</tr>
<tr>
<td>JAWS does not skip navigation at the top of the page.</td>
<td>Pressing Enter causes JAWS to read the skip menu message again. Pressing Tab causes JAWS to read the message again. However, pressing Tab a second time moves the focus and skips the menu.</td>
</tr>
<tr>
<td>JAWS cannot read the application timeout message. The ability to extend the session is lost.</td>
<td>Contact your system administrator to correct this problem. For more information, see “Accessibility Configuration” in the SAS Strategy Management: System Administration Guide.</td>
</tr>
<tr>
<td>JAWS detects two unlabeled tab stops in the application banner.</td>
<td>Press Tab twice to move the focus forward.</td>
</tr>
<tr>
<td>On the Project and Template Manager page, when tabbing through the interface, the focus does not read the Hide icon (&lt;&lt;) that hides the left pane.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>On the Project and Template Manager page, after you create a new template, the focus is not restored to the SAS Strategy Management content area.</td>
<td>Navigate the application interface to return to the location of the last change.</td>
</tr>
<tr>
<td>In the New Element wizard, keystrokes intended for a drop-down list exits the wizard instead.</td>
<td>Press Alt+down arrow to operate the drop-down list.</td>
</tr>
<tr>
<td>JAWS does not open the Image drop-down list.</td>
<td>Move focus forward and then back to the drop-down list.</td>
</tr>
<tr>
<td>JAWS does not detect Information or Error messages.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>In the New Element wizard, JAWS cannot read the label for the Description field. Instead, JAWS reads “General Options Edit.”</td>
<td>The field is available for use. Be aware of the different label that JAWS reads.</td>
</tr>
</tbody>
</table>

Exceptions to accessibility standards are documented in the following table. These exceptions apply to the following features of SAS Strategy Management:

- **Manage Import Options feature**: the Import page and the Import wizard
- **Manage Time Periods feature**: the Time Period Sets page and the Time Period Set wizard
- the SAS Strategy Management enhanced portlet
<table>
<thead>
<tr>
<th>Accessibility Issue</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sometimes, you cannot use the keyboard to sequentially navigate through the interface and move the focus in a meaningful order.</td>
<td>No workaround is available</td>
</tr>
<tr>
<td>The SAS High Contrast theme has a few unresolved focus and contrast issues.</td>
<td>For contrast issues, select a different theme and then press Ctrl+~ to invert the colors.</td>
</tr>
<tr>
<td>Using JAWS with this application can sometimes cause Internet Explorer to stop responding.</td>
<td>Using JAWS 13 or later might resolve the issue.</td>
</tr>
<tr>
<td>JAWS cannot read some of the controls in the application, such as images, icons, and buttons.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS cannot read the tooltips of items in trees and lists.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS refers to table controls as list boxes.</td>
<td>When JAWS reports that a control is a list box, keep in mind that it might actually be a table.</td>
</tr>
<tr>
<td>Sometimes, JAWS does not correctly work with the controls in the Preferences window.</td>
<td>While you are in Virtual PC cursor mode, traverse the entire window to familiarize yourself with its contents before you change any of the settings. Switch to Forms mode or disable the Virtual PC cursor if you are not able to use a control in Virtual PC cursor mode.</td>
</tr>
<tr>
<td>JAWS does not correctly read the states in a tri-state check box tree if JAWS is not in Forms mode.</td>
<td>Disable JAWS' Virtual PC cursor when you work with the check box tree. Tab to the tree, and press Insert+Z to disable the Virtual PC cursor. When you finish interacting with the tree, press Insert+Z to re-enable the Virtual PC cursor.</td>
</tr>
<tr>
<td>The keyboard shortcuts that are used to interact with editable tables can conflict with keyboard shortcuts for JAWS' forms mode.</td>
<td>As a best practice, disable JAWS' Virtual PC cursor when you work with tables. Tab to the table, and press Insert+Z to disable the Virtual PC cursor. When you finish interacting with the table, press Insert+Z to re-enable the Virtual PC cursor.</td>
</tr>
<tr>
<td>JAWS cannot read two-column property tables.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>JAWS does not correctly read the information in a table:</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>■ JAWS cannot read the column headings of a table.</td>
<td></td>
</tr>
<tr>
<td>■ When table cells are not editable and the focus is on the body of the table,</td>
<td></td>
</tr>
<tr>
<td>JAWS reads an entire row at a time instead of cell by cell.</td>
<td></td>
</tr>
<tr>
<td>■ When table cells are editable, and the focus is on the body of the table,</td>
<td></td>
</tr>
<tr>
<td>JAWS reads only the first row of the table. If you use the arrow keys to</td>
<td></td>
</tr>
<tr>
<td>select a cell or row, then JAWS does not read anything. If you press Enter to</td>
<td></td>
</tr>
<tr>
<td>edit a cell, then JAWS reads the row that contains the edited cell.</td>
<td></td>
</tr>
<tr>
<td>When you are in a table cell, if you press Home, End, Page Up, or Page Down, the</td>
<td>Use the arrow keys to navigate through the cells of the table.</td>
</tr>
<tr>
<td>selected cell will change to be one in the first column of the currently</td>
<td></td>
</tr>
<tr>
<td>displayed columns for the table.</td>
<td></td>
</tr>
<tr>
<td>Sometimes, you cannot use F2 to put a table cell into Edit mode.</td>
<td>The following workaround does not apply in all situations. When you are in the cell</td>
</tr>
<tr>
<td></td>
<td>that you want to edit, press Ctrl+F8 twice for</td>
</tr>
<tr>
<td></td>
<td>two-dimensional tables and three times for</td>
</tr>
<tr>
<td></td>
<td>multidimensional tables.</td>
</tr>
<tr>
<td>You cannot use the keyboard to scroll to the left and the right in some tables.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>You cannot use the keyboard to activate the links within how-to topics and Help</td>
<td>Use the Help menu to access the linked documents.</td>
</tr>
<tr>
<td>pop-up windows.</td>
<td></td>
</tr>
<tr>
<td>You cannot use Shift+F10 to open a pop-up menu.</td>
<td>Use Shift+F9 to open pop-up menus that are</td>
</tr>
<tr>
<td></td>
<td>created for the SAS application. The generic</td>
</tr>
<tr>
<td></td>
<td>menu that is provided by the Flash player cannot</td>
</tr>
<tr>
<td></td>
<td>be opened by Shift+F9.</td>
</tr>
<tr>
<td>Note: If you press Shift+F10 in Internet Explorer and no context menu is available,</td>
<td>If you press Shift+F10 in Internet Explorer and</td>
</tr>
<tr>
<td></td>
<td>no context menu is available, the browser will</td>
</tr>
<tr>
<td></td>
<td>move the focus to the File menu for the browser</td>
</tr>
<tr>
<td></td>
<td>tab. To return focus to the application area of</td>
</tr>
<tr>
<td></td>
<td>the browser window, press Esc.</td>
</tr>
<tr>
<td>You cannot use the keyboard to access the close (x) button that is in the top</td>
<td>Make sure that the focus is on the tab, and</td>
</tr>
<tr>
<td>right corner of a tab.</td>
<td>then press Delete to close the tab.</td>
</tr>
<tr>
<td>You cannot use the keyboard to access the close (x) button that is in the top</td>
<td>Make sure that the focus is on the tile, and</td>
</tr>
<tr>
<td>right corner of a tile in the tile pane.</td>
<td>then press Delete to close the tile.</td>
</tr>
<tr>
<td>(The object that is displayed in the tile is not deleted.)</td>
<td></td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Visual focus for the menu bar is indicated with an outline around the entire menu bar instead of around individual menus.</td>
<td>To select individual menus, use the left or right arrow key.</td>
</tr>
<tr>
<td>Sometimes, you cannot use the Tab key to move the focus to the application area of a web browser (that is, the part of the browser window that is controlled by the Flash player).</td>
<td>The following workaround is applicable to Internet Explorer only. Press Ctrl+<em>number</em>, where <em>number</em> is the ordinal position of the application’s tab in the set of tabs that are open in your browser window. Then press Tab to move the focus into the application area.</td>
</tr>
<tr>
<td>You cannot use the Tab key to move the focus outside of a code or expression editor. Pressing Tab within the editor only inserts tabs.</td>
<td>For Internet Explorer, press Shift+F10 and then press Esc to move the focus outside of the editor. For Firefox, press Alt+Tab to switch to another application. When you switch back, the focus will be outside of the editor.</td>
</tr>
<tr>
<td>You cannot use Ctrl+Alt+Shift+M to minimize or maximize the view if the focus is on the workspace bar.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>After you zoom into a window, if you tab to an item that is off-screen, the item is not automatically scrolled back into view.</td>
<td>Sometimes, you can use the arrow keys to scroll the item back into view.</td>
</tr>
<tr>
<td>If you use the Ctrl++ keyboard shortcut to zoom in to a secondary window, the outer edges of that window can become hidden from view if you zoom in too far.</td>
<td>Use the keyboard to access the hidden parts of the window.</td>
</tr>
<tr>
<td>When you use the Ctrl++ keyboard shortcut to zoom, the bottom entries of a drop-down menu can become hidden from view if you zoom in too far.</td>
<td>Use the keyboard to access the hidden entries in the menu.</td>
</tr>
<tr>
<td>The Ctrl++ and Ctrl+- keyboard shortcuts for zooming in and out do not work on some menus unless the menus are first opened.</td>
<td>Open the menu before you use the keyboard shortcut.</td>
</tr>
<tr>
<td>The Ctrl++ and Ctrl+- keyboard shortcuts for zooming in and out do not work on all elements in the application window (for example, tooltips and button labels).</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>If you maximize a tile in the <strong>Home</strong> workspace and then use the Tab key to navigate, the focus appears to be lost after you tab away from the <strong>Log Off</strong> button.</td>
<td>After you maximize the tile, press the Tab key 10 to 25 times, and eventually, the focus will return to the maximized tile.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>You cannot use the keyboard to navigate in the Layout section because it is a read-only interface that is used for the visual verification of the elements that have been created.</td>
<td>Use the test button that is in the Layout section to preview your elements in a secondary window. The items that are displayed in the secondary window are identical to the items that are displayed in the Layout section, but unlike the items in the read-only Layout section, you can interact with the items in the secondary window. Note: After the application opens the secondary window, press Tab to place the focus in the window.</td>
</tr>
<tr>
<td>On the Global Preferences page of the Preferences window, if you press Esc while you are in the color palette that you opened from the Color field or in the Custom Colors window that you opened from the color palette window, the Preferences window will close and any unsaved changes will be lost.</td>
<td>If you are in the color palette window, first tab to the Custom Colors button and then press Esc. If you are in the Custom Colors window, use the Cancel button.</td>
</tr>
<tr>
<td>JAWS cannot read the labels for the Red, Green, and Blue fields in the Custom Colors window.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>JAWS does not explain how to open a drop-down menu or drop-down list.</td>
<td>Press Ctrl+down arrow to open the control.</td>
</tr>
<tr>
<td>When JAWS reads the control names in a breadcrumb, it does not distinguish between the breadcrumb buttons that contain drop-down menus and those that do not.</td>
<td>Check for a drop-down menu by pressing Ctrl+down arrow on a breadcrumb button. A drop-down menu will open if one exists for that button.</td>
</tr>
<tr>
<td>You cannot use standard key sequences to select a dynamic data source for an element. When you use the arrow key to navigate to the A predefined list item, which precedes the A dynamic list item, the Customize Data window appears for the predefined list and prevents you from navigating to the A dynamic list item.</td>
<td>In order to select a dynamic list and specify a data source for that list, first press Ctrl+down arrow to open the Populated by drop-down list in the Properties pane. Select A predefined list. In the Customize Data window, press Tab once and then press Ctrl+Shift+spacebar to add a row to the list. Enter a valid value (for example, 1). Use the OK button to close the Customize Data window. Then use the down arrow key to select A dynamic list from the Populated by drop-down list. The Customize Data window for dynamic lists will immediately open.</td>
</tr>
<tr>
<td>When you add a date value to the predefined list for a date element, you cannot use the keyboard to access the data-selection button in the table cells in the Customize Data window for the predefined list.</td>
<td>Type the date value in the field that is next to the date-selection button.</td>
</tr>
<tr>
<td>Accessibility Issue</td>
<td>Workaround</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>JAWS cannot read the contents of a tree table (that is, a table that contains a tree) unless the table is in Edit mode.</td>
<td>Make sure that the focus is in the tree table, and press F2 to enter Edit mode.</td>
</tr>
<tr>
<td><strong>Accessibility Issue</strong></td>
<td><strong>Workaround</strong></td>
</tr>
<tr>
<td>In the Time Period Set wizard and the Import Configuration wizard, you cannot tab to the button that expands the next section of the wizard.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>In the Time Period Set wizard, you cannot tab, edit, or select the table cells of the wizard.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>On the Import Configuration page, you cannot tab to the button in the Status column heading.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>In the Hierarchy Import Configuration wizard, you cannot tab to Select Source Data or to Map to Hierarchy.</td>
<td>No workaround is available.</td>
</tr>
<tr>
<td>In some steps of the Content Import Configuration wizard, you cannot tab to the Next and Cancel buttons.</td>
<td>No workaround is available.</td>
</tr>
</tbody>
</table>

The following features of SAS Strategy Management have not been tested for accessibility:

- Manage Rules
- Manage Data Entry Forms
- the SAS Strategy Management data-entry form portlet
Introduction to SAS Strategy Management

Chapter 1
  About SAS Strategy Management ............................................. 3

Chapter 2
  How Do You Describe a Strategy? ............................................. 9

Chapter 3
  What Is a View? ................................................................. 19
About SAS Strategy Management

What Is SAS Strategy Management?

SAS Strategy Management enables you to describe your strategy, regardless of the performance management framework that you have chosen. SAS Strategy Management aligns the actions of an organization to optimize strategic outcomes. You can define, plan, execute, and validate your strategy—all using SAS Strategy Management.

- **Define**: Formalize strategy and goals and the relationships between key performance indicators using strategy maps and diagrams.
- **Plan**: Set targets, thresholds, priorities, and weights associated with strategic objectives and metrics. Align strategies to support those of the organization.
- **Execute**: Monitor progress toward targets and goals. Receive alerts to areas of underperformance. Visually depict impact between leading and lagging indicators. Share feedback and commentary.
- **Validate**: Prove that a strategy delivers expected results. Statistically quantify impact, priorities, and relationships and perform what if analysis.

What Is a Performance Management Framework?

A *performance management framework* is a system that is supported by measures of performance. The framework enables you to combine financial and nonfinancial
measures of performance, as well as leading and lagging indicators. Such measures can help your organization:

- Optimize your strategy and manage organizational activities.
- Test strategies before you implement them.
- Evaluate results and accomplishments.
- Correct your strategy to reflect lessons learned.

A performance management framework, for example—a balanced scorecard, can be used to evaluate an organization's impact from several perspectives, including:

- customers
- learning and growth of employees
- internal business processes
- financial results

**Why Use a Performance Management Framework?**

A performance management framework can help your organization achieve the following goals:

- Reverse a losing competitive position.
- Keep pace with new technological advances.
- Respond to changing labor markets.
- Adjust to changes in your employees and staff.
- Comply with government management reforms.

**Benefits of Using SAS Strategy Management**

- Improve governance, focus, and alignment. Your organization can collaboratively gain agreement, direction, and priorities for the short, medium, and long term of key initiatives and goals. You can translate this understanding through a series of connected strategy maps, themes, objectives, and metrics that guide and align the strategic activities of an organization.

- Share fact-based information quickly. Managers can cascade information about current performance and overall strategy within their own teams, and then allocate the right mix of resources—people, money and technology—to achieve strategic goals regardless of the timeline.

- Show visual connections of objectives and metrics. You can monitor performance and visually identify opportunities and threats through cause-and-effect strategy maps and diagrams. Automated alerts ensure that actions are taken in a timely
manner. You can share feedback and commentary on results to improve understanding and document various actions and expectations.

- Identify and quantify potential strategic flaws. You can apply embedded statistical routines within the solution to validate the strategy and perform ad hoc what-if analysis. Where necessary, you can update the strategy based on the results, and cascade the updates to managers and employees.

- Improve accuracy, consistency, and timeliness of information. You can automate and schedule the extraction, cleansing, and transformation of data used to populate the various metrics. SAS provides web-based, manual data entry for metrics that are not currently captured electronically.

### Why Use SAS Strategy Management?

You can use Strategy Management to make sure your organization is executing the right activities in the right way. Strategy Management enables organizations to communicate and measure their progress. Doing so means you can make sure your organization has accomplished what it set out to do. Strategy Management helps employees and teams understand their goals and priorities. With this understanding, it is easier to translate goals into activities that the organization can execute.

You can use SAS Strategy Management to accomplish the following tasks:

- Focus on key indicators of success. You can uncover information clearly, accurately, and quickly.

- Expose relationships between activities and how these relationships affect shareholder value.

- Understand which activities drive others and what impact these activities have on your organization's performance.

- Identify potential problems by understanding root causes.

When you can uncover information and relationships to make cause and effect clear, you can understand why certain activities are more important than others. You can then use time and resources more efficiently.

### SAS Strategy Management Users

SAS Strategy Management serves the following users:

- The builders, or scorecard modelers, that are technical users of Strategy Management.

- The viewers, or business users, that use the views created by the scorecard modelers in Strategy Management.

- The data-entry users that enter data into a project in Strategy Management by using data-entry forms created by scorecard modelers.
SAS Strategy Management Features

SAS Strategy Management provides the following features:

- **SAS Strategy Management Builder**

  By using the Builder, scorecard modelers can create and model their organization's strategy in SAS Strategy Management.

  For information about building a strategy, see Chapter 2, “How Do You Describe a Strategy?,” on page 9. Also, see “Part 2. Describing and Building Your Strategy.”

- **SAS Strategy Management views**

  By creating views, scorecard modelers provide strategy data to their business users. For detailed information about views, see Chapter 3, “What Is a View?,” on page 19. Also, see “Part 3. Navigating Data and Creating Views in SAS Strategy Management Builder.”

  **Note:** Strategy Management information can also be viewed in SAS BI Dashboard. For more information, see Appendix 3, “View SAS Strategy Management Data in SAS BI Dashboard,” on page 387.
Accessing Help and Documentation for SAS Strategy Management

SAS Strategy Management provides the following types of documentation:

**SAS Strategy Management: User’s Guide**

This document, available as a web document and as a PDF file, provides detailed information about the concepts and tasks that are related to using Strategy Management. To access this document, click **Help ➤ Help Contents** in the SAS Strategy Management Builder application. The SAS Documentation window appears.

In the left pane, on the **Contents** tab, expand **SAS Strategy Management ➤ SAS Strategy Management User’s Guide**. Click **View as PDF** to access the PDF file. Click and expand any of the remaining topics or folders to view the web document version of the User’s Guide.

**Embedded help**

Help pop-ups and tooltips provide brief descriptions of various tasks and fields to help you use the Strategy Management enhanced portlet effectively.

To access Help pop-ups for more information about a current topic, click 🔄 when it appears next to a field or area in the user interface. You can also place the mouse pointer over an element in the user interface to view the associated tooltip for more information.

**SAS Strategy Management: Enhanced Portlet Quick Start Guide**

This document, available as a web document and a PDF file, provides detailed information about the tasks that are related to using the Strategy Management enhanced portlet. You must be in the enhanced portlet to access this document.

In the portlet toolbar, click 🔄.

**Note:** The information contained in this document is also available in the SAS Strategy Management: User’s Guide.
Help

Help topics about tasks and concepts are available in the SAS Strategy Management Builder. To access this help, click Help » Help Contents or Help Help on This Page. If you are in a list or wizard, click Help.


Note: You must have a password to access the documentation on this web page. If you do not have the password, contact SAS technical support.
How Do You Describe a Strategy?

The Parts of a Strategy

A strategy created in SAS Strategy Management consists of the following parts:

Templates
Describe the type of strategy that you are creating. Defining a template is the first step in creating your strategy in SAS Strategy Management. You can create a template or use a predefined template.

Projects
Store and manage the content for your strategy. You can have one or more projects associated with a template.

Scorecards
Collect content or information about a specific topic, such as a business unit or product. You can have one or more scorecards in a project. Scorecards are arranged hierarchically.
Templates

Overview

In SAS Strategy Management, your first step is to define a template. The template defines the type of strategy that you are creating by describing the key parts of the strategy.

Examples of Templates

Before defining your template, you must identify your methodology. There are many models and methodologies that can describe a strategy. The following methodologies are examples:

- A customized model that you create or that your organization creates
- Balanced scorecard
- Business process
- European Foundation for Quality Management (EFQM)
- Governance, Risk, and Compliance (GRC)
- Six sigma

Parts of a Template

The Element Types

After you determine your methodology, you must describe the parts of the strategy in the template.

First, you must define what types of information you want the strategy to store. For example, you might want your strategy to include goals and measures. This type of information is called element types. You can have project element types and scorecard element types:

- Project element types are available to all projects (and the scorecards contained in a project) that are associated with a template. For example, a project element type might be named “Contacts,” and contains data that are employee names. The labels and values for a project element type are exactly the same for all of the scorecards contained in a project.

- Scorecard element types are available to one or more scorecards. For example, a scorecard might include an element type named “Strategic Objectives,” and contains data that are names of a company's strategic objectives. The labels and values for scorecard element types are different for each scorecard in a project.

The Metric Attributes

Next, you must describe types of values that help you to measure, group, or track your strategy results. Each value type is a standard of measurement for the strategy
to use as a basis for evaluation or comparison. This type of value is called a **metric attribute**. Actual and Target are examples of metric attributes.

**TIP** Every metric attribute that you define in a template is available to all of the scorecards and projects that are based on the template.

### The Language Setting

Last, you specify the language for your strategy to use to display information in SAS Strategy Management. The user-defined language setting enables you to localize your custom-defined content in the strategy. You might use the user-defined language setting in the following ways:

- To display a different language depending on which locale is using SAS Strategy Management
- To display terminologies that are used in different parts of the same company or in separate divisions of recently merged companies
- To display short and long versions of labels

**TIP** If you do not specify a language in the Strategy Management template, a default language is automatically used. Template content is displayed in the default language that is set in the Information Delivery Portal preferences.

The language setting enables the use of another language set, but does not perform translation. When you specify another language, the default language text is not translated. You must provide the text in the language that you specified by entering the text in SAS Strategy Management.

**Note:**

- The SAS Strategy Management program interface, such as menus and message text, are translated based on language localization settings. Contact your SAS representative to determine which languages are shipped with SAS Strategy Management.
- Data in a template is displayed in different languages, depending on the scorecards that are in an associated project.
- Date and number formatting is not affected.

### Predefined Templates

#### Overview

SAS Strategy Management provides the following predefined templates: Balanced Scorecard template and key performance indicator (KPI) template. If you have chosen either of these methodologies to describe your strategy, these templates enable you to define your strategy in SAS Strategy Management quickly.

**Note:** The user-defined template selection enables you to describe an entirely custom strategy. This selection does not provide any components that are already defined.
Balanced Scorecard Template
The Balanced Scorecard template reflects the Balanced Scorecard methodology for measuring performance. The Balanced Scorecard template contains the following components:
- A project element type named Contacts
- Scorecard element types named Objective, Measure, Initiative, Perspective, Vision, and Mission
- Metric attributes named Actual, Target, Status, and Performance
- A language named U.S. English.

KPI Template
The KPI template is used to measure key performance indicators. The KPI template contains the following components:
- A scorecard element type named KPI
- Metric attributes named Performance, Actual, and Target
- A language named U.S. English.

Projects that are created by using the KPI template do not provide the following features and functions:
- the following features cannot be displayed:
  - association table in the Builder
  - classic-style association portlet
  - association tile in the enhanced portlet
- diagrams cannot show relationships
- regression analysis is not available

TIP If you copy the predefined KPI template, you can create projects by using the template copy that provide the missing features and functions.

Projects
As you work with SAS Strategy Management, you must organize complementary information and content about your strategy. This organization is accomplished by using projects. A project is a top-level container to store and manage all the content in your strategy. The project also provides global settings for your strategy.

Each project is associated with one template. Associated projects are the projects that are associated with the current template. Associated projects share the same project element types, scorecard element types, metric attributes, and languages.
Within the project, you can create and manage the following content:

- Scorecards
- Ranges
- Column selections
- Forms

The following tasks are examples of the work that you can do when you are in a project:

- Create a data entry form and enter data by using that form
- Perform calculations
- View data in the following ways:
  - Tables
  - Aggregate tables
  - Gauges (also called dashboards)
  - Hierarchies
  - Diagrams

For more information about views and viewing data, see Chapter 3, “What Is a View?,” on page 19.

**Scorecards**

A scorecard is a collection of content or information about a specific topic. You can have one or more scorecards in a project. The scorecards can be at a single level or can be arranged in a hierarchical structure. A project can have one or more root-level scorecards. Each root-level scorecard can have child scorecards that are arranged in a hierarchy. For example, a root-level scorecard might represent a corporation’s balanced scorecard. At successively lower levels of the hierarchy, there might be scorecards for geographical areas, divisions, or departments.
A scorecard tracks internal business processes and external outcomes so that you can plan a strategy for your organization. You can use a scorecard to document strategic objectives, targets, initiatives, or any other measurement of your organization’s progress.

**TIP** You can expand and contract the levels of the hierarchy by clicking the arrow that is next to the name of a parent scorecard.
Elements and Attributes

After you define the type of information that you want the strategy to store (element types), you can specify detailed information by defining elements. An element is a unit of data that is represented by a row in a scorecard table. Each element belongs to an element type that is defined in the template that is associated with the project. Typically, there are multiple elements associated with an element type.

**Figure 2.3  The Element Type in a Scorecard**

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Objective</th>
<th>Element</th>
<th>Actual</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td></td>
<td>$15,090,000</td>
<td>▲</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td></td>
<td>$9,973,000</td>
<td>▼</td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td></td>
<td>$5,117,000</td>
<td>▲</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td></td>
<td>98</td>
<td>▼</td>
<td></td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td></td>
<td>78%</td>
<td>▲</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 2.4  An Element Is a Row in a Scorecard Table**

The following table provides examples of element types and the elements that belong to each type.

<table>
<thead>
<tr>
<th>Element Type Example</th>
<th>Element Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goals</td>
<td>Reduce inspection costs</td>
</tr>
<tr>
<td></td>
<td>Reduce overall cost per product</td>
</tr>
<tr>
<td></td>
<td>Provide accurate, on-time, delivery service</td>
</tr>
<tr>
<td>Measures</td>
<td>Average number of failed inspections</td>
</tr>
<tr>
<td></td>
<td>Average cost of each product</td>
</tr>
<tr>
<td></td>
<td>Average number of packages tracked online</td>
</tr>
</tbody>
</table>
For example, an employee name might be an element that belongs to the Contacts project element type. “Create New Products” might be an element that belongs to the Objectives scorecard element type.

An element value can be either periodic or non-periodic:

- Periodic values are values that can vary depending on the period of time in which the measurement took place. For example, sales numbers can vary by month. In Strategy Management, periodic values are called **metric attributes**. A metric attribute is a value residing in a cell of the scorecard row.

  ![Figure 2.5 A Metric Attribute in a Scorecard Table](image)

You can enter these values in the following ways:

- by entering values one cell at a time
- by specifying a formula
- by entering data using a data entry form
- by loading a batch of data

For more information, see “Part 6. Entering Data.”

- Non-periodic values are a second type of data that might be included in a strategy. This data is informational and typically does not change over time. For example, a website address or a contact name can be displayed in the strategy. This information does not change from month-to-month. In Strategy Management, non-periodic values are called **element attributes**.

  ![Figure 2.6 An Element Attribute in a Scorecard Table](image)

Note: Element attributes are defined in the template for each element type. Element attribute values are set when specifying properties for each element.

The following display shows a scorecard and all its attributes, both periodic and non-periodic.
A range is a defined interval with distinct upper and lower boundaries. Using a range, you can control how data values are displayed. For example, you can plot results against a color-coded scale that indicates how close your actual results are to your desired results. Ranges can be composed of intervals, each of which can be associated with a normalized value, a grade, an icon, a label, and a color. When you define a range, you specify the lower bound, upper bound and one or more range intervals. SAS Strategy Management uses the lower bound and upper bound to draw the lowest and highest values in a graph. The range intervals are drawn as segments in the graph between the low and high bounds.

For more information, see “Create a Range” on page 132.
Column Selections

When your strategy contains a lot of data, it can be difficult to understand. You can use column selections to group metric attributes, which appear in columns, to create specific views of your data. A column selection specifies the columns that are displayed with an element type in a table view, aggregate view, or association view.

You can apply column selections to element types within a project. When you create a project that is based on a template that defines metric attributes, column selections for the new project are automatically generated from the metric attributes. Column selections are also generated for the element types.

Figure 2.10  Example of a Table Displaying All Metric Attributes

<table>
<thead>
<tr>
<th>Name</th>
<th>Period</th>
<th>Actual</th>
<th>Target</th>
<th>Performance</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>AUG2010</td>
<td>$24,655,000</td>
<td>$10,000,000</td>
<td>18%</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>AUG2010</td>
<td>$16,919,750</td>
<td>$8,000,000</td>
<td>13%</td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>AUG2010</td>
<td>$8,193,250</td>
<td>$8,000,000</td>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>AUG2010</td>
<td>98</td>
<td>170</td>
<td>58%</td>
<td></td>
</tr>
<tr>
<td>Customer Satisf.</td>
<td>AUG2010</td>
<td>78%</td>
<td>87%</td>
<td>90%</td>
<td></td>
</tr>
</tbody>
</table>

Figure 2.11  Example of a Table Displaying Only Selected Columns

<table>
<thead>
<tr>
<th>Name</th>
<th>Period</th>
<th>Actual</th>
<th>Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>AUG2010</td>
<td>$24,655,000</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>AUG2010</td>
<td>$16,919,750</td>
<td>Red</td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>AUG2010</td>
<td>$8,193,250</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>AUG2010</td>
<td>98</td>
<td>Green</td>
<td></td>
</tr>
<tr>
<td>Customer Satisf.</td>
<td>AUG2010</td>
<td>78%</td>
<td>Green</td>
<td></td>
</tr>
</tbody>
</table>

For more information, see “Create a Column Selection” on page 138.

Forms

A form enables you to enter data or information into a strategy. Using SAS Strategy Management Builder, you can create a form to enter data into your Strategy Management project.

For more information, see Chapter 33, “Creating and Managing Forms,” on page 323.
What Is a View?

Overview

SAS Strategy Management provides different ways to display and explore strategy content and data. These are called views. Depending on your strategy, data might be easier to understand in one type of view compared to another type. The following views are available:

- Table
- Aggregate
- Association
- Diagram
- Gauge (also called dashboard)
- Trend analysis

You can use these views in the following ways:

- You can navigate and explore your data using different views in SAS Strategy Management Builder. You can use only one view at a time. Some business users might access a view in the Builder to adjust the view, but the Builder is primarily used by scorecard modelers. For detailed information, see “Part 3. Navigating Data and Creating Views in SAS Strategy Management Builder.”

- You can create a portlet that is displayed on a portal page in the SAS Information Delivery Portal. Scorecard modelers create portlet views for their business users. Because you can have multiple portlets on a portal page, you can display and use multiple views at a time. Also, the new Strategy Management enhanced portlet can display one or more tiles. A tile is like a window, but it exists within the boundaries of a portlet. In Strategy Management, a tile displays a view. For detailed information, see “Part 4. Creating Portlet Views for Business Users.”
Note: Strategy Management information can also be viewed in SAS BI Dashboard. For more information, see Appendix 3, "View SAS Strategy Management Data in SAS BI Dashboard," on page 387.

The views are available in the following ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Builder</th>
<th>Classic-style Portlet</th>
<th>Enhanced-portlet Tile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Association</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Diagram</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Gauge</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Trend</td>
<td>Yes¹</td>
<td>Yes¹</td>
<td>Yes²</td>
</tr>
</tbody>
</table>

1. Links to the Trend Analysis page that provides the classic style dynamic analysis features.
2. Provides the trend analysis tile with enhanced dynamic features and a static trend chart option.

---

Table

Tables display data in rows and columns.

**Figure 3.1 Table Example**

<table>
<thead>
<tr>
<th>Name</th>
<th>Period</th>
<th>Actual</th>
<th>Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>AUG2010</td>
<td>$24,655,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>AUG2010</td>
<td>$16,161,750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>AUG2010</td>
<td>$8,193,250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>AUG2010</td>
<td>98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Sats.</td>
<td>AUG2010</td>
<td>78%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The columns in the table are determined by the template with which the project is associated. The elements are displayed in rows. You can create elements in a table. In a table, you can perform the following tasks:

- Display data that is organized by element type, attribute, and date.
- Create, copy, move, and delete elements.
- Customize the rows, columns, and types of links that are displayed in the table.
- Format columns and cells.
- Apply formulas and ranges to columns.
- Set global and personal threshold options.
- Display history.
- View and add comments.

**Aggregate**

An aggregate table shows data from the selected scorecard and all of its children. You can choose to view the aggregated data by scorecard or by metric attribute.

**Note:** If a scorecard does not contain child scorecards, the aggregate table is not displayed.

**Figure 3.2 Aggregate Example**

<table>
<thead>
<tr>
<th>Name</th>
<th>Asia Pacific</th>
<th>India</th>
<th>China</th>
<th>Asia Pacific</th>
<th>India</th>
<th>China</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>17,380,000</td>
<td></td>
<td>2,880,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>5,118,000</td>
<td>3,240,000</td>
<td>1,878,000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>12,271,500</td>
<td>1,260,000</td>
<td>1,011,500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>98</td>
<td>98</td>
<td>98</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Stats</td>
<td>78%</td>
<td>78%</td>
<td>78%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Association**

An association displays relationships between scorecard element types and their associated attributes in a project. The elements are displayed in a hierarchy to reflect their association.

**Figure 3.3 Association Example**

<table>
<thead>
<tr>
<th>Name</th>
<th>Actual</th>
<th>Target</th>
<th>Perform.</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality management</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer loyalty program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revenues</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Market share</td>
<td>$45</td>
<td>75</td>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>90</td>
<td>170</td>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>New Customers</td>
<td>180</td>
<td>150</td>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>78%</td>
<td>87%</td>
<td>90%</td>
<td></td>
</tr>
<tr>
<td>Productivity</td>
<td>$15</td>
<td>65</td>
<td>78%</td>
<td></td>
</tr>
<tr>
<td>Hours spent with CU</td>
<td>76</td>
<td>65</td>
<td>86%</td>
<td></td>
</tr>
</tbody>
</table>
Diagram

A diagram is a graphical way of representing elements, their relationships to one another, and their respective scores. A diagram is a way to present information found in tables, but in a more intuitive way. When you use a diagram, you can display results in the context of the strategy and provide answers about how well the organization is performing and why certain data or a certain relationship is important.

A diagram enables users to see the relationship between strategy elements. These relationships are sometimes difficult to convey in a table. You can create diagrams that illustrate the relationships between scorecard elements or project element types.

Note: A diagram is often used to present the strategy map, which is a layered representation that conveys the drivers and relationships.

Figure 3.4 Example of a Diagram View Displayed in a Classic-Style Portlet

Gauge (Also Called Dashboard)

A gauge (also called dashboard) displays ranges of data in a graphical format. You can display key performance indicators or any SAS Strategy Management elements by using the gauge view. Each element is represented by a gauge that displays the data ranges that are defined. In addition to displaying ranges, you can provide links to comments, trend data, and element properties.
Gauges can be displayed as a dial, a slider, a stoplight, a speedometer, or a bullet bar.

Figure 3.5  Example of a Gauge Dial

Trend Analysis

An element's trend is its performance over time. You can view a trend analysis that displays the trend of an element's data. SAS Strategy Management provides different trend view implementations depending on the product feature.

<table>
<thead>
<tr>
<th>Product Feature</th>
<th>Trend Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Builder</td>
<td>When you are working in the Builder using the table or association views, the Trend Analysis button is available. When you click this button, the Trend Analysis page appears.</td>
</tr>
<tr>
<td>Classic-style portlet</td>
<td>When you are working in the table, association, or dashboard views in a classic-style portlet, the Trend Analysis button might be available, depending on how the portlet is customized. When you click this button, the Builder opens and the Trend Analysis page appears.</td>
</tr>
<tr>
<td>Enhanced-portlet tile</td>
<td>The Strategy Management enhanced portlet can be customized to include a trend analysis tile. You can drag a value or an element from one or more table, aggregate, association, or gauge tiles onto the trend analysis tile. You can manipulate the resulting graph to further explore the trend analysis. You can also add or remove more data from other tiles. See Figure 3.6 on page 24.</td>
</tr>
<tr>
<td>Enhanced-portlet option</td>
<td>The enhanced-portlet tiles for the table, association, diagram, and gauge views provide an option to display a static trend chart. If the tile is customized to use this option, you can click an icon that opens a trend chart. The data is static although you can change the date range using the date slider. See Figure 3.7 on page 25.</td>
</tr>
</tbody>
</table>

With the Trend Analysis page, the initial analysis uses the element whose row you clicked to open the Trend Analysis page. However, you can dynamically add to or
change the analysis after it opens. For more information, see Chapter 22, “Creating and Editing Trend Analysis Views,” on page 231.

For more information about the enhanced-portlet implementations of trend analysis, see the following sections:

- “Edit the Trend Analysis Tile Properties” on page 274
- Chapter 30, “Navigating and Viewing the Strategy Management Enhanced Portlet and Its Tiles,” on page 299

Figure 3.6 Example of a Dynamic Trend Analysis in an Enhanced Portlet Tile
Figure 3.7  Example of a Static Trend Chart in the Enhanced Portlet
Chapter 3 / What Is a View?
Part 2

Describing and Building Your Strategy

Chapter 4
Starting SAS Strategy Management Builder ........................................... 29

Chapter 5
The SAS Strategy Management Builder Interface ................................... 37

Chapter 6
Working with Templates ............................................................................. 41

Chapter 7
Working with Projects ............................................................................... 59

Chapter 8
Working with Scorecards ......................................................................... 83

Chapter 9
Working with Elements and Element Attributes .................................... 93

Chapter 10
Defining Rules ......................................................................................... 119

Chapter 11
Working with Formulas ........................................................................... 123

Chapter 12
Calculating a Project ................................................................................. 129
Chapter 13
Working with Ranges .......................................................... 131

Chapter 14
Working with Column Selections ........................................ 137

Chapter 15
Common Tasks ................................................................... 143
Starting SAS Strategy Management Builder

Starting SAS Strategy Management Builder Using a Link

Overview
You can create a shortcut link that opens SAS Strategy Management Builder in your web browser by using the web address of the SAS Strategy Management web application (the Builder).

Create the Shortcut Link
To create the shortcut link that opens SAS Strategy Management Builder:


2. In the Type the location of the item field, enter the web address for the SAS Strategy Management web application.
   - Note: To obtain the web address, contact your system administrator.

3. Click Next.
In the **Type a name for this shortcut**, enter a short, descriptive name for this shortcut.

5 Click **Finish**. The shortcut appears on your Windows desktop.

---

**Log On**

To log on to the SAS Strategy Management web application (the Builder):

1 Click the shortcut on your desktop. The Log On page appears.

2 Enter your user ID and password.

3 Click **Log On**. The SAS Strategy Management Builder appears and the Template and Project Manager page is displayed.

---

**Starting SAS Strategy Management Builder from a Portlet**

**Overview**

Before you access SAS Strategy Management Builder, you must log on to the SAS Information Delivery Portal and create a portal page. Then you can add a Collection portlet from which to start SAS Strategy Management Builder.
Log On

To log on to the SAS Information Delivery Portal:

1. Open your browser and enter the web address for the portal. The Log On page appears.
   
   **Note:** To obtain the web address, contact your portal administrator.

2. Enter your user ID and password.

3. Click Log On. Your personal portal opens. Initially, the portal contains no pages or portlets.

Create a Page

To create a new portal page to contain the SAS Strategy Management Builder portlet:

1. Click Customize ➤ Add Page. The Add Pages to Profile page appears.

   ![Add Pages to Profile](image)

2. On the Create tab, type descriptive information about the page:
   
   **Name**
   
   a short name that appears in the page tab in the navigation bar.

   **Description**
   
   a short description that appears along with the page title in search results.

   **Keywords**
   
   single words that you or other users can use to search for this page. Use spaces to separate keywords from one another.

   **Note:** To ensure efficient searching, develop a list of standard keywords and use these keywords consistently.

   **Page rank**
   
   a number that indicates the importance of this page as compared to other pages. The default value is 100.

   This number determines the order in which pages are listed in the navigation bar. The pages are ordered by rank from lowest to highest. Pages that have equal rank are listed in the order in which they were created.
Location (group)

Note: This list appears only if you are a group content administrator.

specifies the group with which to share the page. If you select a value in the Location (group) field, the Share type field appears.

**TIP** This selection supports sharing with only one group at a time. To share with more than one group, you must have authorization manager capability in the SAS Management Console. In SAS Management Console Permissions, expand Authorization Manager ➤ By Type ➤ PSPortletPage. Click your new portal page. In the View Properties list, on the Authorization tab, add any users and groups to share. Click OK.

**TIP** To share with everyone, select Public from the list.

Share type

Note: This list appears only if you are a group content administrator and have made a selection in the Location (group) list.

indicates how the page is shared with users. This list provides the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>Users in the group can find the page using Search. They can add the page if needed.</td>
</tr>
<tr>
<td>Default</td>
<td>Users in the group automatically see the page the next time they log on to the portal. Users can remove the page from the navigation bar if the page is not needed.</td>
</tr>
<tr>
<td>Persistent</td>
<td>Users in the group automatically see the page the next time they log on to the portal. However, users cannot remove the page from the navigation bar.</td>
</tr>
</tbody>
</table>

3 Click Add.

4 Click Done. The new, empty page appears in the portal.

Add a Portlet to the Page

A Collection portlet can contain links to the content and applications that you frequently use. Your portal might contain several of these portlets, each containing its own set of links. For SAS Strategy Management, these portlets can contain a task link that starts SAS Strategy Management Builder.

To add a portlet to a page:

1 Navigate to the Information Delivery Portal page to which you want to add a portlet.

2 Click Customize ➤ Edit Page ➤ Edit Page Content. The Edit Page Content page appears.
3 Click **Add Portlets**. The Add Portlets to Page page appears.

4 From the **Portlet type** list, select **Collection**.

5 Enter the name, description, and keywords, if any.

6 Click **Add**.

7 Click **Done**.

8 On the Edit Page Content page, click **OK**. The new portlet appears on the page.

### Add Links to the Collection Portlet

You can add links to the Collection portlet that open a limited set of features in Strategy Management Builder. You can also add a link that opens a specific project or scorecard.

Complete the following steps in the My Collection portlet:

1 On the My Collection portlet toolbar, click **Edit Content**. The Edit Portlet Content page appears.

2 Click **Add Items**. The Add Items to Portlet page appears.

3 To add a predefined link to the portlet, complete the following steps:
   a Click the **Search** tab.
   b In the **Keywords** field, type **Strategy**.
   c In the list, click **Application**.
   d Click **Search**. In the right pane, the search results appear. Any application link that includes the word **Strategy** is displayed.
   e Select one or both of the following results:
Manage Strategy Management Scorecard Projects and Templates

New Strategy Management Scorecard Project

Click Add.

To add a custom link to the portlet, complete the following steps:

a. Click Application. Doing so makes sure that you do not have to log on to the portal again.

b. On the Create tab, in the Name field, enter the name that you want to use to label the link.

c. In the URL field, type or paste the web address for the SAS Strategy Management project or scorecard that you want the link to open.

Note: To obtain the web address, navigate to the project, scorecard, or any other location within the Strategy Management Builder that you want to open. Then, copy that web address from your web browser address field.

d. Click Add.

Click Done to exit the Add Items to Portlet page.

On the Edit Portlet Content page, click OK. The portlet now contains the links that you added. For information about starting the Builder, see “Start the Strategy Management Builder” on page 34.

**Start the Strategy Management Builder**

To start the Strategy Management Builder from a Collections portlet, click the link label that you specified for the Strategy Management Builder web address. The Builder appears.

Using SAS Strategy Management Builder and SAS Visual Analytics

If you have SAS Visual Analytics 6.2 installed in your environment with SAS Strategy Management 5.5, the SAS Visual Analytics home page can contain links to SAS Strategy Management projects. If you select a project on the home page, the SAS Strategy Management Builder opens and you can edit the content.

Log Off from SAS Strategy Management Builder

To log off from SAS Strategy Management Builder, click Log Off in the upper right corner of the user interface.

Note: If your session is inactive longer than the SAS Information Delivery Portal time-out value, you are automatically logged off.
Your First Look at the Strategy Management Builder

The following display shows the SAS Strategy Management interface and its major parts:
About the Banner

The following display shows the banner interface and its features:

1. **Title**
   - Identifies the current page in SAS Strategy Management and the currently selected template, project, or scorecard. In this example, the selected template name is displayed.

2. **Log Off**
   - Click to log off from SAS Strategy Management.

3. **Preferences**
   - Click to view and set preferences for the SAS Information Delivery Portal, its pages, and its portlets.

4. **Help**
   - Displays the Help menu that provides help for SAS Strategy Management, the SAS Information Delivery Portal, and any other products installed in the portal.

Note: Depending on where you are in SAS Strategy Management, the Back link appears next to the Portal link. Click Back to return to the previous page.

About the Toolbar

The toolbar provides buttons for frequently used tasks in the Builder. The buttons that are displayed vary depending on selections that you made in the Builder. The following display shows the toolbar when you first open SAS Strategy Management Builder:

*Figure 5.1 Initial Toolbar in the Builder*

![Initial Toolbar in the Builder](image)

When you open a project or scorecard, the toolbar displays one set of buttons above the navigation pane and another set of buttons above the content pane.
Figure 5.2  Toolbar above Navigation Pane

1 Displays the **Project** menu. For more information, see Chapter 7, "Working with Projects," on page 59.

2 Displays the **Scorecard** menu. For more information, see Chapter 8, "Working with Scorecards," on page 83.

3 Prints the current view in the content pane. For more information, see “Print a View” on page 239.

The content pane buttons include buttons that are always available and other buttons that vary depending on the type of content that appears in the pane.

Figure 5.3  Buttons That Are Always Available above the Content Pane

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Table view</td>
<td>Displays the table view. This is the default view. For more information, see Chapter 17, &quot;Creating and Editing Table Views,&quot; on page 159.</td>
</tr>
<tr>
<td></td>
<td>Aggregate view</td>
<td>Displays the aggregate view. For more information, see Chapter 18, &quot;Creating and Editing Aggregate Views,&quot; on page 165.</td>
</tr>
<tr>
<td></td>
<td>Association view</td>
<td>Displays the association view. For more information, see Chapter 19, &quot;Creating and Editing Association Views,&quot; on page 167.</td>
</tr>
<tr>
<td></td>
<td>Diagram view</td>
<td>Displays the diagram view. For more information, see Chapter 20, &quot;Creating and Editing Diagram Views,&quot; on page 173.</td>
</tr>
<tr>
<td></td>
<td>Add to portlet</td>
<td>Provides a way to save a view to a portlet. For more information, see &quot;Save a View to a Portlet&quot; on page 238.</td>
</tr>
<tr>
<td></td>
<td>Save as a SAS Information Map</td>
<td>(Table view only) Provides a way to save the scorecard as a SAS Information Map. For more information, see “Save a Scorecard as a SAS Information Map” on page 85.</td>
</tr>
<tr>
<td></td>
<td>Copy web address</td>
<td>Provides a way to copy the web address of the view. For more information, see “Link to a View Using a Web Address” on page 239.</td>
</tr>
<tr>
<td></td>
<td>Refresh</td>
<td>Refreshes the current view.</td>
</tr>
</tbody>
</table>

**Note:** The buttons that are displayed depending on the current content are described in the chapters related to that content.
About the Navigation Pane

The navigation pane, located on the left side of the SAS Strategy Management Builder interface, enables you to navigate the following hierarchies:

- If you are working on the Templates and Project Manager page, it provides the available templates.
- If you are working in a project or scorecard, this pane provides the scorecards in the project.

About the Content Pane

The content pane, located on the right side of the SAS Strategy Management Builder interface, enables you to view lists of available content or to view the currently selected content.
Working with Templates

Overview .................................................. 42
List Templates .............................................. 42
Create a Template .......................................... 42
Open a Template ........................................... 45
Working with Project Elements .......................... 45
  Overview .................................................. 45
  Edit Project Element Type Properties .................. 45
  Copy Project Element Types or Scorecard Element Types .......... 48
  Delete Project Element Types ................................ 48
  Change the Order of Element Types .......................... 48
Working with Scorecard Element Types ................. 49
  List Scorecard Element Types ................................ 49
  Edit Scorecard Element Type Properties ...................... 49
  Copy Scorecard Element Types ................................ 52
  Delete Scorecard Element Types ................................ 52
Working with Metric Attributes ............................ 52
  List Metric Attributes .......................................... 52
  Rename a Metric Attribute ...................................... 53
  Delete Metric Attributes ....................................... 53
Working with Language Settings .......................... 53
  Overview .................................................. 53
  Create and Edit a User-Defined Language ...................... 53
  Set a User-Defined Language as the Default Language .......... 54
  List Defined Languages ...................................... 54
  Rename a Language .......................................... 54
  Delete a Language .......................................... 55
List Associated Projects .................................... 55
Edit User-Defined Template Properties .................. 55
Edit Predefined Template Properties ...................... 57
Copy a Template ........................................... 58
Delete a Template ........................................... 58
Manage Time Periods .......................................... 58
View Audit Records .......................................... 58
Manage Mobile Applications ............................... 58
Overview

For a description of templates, projects, and scorecards, and how they relate to each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

List Templates

Templates are listed in the Template and Project Manager. For more information, see “Display the Template and Project Manager Page” on page 143.

Create a Template

To create a template, complete the following steps:

1. Display the Template and Project Manager page. For more information, see “Display the Template and Project Manager Page” on page 143.


3. Type a name for the new template in the Template name field.
   Note: The name must be unique among the user-defined templates.

4. Click OK. The Template Editor page appears.

5. To define the project elements, select Project Element Types from the list on the left and complete the following steps:
   a. Click New Project Element Type. The New Project Element Type page appears.
In the **General settings** section, type a name for the element type. You can also type a description.

**Note:** The name must be unique among the project element types and the scorecard element types in the template.

c Click the icon that is next to **Image** and select an image to represent the element type.

**Note:** When you view a scorecard later, if the image that is specified here is missing, no image is displayed for that project element type. An image might be missing because the previously assigned image has been removed.

d In the **Diagram settings** section, click the icon that is next to **Font color** and select a font color to be displayed with the element type in a diagram.

e Click the icon that is next to **Background color** and select a color to be displayed in the background of the element type in a diagram.

f From the **Shape** list, select a shape to be displayed with the element type in a diagram.

g Click **OK**.

6 To define a scorecard element type, select **Scorecard Element Types** from the list on the left and complete the following steps:

a Click **New Scorecard Element Type**. The New Scorecard Element Type page appears.
In the General settings section, type a name for the element type. You can also type a description.

Click the icon that is next to Image and select an image to represent the element type.

Note: When you view a scorecard later, if the image specified here is missing, no image is displayed for that scorecard element type. An image might be missing because the previously assigned image has been removed.

To enable users to suggest elements, select Allow Suggested Elements.

In the Diagram settings section, click the icon that is next to Font color and select a font color to be displayed with the element type in a diagram.

Note: The diagram settings are applied only when a diagram is created. The settings do not affect existing diagrams.

Click the icon that is next to Background color and select a color to be displayed in the background of the element type in a diagram.

From the Shape list, select a shape to be displayed with the element type in a diagram.

Click OK.

To define a metric attribute, select Metric Attributes from the list on the left and complete the following steps:

Click New Metric Attribute. The New Metric Attribute page appears.

Type a name for the metric attribute.

Click OK.

(Optional) To define a language, select User-Defined Languages from the list on the left and complete the following steps.

Note: For more information, see “Working with Language Settings” on page 53.

Click New Language. The New Language page appears.

Type a name for the language.
Open a Template

You can open a template for editing and viewing. Element types, metric attributes, and languages that you add to a template after you have created a project are reflected in the project. If you delete element types, metric attributes, or languages from a template, those items are deleted from the project, whether or not they contain data.

To open a template, complete the following steps on the Template and Project Manager page:

1. Select a template name in the list of templates.
2. Click Template ➤ Edit Template. The Template Editor page appears.

Working with Project Elements

Overview

You define a project element type when you create a template. For more information, see “Create a Template” on page 42.

To list the project element types that are in a template, open a template and click Project Element Types.

The Project Element Types table displays the element types that you have created for the selected template. From this table, you can create new element types, edit the properties of element types, and copy and delete element types.

Edit Project Element Type Properties

To edit project element type properties in a template, complete the following steps in an open template:

1. Select Project Element Types from the list on the left.
2. Next to an element type in the table, click ☐ and click Properties. The Project Element Type Properties page appears.
To change the general properties of a project element type, complete the following steps:

a. In the General section, type a new name in the Element type name field.

b. (Optional) Change the description in the Description field.

c. To change the image to be displayed with the element type, click the icon that is next to Image and select an image.

   Note: If an image does not exist, no image is displayed for that element type. Images might be missing because a previously assigned image has been removed without updating the element type properties.

d. In the Diagram Settings section, click the icon that is next to Font color to change the font color to be displayed with the element type in a diagram.

e. Click the icon that is next to Background color to change the color to be displayed in the background of the element type in a diagram.

f. From the Shape list, change the shape to be displayed with the element type in a diagram.

To define an attribute for a project element type, complete the following steps.

Note: An attribute definition describes the types of information that can be displayed with project element types. You can define more than one attribute for an element. An attribute can belong to one of the following categories:

- Text
- E-mail
- Date
- URL (web address)
- Element type.

a. Expand the Attribute Definition section.
b. Click Add Attribute. A new attribute is added to the right-most column.

c. In the **Label** field, type a new label such as User ID for the attribute.

d. (Optional) In the **Description** field, type a description of the attribute.

e. From the **Attribute category** list, select a category.

f. If you select **Element Type** as the category, select an element type from the **Element type** list. Doing so associates the attribute to an element type.

**TIP** To associate the attribute with more than one element type, click **Allow multiple selections**.

g. To edit an attribute definition, type a new label or a new description, or select a different category for the selected attribute in the Attribute Settings window.

h. To delete an attribute, click that is next to the attribute name in the Attribute Settings window.

5. When you are finished editing the project element type properties, click **OK**.
Copy Project Element Types or Scorecard Element Types

To save a project element type or a scorecard element type under a different name in the same user-defined template, complete the following steps in an open user-defined template:

1. Select **Project Element Types** or **Scorecard Element Types** from the list on the left.

2. Next to an element type in the table, click ![edit button] and click **Copy**. The Copy page appears.

3. Type a name for the copy of the element type.
   
   **Note:** By default, the name is *element-type-name-copy*.

4. Click **Copy**.

Delete Project Element Types

To delete a project element type, complete the following steps in an open template:

1. Select **Project Element Types** from the list on the left.

2. Next to an element type in the table, click ![delete button] and click **Delete**.

3. To delete more than one element type, perform one of the following steps:
   
   - Click the check box to the right of each element type that you want to delete. Then, click ![check box] for the column and click **Delete**.
   
   - To delete all element types, click the check box at the top of the right-most column, click ![check box] for the column and click **Delete**.

Change the Order of Element Types

You can change the order in which element types are displayed within SAS Strategy Management.

To change the order of element types, complete the following steps in an open template:

1. On the left, select **Project Element Types** or **Scorecard Element Types**.

2. To the left of an element type, click ![up arrow] and click **Reorder**. The Reorder Element Types page appears.
3 To sort in ascending or descending alphabetic order, click **Sort Ascending** or **Sort Descending**.

4 To move scorecards, select one or more scorecards and use the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Up]</td>
<td>Moves the selected scorecard to the beginning of the list.</td>
</tr>
<tr>
<td>![Up]</td>
<td>Moves the selected scorecard up.</td>
</tr>
<tr>
<td>![Down]</td>
<td>Moves the selected scorecard down.</td>
</tr>
<tr>
<td>![Down]</td>
<td>Moves the selected scorecard to the end of the list.</td>
</tr>
</tbody>
</table>

---

**Working with Scorecard Element Types**

**List Scorecard Element Types**

To list the scorecard element types in a template, open a template, and select **Scorecard Element Types** from the list on the left. The table displays the scorecard element types that have been created for the selected template. From this table, you can create new scorecard element types, edit the properties of scorecard element types, and copy and delete scorecard element types.

**Edit Scorecard Element Type Properties**

To edit scorecard element type properties, complete the following steps in an open template:

1 Select **Scorecard Element Types** from the list on the left.

2 Next to an element type in the table, click ![Properties] and click **Properties**. The Scorecard Element Type Properties page appears.
To change the general properties of a scorecard element type, complete the following steps:

a. In the General section, type a new name in the Element type name field.

b. Change the description in the Description field.

c. To change the image to be displayed with the element type, click the icon that is next to Image and select an image.

   Note: If an image does not exist, no image is displayed for that element type. Images might be missing because a previously assigned image has been removed without updating the element type properties.

d. In the Diagram Settings section, click the icon that is next to Font color to change the font color to be displayed with the element type in a diagram.

e. Click the icon that is next to Background color to change the color to be displayed in the background of the element type in a diagram.

f. From the Shape list, change the shape to be displayed with the element type in a diagram.

4. To define an attribute for a scorecard element type, complete the following steps:

a. Expand the Attribute Definition section.
b Click **Add Attribute**. A new attribute is added to the right-most column.

![Attribute Definition](image)

- In the **Label** field, type a new label for the attribute, such as “Vision.”
- In the **Description** field, type a description of the attribute.
- From the **Attribute category** list, select a category.
- If you select **Element Type** as the category, select an element type from the **Element type** list.

  This action associates the attribute to an element type. Associated elements are affected by formula functions that calculate the mean, max, min, or sum of all elements that are associated. Associations show relationships between elements that have been defined. For more information, see “Association” on page 21.

  To associate the attribute to more than one element type, click **Allow multiple selections**.

  To edit an attribute definition, type a new label or a new description, or select a different category for the selected attribute.

  To delete an attribute, click ✗ that is next to the attribute name.
Copy Scorecard Element Types

To copy a scorecard element type in the same template, complete the following steps in an open template:

1. Select **Scorecard Element Types** from the list on the left.
2. Next to an element type in the table, click ▶️ and click **Copy**. The Copy page appears.
3. Type a new name for the copy of element type.
   **Note:** By default, the name is `element-type-namecopy`.

Delete Scorecard Element Types

To delete a scorecard element type, complete the following steps in an open template:

1. Select **Scorecard Element Types** from the list on the left.
2. To delete a single element type, next to an element type in the table, click ▶️ and click **Delete**.
3. To delete more than one element type in a user-defined template only, perform one of the following steps:
   - Select the check box to the right of each element type, click ▶️ for the column and click **Delete**.
   - To delete all element types, click the check box at the top of the right-most column, click ▶️ for the column and click **Delete**.

Working with Metric Attributes

List Metric Attributes

To list metric attributes, in an open template, select **Metric Attributes** from the list on the left. The Metric Attributes table displays the metric attributes that you have created for the selected template.
Rename a Metric Attribute

To rename a metric attribute, complete the following steps in an open template:

1. Select Metric Attributes from the list on the left.
2. Next to a metric attribute in the table, click [ ] and click Rename. The Rename Metric Attribute page appears.
3. Type a new name in the New name field.
4. Click OK.

Delete Metric Attributes

To delete a metric attribute from a template, complete the following steps in an open template:

1. Select Metric Attributes from the list on the left.
2. Next to a metric attribute in the table, click [ ] and click Delete.

Working with Language Settings

Overview

You can define a language when you create a template. This language is an alternative to the default language and is available to any user of the affected template and its projects. For more information, see “Create a Template” on page 42.

Create and Edit a User-Defined Language

Note: The following procedure presumes that the template content has already been created in the default language.

To create a user-defined language to use when working in a template and its projects, complete the following steps in an open template:

1. In the left pane, click User-defined Languages. The list of available languages appears in the right pane.
2. Click New Language. The New Language page appears.
3 In the Language name field, type the name of the language and click OK. The new language appears in the language list.

4 Click Template ▶ Select Template Edit Language. The Edit Template in This Language page appears.

5 Select the new language that you created from the Language list and click OK.

6 In the left pane, click Project Element Types. For each element type in the right pane, complete the following steps:
   a Next to the element in the table, click and click Properties. The Properties page appears.
   b In the Element type name field, type the name in the new language and click OK. The translated element name appears in the list.
   c Repeat step 3 for the Scorecard Element Types and the Metric Attributes lists.

Note: If a name is not translated and you set the user-defined language to be the default language, whenever the untranslated name is supposed to appear in the interface, the following label appears instead: Not defined in current or default language.

Set a User-Defined Language as the Default Language

Note: The following procedure require that the user-defined language is already created. For more information, see “Create and Edit a User-Defined Language” on page 53.

To set a user-defined language as the default language for a template, complete the following steps:

1 In the Template and Project Manager page, select the template in the left pane.

2 Click Template ▶ Properties. The Template Properties page appears.

3 From the Default language list, select the user-defined language that you want to use and click OK.

Note: If a name is not translated and you set the user-defined language to be the default language, whenever the untranslated name is supposed to appear in the interface, the following label appears instead: Not defined in current or default language.

List Defined Languages

To list languages, open a template and select User-Defined Languages from the list on the left. The Languages table displays the languages that are defined for the selected template.

Rename a Language

You can change the name of a language.
To rename a language, complete the following steps in an open template:

1. Select User-Defined Languages from the list on the left.

2. Next to a language name in the Languages table, click and click Rename. The Edit Language page appears.

3. Type a new name in the New name field.
   
   Note: The name must be unique in the template.

4. Click OK.

Delete a Language

To delete a language from a template, complete the following steps in an open template:

1. Select User-Defined Languages from the list on the left.

2. Next to a language in the table, click and click Delete.

3. To delete multiple languages, click the check mark that is next to each language, then, click that is at the top of the right-most column and click Delete.
   
   Note: You cannot delete the default language.

List Associated Projects

You can view the projects that are associated with a template.

To view associated projects from the Template and Project Manager page, complete the following steps:

1. Display the Template and Project Manager page. For more information, see "Display the Template and Project Manager Page" on page 143.

2. Select the template. The projects that are associated with the selected template are displayed on the right.

3. To open a project, click the project name.

Edit User-Defined Template Properties

You can edit some properties in a user-defined template such as the name, default language, and the users and groups who have access to the template.
To edit template properties, complete the following steps on the Template and Project Manager page:

1. Select a user-defined template.

2. Click **Template ▶ Properties**. The Template Properties page appears.

3. To change the name of the template, type a new name in the **Template name** field.

4. (Optional) Type a description.

5. To specify the owner of the template, click **Select Owner**. For more information about selecting an owner, see “Select the Owner of a Template, Project, Scorecard, or Element” on page 143.

6. To change the default language, select a language from the **Default language** list. For more information, see “Create a Template” on page 42.

   **Note:** After you change the language, the SAS Strategy Management labels for the template, and all of the scorecards based on the template, change to the specified language, if labels exist in that language.

7. Expand the **Permissions** section.

8. Click **Add Users & Groups**. For more information, see “Add Users and User Groups” on page 144.

9. In the Permissions table, select the appropriate **Read**, **Write**, **Delete**, or **Administer** access permissions for each user or group. For more information, see “Working with Access Permissions” on page 146.
To remove the user or group name from the list, click X to the right of the check boxes.

When you are finished editing the template properties, click OK.

Edit Predefined Template Properties

You can edit the default language of a predefined template such as the Balanced Scorecard template or KPI template.

Note: For projects and data created using the KPI template, you can display KPI data only in the following ways:
- the table view in SAS Strategy Management Builder
- the table portlet (classic style)
- the dashboard portlet (classic style)
- the table tile in the Strategy Management enhanced portlet
- the aggregate tile in the Strategy Management enhanced portlet
- the gauge tile in the Strategy Management enhanced portlet
- the trend analysis tile in the Strategy Management enhanced portlet

To edit predefined template properties, complete the following steps on the Template and Project Manager page:

1. Select a predefined template.
2. Click Template ➤ Properties. The Template Properties page appears.

3. To change the default language, select a language from the Default language list. For more information, see “Create a Template” on page 42.

Note: After you change the language, the SAS Strategy Management labels for the template, and all of the scorecards based on the template, change to the specified language, if labels exist in that language.
Copy a Template

When you copy a template, even a predefined template, the copy appears in the User-defined Templates list. To save a copy of a template under a different name, complete the following steps on the Template and Project Manager page:

1. Select the template.
2. Click **Template ➤ Copy**. The Copy page appears.
3. Type a name for the copy of the template in the **Template name** field.
   
   Note: By default, the name is `template-nameCopy`.
4. Click **Copy**.

Delete a Template

You cannot delete a predefined template; you can delete only a user-defined template. To delete a user-defined template, on the Template and Project Manager page, select a template and click **Template ➤ Delete**.

Manage Time Periods

For information about managing time periods for a template, see the SAS Strategy Management: System Administration Guide.

View Audit Records

For information about viewing audit records, see the SAS Strategy Management: System Administration Guide.

Manage Mobile Applications

SAS Strategy Management provides a feature that saves the content of a Strategy Management enhanced portlet as a SAS Mobile BI report. Because SAS Strategy Management users can now use mobile devices, the ability to enable and disable access to the mobile reports server is provided by the Manage Mobile Applications option. For information about managing mobile applications, see the SAS Strategy Management: System Administration Guide. For information about SAS Mobile BI reports, see “Save the Portlet as a SAS Mobile BI Report” on page 312.
Working with Projects

Overview ........................................................................ 60
Create a Project ................................................................. 60
Open a Project ................................................................ 61
Register a Project ............................................................. 61
Edit Project Properties ...................................................... 62
Suggest a New Element to Be Added to a Project ................. 63
Manage Suggested New Elements for a Project ................. 64
Customize Project Content Displayed by Default ............... 65
About Project Options ....................................................... 65
Save Settings for All Users ............................................... 65
Specify the Default View and Default Scorecard to Use for the Project .............................................. 65
Specify the Dates to Use .................................................. 66
Specify the Default Language .......................................... 67
Customize the Table View ............................................... 67
Customize the Aggregate Table View .............................. 68
Customize the Association Table View ............................. 68
Specify the Default Diagram and Format to View ............... 69
Specify If Diagrams Are Saved ....................................... 69
Specify the Metric Attributes to Use in the Trend Chart and Trend Analysis Views .................................. 70
Specify the Date Range to Use in the Trend Chart and Trend Analysis Views ...................................... 71
Copy a Project .................................................................. 71
Add a Project to a Classic-Style Portlet ............................. 72
Delete a Project ................................................................ 73
Managing Link Definitions ................................................. 74
About Link Definitions ..................................................... 74
Define a Link .................................................................... 75
Examples of Link Definitions .......................................... 78
Edit a Link ........................................................................ 79
View Link Properties ....................................................... 80
Copy a Link ....................................................................... 80
Delete a Link .................................................................... 80
Importing a Document ..................................................... 80
Overview

For a description of templates, projects, and scorecards, and how they relate to each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create a Project

The New Project Wizard specifies the location, template, and other aspects of the project. You can start the New Project Wizard from the portal or from the Template and Project Manager, or from within another project. To create a project, you must be a scorecard modeler, and you must have the appropriate access permissions.

1. Start the New Project Wizard using one of the following ways:
   - From an open project or scorecard, click Project ➤ New Project. The New Project Wizard appears.
   - From the Template and Project Manager page, click New Project. The New Project Wizard appears.
     For more information, see “Display the Template and Project Manager Page” on page 143.
   - From the portal. In the Collections portlet, click New Strategy Management Scorecard Project. Then click New Project. The New Project Wizard appears. For more information, see “Add Links to the Collection Portlet” on page 33.

2. To specify the storage location for the project, complete the following steps:
   a. Click on the folders to expand the Save in tree, and select a folder as the location for the project.
   b. Click Next.

3. To specify the project properties, complete the following steps:
   a. Type the name of the project in the Project name field.
      Note: The project name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).
   b. If more than one time hierarchy has been defined, expand the Time hierarchy tree and select a hierarchy for the project.
   c. Click Next.

4. To specify the template on which the new project is based, select a template from the list of predefined or user-defined templates and click Next.
   For more information, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.
5 Review all of the options that you have selected for the project. To make changes, click Previous to return to the page that you want to change. If you do not want to make any more changes, click Finish to complete the creation of the new project.

Open a Project

You can open a project in the following ways:

- If you have added a project name to a portlet in the portal, click the project name in the portlet.
- To open a project from Document Manager, open the folder that contains the project and click the project name.
- To open a project, complete the following steps on the Template and Project Manager page:
  1. Select the template with which the project is associated.
  2. Click the project name in the list of projects that are associated with the template.

By default, the project opens with the table view on the right and the scorecard hierarchy on the left.

Note: If a project no longer exists in the database or if you do not have the appropriate access permissions, you cannot open the project.

Register a Project

To work with a project that was imported (such as a migrated project) or created with the %SPMBMF macro, you must register the project. A project that is created with the New Project wizard is automatically registered. For information about the %SPMBMF macro, see the SAS Strategy Management: System Administration Guide.

When a project is registered, it is available to other applications. One such application, the SAS Add-In for Microsoft Office, enables you to add reports from SAS Strategy Management into a Microsoft Office document.

To register a project, complete the following steps in an open project:

1. Click Project ➤ Register. The Register Project page appears.
2. Select the location of the project that you want to register.
Edit Project Properties

Project properties define the name, project and scorecard hierarchy, time and dimension, image location, and access permissions for the project.

Note: Depending on your access privileges for the project, you might be able to change the project name, owner, and access permissions. Access permissions that you cannot change are unavailable.

To view or edit a project's properties, complete the following steps in an open project:

1. Click **Project » Properties**. The Project Properties page appears.

If the project is not registered, a message appears. For more information, see "Register a Project" on page 61.

2. In the General Settings section, you can edit the following settings:

   a. To change the project name, type a new name in the **Project name** field.

      Note: The project name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

   b. Type text in the **Description** field.

   c. To change the project owner, click **Select Owner**. The Owner page appears.

      For more information about selecting an owner, see "Select the Owner of a Template, Project, Scorecard, or Element" on page 143.
3 To review the time properties, expand the **Time** section.

<table>
<thead>
<tr>
<th>Time properties of the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time dimension: Strategy Management Time Standard (Predefined) (STM_TIME_STD)</td>
</tr>
<tr>
<td>Time hierarchy: STM Time Hierarchy (Stm_Time_Hierarchy)</td>
</tr>
</tbody>
</table>

4 To review where images are located, expand the **Image Location** section.

<table>
<thead>
<tr>
<th>Location of images.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common image library: images/customer</td>
</tr>
<tr>
<td>Project image library: images/customer/48b39269-0a10-1105-37b0-33a11050c9a7</td>
</tr>
</tbody>
</table>

5 To set access permissions, expand the **Permissions** section. This section displays user names and their access permissions for the project.

<table>
<thead>
<tr>
<th>Permissions define the type of access granted to a user or group for an object.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>sasdemo</td>
</tr>
<tr>
<td>Strategy Management Data Entry Approver Group</td>
</tr>
<tr>
<td>Strategy Management Data Entry Group</td>
</tr>
</tbody>
</table>

6 Click **Add Users & User Groups**. For more information, see “Add Users and User Groups” on page 144.

7 Click the check boxes below **Read**, **Write**, **Delete**, and **Administer** to add or remove that access permission for the listed user or user group.

Note: To delete a user or user group, click ✗ to the right of the check boxes.

8 When you have finished editing properties, click **OK**.

---

**Suggest a New Element to Be Added to a Project**

You can suggest a new element to be added to a project. You might suggest a new element that supports achieving a goal or objective, or that improves performance.

As business users suggest new elements, your organization's scorecard modeler then reviews and approves all suggested elements.

Note: The scorecard modeler might customize a portlet to not accept element suggestions.

To suggest a new element, complete the following steps:

1 At the bottom of a SAS Strategy Management portlet (classic style), click **Suggest New Elements**.
Note:

- In a SAS Strategy Management enhanced portlet, click 🏆 in the toolbar to suggest a new element. However, a scorecard modeler might customize the portlet to not display the toolbar. If the toolbar is not available, neither is the Suggest New Elements icon. Also, if the scorecard modeler has customized an enhanced portlet to not accept element suggestions, the icon does not appear in the toolbar.

- If the scorecard modeler has customized a classic style portlet to not accept element suggestions, a message is displayed that suggestions are not accepted. Click Close to return to the portlet.

If a portlet is customized to accept element suggestions, the Suggest New Elements page appears.

Note: If a portlet does accept element suggestions, the affected scorecard element types might not. If so, a message is displayed. Click Close to return to the portlet.

2 Type a name and, if needed, a description.

3 Select the scorecards in which you want to include the element.

4 Select the type of period, the start period, and the end period.

5 Click 🏆 A new row is added to the table.

6 To suggest more elements, repeat steps 2 through 5.

7 When you are finished suggesting elements, click Save.

Manage Suggested New Elements for a Project

After business users have suggested new elements to be added to a project, a scorecard modeler then reviews, and approves all suggested elements.

To manage suggested new elements, complete the following steps in an open project:

1 Click Project ➤ Manage Suggestion Elements. The Manage Suggestion Elements page appears.
For each suggested element, click ▶ to the left of the element and click an action. Clicking Send Notification invokes your default e-mail application so that you can alert the business user who submitted the suggestion.

To view properties associated with a suggestion element, click ▶ next to the suggestion that you want to view and then click Properties. The Properties window appears. You can only view this window. You cannot edit the properties.

Note: If Properties is the only selection available on the menu, the role and capability settings associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

Customize Project Content Displayed by Default

About Project Options

You can customize how and what project content is displayed by default. The options include the default scorecard, date, and type of view to use. When you open a project in SAS Strategy Management Builder, the project appears with the default scorecard selected in the scorecard hierarchy. The default scorecard content appears in the selected type of view for the selected date.

You can also customize the default content that is displayed for each type of view: table, aggregate, association, diagram, and trend. Then, when you change the view type in the open project, the projects appear using the settings for that view.

Save Settings for All Users

The Project Options page contains sections for general settings and view-specific settings. In each section, you can select Save these settings for all users. Use this selection to specify that the settings in the affected section be used for every user that can access the project and its views.

If you do not make this selection, the settings apply only to yourself.

Specify the Default View and Default Scorecard to Use for the Project

In an open project:

1. Click Project ➤ Options. The Project Options page appears and displays the General Settings section.
2 From the **View** list, select the default view to display.

3 In the **Scorecard** tree, select the default scorecard.

   Note: You cannot select a scorecard for which you do not have access permissions. If you require access, contact your SAS Strategy Management administrator.

4 Click **OK**.

### Specify the Dates to Use

You can specify the default date that is used by the views of this project. You can specify a date or you can have the view use the date that is current when the view is opened. However, the default date is not used by the trend chart and trend analysis
views. See “Specify the Date Range to Use in the Trend Chart and Trend Analysis Views” on page 71.

1 In an open project, click Project ➤ Options. The Project Options page appears and displays the General Settings section.

2 In the Default Date for Views section, perform one of the following steps:
   - To use the current date, select Current date.
   - To use a specific date, select Specific date and click to select a date.

3 Click OK.

Specify the Default Language

A template can provide additional languages. If the project is based on a template that provides additional languages, you can change the default language for the project. For more information, see “Working with Language Settings” on page 53.

In an open project:

1 Click Project ➤ Options. The Project Options page appears and displays the General Settings section.

2 In the Default Content Language section, perform one of the following steps:
   - To display the scorecard in the default language, select Use the default language.
   - To display the scorecard in another defined language, select Use the following language and then select a language from the list.
     
     Note: Selecting another language does not affect the display of dates or numbers.

3 Click OK.

Customize the Table View

You can specify the appearance and content of the table view. When a user opens a table view of the project, the view uses your settings.

On the Project Option page:

1 Expand the Table Options section.

2 From the Element type list, select the default element type to display in the scorecard.

3 From the Column selection list, select the default column selection to display in the scorecard.
4 To display the formula icon for an element, click **Show formula icon**.

**TIP** If the element is calculated by a formula, the formula icon \( f_o \) is displayed in the view.

5 Click **OK**.

**Customize the Aggregate Table View**

You can specify the appearance and content of the aggregate table view. When a user opens an aggregate table view of the project, the view uses your settings. By selecting a column selection, you control which metric attributes are displayed in the aggregate table. For more information, see "Create a Column Selection" on page 138.

On the **Project Option** page:

1 Expand the **Aggregate Table Options** section.

   ![Aggregate Table Options](image)

2 Select an element type from the **Element type** list.

3 Select a column selection from the **Column selection** list.

4 To display only personal thresholds, click **Show personal thresholds**.

5 To display only global thresholds, click **Show global thresholds**.

6 Click **OK**.

**Customize the Association Table View**

You can specify the appearance and content of the association table view. When a user opens an association table view of the project, the view uses your settings. By selecting a column selection, you control which metric attributes are displayed in the table. For more information, see "Create a Column Selection" on page 138.

On the **Project Option** page:

1 Expand the **Association Table Options** section.

   ![Association Table Options](image)
Select a name from the **Association name** list.

3 Select a column selection from the **Column selection** list.

4 Click **OK**.

### Specify the Default Diagram and Format to View

You can specify the diagram to open and the type of file format to use for the diagram. When a user opens a diagram view of the project, the view uses your settings. You can choose between a static format (PNG) and a somewhat interactive format (SVG).

**On the Project Option page:**

1 Expand the **Diagram Options** section.

   ![Diagram Options](image)

   A diagram can be viewed using two formats: PNG or SVG. PNG is a static format while SVG allows for more interactivity.

   - **Show diagrams in PNG format**
   - **Show diagrams in SVG format**

2 Select a diagram from the **Diagram name** list.

   **Note:** When there are no diagrams, the list is replaced with the word **None**.

3 Select a diagram format.

4 Click **OK**.

### Specify If Diagrams Are Saved

When you view a diagram, that instance of the diagram is saved in the diagram cache. When you view the diagram again, it can be displayed quickly by loading the diagram from the cache. However, if the diagram or its underlying data has been changed since the last viewing, loading the diagram from the cache does not display the latest changes. You can make sure that you see the latest version of a diagram in the following ways:

- Refresh each diagram as it is viewed. In the diagram view, click ![Refresh](image).
- Clear the diagram cache. This option forces a diagram to be rebuilt when it is next viewed.
- If you want to view the latest version of all diagrams at all times, disable the diagram cache.

**On the Project Option page:**

1 Expand the **Diagram Options** section.
2 To clear the cache of previously viewed diagrams, click **Clear Diagram Cache**.

3 (Optional) If you want to force all diagrams to be rebuilt each time they are viewed, select **Disable diagram caching**.

   **TIP** Because diagrams are not cached, this setting causes diagrams to take longer to open.

4 Click **OK**.

   **Note:** The diagram cache is located in a user’s DAV folder on the DAV server.

---

### Specify the Metric Attributes to Use in the Trend Chart and Trend Analysis Views

You can specify the content of the trend chart and trend analysis views. When a user opens one of these views for a project, the view uses your settings. For information about the difference between trend chart and trend analysis, see “Trend Analysis” on page 23.

**Note:** The selected metric attributes provide the Y-axis labels in the view. However, if you make more than one selection and the selections are not the same data type, the labels are not formatted. For example, one selection might be a currency and another might be a percentage.

On the **Project Option** page:

1 Expand the **Trend Chart and Trend Analysis Options** section.

2 In the **Default Metric Attributes** section, select one or more metric attributes to include in the chart:
To include specific metric attributes, select the check box that is next to the attribute.

To include all metric attributes, select the check box that is at the top of the table.

3 Click OK.

Specify the Date Range to Use in the Trend Chart and Trend Analysis Views

You can specify the date range of the trend chart and trend analysis views. When a user opens one of these views for a project, the view uses your settings.

Note: The default date specified in the General Settings section is not used by the trend chart and trend analysis views.

On the Project Option page:

1 Expand the Trend Chart and Trend Analysis Options section.

2 In the Default Start and End Date section, specify a start date and an end date.

3 Click OK.

Copy a Project

To copy a project to another location, complete the following steps on the Template and Project Manager page:

1 Select a template name in the list of templates.

2 Next to the project that you want to copy, click and click Copy To.

Note: If the project is not registered, a message appears stating that you must register the project before it can be copied. For more information, see “Register a Project” on page 61.

The Copy To page appears.
3 In the Location tree, select the location in the project hierarchy to which you want to copy the project.

4 Type a name for the project in the Project name field. By default, the copied project is named Copy:project-name.

   Note: The project name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

5 To copy elements and attributes that are associated with the current project, click Elements and attributes.

6 To copy all other information, click Select all options below. If you want to copy only some of the information, click one or more the applicable options: Metric attribute values, Formulas, Ranges, Thresholds, Links, Rules, Data Entry Forms.

Add a Project to a Classic-Style Portlet

To add a project to a classic-style portlet, complete the following steps in an open project:
1 Click 📌. The Add to Portlet page appears.

2 To add to an existing portlet, select the portlet from the Portlet list.
   Note: The list includes only those portlets that are of the same type of view as the current view. For example, when you add a portlet from the table view, the Portlet list includes only Performance Table portlets.

3 To create a new portlet and add to that portlet, complete the following steps:
   a Click <Create a New Portlet> from the Portlet list.
   b Specify the portlet name, description, and keywords.
   c To specify the page on which the portlet appears, click Add to page and select a page from the list.
      Note: If you do not click Add to page, the portlet is created but is not added to a page. You can search for the portlet later and add it to a page.

4 Click OK.

---

Delete a Project

To delete a project from the Template and Project Manager page, complete the following steps on that page:

1 Click Manage Scorecard Projects in the portal, or open a project and click Project ▶ Manage Templates and Projects. The Template and Project Manager page appears.

2 Click the template that is associated with the project that you want to delete.

3 Click the check box that is next to one or more project names.

4 Click 🗑 that is at the top of the right-most column and click Delete.
   Note: Alternately, to delete a single project, click 🗑 for the row and click Delete.
Managing Link Definitions

About Link Definitions

Ways to Use Links
You can define a link once on the New Link page and then use that link in multiple places in a project and in its scorecards. You select which link definitions to use when you specify properties for elements and metric attributes. You can also use these links in forms, diagrams, the Batch Maintenance Facility (BMF), and the Import wizard.

For more information, see the following documentation:

- “Edit Metric Attributes” on page 95
- “Edit Multiple Elements” on page 100
- “Interactive Features in Diagrams” on page 211
- Chapter 33, “Creating and Managing Forms,” on page 323
- Chapter 35, “Importing Data into a Strategy Management Project,” on page 337

Types of Links That You Can Define
You can define links of the following types:

<table>
<thead>
<tr>
<th>Link type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External link</td>
<td>Opens a web page or an external document.</td>
</tr>
<tr>
<td>Element details</td>
<td>Opens a view of the metric attributes and non-metric attributes associated</td>
</tr>
<tr>
<td></td>
<td>with the project that is open.</td>
</tr>
<tr>
<td>File</td>
<td>Opens any type of file that is registered as DAV content in the SAS Content</td>
</tr>
<tr>
<td></td>
<td>Server. For information about importing a file into the SAS Content Server,</td>
</tr>
<tr>
<td></td>
<td>see “Importing a Document” on page 80.</td>
</tr>
<tr>
<td>SAS Financial Management report</td>
<td>Opens an associated form if SAS Financial Management is installed in your</td>
</tr>
<tr>
<td></td>
<td>environment.</td>
</tr>
<tr>
<td>SAS Information Map</td>
<td>Opens a SAS Information Map.</td>
</tr>
<tr>
<td>SAS Portal page</td>
<td>Opens a SAS Portal page. By using this link type, you can open a pre-existing</td>
</tr>
<tr>
<td></td>
<td>portal page that can contain dashboards, reports, and other information.</td>
</tr>
</tbody>
</table>
### Link type

<table>
<thead>
<tr>
<th>Link type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAS Web Report Studio report</td>
<td>Opens a report that was created by using SAS Web Report Studio.</td>
</tr>
<tr>
<td>SAS Strategy Management project</td>
<td>Opens a SAS Strategy Management project.</td>
</tr>
<tr>
<td>Directive</td>
<td>Processes instructions for other SAS software.</td>
</tr>
</tbody>
</table>

**Note:** SAS Strategy Management 5.5 adds the option to specify a scorecard, element type, column selection, and date.

**Note:** This option is provided for migrating from SAS Strategy Management 5.2 and earlier. For version 5.3 and later, use the other link options.

### Define a Link

To define a link, complete the following steps in an open project:

1. Select **Project ▶ Manage Links**. The Manage Links page appears.

![Manage Links](image)

2. Click **New** to open the New Link page.
3 In the **General Settings** section, complete the following steps:

   a  Type a name in the **Link name** field. A description is optional.

   b  From the **Link type** list, select the type of link that you want to define. For more information, see “Types of Links That You Can Define” on page 74.

   c  If you want the link to open in a new window, select **New window**. Otherwise, if you want the link to open in the same window that contains the SAS Strategy Management scorecard, select **This window**.

      **Note:** If you are opening a Microsoft Office document, you must select **New window**.

      **Note:** If you subsequently select a link definition for use in a data-entry form, the link will open only in a new window. Data-entry forms do not support opening a link in the same window as the form.

   d  Specify the link content using the applicable steps.

<table>
<thead>
<tr>
<th>Link type</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element details</td>
<td>1  Click <strong>Select</strong> to open the Select Column Selection page.</td>
</tr>
<tr>
<td></td>
<td>2  Select the type of column selection to use from the <strong>Column selection type</strong> list.</td>
</tr>
<tr>
<td></td>
<td>3  Select the column selection from the <strong>Column selection</strong> list. Information about your selection appears, including a <strong>Preview</strong> table so you can verify that you made the correct selection.</td>
</tr>
<tr>
<td></td>
<td>4  Click <strong>OK</strong> to save the link content.</td>
</tr>
<tr>
<td>External link</td>
<td>In the <strong>Link content</strong> field, type the location that you want to use for the external link.</td>
</tr>
<tr>
<td>Link type</td>
<td>Steps</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>File</td>
<td>1 Click <strong>Select</strong> to open the Select Link Location page.</td>
</tr>
<tr>
<td>SAS Financial Management report</td>
<td>2 Select the file to use from the <strong>Link content</strong> list. The location appears in the <strong>Location</strong> field.</td>
</tr>
<tr>
<td>SAS Information Map</td>
<td>3 Click <strong>OK</strong> to save the link content.</td>
</tr>
<tr>
<td>SAS Portal page</td>
<td></td>
</tr>
<tr>
<td>SAS Stored Process</td>
<td></td>
</tr>
<tr>
<td>SAS Web Report Studio report</td>
<td></td>
</tr>
<tr>
<td>Directive</td>
<td></td>
</tr>
<tr>
<td>SAS Strategy Management project</td>
<td>1 Click <strong>Select</strong> to open the SAS Strategy Management page.</td>
</tr>
<tr>
<td></td>
<td>2 Select the project from the <strong>Project</strong> list. Its location appears in the <strong>Location</strong> field.</td>
</tr>
<tr>
<td></td>
<td>3 (Optional) Select the scorecard to use from the <strong>Scorecard</strong> list. Its path appears in the <strong>Scorecard path</strong> field.</td>
</tr>
<tr>
<td></td>
<td>4 (Optional) Select the element type from the <strong>Element type</strong> list.</td>
</tr>
<tr>
<td></td>
<td>5 (Optional) Select the column selection from the <strong>Column selection</strong> list.</td>
</tr>
<tr>
<td></td>
<td>6 Select the type of view in which you want the content appear from the <strong>View</strong> list.</td>
</tr>
<tr>
<td></td>
<td>7 Choose whether to use a display date or a specific date.</td>
</tr>
<tr>
<td></td>
<td>8 Click <strong>OK</strong> to save the link content.</td>
</tr>
</tbody>
</table>

4 Expand the **Parameter Definitions** section.

In this section, define one or more parameters that are passed as part of the link. When you open a link in SAS Strategy Management, the parameter can pass information that controls how data appears at the link destination. For example, if you define the parameter to pass *Scorecard name*, the information located at the link destination is filtered by the name of the scorecard from which the link originated.

a From the **Parameter** list, select the type of SAS Strategy Management information that you want the parameter to pass. Then, in the field next to the list, enter the source parameter (target).

![Parameter Definitions](image)

b Click **Add Parameter** to add the parameter definition to the table that is below the list.

![Parameter Definitions](image)
TIP A default parameter name is selected for you. However, you can change the name to match the name that is expected by the link target.

Note: For more information, see “Examples of Link Definitions” on page 78.

5 Expand the **Advanced Parameters** section.

In this section, specify one or more parameters that can control how information appears at the link destination. These parameters pass static information that you set in this section. The target link location takes the static value from the parameter to affect the information displayed.

**Note:** Refer to the documentation for the link target software in order to determine which parameters it supports. SAS Strategy Management passes the specified parameters without verifying that the link target can use the parameters. If the link target does not use the parameters, unexpected behavior might occur.

In the **Parameter** field, enter a description of the parameter.

Suppose, for example, that you specify an external link called `finance.yahoo.com/q`. In the **Parameter** field, you specify `s=AAPL,GOOG`. This parameter causes the website to display stock quotes for Apple Inc. and Google Inc.

6 Click **OK** to save the link definition.

### Examples of Link Definitions

**Example: Define a Link That Opens a Web Page**

In this example, a link is defined that opens the Google web page.

In the New Link page, complete the following steps:

1 In the **General Settings** section, complete the following steps:
   a Type a name in the **Link name** field. A description is optional.
   b From the **Link type** list, select **External link**.
   c Select **New window** for the link target.
   d In the **Link content** field, type `www.google.com/search` after the provided `http://`

   **Note:** The link location must include `http://` at the beginning of the web address.

2 Expand the **Parameter Definitions** section and complete the following steps:
   a From the **Parameter** list, select **Element name**.
   b In the field next to the list, change `ELEMENT` to `q`.

   **Note:** The Google website requires a lowercase parameter.
   c Click **Add Parameter** to add the parameter definition to the table that is below the list.
The value passed by this parameter is derived from the element name in the Strategy Management project. The Google website uses the parameter value as a search value.

3 Expand the **Advanced Parameters** section. In the **Parameter** field, enter the following parameters:

```
&start=0&num=10&cr=countryCA&lr=lang_fr
```

**Note:** You cannot include blanks when you enter the parameter.

These parameters limit the search output to the first ten results that are located in Canada and that are in French.

4 Click **OK** to save the link definition.

**Example: Define a Link That Runs a SAS Stored Process**

In this example, a link is defined that runs a SAS Stored Process and displays its output.

In the New Link page, complete the following steps:

1 In the **General Settings** section, complete the following steps:
   a Type a name in the **Link name** field. A description is optional.
   b From the **Link type** list, select **SAS Stored Process**.
   c Select **New window** for the link target.
   d For the **Link content** field, click **Select** and navigate to the file location of the stored process.

2 Expand the **Advanced Parameters** section. In the **Parameter** field, type the following parameters:

```
&GENDER=M&AGELIMIT=14
```

These parameters, which are already defined in the stored process, cause the stored process to filter its data by male gender and individuals no older than 14.

3 Click **OK** to save the link definition.

**Edit a Link**

To edit a link, complete the following steps in an open project:

1 Select **Project ▶ Manage Links**. The Manage Links page appears.

2 Click the name of the link that you want to edit. The Link Properties page appears.

3 Change the applicable settings in the link definition as described in “Define a Link” on page 75.
View Link Properties

To view properties and settings associated with an item, click 📁 next to the item that you want to view, and then click Properties. The Properties window appears. You can only view this window. You cannot edit the properties and settings.

Note: If Properties is the only selection available on the menu, the role and capability settings associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

Copy a Link

To copy a link, complete the following steps in an open project:

1. Select Project ➤ Manage Links. The Manage Links page appears.
2. Click 📁 next to the link definition that you want to copy and then click Copy.
3. The wizard appends copy to the link name. In the New link name field, edit the name to describe the new link definition that you are creating.
4. Click Copy. The copied link definition appears in the Manage Links selection list.
5. To edit the copied link definition, click its name. The Link Properties page appears.
6. Change the applicable settings in the link definition as described in “Define a Link” on page 75.

Delete a Link

To delete a link, complete the following steps in an open project:

1. Select Project ➤ Manage Links. The Manage Links page appears.
2. Click 📁 next to the link definition that you want to delete and then click Delete.
3. A confirmation message appears. Click Yes to delete the link.

Importing a Document

Document Types That You Can Import

You can import a document for use in SAS Strategy Management. Importing a document registers the document as DAV content in the SAS Content Server. After you import a document, you can use it as a target when you define a link using the link type File.
This feature supports importing the following types of files.

**Microsoft Office**
- Excel (XLS, XLT, WKS, CSV, XLSX, XLTX)
- PowerPoint (PPT, PPS, PPTX, PPSX)
- Word (DOC, DOCX)

**Graphics**
- BMP
- GIF
- JPEG, JPG, JPE
- PNG
- TIFF, TIF

**Video**
- AVI
- MPEG, MPG, MPE

**Other document types**
- ASCII text (TXT, TEXT, ASC)
- HTML, HTM
- PDF
- Postscript (PS, AI, EPS)
- RTF
- WordPerfect (WPD, WP)
- XML

---

**Import a Document**

To import a document, complete the following steps in the SAS Strategy Management Builder:

1. On the Template and Project Manager page, select the template that contains the project in which you want to import a document.

2. Click the project name.

3. On the Project page, select **Project ▶ Import a Document**.

4. On the Import a Document page, click **Browse** and navigate to the file that you want to import.

5. In the **Save in** tree, navigate to the folder in which you want to save the file that you are importing.

6. If the file already exists and you want to replace it, select **Overwrite existing document**.

7. Click **OK**. The document is imported and saved.
Overview

For a description of templates, projects, and scorecards, and how they relate to each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create a Scorecard

Before you can create a scorecard, you must create a project to contain the scorecard. For more information, see “Create a Project” on page 60.

To create a scorecard, open a project and complete the following steps:

1. Click Scorecard ➤ New Scorecard.
2. On the Properties page, complete the following steps:
   a. Type the name of the scorecard in the Scorecard name field.
Note: The scorecard name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

b  Click Next.

3 Each scorecard that you create is in a scorecard hierarchy. A parent can be either another scorecard or the project that contains the new scorecard. A parent is above other scorecards in the hierarchy. Child scorecards are below a parent.

On the Location page, complete the following steps:

a  Click the project or scorecard name in the hierarchy that you want to designate as the scorecard’s parent.

b  To cause the new scorecard to inherit elements that exist in a parent scorecard, click Inherit existing elements from parent scorecard.

Note: If the parent of the scorecard is a project, the scorecard cannot inherit elements.

c  Click Next.

4 On the Summary page, review the scorecard options that you have selected. To change an option, click Previous to return to a preceding page.

5 When you are satisfied with your selections, click Finish.

Open a Scorecard

You can open a scorecard in the following ways:

- To open a scorecard from within a project, open a project and click on the name of the scorecard.
- To open a scorecard from the portal, create a link to the scorecard from a portlet and click on the link.

Calculate a Scorecard

Note: The following task calculates only one scorecard in a project. To calculate all scorecards, see “Calculate a Project” on page 129.

To calculate a scorecard, complete the following steps:

1  Click Scorecard ➤ Calculate. The Calculate page appears.
2 Specify either the date range or the period.

3 (Optional) Click Include child scorecards.

4 Click Calculate.

Save a Scorecard as a SAS Information Map

To save a scorecard as a SAS Information Map:

1 Select Scorecard ➤ Save As Information Map. The Save As SAS Information Map page appears.

2 Click Add to select a storage location for a new information map or to select an existing information map. The SAS Information Map window appears.

3 Navigate the hierarchy and select a folder or an information map. Then click OK.

4 (Optional) Enter the name and description of the information map.

   Note: If you select an existing information map and do not change the name, the existing information map is overwritten.

5 In the Data Options section, set the options for the scorecards, time periods, and the element types that you want to include in the information map.

   TIP To create an information map that includes all scorecards in the project, select All scorecards.

6 Click OK.

   Note: If the information map either fails to display or fails to display correctly, contact your system administrator. For more information, see the SAS Strategy Management: System Administration Guide.
Change the Order of Scorecards

You can change the order in which scorecards are displayed within a scorecard hierarchy. However, you cannot change the order of scorecards that are based on a dimension hierarchy.

To change scorecard order, complete the following steps in an open scorecard:

1. Click **Scorecard ➤ Reorder**. The Reorder Scorecards page appears.

2. In the **Scorecards** list, click a scorecard.

3. To sort in ascending or descending alphabetic order, click **Sort Ascending** or **Sort Descending**.

4. To move scorecards, select one or more scorecards and use the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏆</td>
<td>Moves the selected scorecard to the beginning of the list.</td>
</tr>
<tr>
<td>👁</td>
<td>Moves the selected scorecard up.</td>
</tr>
<tr>
<td>👀</td>
<td>Moves the selected scorecard down.</td>
</tr>
<tr>
<td>🎯</td>
<td>Moves the selected scorecard to the end of the list.</td>
</tr>
</tbody>
</table>

Edit Scorecard Properties

Open the Scorecard Properties Page

To edit the scorecard properties, complete the following steps in an open scorecard:
1 Click **Scorecard ➤ Properties**. The Scorecard Properties page appears.

![Scorecard Properties](image)

2 In the **General Settings** section, complete the following steps:

   a Change the scorecard name by typing a new name in the **Scorecard name** field.

   Note:
   
   - The name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).
   - You cannot change the name of a scorecard in a project that is based on an existing hierarchy.

   b (Optional) Type a description.

   c To specify the owner of the scorecard, click **Select Owner**. The Owner page appears. For more information about selecting an owner, see “Select the Owner of a Template, Project, Scorecard, or Element” on page 143.

3 To assign access permissions, complete the following steps:

   a Expand the **Permissions** section.

   ![Permissions](image)

   b Click **Add Users & Groups**. For more information, see “Add Users and User Groups” on page 144.
c In the Permissions table, click **Read**, **Write**, **Delete**, or **Administer** access permissions for each user or group. For more information about access permissions, see “Working with Access Permissions” on page 146.

d To remove a user's name from the list of users who have access to the scorecard, click ✗ to the right of the check boxes.

4 When you are finished editing the properties, click **OK**.

---

# Add a Scorecard to a Classic-Style Portlet

To add a scorecard to a classic-style portlet, complete the following steps in an open scorecard:

1 Click ✉. The Add to Portlet page appears.

![Add to Portlet](image)

2 To add to an existing portlet, select the portlet from the **Portlet** list.

   **Note:** The list includes only those portlets that are of the same type of view as the current view. For example, when you add a portlet from the table view, the **Portlet** list includes only Performance Table portlets.

3 To create a new portlet and add to that portlet, complete the following steps:

   a Click **<Create a New Portlet>** from the **Portlet** list.

   b Specify the portlet name, description, and keywords.

   c To specify the page on which the portlet appears, click **Add to page** and select a page from the list.

      **Note:** If you do not click **Add to page**, the portlet is created but is not added to a page. You can search for the portlet later and add it to a page.

4 Click **OK**.
Move a Scorecard

You can move a scorecard to a different location in the scorecard hierarchy within the same project or to another project that is associated with the same template.

Note:

- You cannot move a scorecard that is in a hierarchy that is based on a dimension.
- If a back-end data feed is set up for extracting, translating, and loading (ETL), moving a scorecard can disrupt the ETL. Be sure to adjust the ETL.

To move a scorecard, complete the following steps in an open scorecard:

1. Click **Scorecard ➤ Move To**. The Move page appears.
2. In the **Location** tree, select the location that you want to designate as the parent of the selected scorecard.
3. Click **Move**.

Copy a Scorecard

You can copy a scorecard to a different location within the same project.

To copy a scorecard, complete the following steps in an open scorecard:

1. Click **Scorecard ➤ Copy To**. The Copy To page appears.
2 In the Location tree, select the location in the project hierarchy to which you want to copy the scorecard.

3 Type a name for the scorecard in the Scorecard name field. By default, the copied scorecard is named scorecard-name copy.

   Note: The scorecard name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

4 If you want to copy all of the child scorecards under the current scorecard to the same location, click Include all scorecards under the current scorecard.

5 If you want to copy attribute selections that are associated with the current scorecard, click Attribute selections.

6 If you want to include one or more types of other information with the copied scorecard, click Metric attribute values, Formulas, Ranges, Thresholds, or Links.

7 If you want to copy all values, click Select all options below.
8 If you want to retain existing links between elements (if this option is available for this element), click **Automatic creation of links between elements**. For more information about linking elements, see “Link Elements” on page 103.

---

### Delete a Scorecard

**Note:** When a scorecard is in a hierarchy, and that hierarchy is based on a dimension, you cannot delete that scorecard.

To delete a scorecard, open the scorecard and click **Scorecard ➤ Delete**.

**Note:** If the scorecard contains child scorecards, the child scorecards are also deleted.

---

### Set Default Scorecard Preferences

You can set the default display preferences for all the scorecards that you open. You can override these preferences by customizing an individual scorecard. For information about customizing the display of an individual scorecard, see “Customize a Scorecard Table” on page 161.

To set default display preferences for all scorecards, complete the following steps:

1. Click **Preferences** in the upper right of the SAS Strategy Management window. The Preferences page appears.

2. Click **Scorecards** in the list on the left. The scorecard preferences appear.
3 Specify the options in the **Table Display Options** section, the **Thresholds** section, and the **Additional Display Options** section.

4 When you have finished setting your preferences, click **Apply**. Otherwise, to return the scorecard preferences to their default settings, click **Restore Defaults**.
Overview

For a description of elements, element attributes, and how they relate to each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create an Element

To create an element, you must be a scorecard modeler and have the appropriate access permissions.

To create an element, complete the following steps in an open project:
1 Click Click.

2 From the Element type list, select a type and click Go.

Note: After you start the New Element wizard, you cannot change the type of element created. To create a different type of element, you must cancel the wizard, select another element type, and restart the wizard.

3 Select New Element. The New Element wizard appears.

4 On the Properties page, complete the following steps to select general options and time settings for the element:

   a In the Element name field, type a name for the element.

      Note: The name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

   b (Optional) Type a description of the element.

   c From the Period type list, select the type of period.

      The period type defines the intervals at which data is collected for the element.

   d From the Start period list, select the beginning date of data collection.

      The start period defines the first interval at which data is collected. For example, if the period type is YEAR, the start period might be 1999. If you have selected Multiyear as the period type, the only available start period is MUTYR. FLOAT means that the start point of the period is not set.

   e From the End period list, select the end date of data collection.

      The end period defines the last interval at which data is collected. FLOAT means that the end point of the period is not set.

   f Click Next.

5 On the Add Element to Project/Scorecards page, specify how you want the new element added to a project or scorecard.

Note: If you are adding the element to a project, the current project is displayed. If you want to add the element to a scorecard, you must specify which scorecard by clicking one of the following options:

<table>
<thead>
<tr>
<th>In current scorecard only</th>
<th>Adds the element to the scorecard that is currently open.</th>
</tr>
</thead>
<tbody>
<tr>
<td>In current scorecard and all its children</td>
<td>Adds the element to the scorecard that is currently open and to all of its children.</td>
</tr>
<tr>
<td>In all scorecards of this project</td>
<td>Adds the element to all of the scorecards in the project that is currently open.</td>
</tr>
</tbody>
</table>

6 To change a setting, click Previous to return to a previous page. When you are satisfied with the settings, click Finish.
Edit Metric Attributes

Metric attributes are defined in the template that is associated with the project. You can change the values and ranges that are associated with metric attributes, and you can specify the time periods to which the changes apply.

To edit metric attributes for an element, complete the following steps in an open project or scorecard:

1. Next to an element, click 
2. and then click Edit Metric Attributes. The Metric Values, Ranges, and Links page appears.

![Metric Values, Ranges, and Links page](image_url)
2 From the **Metric attribute** list, select a metric attribute.

3 From the **Display period** list, select a period and click **Go**.

4 To set the value, click `<metric attribute> Value`, where `<metric attribute>` is the selection that you made in the **Metric attribute** list. Then select one of the following options from the **Computed value** list.

<table>
<thead>
<tr>
<th>Way to Set the Value</th>
<th>Computed Value Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide a value</td>
<td>Select <strong>Manually entered</strong>.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Entered value</strong> field appears into which you can type a value.</td>
</tr>
<tr>
<td>Specify a predefined formula, modify a predefined formula, or define a new formula to apply to the metric value</td>
<td>Select <strong>Formula-based</strong>.</td>
</tr>
</tbody>
</table>

Complete the following steps for the **Formula-based** selection:

- **to specify a predefined formula:**
  1 Select a formula from the **Formula** list.
  2 Select a function from the **Function** list.
  3 If the function that you selected supports an attribute and metric attribute, the **Attribute** and **Metric Attribute** lists appear from which you can select values.
  4 Click **Insert Formula**. The formula is displayed in the **Formula definition** field.

- **to define a new formula or modify a predefined formula:** Click **Advanced Formula** to start the Formula Editor. For more information, see “Creating a Formula” on page 125. If you are starting the Formula Editor for the first time, you must configure your system for Java. For more information, see **Appendix 2, “Configuring Java,” on page 383.**
TIP If you want to override the formula result with another value, select Override formula result and type a value.

5 To set a predefined rule for use on the value, select the rule from Value Rule list. For more information, see Chapter 10, “Defining Rules,” on page 119.

6 To set a text, click `<metric attribute>` Text. Then type text in the Metric text field.

7 To set a predefined rule for use on the text, select the rule from Text Rule list.

8 To set a link that opens another source of information, click `<metric attribute>` Link. Then select a predefined link from the Link list. For more information, see “Managing Link Definitions” on page 74.

9 To set a range, click `<metric attribute>` Range. Then select a range from the Range list. For more information, see “Create a Range” on page 132.

10 To set the time period to the selected period in the table view, click Display period.

11 To set the time period to a specific date range, complete the following steps:
   a Select Start period.
      Note: The default value of the start period is the selected period in the table view. The default value of the end period is the last period in the element’s lifetime.

   b Select a start period or end period from the lists.

12 Click OK.

Edit Element Properties

You can edit element properties such as name, attributes, and access permissions.

To edit the properties of an element, complete the following steps in an open project:

1 Open a scorecard table.

2 Next to an element, click and click Properties. The Element Properties page appears and the General Information section is expanded.
3 To edit the general settings, complete the following steps.

Note: The element type setting is the element type that you have selected to display in the scorecard.

a Edit the name.

   Note: The name cannot contain a caret (^) or vertical bar (|). If you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is converted to a percent sign (%).

b Edit the description, if required.

c To designate the owner of the element, click Select Owner. For more information about selecting an owner, see “Select the Owner of a Template, Project, Scorecard, or Element” on page 143.

d To specify a link that you want associated with the element, select a link definition from the Link list. For more information, see “Managing Link Definitions” on page 74.

4 To edit the time settings, complete the following steps.

Note: If an element has a value, action, range, threshold, or formula that is associated with it, you cannot edit its periodicity. If an element contains values that are not included in the changed time settings, the values are retained in the database and can be displayed if the time settings are readjusted to include those values.

a From the Period type list, select the type of period.

   The period type defines the intervals at which data is collected for the element.

b From the Start period list, select the beginning date of data collection.
The start period defines the first interval at which data is collected. For example, if the period type is \textit{YEAR}, the start period might be 1999. If you have selected \textit{Multiyear} as the period type, the only available start period is \textit{MULTYR}. \textit{FLOAT} means that the start point of the period is not set.

c From the \textbf{End period} list, select the end date of data collection. The end period defines the last interval at which data is collected. \textit{FLOAT} means that the end point of the period is not set.

5 To select associations for an element, complete the following steps.

Note:

- Attributes and their associations are defined in the template on which the project is based. For more information, see “Create a Template” on page 42.
- Attribute information is not available for the elements in a KPI project.

a Expand the \textbf{Attribute Options and Associations} section.

b Select an attribute from the list.

c Type or select the value for the options.

For example, if the element is a contact name and the category of the attribute is e-mail, supply the e-mail address for the contact name.

\textbf{TIP} If you want to specify a link to associate with a non-metric attribute, select a link definition from the \textbf{Link} list. For more information, see “Managing Link Definitions” on page 74.

6 To assign access permissions, complete the following steps.

Note:

- In order to assign access permissions to an element, you must have the appropriate access permissions.
- You can assign access permissions to an element so that only designated individuals and groups can read or change the element.

a Expand the \textbf{Permissions} section.
b Click **Add Users & Groups**. For more information, see "Add Users and User Groups" on page 144.

c In the Permissions table, click **Read, Write, Delete**, or **Administer** access permissions for each user or group. For more information about access permissions, see “Working with Access Permissions” on page 146.

d To remove a user's name from the list of users who have access to the scorecard, click ✗ to the right of the check boxes.

7 When you are finished editing the properties, click **OK**.

---

### Edit Multiple Elements

You can edit the time, owner, and values of more than one element at a time.

To edit multiple elements, complete the following steps in an open project:

1 Click **Edit Elements**. The Edit Elements page appears.

2 To edit project elements, click **Project elements**. Otherwise, to edit scorecard elements, click **Scorecards**.
To edit the elements in all scorecards, click **All scorecards**. Otherwise, to select the scorecard that contains the elements that you want to edit, click **Select**. Then, expand the scorecard hierarchy and select the scorecards that you want to edit.

3 From the **Element type** list, select an element type.

4 To edit all elements, click **All elements**. Otherwise, to edit specific elements, click **Selected elements** and select the check boxes that are next to the elements that you want to edit.

5 To override cell properties, click **Override properties set on an individual cell**.
   
   **Note:** To change any existing values on the selected elements, you must select this option.

6 To change the time properties of the elements, complete the following steps in the **General Properties** section.
   
   **CAUTION!** If you change the periodicity of an element, data is lost.

   ![General Properties](image)

   a Click **Element's lifetime**.
   
   b Select a period type from the **Period type** list.
   
   c Select a start period and an end period from the **Start period** and **End period** lists.
   
   **Note:**
   
   - Select **Float** in the lists to indicate that the start period or end period for the project has not been set.
   - If an element contains values that are not included in the changed time settings, the values are retained in the database and can be displayed if the time settings are readjusted to include those values.

7 To change the owner of the elements, click **Owner** and click **Select Owner**. The **Owner** page appears. For more information about selecting an owner, see “Select the Owner of a Template, Project, Scorecard, or Element” on page 143.

8 To specify whether you receive an alert when a comment is added, click **Comment alert** and click **Change**. The **Alerts on Comments** page appears. For more information, see “Set Alerts on Comments” on page 145.

9 To specify the column to which metric attribute properties are applied, select an attribute from the **Metric attribute** list.
To change the metric attribute values for multiple elements, click Value and click Change. Then, select one of the following options on the Values page.

<table>
<thead>
<tr>
<th>Way to Set the Value</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide a value</td>
<td>Click Entered value.</td>
</tr>
<tr>
<td>Specify a predefined formula to apply to the metric value</td>
<td>Click Formula definition.</td>
</tr>
<tr>
<td>Define a new formula or modify a predefined formula to apply to the metric value</td>
<td>Click Formula definition.</td>
</tr>
</tbody>
</table>

11 (For entered value) Type a new value in the Entered value field.

12 (For formula definition specifying a predefined formula) Complete the following steps:
   a. Select a formula from the Formula list.
   b. Select a function, attribute, and metric attribute as needed.
   c. Click Insert Formula. The formula appears in the Formula definition field.

13 (For formula definition defining a new formula or modifying a predefined formula) Click Advanced Formula. For more information, see “Creating a Formula” on page 125. If you are starting the Formula Editor for the first time, you must configure your system for Java. For more information, see Appendix 2, “Configuring Java,” on page 383.

14 To set a predefined rule for use on the value, click Value rule and select a rule from the list. For more information, see Chapter 10, “Defining Rules,” on page 119.

15 To change or supply text, click Metric text and type the text into the field.

16 To set a predefined rule for use on the text, click Metric text rule and select a rule from the list.
17 To change or apply a range, click **Range**. Then, select a range from the list or click **New** to create a new range. For more information, see “Create a Range” on page 132.

18 To change or apply a global threshold, click **Global threshold** and click **Change**. The Global Threshold Options page appears. For more information about editing thresholds, see “Edit a Global or Personal Threshold” on page 115.

19 To change or apply a personal threshold, click **Personal threshold** and click **Change**. The Personal Threshold Options page appears. For more information about editing thresholds, see “Edit a Global or Personal Threshold” on page 115.

20 To change or apply a link, click **Link** and click **Change**. The Link page appears. Then select a predefined link from the **Link** list and click **OK**. For more information, see “Managing Link Definitions” on page 74.

21 To specify the current period, click **Display period**. Otherwise, to specify a date range, click **Start date** and click that is next to the **Start date** and **End date** fields.

22 Click **OK**.

---

**Link Elements**

In a project that contains multiple scorecards, you can link an element to an element of the same element type in a parent scorecard. Linked elements are used in the following ways:

- Thresholds that are crossed in a child scorecard cause a flag to appear in linked elements in the parent and grandparent scorecards.
- Parent scorecards that have a formula that uses the **Current Children** function include only those child elements that are linked.
- An aggregate view displays all linked elements on the same line of the aggregate table. Elements that are not linked are displayed on separate lines.

To link an element to an element in its parent scorecard, complete the following steps in an open project:

1 Select a scorecard below the level of the top scorecard.

2 Next to an element, click ▼ and click **Link Element**. The Link Element page appears.

3 Select a parent scorecard from the **Scorecard** list.

4 Select an element from the **Link to element** list.

   **Note:** You cannot link multiple elements in one scorecard to a single element in a parent scorecard.

5 To unlink the element, click **Unlink element**.
Change Comment Alert Settings for an Element

You can choose to receive an alert when a comment is added to an element. You can select one element or multiple elements and change the options for all at one time.

To change the comment alert settings, open a project and click.

- To set the option for one element, click next to that element and click Alerts on Comments.
- To set the option for multiple elements, select the elements. Then, at the top of the last column, click and click Alerts on Comments.

The Alerts on Comments page appears. For more information, see “Set Alerts on Comments” on page 145.

Copy Element Properties

You can copy the properties of an element to other elements. Copying properties enables you to define a set of properties for an element, such as a value to be entered manually, a measure or a formula, a global threshold, a personal threshold, a range, and an action. You can then copy the properties from that element to a set of elements throughout the scorecard hierarchy for a given set of periods.

Note: Element associations are copied only to elements that are in the same scorecard.

To copy the properties of an element, complete the following steps in an open project:

1. Click.
2. Next to the element that you want to copy, click and click Copy Properties To. The Copy Properties To page appears.
3 From the **Metric attribute** list, select a metric attribute.

4 Select **Value**, **Value rule**, **Metric text**, **Metric text rule**, **Range**, **Global threshold**, **Personal threshold**, or **Link** to copy these properties.

   Note: The fields to the right of these check boxes are unavailable.

5 Complete the following steps in the **Element Selection** section:

   a To copy the properties to a project, select **Project elements**. Otherwise, to copy the properties to a scorecard, select **Scorecards**, and then click **Select**.

      To copy the properties to all scorecards, select **All scorecards**. Otherwise, to select the scorecard that contains the elements that you want to copy, click **Select**. Then, expand the scorecard hierarchy and select the scorecards that you want to edit.

   b From the **Element type** list, select an element type.

   c To copy the properties to all elements in the selected project or scorecards, select **All elements**. Otherwise, copy the properties only to selected elements, select **Selected elements** and click on the elements that you want to select.
To override existing properties, select **Override properties set on an individual cell**.

6 Complete one of the following steps in the **Period Selection** section:
   - To copy the properties to the currently displayed period, select **Display period**.
   - To specify the time period that you want to copy the properties to, select **Start date** and click the date that is next to the **Start date** and **End date** fields.

7 Click **OK**.

---

**Copy an Element**

You can copy an element to a scorecard in the same project, or in a different project if the project is based on the same template. The copied element retains the link and other attributes of the original element. You can copy project elements only to other projects, and you cannot link project elements. You can copy scorecard elements only to other scorecards.

To copy an element, complete the following steps in an open project:

1 Click **`>`**.

2 Next to the element that you want to copy, click **`>`** and click **Copy**. The Copy Element page appears.

3 Select the project and scorecard to which to copy the element.
   
   **Note:** You can copy the element to more than one scorecard. An element cannot be copied to itself.

4 To change the name of the element when it is copied, type the name in the **Element name** field.
Move an Element

You can move an element to a scorecard in the same project, or in a different project if the project is based on the same template.

To move an element to another scorecard, complete the following steps in an open project:

1. Click 

2. Next to the element that you want to move, click 

3. Select the project and scorecard to which to move the element.

4. Click Move.

Delete an Element

To delete an element, open the project and click . In the element table, perform one of the following actions.

- To delete one item, click next to the element that you want to delete and click Delete.
- To delete more than one item, click the check box to the right of each item. Then click and click Delete.
- To delete all elements, click the check box at the top of the right-most column. Then click and click Delete.

Note: Deleting an element that is used in a formula renders the formula invalid.

Format Numbers and Fonts in Cells

You can change the number format and font of the cells within a scorecard element.

To change cell format, complete the following steps in an open project:

1. Next to the element, click and click Format Cells. The Format Cells page appears.

2. To format numbers and dates in cells, expand the Number Settings section.
3 Select the metric attributes in the table to which to apply the format, or select the Metric Attribute check box in the column heading to select all of the attributes.

4 In the Options section, from the Type list, select the number format to apply to the selected attribute:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Column Format</td>
<td>Applies the format of each column to the cells in the selected row.</td>
</tr>
<tr>
<td>General</td>
<td>Applies a text format.</td>
</tr>
<tr>
<td>Currency</td>
<td>Applies a currency format. An example is $1,234.10.</td>
</tr>
<tr>
<td>Number</td>
<td>Applies a numeric format.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Applies a percentage format. An example is 100%.</td>
</tr>
<tr>
<td>Date</td>
<td>Applies a date format. An example is 03Dec04.</td>
</tr>
</tbody>
</table>

5 (For the Currency type) Complete the following steps:
   a To use the locale that is specified by your preferences, click Use the locale selected in your preferences.
   b To specify a different locale, click Use this locale and choose a locale from the list.
   c From the Decimal places list, select a value.

6 (For the Number type) Complete the applicable steps.
   n To use a numeric format other than the SAS format along with settings that are in your profile, click Other and click Use the settings in your profile.
To use a numeric format other than the SAS format along with settings different from those in your profile, click **Use these settings**. From the **Decimal places** list, select a value. Then, choose whether to use a comma to separate 1000s and whether to switch the 1000 separator and the decimal separator.

To use the SAS numeric format, complete the following steps:

1. Click **SAS Format**.
2. From the **List of formats** list, select a common format.
3. From the **Decimal places** list, select a value.

   **Note:** This field is unavailable for the **BEST** format.

4. In the **Width** field, type a value.

5. (For the **Percentage** type) Choose whether to format the percentage as a standard percentage or to use the format from the locale. From the **Decimal places** list, select a value.

6. If you selected the **Date** type, select a format from the **Available date formats** list.

7. To view the format selection in the metric attribute table, click **Preview**.

8. To set the fonts that are displayed in cells, expand the **Font Settings** section.

11. Select the metric attributes in the table to which to apply the font or click **Metric Attribute** in the column heading to select all of the attributes in the table.

12. To apply the column format to the cells in the selected row, click **Current Column Format**.

   **Note:** The other settings in the **Options** section are unavailable.
In the Alignment section, click the alignment for the text.

In the Style section, click one or more styles of text formatting.

From the Text and Background lists, select a color for the text and background.

To view the font selection in the metric attribute table, click Preview.

Click OK.

---

Format Numbers and Fonts in Columns

You can change the number format and font of the columns within a scorecard table. To change column format, complete the following steps in an open project:

1. Select a column in a scorecard table.

2. At the top of the column, click 
   and click Format Column. The Format Columns page appears.

3. To format numbers and dates in columns, expand the Number Settings section.

4. From the Type list, select the number format to apply to the selected column:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Applies a text format.</td>
</tr>
<tr>
<td>Currency</td>
<td>Applies a currency format. An example is $1,234.10.</td>
</tr>
<tr>
<td>Number</td>
<td>Applies a numeric format.</td>
</tr>
<tr>
<td>Percentage</td>
<td>Applies a percentage format. An example is 100%.</td>
</tr>
<tr>
<td>Date</td>
<td>Applies a date format. An example is 03Dec04.</td>
</tr>
</tbody>
</table>

5. (For the Currency type) Complete the following steps:
To use the locale that is specified by your preferences, click **Use the locale selected in your preferences**.

To specify a different locale, click **Use this locale** and choose a locale from the list.

From the **Decimal places** list, select a value.

(For the **Number** type) Complete the applicable steps.

- To use a numeric format other than the SAS format along with settings that are in your profile, click **Other** and click **Use the settings in your profile**.
- To use a numeric format other than the SAS format along with settings different from those in your profile, click **Use these settings**. From the **Decimal places** list, select a value. Then, choose whether to use a comma to separate 1000s and whether to switch the 1000 separator and the decimal separator.
- To use the SAS numeric format, complete the following steps:
  1. Click **SAS Format**.
  2. From the **List of formats** list, select a common format.
  3. From the **Decimal places** list, select a value.

  **Note:** This field is unavailable for the **BEST** format.
  4. In the **Width** field, type a value.

(For the **Percentage** type) Choose whether to format the percentage as a standard percentage or to use the format from the locale. From the **Decimal places** list, select a value.

If you selected the **Date** type, select a format from the **Available date formats** list.

To view the format selection in the metric attribute table, click **Preview**.

To set the fonts that are displayed in cells, expand the **Font Settings** section.

In the **Alignment** section, click the alignment for the text.

In the **Style** section, click one or more styles of text formatting.

From the **Text** and **Background** lists, select a color for the text and background.
To view the font selection in the metric attribute table, click **Preview**.

Click **OK**.

---

### Set a Global or Personal Threshold

To set a threshold, complete the following steps in an open project:

1. Select a project or scorecard table.
2. Select the element in the table to which you want to apply a threshold.
3. Next to the element, click ▼ and click the applicable action.

<table>
<thead>
<tr>
<th>To set a global threshold</th>
<th>Global Threshold Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set a personal threshold</td>
<td>Personal Threshold Options</td>
</tr>
</tbody>
</table>

The applicable threshold page appears. The following example is the Global Threshold Options page.

4. To view threshold information for a specified period, select a period from the **Period** list and click **Go**. The current period is displayed by default.
5 From the **Select a metric attribute** list, select the metric attribute to which you want to apply the threshold.

6 Activate the applicable threshold.

| To activate a global threshold                  | Select **Enable global threshold**. |
| To activate a personal threshold               | Select **Enable personal threshold**. |

7 To specify the conditions that trigger alert notifications to subscribers, complete the following steps in the **Threshold trigger** section:

   a Select an interval type from the **Interval type** list.
      
      - If you have applied a range to the metric attribute, the list contains intervals that are defined in the range properties.
      
      - If you have not applied a range to the metric attribute, **Value** is the only item in the **Interval type** list.

      For more information, see “Create a Range” on page 132.

   b Select an operator from the **Condition** list. For example, if you want an alert to be triggered when the interval falls below a certain value, select the < (less than) operator.

   c Type a value in the **Threshold** field or select an interval from the **Threshold** list.

   d To specify the period of time to which the threshold applies, perform one of the following steps:
      
      - Select **Period range** and select a start period and end period from the **Start** and **End** lists.

      Note: The default value of the start period is the selected period in the table view. The default value of the end period is the last period in the element's lifetime.

      - Select **Current period**.

8 To identify subscribers to alert when a threshold is triggered, complete the applicable steps in the **Notification and subscription** section.
For global thresholds

To enable alert notifications and add users to the list of subscribers so they are notified when an alert is triggered, select **Enable alert notifications**. To add a user or user group to the list of subscribers to a global threshold, click **Add**. For more information, see “Add Users and User Groups” on page 144. To remove a user from the list of subscribers to a global threshold, click **Remove**.

For personal thresholds

To subscribe yourself so that you are notified when an alert is triggered, select **Enable alert notifications and subscribe me**.

**Note:** In order for a subscriber to receive alert notifications by e-mail, the subscriber’s portal preferences must include one of the following selections for alert notifications:

- Via e-mail
- Both e-mail and alerts portlet

For more information, see “Set Alert Preferences” on page 145.

**Note:** If an alert notification is triggered by a formula-based cell value, the notification occurs only when both of the following criteria are met:

- the formula-based cell value has changed
- the project, scorecard, or both are recalculated

9 To specify a stored process to run when the threshold is met, complete the following steps in the **Stored Process** section:

a Click **Add**, expand the hierarchy as needed, and then select a stored process.

b If the stored process requires one or more parameters, type the parameters in the **Stored Process parameter** field.

   **TIP** Separate each parameter with a semicolon (;).

c To delete the stored process, click **Remove**.

10 Click **OK**.
Edit a Global or Personal Threshold

To edit a threshold, complete the following steps in an open project:

1. Click **Edit Elements**. The Edit Elements page appears.
2. In the **Metric Attribute Properties** section, perform the applicable step:
   - To edit a global threshold: Click **Global Threshold** and click **Change**.
   - To edit a personal threshold: Click **Personal Threshold** and click **Change**.

   The applicable threshold options page appears. The following example is for the Global Threshold Option page.

3. To edit the conditions that trigger alerts to subscribers, perform the applicable steps in the **Threshold trigger** section:
   - To set a new threshold, complete the following steps:
     1. Click **Set threshold** and select an interval type from the **Interval type** list.
2. Select an operator from the **Condition** list. For example, if you want an alert to be triggered when the interval falls below a certain value, select the `<` (less than) operator.

3. Type a value in the **Threshold** field.
   - To remove all thresholds from the selected elements, click **Remove thresholds on selected elements**.
   - **Note:** This choice also removes all subscribers, including your personal subscription.
   - To make no change to elements with different thresholds, select **No change**.

4. To edit the list of subscribers who receive alerts when a threshold is triggered, perform the applicable step in the **Notification and Subscription** section:

   - **For global thresholds**
     - To add a user to the list of subscribers to a global threshold, click **Set subscribers on selected elements** and click **Subscribe**. For more information, see “Add Users and User Groups” on page 144.
     - To remove a user from the list of subscribers, click the user and click **Remove**.
     - To remove all subscribers from the selected elements, click **Remove all subscribers on selected elements**.
     - To make no change to elements with different notifications, click **No change**.

   - **For personal thresholds**
     - To be notified, click **Enable alert notifications and subscribe me**.
     - To remove notification, click **Remove my alert notifications subscription on selected elements**.
     - To make no change to elements with different notifications, select **No change**.

5. To edit a stored process to run when the threshold is met, perform the applicable step in the **Stored Process** section:

   a. Click **Add**, expand the hierarchy as needed, and then select a stored process.
   b. If the stored process requires one or more parameters, type the parameters in the **Stored Process parameter** field.

     **TIP** Separate each parameter with a semicolon (;).
   c. To delete the stored process, click **Remove**.

6. Click **OK**.
View Thresholds

To view the thresholds that have been set for a table, complete the following steps in an open project:

1. Select a project or scorecard table.
2. Customize the table so that threshold flags are displayed. For information, see “Customize a Scorecard Table” on page 161.
3. Click one of the threshold icons (✓ or ⬜️) in a cell. The Threshold Conditions page appears.

   The table displays the name of the scorecard, the value of the selected element, the threshold, and the absolute difference between the threshold and the value. The table also displays any scorecards that meet the threshold conditions for that metric attribute, starting at the selected scorecard and including any of its child scorecards.

   Note: Click the scorecard name to display the scorecard.
Defining Rules

Overview of Rules

Ways to Use Rules

You can define a rule once on the Manage Rules page and then use the rule in multiple places in a project and in its scorecards. You can select which rule definition to use when you apply rules to one or more metric attributes. Rules are then validated in the data-entry form.

For more information, see:
- “Edit Metric Attributes” on page 95
- “Edit Multiple Elements” on page 100

Types of Rules That You Can Define

The following table describes the types of rules that you can define.

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Numeric   | The rule evaluates the cell value against a lower and upper boundary. For example, if value is the cell value that the rule evaluates, then:
  lower boundary <= value <= upper boundary
  You do not have to specify both boundaries. If you do not specify both boundaries, you can have an unlimited upper or lower boundary. For example,
  10 <= value
  validates that the cell value is equal to or greater than 10. |
## Define a Rule

To define a rule, complete the following steps from the Project page:

1. Select **Project ➤ Manage Rules**. The Manage Rules page appears.

2. Click 📂. The **Properties** section appears below the **Rules** list.

3. On the **Identification** tab:
   - a. In the **Name** field, enter a unique name for the rule.
   - b. (Optional) In the **Description** field, enter an optional description of the rule.
   - c. Click **Required entry** if you want to require that the affected data cell be filled in. The user can save the form, but the user cannot submit the form without entering a value in the affected data cell.

   **Note:** If the form does not have a workflow, then only the **Submit** button is available in the form. The form does not have a **Save** button.

   **TIP** You can click **Save** at any time in the **Properties** section. Doing so saves a draft of the rule. The draft appears in the **Rules** list above the **Properties** section. The draft contains the selections that you made before you clicked **Save**. If you continue working in the **Properties** section but do not click **Save**, any subsequent selections can be lost.

4. Click the **Rule Properties** tab. To define the rule, select the type of rule that you want to define and complete the applicable steps:

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Step</th>
</tr>
</thead>
</table>
| Numeric   | In the **Lower boundary** and **Upper boundary** fields, enter the boundary values that you want the rule to use to evaluate cell value.  
   **Note:** If value is the cell value that the rule evaluates, then lower boundary <= value <= upper boundary. If you specify only one boundary, the unspecified boundary is an unlimited boundary. For example, 10 <= value validates that the cell value is equal to or greater than 10. |
<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>In the <strong>Maximum length</strong> field, enter the length value that you want the rule to use to evaluate the cell value.</td>
</tr>
<tr>
<td>Choices</td>
<td>In the <strong>Choices</strong> field, enter the choices from which the user can select in the affected cell. Enter each choice separated by a semi-colon (;). For example, enter three choices by typing: <strong>dog; cat; rabbit</strong></td>
</tr>
<tr>
<td>Formula</td>
<td>In the <strong>Formula</strong> field, enter the formula that you want the rule to use to evaluate the cell value. To use the Formula Editor to define the formula, click <strong>Advanced Formula</strong>. The <strong>Validation message</strong> field indicates whether the formula validated correctly. <strong>Note:</strong> In the <strong>Validation message</strong> field, you can specify a message to display to the data-entry user. This message appears if the data-entry user enters a value that is not valid for the formula. You can use this message to explain the formula and its expected values to the data-entry user.</td>
</tr>
</tbody>
</table>

5. Click **Save** to save your selections. The draft of the rule appears in the **Rules** list above the **Properties** section. Click **Cancel** to exit the **Properties** section without saving your selections.

---

### Edit or View the Properties of a Rule

**Note:** If is the only button available on the toolbar, the role and capability settings that are associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

To edit the properties of a rule, complete the following steps on the Manage Rules page:

1. Double-click the rule that you want to edit. The **Properties** section appears below the **Rules** list.

2. Change the applicable settings in the rule as described in “Define a Rule” on page 120.

3. Click **Save** to save your selections. Click **Cancel** to exit the **Properties** section without saving your selections.

---

**Note:** If you click the column headings in the **Rules** list to sort items in the list, the feature does not sort the items correctly in languages other than English.
Copy a Rule

To copy a rule, complete the following steps on the Manage Rules page:

1. Select the rule that you want to copy and click .
   The copied rule appears in the list. A number is appended to the rule’s name.

2. To edit the copied rule, double-click its name. The Properties section appears below the Rules list.

3. Change the applicable settings in the rule as described in “Define a Rule” on page 120.

4. Click Save to save your selections. Click Cancel to exit the Properties section without saving your selections.

Delete a Rule

To delete a rule, complete the following steps on the Manage Rules page:

1. Select the rule that you want to delete and click .

2. A confirmation message appears. Click Yes to delete the rule.
You can define and apply formulas to the columns in scorecard tables. When applying formulas, keep the following requirements in mind:

- Formulas can be applied only to columns that contain numeric values. Any calculation that cannot be computed appears as #NUM!.
- A formula on a cell always takes precedence over a column formula. Therefore, when you apply a formula to a column, any cells that already have a formula ignore the column formula; all other cells in the column accept the formula. Likewise, when you remove a formula from a column, the formula is removed only from those cells that accepted the column formula; the other cells retain their cell formulas.

To apply a formula to a column, complete the following steps in an open project:

1. Open the scorecard table to which you want to apply the formula.

2. In a column heading, click ![Action Menu] and click Apply Formula.

   **Note:** To see the action menu, the column selection must include numeric values. For more information, see “Create a Column Selection” on page 138.

   The Apply a Formula to a Column page appears.
3 To apply a predefined formula to the column, complete the following steps:
   a Select a formula from the **Formula** list.
   b Select a function from the **Function** list.
   c Click **Insert Formula**. The formula appears in the **Formula definition** field.

4 To define or edit a formula, click **Advanced Formula**. For more information, see “Creating a Formula” on page 125. If you are starting the Formula Editor for the first time, you must configure your system for Java. For more information, see Appendix 2, “Configuring Java,” on page 383. After you exit the Formula Editor, continue to the following step.

5 To specify the dates to which the formula applies, complete the following steps:
   a To apply the formula to periods that extend from the selected period to the last period in the element's life time, click **Display date to the last date of the element's lifetime**.
   b To specify a start and end date, click **Start date** and click ![next to the Start date and End date fields.](image)
   c To apply the formula to the date that is specified in the column selection definition, click **Based on existing date**.

Note: When you apply a formula to a column selection, the current date is the absolute date that is specified in the column selection definition, or that is followed by an indicator of the relative period offset from the column selection definition. For more information, see “Create a Column Selection” on page 132.
Creating a Formula

Your First Look at the Formula Editor

Use the Formula Editor to build and edit formulas.

1 Expression Text area.
   The current formula appears in the Expression Text field. You can insert text into the formula at the insertion marker. Before you insert text, be sure to position the insertion marker at the correct location by clicking that location.

2 Symbol toolbar
   To insert a symbol, use the symbol toolbar. For more information, see “Insert a Symbol” on page 126.

3 Undo and Redo buttons

4 Functions tab
   To insert a function, use the Functions tab. For more information, see “Insert a Function” on page 126.

5 Data Sources tab
   To insert a reference to a data source, use the Data Sources tab. For more information, see “Insert a Data Source Reference” on page 127.

6 OK and Cancel buttons

Note:

- The Formula Editor is also used in SAS Financial Management. For more information about the Formula Editor, see the SAS Financial Management
The Data Sources tab is not provided in SAS Financial Management and the tab is not described in its documentation.

Any calculation that cannot be computed appears as #NUM!.

Start the Formula Editor

You start the Formula Editor by clicking Advanced Formula.

Note: If you are starting the Formula Editor for the first time, you must configure your system for Java. The Formula Editor requires the Java 2 Runtime Environment (J2RE). For information about installing the J2RE, see Appendix 2, “Configuring Java,” on page 383.

Close the Formula Editor

To close the Formula Editor, click OK to save and exit or click Cancel to exit without saving your work.

Insert a Symbol

To insert a symbol, click the applicable button in the symbol toolbar. From left to right, the buttons are in the following groups:

- Arithmetic operators
- Boolean operators
- Comparison operators, which can be used to compare two numeric values or two strings
- A miscellaneous group, which includes a matching pair of single quotation marks and a matching pair of parentheses.

Insert a Function

To insert a function into the formula that you are building, complete the following steps:

1. In the Categories list, click a category that contains the function. Each function is in the All Functions category and also in one other, more focused category. When you select a category, all the functions in the selected category are listed alphabetically in the Functions list.
Note: One of the selections in the Categories list is StM Functions. These are functions provided by Strategy Management. The other selections in the Categories list are standard SAS functions. For information about Strategy Management functions, see Appendix 1, “Strategy Management Function Dictionary,” on page 365.

2 In the Functions list, click a function. For information about Strategy Management functions, see Appendix 1, “Strategy Management Function Dictionary,” on page 365.

TIP When you select a function, a brief description of the function is displayed below the list.

3 Click Insert. A syntactic template of the function is inserted into the Expression Text field at the insertion point.

4 In the syntactic template, replace each argument placeholder with an appropriate argument.

Special constants enable you to account for unresolved and missing values in a formula. The following special constants are supported by the Formula Editor:

<table>
<thead>
<tr>
<th>Special Constant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>BLANK</em></td>
<td>Indicates a value that is missing. You can use <em>BLANK</em> in an IF condition to determine whether a value is missing.</td>
</tr>
<tr>
<td><em>ERROR</em></td>
<td>Indicates an error such as divide-by-zero. You can use <em>ERROR</em> in an IF condition to determine whether a value has an error.</td>
</tr>
</tbody>
</table>

Insert a Data Source Reference

To insert a reference to a data source, complete the following steps:

1 Click the Data Sources tab.
2 From the **Data Source** list, select a data source.

3 From the **Scorecards** list, select a project. The scorecards in the project appear in the tree. Select a scorecard in the tree.

4 From the **Tables** list, select a table. The elements that have been defined for each table are displayed.

**Note:** `<Current Element>` applies to the element that you select in the scorecard table. Select `<Current Element>` if you are assigning the formula to a column or if the formula will be copied to another element as part of a scorecard or element copy operation.

5 From the **Metric Attribute** list, select a metric attribute.

6 From the **Time Period** list, select a time period.

**Note:** Select `<Current>` if you are assigning the formula to a column or if the formula will be copied to another element as part of a scorecard or element copy operation. The Formula Editor uses the period code, rather than the period name, in its syntax.

7 From the **Use Value From** list, select a scorecard.

**Note:** The value of the metric attribute is the value of the attribute from the selected scorecard.

8 Click **Add** to the right of the **Variable to Add** field. The contents of the **Variable to Add** field are inserted into the formula at the insertion point.

### Validate the Expression

When you have entered the formula text, click **Validate Expression** to verify that the formula is valid.

**Note:** Numeric constants without decimal points are limited to a range between $-2,147,482,648$ and $2,147,483,647$. To use a numeric constant that is outside of that range, insert a decimal point and a zero after the constant, such as $-2,147,482,649.0$. 

---

128  Chapter 11 / Working with Formulas
Calculating a Project

Overview

If you have created formulas for your project, you can calculate them and display the results in the cells that contain formulas. Any calculation that cannot be computed appears as #NUM!.

For information about formulas for columns, see “Apply a Formula to a Column” on page 123. For information about formulas for cells, see “Edit Metric Attributes” on page 95 concerning the formula-based method for editing metric attributes.

Calculate a Project

Note: The following task calculates all scorecards in a project. To calculate only one scorecard, see “Calculate a Scorecard” on page 84.

To calculate to a project, complete the following steps in an open project:

1 Click Project ➤ Calculate.

2 Click Calculate. The Calculate page appears.

3 You can specify a date range or a period to calculate. Complete one of the following steps:

- To calculate according to a range of dates
  - Click Select by date range.
  - Note: This is the default selection.
  - In the Start date and End date fields, type a date or click to select a date.

- To calculate according to a period
  - Click Select by period.
  - Note: The default value is the period that is displayed in the table view.
  - From the Period type list, select a period type. Then, from the Period list, select a period.
4 If you have imported a project into your SAS Strategy Management installation, you must import the formulas that are associated with the project. To do so, click *Import formulas that have been exported from previous or current versions of SPM 2.x*. For more information about importing, see the *SAS Strategy Management: System Administration Guide*.

5 Click *Calculate*.
Working with Ranges

Overview

For a description of ranges, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

List Ranges

To list ranges, in an open project, click Project ▶ Manage Ranges. The Manage Ranges page appears.
Create a Range

Note: You cannot create a range unless you have Scorecard Modeler access permissions.

To create a range, complete the following steps:

1. List the ranges. For more information, see “List Ranges” on page 131.


3. Expand the General Settings section.

4. Type a name for the new range in the Range name field.

5. (Optional) Type a description for the range in the Description field.

6. A range can contain several intervals, or subsets of data. To define an interval, expand the Interval Definitions section.

7. You can specify a value for the interval or you can create a formula to calculate a range interval. The formula can use all of the constructs that are normally used for formula-based metric attributes. These constructs enable you to reference the values of other metric attributes within the same scorecard or different scorecards, or to access the values of the current metric attribute over time (for example, the mean of the last six periods).

Note:

- Any calculation that cannot be computed appears as #NUM!.

- Formula-based ranges might generate unexpected range results. The results of formula-based ranges are not calculated when you create them. They are calculated at run time. As a result, it is possible to create ranges that have overlapping intervals. When this happens, SAS Strategy Management returns the last interval that satisfies the condition.

- If you reference an element or an attribute on a formula-based range, you must provide a full reference to that element or attribute. For more information, see “Specify a Full Reference to an Element or Attribute” on page 382.

To create an interval, complete the applicable steps:
For an interval based on a specific value

Type a value for the lower bound of the range in the **Boundary value** field and click **Add Value**.

The new interval appears in the table below the **Boundary value** field.

For an interval based on a formula

Click **Add Formula** and perform one of the following steps:

- In the **Formula definition** field, type a formula.
- Click **Advanced Formula** to open the Formula Editor. For more information, see “Creating a Formula” on page 125. If you are starting the Formula Editor for the first time, you must configure your system for Java. For more information, see Appendix 2, “Configuring Java,” on page 383.

8 In the **Interval 1** row, type a label in the **Label** field for values that fall below the lower bound of the interval.

9 In the **Grade** field, type a letter grade that represents the interval.

10 In the **Normalized Value** field, type a value that represents the interval.

11 Click the icon in the **Color** column, and select from the palette a color to be displayed with values that fall below the lower bound.

12 Click the icon in the **Icon** column, and select an icon to be displayed with values that fall below the lower bound.

**Note:** If an image does not exist, no image is displayed for that interval. Images might be missing because a previously assigned image has been removed without updating the interval properties.

13 In the **Interval 2** row, select an operator from the list in the **Interval** column.

14 Specify a label, grade, normalized value, color, and icon to be displayed with the interval.

15 To add more intervals, repeat steps 7 through 10.

16 To verify that all of the intervals have values and that the boundary values of the intervals do not conflict with each other, click **Validate**.

**Note:**

- To remove an interval, click ✗ in the row that contains the interval.
- To display percentages within a range, specify the interval boundaries as decimal values. For example, specify a boundary of 90% as .90.

17 Unresolved or missing values might appear in the new range. Unresolved values (any calculation that cannot be computed) appear as #NUM!. Missing values appear as blank cells.

To define labels for these values, expand the **Special Value Definitions** section.
For the Missing value and Unresolved value labels, specify a grade, normalized value, color, and icon to be displayed with the value.

Click OK.

**Edit a Range**

**Note:** You cannot edit a range unless you have Scorecard Modeler access permissions.

To edit a range, complete the following steps from the range list on the Manage Ranges page:

1. Click the name of the range. The Range Properties page appears.
2. Modify the general information, interval definitions, and special value definitions.
   For more information, see “Create a Range” on page 132.

**View Range Properties**

To view properties and settings associated with an item, click next to the item that you want to view, and then click Properties. The Properties window appears. You can only view this window. You cannot edit the properties and settings.

**Note:** If Properties is the only selection available on the menu, the role and capability settings associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

**Copy a Range**

To base a new range on a range that has already been created, complete the following steps from the range list on the Manage Ranges page:

1. Click Copy Ranges. The Copy Range page appears.
2. From the Project list, select the name of the project that contains the existing range.
3. Click Go.
4 From the Range list, select the name of the existing range.

5 Click Go.

6 Type a name for the new range in the New range name field.

7 Type a description for the range in the Description field.

8 Modify the interval definitions and special value definitions as needed.

   For more information, see “Create a Range” on page 132.

---

**Delete a Range**

To delete a range, perform one of the following steps from the range list on the Manage Ranges page:

- To delete one range, click [ ] next to the range that you want to delete and click Delete.
- To delete more than one range, click the check box to the right of each range, click [ ] for the column, and click Delete.
- To delete all ranges, click the check box at the top of the right-most column, click [ ] for the column, and click Delete.

---

**Apply a Range to a Column**

To apply a range to a column, complete the following steps in an open project:

1 Click [ ]

2 In a column label, click [ ] and click Apply Range. The Apply a Range to a Column page appears.

3 From the Range list, select a range.

4 Specify the dates to which the range applies by performing one of the following steps:

   - To apply the range to periods that extend from the selected period to the last period in the element's lifetime, click Display date to the last date of the element's lifetime.
   - To specify a start and end date, click Start Date, and click [ ] that is next to Start Date and End Date fields.
   - To apply the range to the date that is specified in the column selection definition, click Based on existing date.

**Note:** When you apply a range to a column selection, the existing date is the absolute date that is specified in the column selection definition, or that is followed by an indicator of the relative period offset from the column selection definition. For more information, see “Create a Column Selection” on page 138.
Overview

For a description of column selections, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

List Column Selections

To display the list of column selections, complete the following steps in an open project:

1. Click Project » Manage Column Selections. The Manage Column Selections page appears.
2 From the **List by** list, select which column selections to display in aggregate tables.

3 Click **Go**.

---

**Create a Column Selection**

To create a column selection, complete the following steps:

1 List column selections. For more information, see “List Column Selections” on page 137.

2 Click **New**. The New Column Selection page appears.

3 Expand the **General** section.

4 Type a name for the column selection in the **Column selection name** field.

5 (Optional) Type a description in the **Description** field.

6 To make the column selection available to all users of the project, click **Share this column selection to make it available to all users**. This type of column selection is called **Shared**.

   **Note:** By default, the column selection is available only to its creator. This type of column selection is called **Personal**.

   **TIP** To use a column selection in a data-entry form, the column selection must be **Shared**.

7 Expand the **Definition** section.

   You can apply a column selection to the elements in a table view, to the associations in an association view, or you can create a column selection that is not connected to element types or associations.

8 To specify how you want to apply the column selection, complete the following steps:

   a From the **List by** list, select one of the following options:
### Element Types
Applies the column selection to elements in a table view.

### General
Creates a column selection that is not connected to element types or associations. The **General** column selection is used to display metric attributes in aggregate tables.

#### 9
To determine the element type on which the column selection is based, select an element type from the **Selection based on** list and click **Go**.

#### 10
To display attributes as columns with the element type or association, complete the following steps:

- **a** Select attributes from the **Available attributes** list.
  
  **Note:** The **General** column selection can contain only metric attributes.

- **b** Click **Add**.

- **c** (Optional) Type a label for each column in the **Label** field.
  
  **Note:** By default, the column label is the same as the attribute name.

- **d** To move a column, click the check box that is next to the column name, and click **Move as First**, **Move Left**, **Move Right**, or **Move as Last**.

- **e** To delete a column, click the check box that is next to the column name, and click **Delete**.

#### 11
Click **OK**.

---

**Edit Column Selection Properties**

To edit the properties of a column selection, complete the following steps on the **Manage Column Selections** page:

1. To the left of the row, click ![Definition](image) and click **Properties**. The Edit Column Selection page appears.
2. Edit the properties of the column selection. For information about column selection properties, see “Create a Column Selection” on page 138.

**View Column Selection Properties**

To view properties and settings associated with an item, click next to the item that you want to view, and then click Properties. The Properties window appears. You can only view this window. You cannot edit the properties and settings.

Note: If Properties is the only selection available on the menu, the role and capability settings associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

**Copy a Column Selection**

To copy a column selection and add it to the list of column selections, complete the following steps in the Manage Column Selections page:

1. To the left of the row, click and click Copy. The Copy page appears.

2. Type a name for the copy in the Column selection name field.
   
   Note: By default, the copy is named column-selection-nameCopy.

**Delete a Column Selection**

Note: To perform this task, you must have the appropriate access permissions.

To delete a column selection, on the Manage Column Selections page, click to the left of the row and click Delete.

**Apply a Column Selection to a Table or Aggregate Table**

To display the selected columns for an element type in a table, complete the following steps in an open project:

1. Click . The table view appears.

2. Select a project or scorecard.

3. Select an element type from the Element type list.
Apply a Column Selection to an Association

To display the selected columns for an association, complete the following steps in an open project:

1. Select a scorecard.
2. Click \( \text{Go} \). The association view appears.
3. Select an association from the Association list.

   Note: The list includes only column selections based on associations and general column selections.

4. Select a column from the Column selection list.
5. Click Go.

Create a Column Selection for Use in a Data-Entry Form

When you create a data-entry form, you specify a column selection to use in that form. Before you can specify the column selection, you must create it.

To create a column selection to use in a form:

1. List column selections. For more information, see “List Column Selections” on page 137.
2. Click New. The New Column Selection page appears and the General section is expanded.
3. Enter a name for the column selection in the Column selection name field.
4. (Optional) Enter a description in the Description field.
5. Click Share this column selection to make it available to all users.

   TIP To use a column selection in a data-entry form, the column selection must be Shared.

6. Expand the Definition section.
7 From the List by list, select General and click Go. To use a column selection in a data-entry form, it must be defined as General.

8 In the Available attributes tree, select the metric attribute to use and click Add. The settings appear in the right section.

9 Enter a label for each column in the Label field. By default, the column label is the same as the attribute name.

**TIP** It is a best practice to make each label unique. The unique label is used in the scorecard table view because all of the elements are displayed in this view and the elements have a mixture of period types (months, quarters, years). However, in a data-entry form, only one period type is displayed. In a form, the column labels consist of the metric attribute name combined with the selected date option.

10 Select the data option.

- To specify the current date, select Selected date.
- To always use a specified date, select Date. Then enter a date in the field or click \( \text{calendar} \) to choose a date from the calendar.
- To specify a period relative to the current date, select Relative period and enter a value in the field.

**TIP** Column selections in forms only contain one period type. Therefore, you do not select the period type to use.

11 By default, a column selection is Read-Only when it is displayed in a form. To enable the column selection for editing, click Allow Data Entry.

12 Click OK.
Common Tasks

Display the Template and Project Manager Page

Select the Owner of a Template, Project, Scorecard, or Element

Add Users and User Groups

Set Alert Preferences

Set Alerts on Comments

Working with Access Permissions

What Are Access Permissions?

Set Access Permissions for Multiple Objects

Export Access Permissions

Display the Template and Project Manager Page

To display the Template and Project Manager page, perform one of the following steps:

- If you are at the portal level, click Manage Scorecard Projects.
  
  Note: If this task does not appear in the portal, add the task to a portlet.

- If you are using SAS Strategy Management Builder, click Project ▶ Manage Templates and Projects.

Select the Owner of a Template, Project, Scorecard, or Element

One of the properties of a template, project, scorecard, or element is its owner. To select or change the owner, open the Properties window for the template, project, scorecard, or element, and click Select Owner. The Owner window appears.
Select a user name from the list. If the list is large, you can search the list by typing a user name in the **Find** field, click **Search**, and select a user name from the resulting list.

---

### Add Users and User Groups

One of the properties of a template, project, scorecard, or element is its permissions and the users and user groups that have permission for access. To add one or more users or user groups, open the Properties window for the template, project, scorecard, or element, and expand the **Permission** section. Click **Add Users and Groups**. The Add Users and Groups page appears.

To add one or more users or user groups, complete the following steps:

1. **Type a search string in the Search field.**
2. **Choose whether to include users and user groups.**
3. **Click Search.** A table of results is displayed.
4 In the table of results, select the check mark next to one or more items and click Add.

Set Alert Preferences

The SAS Information Delivery Portal lets you set preferences for receiving alerts. In SAS Strategy Management, you might specify to receive an alert when an action occurs, such as when a comment is added to an element. When the alert is generated, it can be sent in any of the following ways:

- E-mail
- Short Message Service (SMS) text message
- Via an alerts portlet that you have added to a portal page

To specify which of these ways you want to receive your alerts, complete the following steps:

1. In SAS Information Delivery Portal, click Options ➤ Preferences in the banner. The Preferences page appears.
2. In the Notifications section, in the Alert notifications list, select the way you want to receive your alerts.
3. Click Apply.
4. If you do not want to set any other preferences, click OK.

Set Alerts on Comments

You can choose to receive an alert when a comment is added to an element.
Click **On** to enable alerts. Then select a notification method from the **Delivery method** list and click **OK**.

**Note:** If you are setting the comment alert option for multiple items at once and you want to maintain the different states of notification for multiple items, click **No change**.

Otherwise, click **Off** to disable alerts and click **OK**.

---

**Working with Access Permissions**

**What Are Access Permissions?**

Access permissions control the method that a particular user or group can use to access a SAS Strategy Management object. More than one type of access permission can be assigned to a user or group. The following access permissions are available.

**Read**

Enables you to view or display the object. When users have Read access permission only, they cannot move or rename the object or change any of its information.

**Write**

Enables you to edit the object. Users can rename and change the properties and contents of the object. Read access permission is automatically granted with Write access permission.

**Delete**

Enables you to delete the object. Read and Write access permission is automatically granted when users have Delete access permission.

**Administer**

Enables you to change all access permissions for the object. Read, Write, and Delete access permission is automatically granted when users have Administer access permission.

The user who creates an object receives all access permissions for the object. Subsequent users who are added to the access permissions list for an object are given Read access permission by default.
A user inherits the access permissions of the group that the user belongs to. A group does not inherit access permissions that have been assigned to a specific user.

You assign access permissions when you perform the following tasks:

- Edit the properties of a user-defined template. For more information, see “Edit User-Defined Template Properties” on page 55.
- Edit the properties of a project. For more information, see “Edit Project Properties” on page 62.
- Edit the properties of a scorecard. For more information, see “Edit Scorecard Properties” on page 86.
- Edit the properties of an element. For more information, see “Edit Element Properties” on page 97.

You can also set access permissions for multiple objects. For more information, see “Set Access Permissions for Multiple Objects” on page 147.

Set Access Permissions for Multiple Objects

You can set the access permissions for multiple objects from one location rather than navigating to each object. One location enables you to set the access permissions quickly.

To set access permissions for multiple objects, complete the following steps in an open project:

1. Click Project ➤ Security Administration. The Security Administration - Project Permissions Display page appears.
2. From the Administration Selection list, select a project. The list of the project's objects and their access permissions appears in a table.
3. Click the name of an object. The object's properties page appears.
4. Set the access permissions.

Export Access Permissions

You can export the access permissions for scorecards and elements as comma-separated values (CSV) files with the following filenames:

<table>
<thead>
<tr>
<th>Permission type</th>
<th>Filename</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>&lt;Project-name&gt;_Scorecard_Permissions.csv</td>
</tr>
<tr>
<td>Element</td>
<td>&lt;Project-name&gt;_Element_Permissions.csv</td>
</tr>
</tbody>
</table>

where <Project-name> is the name of the project in which the scorecard or element belong.

Note: Access permissions that are inherited from a project are not included in the CSV files. If the access permissions for all of the scorecards and elements are inherited, the CSV files are empty (except for the first row, which contains column headings).
To export the access permissions, complete the following steps in an open project:

1. Click **Project ➤ Security Administration**. The Security Administration - Project Permissions Display page appears.

2. Click **Export Permissions**. The Security Administration - Specify Export Directory Name page appears.

3. In the **Directory name** field, type the path in which to create the CSV files.
   
   Note: The path is relative to the current working directory on the server.

4. Click **Save**.
Part 3

Navigating Data and Creating Views in SAS Strategy Management Builder

Chapter 16  
*What Is a View?*  ................................................................. 151

Chapter 17  
*Creating and Editing Table Views*  .................................................. 159

Chapter 18  
*Creating and Editing Aggregate Views*  ........................................ 165

Chapter 19  
*Creating and Editing Association Views*  ..................................... 167

Chapter 20  
*Creating and Editing Diagram Views*  ........................................ 173

Chapter 21  
*Creating and Editing Gauge (Also Called Dashboard) Views* ............ 229

Chapter 22  
*Creating and Editing Trend Analysis Views*  .................................. 231

Chapter 23  
*Managing Views*  ................................................................. 237
What Is a View?

Overview
SAS Strategy Management provides different ways to display and explore strategy content and data. These are called views. Depending on your strategy, data might be easier to understand in one type of view compared to another type. The following views are available:

- Table
- Aggregate
- Association
- Diagram
- Gauge (also called dashboard)
- Trend analysis

You can use these views in the following ways:

- You can navigate and explore your data using different views in SAS Strategy Management Builder. You can use only one view at a time. Some business users might access a view in the Builder to adjust the view, but the Builder is primarily used by scorecard modelers. For detailed information, see “Part 3. Navigating Data and Creating Views in SAS Strategy Management Builder.”

- You can create a portlet that is displayed on a portal page in the SAS Information Delivery Portal. Scorecard modelers create portlet views for their business users. Because you can have multiple portlets on a portal page, you can display and use multiple views at a time. Also, the new Strategy Management enhanced portlet can display one or more tiles. A tile is like a window, but it exists within the boundaries of a portlet. In Strategy Management, a tile displays a view. For detailed information, see “Part 4. Creating Portlet Views for Business Users.”
Note: Strategy Management information can also be viewed in SAS BI Dashboard. For more information, see Appendix 3, “View SAS Strategy Management Data in SAS BI Dashboard,” on page 387.

The views are available in the following ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Builder</th>
<th>Classic-style Portlet</th>
<th>Enhanced-portlet Tile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Association</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Diagram</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Gauge</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Trend</td>
<td>Yes¹</td>
<td>Yes¹</td>
<td>Yes²</td>
</tr>
</tbody>
</table>

1 Links to the Trend Analysis page that provides the classic style dynamic analysis features.
2 Provides the trend analysis tile with enhanced dynamic features and a static trend chart option.

Table

Tables display data in rows and columns.

*Figure 16.1 Table Example*

<table>
<thead>
<tr>
<th>Name</th>
<th>Period</th>
<th>Actual</th>
<th>Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenues</td>
<td>AUG2010</td>
<td>$24,655,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expenses</td>
<td>AUG2010</td>
<td>$16,461,750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>AUG2010</td>
<td>$8,193,250</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>AUG2010</td>
<td>98</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Sats.</td>
<td>AUG2010</td>
<td>78%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The columns in the table are determined by the template with which the project is associated. The elements are displayed in rows. You can create elements in a table.

In a table, you can perform the following tasks:

- Display data that is organized by element type, attribute, and date.
- Create, copy, move, and delete elements.
- Customize the rows, columns, and types of links that are displayed in the table.
- Format columns and cells.
- Apply formulas and ranges to columns.
- Set global and personal threshold options.
- Display history.
- View and add comments.

### Aggregate

An aggregate table shows data from the selected scorecard and all of its children. You can choose to view the aggregated data by scorecard or by metric attribute.

**Note:** If a scorecard does not contain child scorecards, the aggregate table is not displayed.

**Figure 16.2  Aggregate Example**

<table>
<thead>
<tr>
<th>Name</th>
<th>Actual</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Asia Pacific</td>
<td>India</td>
</tr>
<tr>
<td>Revenues</td>
<td>$17,300,000</td>
<td>$4,500,000</td>
</tr>
<tr>
<td>Expenses</td>
<td>$5,119,500</td>
<td>$3,240,000</td>
</tr>
<tr>
<td>Profitability</td>
<td>$12,271,500</td>
<td>$1,260,000</td>
</tr>
<tr>
<td>Customers</td>
<td>50</td>
<td>90</td>
</tr>
<tr>
<td>Customer Stats</td>
<td>78%</td>
<td>78%</td>
</tr>
</tbody>
</table>

### Association

An association displays relationships between scorecard element types and their associated attributes in a project. The elements are displayed in a hierarchy to reflect their association.

**Figure 16.3  Association Example**

<table>
<thead>
<tr>
<th>Name</th>
<th>Actual</th>
<th>Target</th>
<th>Performance</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality management</td>
<td>$8,193,250</td>
<td>$3,000,000</td>
<td>50%</td>
<td></td>
</tr>
<tr>
<td>Profitability</td>
<td>$24,555,000</td>
<td>$10,000,000</td>
<td>16%</td>
<td></td>
</tr>
<tr>
<td>Customer loyalty program</td>
<td>50</td>
<td>170</td>
<td>56%</td>
<td></td>
</tr>
<tr>
<td>Revenues</td>
<td>90</td>
<td>150</td>
<td>56%</td>
<td></td>
</tr>
<tr>
<td>Market share</td>
<td>73%</td>
<td>87%</td>
<td>90%</td>
<td></td>
</tr>
<tr>
<td>Customers</td>
<td>45</td>
<td>65</td>
<td>78%</td>
<td></td>
</tr>
<tr>
<td>New Customers</td>
<td>8%</td>
<td>15%</td>
<td>56%</td>
<td></td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>78%</td>
<td>87%</td>
<td>90%</td>
<td></td>
</tr>
<tr>
<td>Productivity</td>
<td>75</td>
<td>65</td>
<td>78%</td>
<td></td>
</tr>
<tr>
<td>Hours spent with CL</td>
<td>45</td>
<td>65</td>
<td>88%</td>
<td></td>
</tr>
</tbody>
</table>
A diagram is a graphical way of representing elements, their relationships to one another, and their respective scores. A diagram is a way to present information found in tables, but in a more intuitive way. When you use a diagram, you can display results in the context of the strategy and provide answers about how well the organization is performing and why certain data or a certain relationship is important.

A diagram enables users to see the relationship between strategy elements. These relationships are sometimes difficult to convey in a table. You can create diagrams that illustrate the relationships between scorecard elements or project element types.

Note: A diagram is often used to present the strategy map, which is a layered representation that conveys the drivers and relationships.

**Figure 16.4** Example of a Diagram View Displayed in a Classic-Style Portlet

---

**Gauge (Also Called Dashboard)**

A gauge (also called dashboard) displays ranges of data in a graphical format. You can display key performance indicators or any SAS Strategy Management elements by using the gauge view. Each element is represented by a gauge that displays the data ranges that are defined. In addition to displaying ranges, you can provide links to comments, trend data, and element properties.
Gauges can be displayed as a dial, a slider, a stoplight, a speedometer, or a bullet bar.

Figure 16.5  Example of a Gauge Dial

<table>
<thead>
<tr>
<th>Trend Implementation</th>
<th>Product Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you are working in the Builder using the table or association views, the Trend Analysis button is available. When you click this button, the Trend Analysis page appears.</td>
<td>Builder</td>
</tr>
<tr>
<td>When you are working in the table, association, or dashboard views in a classic-style portlet, the Trend Analysis button might be available, depending on how the portlet is customized. When you click this button, the Builder opens and the Trend Analysis page appears.</td>
<td>Classic-style portlet</td>
</tr>
<tr>
<td>The Strategy Management enhanced portlet can be customized to include a trend analysis tile. You can drag a value or an element from one or more table, aggregate, association, or gauge tiles onto the trend analysis tile. You can manipulate the resulting graph to further explore the trend analysis. You can also add or remove more data from other tiles. See Figure 16.6 on page 156.</td>
<td>Enhanced-portlet tile</td>
</tr>
<tr>
<td>The enhanced-portlet tiles for the table, association, diagram, and gauge views provide an option to display a static trend chart. If the tile is customized to use this option, you can click an icon that opens a trend chart. The data is static although you can change the date range using the date slider. See Figure 16.7 on page 157.</td>
<td>Enhanced-portlet option</td>
</tr>
</tbody>
</table>

With the Trend Analysis page, the initial analysis uses the element whose row you clicked to open the Trend Analysis page. However, you can dynamically add to or
change the analysis after it opens. For more information, see Chapter 22, “Creating and Editing Trend Analysis Views,” on page 231.

For more information about the enhanced-portlet implementations of trend analysis, see the following sections:

- “Edit the Trend Analysis Tile Properties” on page 274
- Chapter 30, “Navigating and Viewing the Strategy Management Enhanced Portlet and Its Tiles,” on page 299

Figure 16.6 Example of a Dynamic Trend Analysis in an Enhanced Portlet Tile
Figure 16.7  Example of a Static Trend Chart in the Enhanced Portlet
Creating and Editing Table Views

Open a Table

To open a table, complete the following steps:

1. Open a scorecard. For more information, see “Open a Scorecard” on page 84.
2. In the toolbar, click to display the table.
3. To display the most current updates to the data in the table, especially after you perform a calculation, click in the toolbar.

Specify How to View Scorecard Table Data

To specify how to view scorecard table data, complete the following steps in an open table:

1. To display the metric attributes by the type of element, select an element type from the Element type list.
2. To display the metric attributes that belong to a specified column selection in a scorecard table, select a column selection from the Column selection list.
   Column selections are defined in the project options. For more information, see “Create a Column Selection” on page 138.
3. To display data for a particular date, type a date in the Date field or click to choose a date from the calendar.

Note: SAS Strategy Management matches the date that you specify to the appropriate time period for each element. For example, if one element is based on a yearly period, and another element is based on a monthly period, the table
displays data that is valid for the year and the month that contain the date that you specified.

4 Click Go. The table displays the data as you have specified.

Sort Rows

To sort the rows of data in a table according to the value of the column, click a column heading in the table to sort the rows by that column. The column used to sort the list contains either an up or down arrow in the column heading.

- An up arrow (▲) indicates that the list is sorted in ascending order (A-Z).
- A down arrow (▼) indicates that the list is sorted in descending order (Z-A).

Change the Order of Rows in a Scorecard Table

To change the order of rows within a table, complete the following steps in an open table:

1 Click ▼ for a specific row and click Order Rows. The Order Rows page appears.

2 Select an element.

3 To sort in ascending or descending alphabetic order, click Sort Ascending or Sort Descending.

4 To move scorecards, select one or more scorecards and use the following icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Moves the selected scorecard to the beginning of the list.</td>
</tr>
<tr>
<td>Icon</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>![up icon]</td>
<td>Moves the selected scorecard up.</td>
</tr>
<tr>
<td>![down icon]</td>
<td>Moves the selected scorecard down.</td>
</tr>
<tr>
<td>![bottom icon]</td>
<td>Moves the selected scorecard to the end of the list.</td>
</tr>
</tbody>
</table>

**Customize a Scorecard Table**

You can change the way in which the information in a scorecard table view is displayed.

**Note:** Customized settings, except for row and column size, continue to apply to the project after it is closed and reopened.

To customize a scorecard table, complete the following steps in an open table:

1. Click **Customize** in the toolbar. The Customize page appears.
2 Expand the **Row and Column Paging** section and make the applicable selections:

- To display all the rows and columns in a scorecard table, click **All rows and columns**.
- To specify the number of rows and columns that are displayed, click **Specify number of rows and columns**. Then select the applicable number from the **Rows** and **Columns** lists.

3 Expand the **Cell Display** section and make the applicable selections:

- To display a formula icon when a formula is applied to the cell, click **Show formula icon**.
- To display thresholds, click **Show threshold icon** and click either **Personal** or **Global**.

**Note:** Cell display information applies only to cells that contain values. For example, cells that display range icons do not display threshold or formula icons.
To display a rule icon when a rule is applied to the cell, click **Show rule icon**.

4 Expand the **Additional Information Columns** section and make the applicable selections:

- To display a column with links to comments, click **Comments**.
- To display a column with links to comment alerts, click **Comment Alert**.
- To display a column with links to a trend analysis chart, click **Trend Analysis Chart**.
- To display a column with period information, click **Period**.

5 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Open an Aggregate Table

Note: Aggregate table can be displayed only with numerical data, that is, metric attributes.

To open an aggregate table, complete the following steps:

1. Open the project that contains the table. For more information, see “Open a Project” on page 61.

2. Select a parent scorecard.

3. In the toolbar, click \( \text{display} \) to display the aggregate table.

4. Move the mouse pointer over each value, range icon, range color, or range label to display the names of the associated element.

5. To drill-down into a child scorecard, click the name of a child scorecard.
   
   Note: To expand and collapse the hierarchy of an aggregate table, click the tree icon in the column heading.

6. To display the most current updates to the data in the table, especially after you perform a calculation, click \( \text{refresh} \) in the toolbar.

Specify How to View Aggregate Table Data

To specify how to view aggregate table data, complete the following steps in an open aggregate table:

1. To display the metric attributes by the type of element, select an element type from the Element type list.
2 To display the metric attributes that belong to a specified column selection in a scorecard table, select a column selection from the **Column selection** list.

Column selections are defined in the project options. For more information, see “Create a Column Selection” on page 138.

3 To display data for a particular date, type a date in the **Date** field or click ![calendar] to choose a date from the calendar.

**Note:** SAS Strategy Management matches the date that you specify to the appropriate time period for each element. For example, if one element is based on a yearly period, and another element is based on a monthly period, the table displays data that is valid for the year and the month that contain the date that you specified.

4 Click **Go**. The table displays the data as you have specified.

5 To organize data in an aggregate table by scorecard or metric attribute, click **Scorecard** or **Metric Attribute**.

**Note:** Metric attributes are defined in the template with which the project is associated.

---

**Sort Rows**

To sort the rows of data in a table according to the value of the column, click a column heading in the table to sort the rows by that column. The column used to sort the list contains either an up or down arrow in the column heading.

- An up arrow (▲) indicates that the list is sorted in ascending order (A-Z).
- A down arrow (▼) indicates that the list is sorted in descending order (Z-A).
Creating and Editing Association Views

**List Associations**

Note: To perform this task, you must have the appropriate access permissions.

To list associations, complete the following steps:

1. Open a project. For more information, see “Open a Project” on page 61.
2. Click in the toolbar.
3. Click **Manage Associations** in the toolbar. The Manage Associations page appears and displays a list of associations.

**Create an Association**

Note: To perform this task, you must have the appropriate access permissions.

To create an association, complete the following steps in a list of associations:

2. On the Properties page, type the name of the association and, optionally, a description.
3. Click **Next**.
4 On the Select Element Type page, specify an element type to display at the highest level in the association by selecting an element type from the **Element type** list. After you select a type, an **Association preview** appears.

5 Click **Next**.

6 On the Associate Attribute page, you can use an association to display attributes that are associated with an element type. Attributes are associated with element types in the template on which the project is based.

   a Select an attribute from the **Attribute** list.
   
   b Click **Add**. The attribute appears in the **Association preview** list.

   ```
   **Associate Attribute**
   Select an attribute to add it as a new row in the association.
   
   What is the linked attribute that is next in the association?
   
   ![Attribute list with Measure and Measure (Objective) options]
   
   **Association preview:**
   
<table>
<thead>
<tr>
<th>Level</th>
<th>Element type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Measure</td>
</tr>
<tr>
<td>2</td>
<td>Measure (Objective)</td>
</tr>
</tbody>
</table>
   ```

   c Add as many attributes as needed.

7 Click **Next**.

8 On the Subtotaling and Totaling Rows page, you can display the totals and subtotals of rows in the association. You can also apply functions to the totals and subtotals.

   a To display row totals, click **Include totals**.
   
   b To include subtotals from the selected element type, select the check boxes that are below **Include subtotals for**.
   
   c To apply a function to the total for each metric type attribute, in the **Select metric type attribute functions for** group, select functions from the metric attribute lists. The default value for each of these lists is **None**.

9 Click **Next**.

10 On the Summary page, review the association information. If you want to make changes, click **Previous** to return to a previous page to change a property.

11 When you are satisfied with your settings, click **Finish**. To exit the wizard without saving changes, click **Cancel**.

---

**View an Association**

To view an association, complete the following steps in an open scorecard table:
1 Click on the toolbar.

2 Select an association from the Association list.

3 Select a column selection from the Column selection list. For more information, see “Create a Column Selection” on page 138.

   Note: Element type column selections are not included in the list. Only association column selections and general column selections are included.

4 To display data for a particular date, type a date in the Date field or click to choose a date from the calendar.

   Note: SAS Strategy Management matches the date that you specify to the appropriate time period for each element. For example, if one element is based on a yearly period, and another element is based on a monthly period, the table displays data that is valid for the year and the month that contain the date that you specified.

5 Click Go. The table displays the data as you have specified.

6 To display all the levels of associated attributes and subtotals, click Expand All.

7 To collapse all levels, click Collapse All.

---

**Customize an Association**

You can change the way in which the information in an association is displayed.

Note: Customized settings, except for row and column size, continue to apply to the project after it is closed and reopened.

To customize an association, complete the following steps in an open association:

1 Click Customize in the toolbar. The Customize page appears.

2 Expand the Cell Display section. To display thresholds, click Show threshold icon and click either Personal or Global.

   Note: Cell display information applies only to cells that contain values. For example, cells that display range icons do not display threshold icons.

3 Expand the Additional Information Columns section and make the applicable selections:
   - To display a column with links to comments, click Comments.
   - To display a column with links to comment alerts, click Comment Alert.
   - To display a column with links to a trend analysis chart, click Trend Analysis Chart.

4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.
Edit Association Properties

Note: To perform this task, you must have the appropriate access permissions.

To edit the properties of an association, complete the following steps in a list of associations:

1. On the Manage Association page, click the association name. The Association Properties page appears.

2. In the General section, complete the following steps:
   a. Type a new name in the Association name field.
   b. (Optional) Type a new description in the Description field.

3. To change association levels, expand the Association Definition section.
   a. To delete a level, click Delete that is next to the attribute name.
   b. To add a level, click Add Level. The Add Attribute to Association page appears.
   c. Select an attribute from the Attribute list.
   d. Click OK to save your changes and return the Association Properties page.

4. To change the display of totals and subtotals, and change the functions that are applied, expand the Subtotaling and Totaling section and complete the following steps:
   a. To display row totals, click Include totals.
   b. To include subtotals from the selected element types, select the check boxes below Include subtotals for.
   c. To apply the function to the total for each metric type attribute, select functions from the lists under Select metric type attribute functions for.

5. Click OK to save your changes and exit the page. Click Apply to apply your changes and remain on the page. Click Cancel to exit the page without saving changes.

Copy an Association

Note: To perform this task, you must have the appropriate access permissions.

To copy an association, complete the following steps in a list of associations:

1. On the Manage Association page, click the association and click Copy. The Copy page appears.
2 Type the name of the copy. By default, the copy is saved with the name Copy of association-name. You can also type a description of the association.

Delete an Association

Note: To perform this task, you must have the appropriate access permissions.

To delete an association, in a list of associations on the Manage Association page, click to the left of the association and click Delete.
Creating and Editing Diagram Views

Overview
- What Is a Diagram? 175
- Diagram Layers and Their Objects 176
- Data Layer Objects 176
- Shape Layer Objects 177

Create a Diagram 177

About the Diagram Editor
- Using the Diagram Editor 178
- The Diagram Editor Interface 178
- The Toolbar 179
- Start the Diagram Editor 180
- Close the Diagram Editor 180

Adding Diagram Objects
- Add an Element 181
- Add and Remove Data Nodes 181
- Add an Association Link 182
- Add a Section 183
- Add a Line 184
- Add a Shape 184
- Add Text 185
- Add an Image 185

Deleting Diagram Objects 186
- Delete Objects in the Data Layer 186
- Delete Objects in the Shape Layer 186

Arranging the Layout of Diagram Objects 187
- Arranging Layout to Make a Diagram More Readable 187
- Use the Grid to Arrange Objects in a Diagram 187
- Zoom the Diagram View 187
- Hide or Show an Element 187
- Arranging Association Links 188
- Copy and Paste a Diagram Object 188
- Select or Deselect Shapes, Text, or Images 188
- Resize a Diagram Object 189
- Move a Diagram Object 189
- Rotate a Polygon 190
- Grouping Objects 190
- Arranging Lines 193

Specify Object Appearance 194
- About Object Appearance 194
Overview

What Is a Diagram?

A diagram is a graphical way of representing elements, their relationships to one another, and their respective scores. A diagram is a way to present information found in tables, but in a more intuitive way. When you use a diagram, you can display results in the context of the strategy and provide answers about how well the organization is performing and why certain data or a certain relationship is important.

A diagram enables users to see the relationship between strategy elements. These relationships are sometimes difficult to convey in a table. You can create diagrams that illustrate the relationships between scorecard elements or project element types.

Note: A diagram is often used to present the strategy map, which is a layered representation that conveys the drivers and relationships.

Figure 20.1 Example of a Diagram View Displayed in a Classic-Style Portlet
Diagram Layers and Their Objects

You can create diagrams that illustrate the relationships between scorecard elements. Diagrams can be based on project element types or scorecard element types.

Diagrams have two layers:

- **data layer**: The data layer can contain elements, data nodes, and association links. These diagram objects represent the underlying data from the project that the diagram is illustrating.

- **shape layer**: The shape layer can contain sections, lines, shapes, text, and images. You can use these diagram objects to group data objects and otherwise improve the appearance of the diagram. You can use both shapes and sections to group and contain data nodes.

Data Layer Objects

**Elements**

You can make changes to the scorecard data that underlies a diagram by adding, changing, or deleting elements in the diagram. In a single diagram, you can display any metric attribute from any scorecard, and you can display multiple instances of the same element but with element values for different dates.

**Data Nodes**

The data layer consists primarily of data nodes that represent the elements in a scorecard or a project. A **data node** contains all of the data and metadata that are associated with an element, such as its labels, attributes, associations, and values. You can display any or all of the metric attributes of an element type in a data node. The initial shape and background color of a data node are set in the template for the project. For more information, see “Create a Template” on page 42.

The node properties that are specified in the project template apply across all diagrams in all scorecards within the project. You can override these properties and specify additional properties for a particular diagram. For example, the scorecard master table might specify that nodes that represent strategic objectives are ellipses, yet within a particular diagram, you can specify that nodes that represent strategic objectives are triangles. In this case, nodes that represent strategic objectives are generally ellipses, but in that particular diagram, nodes that represent strategic objectives are triangles.

Data nodes can show range icons and colors for each attribute value. You can also include icons that enable users to drill down to the following features:

- trend charts
- comment manager
- metric attribute directives
- global and personal thresholds
Association Links

Association links depict associations between data nodes. These associations are set in the following places:

- The attribute definitions are set in the project, and the scorecard element properties are set in the template.
- The properties for each element are set in a project or scorecard.

Shape Layer Objects

A section is a movable and resizable rectangle that can represent an element or a scorecard. You can use sections to organize the data in a diagram by project, scorecard, and attribute.

You can use straight or curved lines to connect containers. A straight line can be a single straight-line segment or a chain of two or more straight-line segments that are connected in a zigzag arrangement. A curved line can be a single smooth curve or a chain of two or more smooth curves that are connected at cusp points. Single straight-line segments and single smooth curves should meet most of your needs.

You can also include shapes (rectangles, ellipses, and polygons), text, and images in a diagram.

Create a Diagram

To create a new diagram:

1. Open a project. For more information, see “Open a Project” on page 61.
2. Select a project or scorecard name in the hierarchy and click on the toolbar.
4. The Name page displays the project and scorecard that contain your diagram, and the name of the diagram. In the Diagram name field, enter the name of the new diagram. Click Next.

   Note: Project diagram names must be unique within a particular project. Scorecard diagram names must be unique within a particular scorecard.

5. On the Element Types page, click the names of the element types that you want the diagram to display. The Element types list provides the element types in your project and scorecard. The diagram displays all of the elements of the element types that you select. Click Next.

   TIP To select more than one item, hold down the Ctrl key and click multiple items in the list.

6. On the Associations page, click an association name to select an association to display in the diagram. The Associations list provides the associations that have been established between your project or scorecard element types. Click Next.

   Note: To select more than one item, hold down the Ctrl key and click multiple items in the list.
7 On the Layout page, click a style for laying out the element types in the diagram. Click Next.

8 On the Finish New Diagram page, review your selections. To change a selection, click Previous.

9 Click Finish to save your selections and exit. Click Cancel to exit without saving your selections.

After the diagram is created, you must use the Diagram Editor to edit and complete your diagram. For more information, see “About the Diagram Editor” on page 178.

---

**About the Diagram Editor**

**Using the Diagram Editor**

Use the Diagram Editor to edit the following kinds of diagrams:

- a new diagram that you have created by using the New Diagram Wizard
- an existing diagram that you created in this installation of SAS Strategy Management

*Note:* You cannot import diagrams into SAS Strategy Management.

If you are starting the Diagram Editor for the first time, you must configure your web browser to use the Java plug-in. For information about installing the J2RE, see Appendix 2, “Configuring Java,” on page 383.

**The Diagram Editor Interface**

The Diagram Editor interface includes a menu bar with all its functions and a toolbar for its commonly used functions. The following figure shows the Diagram Editor interface and its major parts.
Figure 20.2  Diagram Editor Interface

1  Menu bar

2  Toolbar (For a description of the toolbar buttons, see “The Toolbar” on page 179.)

3  Ruler

4  Drawing area

5  Progress indicator
   Indicates the status or progress when opening or saving the diagram image file.

The Toolbar

The toolbar provides buttons that you use to create your diagram.

Figure 20.3  The Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Saves the diagram.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a rectangle.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Rectangle with rounded corners]</td>
<td>Creates a rectangle with rounded corners.</td>
</tr>
<tr>
<td>![Ellipse]</td>
<td>Creates an ellipse.</td>
</tr>
<tr>
<td>![Line]</td>
<td>Creates a line.</td>
</tr>
<tr>
<td>![Polygon]</td>
<td>Creates a polygon.</td>
</tr>
<tr>
<td>![Text]</td>
<td>Opens a list for adding text.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Adds an image to the diagram.</td>
</tr>
<tr>
<td>![Grid]</td>
<td>Toggles the display of the grid.</td>
</tr>
<tr>
<td>![Ruler]</td>
<td>Toggles the display of the ruler.</td>
</tr>
<tr>
<td>![Zoom]</td>
<td>Changes the size of the diagram view.</td>
</tr>
</tbody>
</table>

**Start the Diagram Editor**

To start the Diagram Editor:

1. Open a project. For more information, see “Open a Project” on page 61.
2. Select a project or scorecard name in the hierarchy, and click ![Zoom] in the toolbar.
3. Select a diagram.
4. Click ![Zoom].

**Close the Diagram Editor**

To close the Diagram Editor, select File ➤ Exit.
Adding Diagram Objects

Add an Element

To add an element:

1. Select Elements ▶ New. The New Element list appears.
2. From the Element types list, select a type.
3. From the Period types list, select a type.
4. Click OK.

An element of the selected type is added to the scorecard, and a corresponding node appears in the diagram. The node is inserted at x, y coordinates 200, 200. You can insert a new node under other nodes. You can rearrange the other nodes to display the new node.

Add and Remove Data Nodes

In a new diagram, the data nodes are organized by the layout style that you selected when you created the diagram. After you change the layout, you might want to remove certain nodes. You can redisplay the removed nodes in their last position. When you save the diagram, any nodes that you removed are removed from the display.

**TIP** The Diagram Editor supports undo and redo when you add or remove data nodes. You can undo or redo up to ten of these actions.

To select which data nodes are displayed in the diagram and which data nodes are not displayed:

The hierarchy icons that contain selected elements are highlighted.

2. To limit which element types are displayed in the list, click Select. The Select Element Types window appears.

3. Select the element types to display and click OK.

4. In the Add/Remove Elements window, expand a hierarchy, and select or clear an element.

   Note: Adding or removing elements in a diagram does not affect the underlying data.

5. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Add an Association Link

In addition to the associations that are displayed as links when you open a diagram, you can also create a link between data nodes.

To create a link, hold down the Ctrl key and drag the mouse pointer from one node to another. If the source node has an attribute of the type of the target node, the target node allows an association and the mouse pointer changes to a green check mark. Release the mouse button to add a link between the two nodes.

TIP If an association is not allowed, the mouse pointer changes to a red X, and a link is not created.
Add a Section

Add a Project Section to a Diagram
To add a section for the current project to a diagram, select Sections ➤ Add Project Section.

Add Scorecard Sections to a Diagram
To add scorecard sections to a diagram:

1 Select Sections ➤ Add Scorecard Sections. The Add Scorecard Sections window appears.

2 Drag a scorecard from the list onto the diagram. A section is that has the name of the scorecard is created. You can also drag a parent scorecard onto a diagram to create a scorecard section for each child scorecard that is in the parent scorecard.

3 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Add Attribute Sections to a Diagram
To add attribute sections to a diagram:

1 Select Sections ➤ Add Attribute Sections. The Add Attribute Sections window appears. Attributes for the element types in the scorecard are available.
2 Drag an attribute from the list onto the diagram. A section that has the name of the attribute is created. You can also drag an attribute category onto a diagram to create a section for each attribute in that category.

3 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**Add a Line**

To add a line to a diagram, click on the toolbar. A new line appears at the center of the diagram. The line starts as a horizontal straight line with a handle at each end. To make the handles disappear, click anywhere in the diagram background. To make the handles appear, click either endpoint.

**Add a Shape**

To add a shape, use the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Rectangle" /></td>
<td>Creates a rectangle.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Rectangle with Rounded Corners" /></td>
<td>Creates a rectangle with rounded corners.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Ellipse" /></td>
<td>Creates an ellipse.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Polygon" /></td>
<td>Creates a polygon.</td>
</tr>
</tbody>
</table>
The new shape appears at the center of the diagram. Selection handles appear around the shape.

- A rectangle starts as a square. The border of a rectangle is defined by the four points.
- An ellipse starts as a circle. The border of an ellipse is defined by a rectangle that snugly contains the ellipse.
- A polygon starts as a triangle. Polygons can have any number of vertices and can be any polygonal shape, such as triangle, pentagon, or octagon.

### Add Text

To add text:

1. Click \( \text{A} \). The Enter Text window appears.
2. Type a single line of text. Later, you can edit the properties of the text to add more lines of text.

The text is contained in a rectangular box that snugly contains the text. You can move the box in the diagram as well as edit the text properties.

### Add an Image

You can add images, including drawings in SVG format, to a diagram.

**Note:** SAS Strategy Management cannot load image files with names that contain characters in the double-byte character set (DBCS). Make sure that your image filenames do not contain DBCS characters.

To add an image:

1. Click \( \text{A} \). The Select Image window appears.
2. Select an image file.
3. To add an image file to the list, click **Upload Image**, navigate to the image file, select it, and click **OK**.
4. To refresh the list of images, click **Refresh**.

**Note:**

- Images might be missing because a previously uploaded image was removed.

**Note:** If an image file is used in a diagram, you do not receive any warning if you delete the image file. If a diagram uses an image file that has been deleted, a red X appears in the diagram in place of the missing image.

- Most uncompressed image formats are supported by the Diagram Editor. The Diagram Editor uses the Java Virtual Machine (JVM). The JVM installed on your computer might support compressed formats. See the documentation for your JVM for information about the image formats that are supported.

5. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Deleting Diagram Objects

Delete Objects in the Data Layer

The following diagram objects are part of the data layer and represent data:

- elements
- nodes
- association links

**CAUTION!** When you delete a node, an element, or an association link, you also delete the data that underlies these objects.

The following table describes the related objects and data that you delete when you delete these objects, and how to delete these objects.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>What to Delete</th>
<th>How to Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>the data node that represents the element and the corresponding element from the underlying table</td>
<td>To delete an element, select the node that represents the element you want to delete and select Edit ➤ Delete.</td>
</tr>
<tr>
<td>Node</td>
<td>the underlying element and all values for the element that are in the database for the scorecard and any shapes in the diagram that are associated with the element</td>
<td>To delete a data node, select a data node in the diagram and select Edit ➤ Delete.</td>
</tr>
<tr>
<td>Association link</td>
<td>the association link and the data value that underlies the link</td>
<td>To delete an association link, click the origination point or endpoint of the link, and select Link ➤ Delete.</td>
</tr>
</tbody>
</table>

Delete Objects in the Shape Layer

The following diagram objects are members of the shape layer:

- lines
- sections
- shapes, text, and images

To delete these diagram objects, select the object and then select Edit ➤ Delete.
Arranging the Layout of Diagram Objects

Arranging Layout to Make a Diagram More Readable

When you first open a diagram that you have created, the data nodes are organized by the layout style that you selected when you created the diagram. To make the diagram more readable, drag the nodes so that they do not cover other nodes or links.

If you need to improve the readability of a diagram, consider the following tips:

- Use containers or sections to group data nodes.
- Limit the number of data nodes, containers, and connecting arrows. One way to do this is to focus on a limited set of relationships. Do not try to show everything in one diagram.
- Drag nodes so that nodes do not cover other nodes or arrows.
- Do not make the diagram too big. The rulers in the Diagram Editor represent screen pixels. Consider the typical screen dimensions of your users’ computers when you create a diagram.

Use the Grid to Arrange Objects in a Diagram

Every diagram has a grid that you can use to arrange objects.

- To show or hide the points of the grid, select Grid ➤ Show Grid.
- To change the coarseness of the grid, select Grid ➤ Grid Size, and select a coarseness.
- To align shapes with the grid, select Grid ➤ Snap To Grid. Any node or container that you drag to a new location snaps to alignment with the grid.
- If you select a container, right-click on it, and select Shapes ➤ Resize To Grid. Each handle of the container snaps to the nearest grid point. The result is to subtly change the size and shape of the container.

**TIP** If the grid is shown, performance can decrease, particularly for small grid sizes when they are viewed in zoomed-out mode. To increase performance, hide the grid. Even when the grid is hidden, Snap to Grid continues to be in effect.

Zoom the Diagram View

To magnify or shrink your view of a diagram, select Grid ➤ Zoom, and select a percentage.

Hide or Show an Element

To hide an element, right-click on the element and select Hide.
Note: Hiding an element in a diagram does not affect the underlying data.
To display an element again, select Elements ▶ Add/Remove. In the Add/Remove Elements list, select the element and click OK.

**Arranging Association Links**

**Curve an Association Link**
To activate the handles of a curved link, click the origination point or the endpoint of the link. To manipulate the curvature of a curved link, drag a handle.

**Route an Association Link around Other Content**
You can route an association link that exists between element nodes around other content in the diagram so that the other content remains visible. The links between elements are orthogonal. That is, they consist of multiple straight line segments that can be arranged at different angles.
To route a link around other diagram content:

1. Select a link and right-click on one of the handles.
2. Select Link ▶ Insert point. Insert as many points as you need.
3. Drag the link handles to arrange the line segments.

**Copy and Paste a Diagram Object**
You can copy and paste objects that are members of the shape layer:
- lines
- sections
- shapes, text, and images
To copy, select the object and click Edit ▶ Copy
To paste, select the object and click Edit ▶ Paste
For information about selecting an object, see “Select or Deselect Shapes, Text, or Images” on page 188.

**Select or Deselect Shapes, Text, or Images**
To select or deselect a shape, text, or image, use the applicable step:
- To select a shape, text, or image, click anywhere inside the item. Handles appear at the points that define the item.
- To deselect a shape, text, or image, click anywhere in the diagram background. The handles disappear.
- To select more than one item, hold down the Ctrl key and click each item or drag the mouse pointer across the background to create a selection rectangle that completely contains the items.
- To select all of the shapes, text, images, lines, and sections in a diagram, select Edit ▶ Select All.
Resize a Diagram Object

**TIP** The Diagram Editor supports undo and redo when you resize a shape or image. You can undo or redo up to ten of these actions.

You can change the dimensions of the following objects:
- elements
- sections
- shapes and images

To change the dimensions of an object, select the object. Handles appear on the object. Drag a handle to a new location.

Note:
- When you drag a handle of a rectangle, an ellipse, or an image, two handles on one side of the item always move together so that the item maintains its shape. When you drag a handle of a polygon, only the selected handle moves.
- You can also edit the properties of a rectangle or an ellipse in order to change the width and height. You cannot edit the properties of a polygon to change its dimensions. For more information, see “Specify the Position, Alignment, and Depth of an Object” on page 205.

Move a Diagram Object

You can move the following objects:
- data nodes
- elements
- sections
- lines
- shapes, images, and text

**TIP** The Diagram Editor supports undo and redo when you move objects. You can undo or redo up to ten of these actions.

To move an object, select the object and drag it to a new location.

**TIP** When you drag a node, any association links that connect to that node move, stretch, or shrink accordingly.

To move several objects together as a single unit:

1. Hold down the Ctrl key.
2. Click each object or drag the mouse pointer across the background to create a selection rectangle that completely contains the objects.
3. Drag any one of the objects in the group. The objects retain their relative positions to each another.
**TIP** To move a node and all nodes that link to it or from it as a fixed formation, hold down the Shift key and drag the unit of nodes to a new location. Any links to or from a moved node that are not part of the unit of nodes move, stretch, or shrink accordingly.

---

**Rotate a Polygon**

To turn a polygon upside down, select the polygon and select **Shapes ▶ Rotate ▶ Horizontal**.

To reverse the left and right sides of a polygon, select the polygon and select **Shapes ▶ Rotate ▶ Vertical**.

---

**Grouping Objects**

**About Groups**

You can use a section, a shape, text, or an image to contain other objects such as shapes and data nodes in a diagram. Such a container is useful for creating a visual grouping of objects.

**Use Sections to Group Data Nodes by Attribute**

To group data nodes into sections in accordance with a selected attribute:

1. Select any node, and then select one of the following:
   - **Elements ▶ Sort This Node by Attribute**
   - **Elements ▶ Sort All of This Type By Attribute**

   The Sort window appears.

2. Click the attribute or element type that you want to group the nodes by.

3. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**TIP** Nodes are grouped together in the sections that you have created. If you sort data nodes into sections and then change some of the data that affects the result of the sort operation, the diagram is not automatically refreshed. To align the diagram with the new data, you must repeat the sort operation.
Use Project and Scorecard Sections to Group Data Nodes

To sort data nodes into project sections and scorecard sections, select any node, and then select one of the following:

- **Elements** ▶ Sort This Node by Scorecard or Project
- **Elements** ▶ Sort All of This Type By Scorecard or Project

**TIP** Nodes are grouped together in their respective sections: project nodes are grouped into the project section and scorecard nodes into their scorecard sections. If you sort data nodes into sections and then change some of the data that affects the result of the sort operation, the diagram is not automatically refreshed. To align the diagram with the new data, you must repeat the sort operation.

Sort and Lay Out the Data Nodes in a Section

As you group data nodes in a section, the data nodes might become poorly spaced and difficult to read. To sort and lay out the data nodes in a section:

1. Right-click on a section and select **Sort and Layout Nodes**. The Section Layout window appears.

2. In the **Margins** section, specify the margins to use around each element.

3. In the **Columns** sections, specify the maximum number of columns.

4. Click the **Order** tab.
You can order the elements by element type or by element name.

To order the elements by element type:

a Select **Order by element type**.

b To change the order, select a type in the **Element types** list and click the arrows to the right to move the selection.

c To start each element type on a new row, select **Start each element type on a new row**.

To order the elements by name, select **Order by name**, and then select the order method.

Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**Lock the Contents of a Section**

After you arrange the contents of a section, you can lock the contents so that no item is inadvertently moved out of the section. However, you can still add new items to the section.

To lock the contents, select a section and select **Sections** ➤ **Lock Contents**.

**Use a Shape, Text, or an Image to Contain Other Objects**

You can capture an object within another object in either of the following ways:

- Drag one item into another item (the container) so that the borders of the container item completely surround the contained item.
- Drag one item (the container) so that its borders completely surround another item.

When you drag a container to a new location, all of the captured items within the container move with the container in a fixed formation.

**TIP** To move the shape without moving the contents, hold down the Shift key while dragging the shape.

**TIP** To remove a data node from a container, hold down the Shift key and drag the node.

**Use a Shape, Text, or an Image to Contain Data Nodes**

You can capture data nodes inside a container by sorting the nodes. To sort data nodes:

1 Associate a node with a container by dragging the node into the container.

2 Select any data node.

3 Right-click on the selected data node and click **Sort This Node by Attribute**. The **Sort** list appears, showing a list of all the available attributes.

4 Select the attribute by which to group the nodes.
Nodes are captured by containers according to the following rule. Node A is captured by container X if the node A element has the attribute that you select, and if container X represents the first value or the only value of that attribute for the element. For example, if you associate an employee with a container and sort nodes by the owner attribute, then all the nodes whose owner is a given employee are captured by the container that represents that employee. If you sort data nodes into containers and then change some of the data that affects the result of the sort operation, the diagram is not automatically refreshed. To align the diagram with the new data, you must repeat the sort operation.

5 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

**TIP** To remove a data node from a container, hold down the Shift key and drag the node.

### Arranging Lines

#### Turn a Straight Line into a Curved Line

To turn a straight line into a curved line:

1 Click either endpoint of the straight line to display the line's handles.

2 Right-click on the line (not a handle) and click Properties. The Edit Shape window appears.

3 From the Line Type list, select Curved.

4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

5 The line now has four handles that define a curve. Drag the handles to curve the line.

**TIP** To return to a single straight line segment, you must delete two segments that define the curve. Right-click on an endpoint and click Delete Point. Repeat to delete a second endpoint. The remaining segment is the straight line.

### Add and Remove Line Segments

To add a straight line segment to an existing straight line or to a chain of line segments:

1 Click either endpoint of the line to display the line’s handles.

2 Right-click on a handle and select Insert Point. The line splits into two segments.

To remove a straight line segment from an existing chain of segments:

1 Click an endpoint of an existing segment to display handles at all of the endpoints.
2 Right-click on a handle that marks the endpoint that you want to remove and click Delete Point. The point is removed and the chain of segments is redrawn without it.

**Connect or Disconnect Two Containers**

When you use a line to connect two containers, you typically attach each endpoint of the line to one of the containers. When an endpoint of a line is attached to a container, the endpoint moves with the container.

To attach one endpoint of a line to a container, hold down the Ctrl key and drag the endpoint into the container. The endpoint takes a position near the border of the container and is attached to the container.

To break an attachment between an endpoint of a line and a container:

1 Click an endpoint of the line. Observe whether the end that you want to detach is marked with a horizontal bar (end A) or a vertical bar (end Z).

2 To detach end A, right-click on the line and select Unattach A.

3 To detach end Z, right-click on the line and select Unattach Z.

---

**Specify Object Appearance**

**About Object Appearance**

You can specify the appearance of objects in the following ways:

- fonts
- colors
- borders
- position, alignment, and depth

**Set the Font to Use for a Diagram Object**

You can set the font to use for the following diagram objects:

- diagrams
- nodes
sections
- shapes
- text

**TIP** The Diagram Editor supports undo and redo when you set the properties for fonts. You can undo or redo up to ten of these actions.

To set the font that is used for an object:

1. Open the Properties window for the object.
   - **Diagram**: Select `File` ➤ `Diagram Settings`. The Diagram Properties window appears and the `General` tab is displayed. Note: The font properties that are located in Diagram Properties window do not override existing node properties.
   - **Node**: Select `Elements` ➤ `Element Type Properties` ➤ `<element-type>`. The Element Type Properties window appears. Click the `Contents` tab.
   - **Section**: Right-click on the section and select `Edit`. The applicable Section Properties window appears and the `Appearance` tab is displayed.
   - **Text**: Right-click on the item and select `Edit`. The Shape Properties window appears. Click the `Appearance` tab.

2. Click the ellipses button (…) that is next to the `Font` field.
3. In the Select Font window, select a font, font style, and font size.
   Note: By default, the list of fonts includes only basic fonts.
4. To include all the fonts that are installed on the computer, select `Include system fonts`.
   Note: If the specified font does not exist on the SAS Strategy Management server, the rendering of the font can differ when the diagram is viewed in SAS Strategy Management.
5. Click `OK` to save your changes and exit. Click `Cancel` to exit without saving any changes.

## Set the Colors to Use for a Diagram Object

### Objects That Use Colors
You can set the colors to use for the following diagram objects:
- association links
- lines
- nodes
Set the Colors to Use for Association Links

You can set the following colors for association links:

- the line color
- the transparency of the line color
- the color of the link connection points in a diagram

To set the color to use:

1. Open the Edit Link Properties window.

To set the color for all association links

Select File ➤ Link Settings.

To set the color for an individual association link

Right-click on the origination point or endpoint of the link, and select Link ➤ Properties.

The Edit Link Properties window appears.

2. Click the button that is associated with the Line color field and select a color from the palette.

   **TIP** You can also enter a hexadecimal value for the color.

3. Click OK in the palette window to save the color setting.

4. To select a saturation value (transparency), move the Transparency slider that is next to the color field.

5. To set the color of the link connection points in a diagram, click the button that is associated with the End A color or End Z color field and select a color from the palette.
Set the Colors to Use for a Line

You can set the following colors for a line:
- the color and transparency of the line
- the color for each endpoint of the line

To set the colors to use for a line:
1. Click an endpoint to select the line.
2. Right-click on a handle and select Edit. The Edit Shape window appears.

3. Click the button that is associated with the Line color field and select a color from the palette, or enter a hexadecimal value for the color.

   **TIP** To specify a black line, leave the field empty.

4. Click OK to save the color setting.
5. To select a saturation value (transparency), move the Transparency slider that is next to the color field.
6. Click the button that is next to the End A color field and select a color from the palette, or enter a hexadecimal value for the color.

   **TIP** End A is the end whose handle is marked with a horizontal bar. The color is applied only when the end shape is an arrowhead or a solid circle.
To specify a black line, leave the field empty.

Click the button that is next to the End Z field and select a color from the palette, or enter a hexadecimal value for the color.

End Z is the end whose handle is marked with a vertical bar. The color is applied only when the end shape is an arrowhead or a solid circle.

To specify a black line, leave the field empty.

Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Set the Colors to Use for a Node

You can set the following colors in a data node:

- the foreground and background colors
- the gradient of the background color
- the background color of the text
- the color of the border

The Diagram Editor supports undo and redo when you edit data nodes properties. You can undo or redo up to ten of these actions.

To set the colors to use:

1. Select Elements ➤ Element Type Properties ➤ <element-type>. The Element Type Properties window appears.

2. Click the Appearance tab.

![Element Type Properties window](image)
3 To specify the border, complete the following steps:
   a From the **Border style** list, select a style.
   b Type the number of pixels in the **Border width** field.
   c Click the ellipses button (...) that is next to the **Border color** field and select a color from the palette, or enter a hexadecimal value for the color.
   d Click **OK** to save the color setting.
   e To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

4 To specify the foreground and background colors, complete the following steps:

   **Note:**
   - You cannot specify the background color of an image.
   - The **Background color** field is not available if **Show range color as object background** is selected on the **Contents** tab.
   a Click the ellipses button (...) that is next to the **Foreground color** or the **Background color** field and select a color from the palette, or enter a hexadecimal value for the color.
   b Click **OK** to save the color setting.
   c To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

5 To specify the text background color, complete one of the following steps:

   **Note:** You cannot specify a gradient for an image.
   - To use the same background color for the text and the shape, click **Use shape background color for text background**.
   - To specify a color, click the ellipses button (...) that is next to the **Text background color** field and select a color from the palette, or enter a hexadecimal value for the color. Click **OK** to save the color setting.

6 To specify a gradient in the background color, complete the following steps:

   **Note:** You cannot specify a gradient for an image.
   a Click **Use gradient**.
   b Click the ellipses button (...) that is next to the **Background color2** field and select a color from the palette, or enter a hexadecimal value for the color in the field.
   c Click **OK** to save the color setting.
   d To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.
   e Click the button that is next to **Gradient**. The **Pick a Gradient** list appears.
   f Click the image of a gradient pattern to use, and then click **OK**.

7 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Enable a Node Background Color Based on the Metric Attribute

The data node can use a background color that is based on the metric attribute.

To limit data node content, select Elements > Element Type Properties > <element-type>. In the Element Type Properties window, click the Contents tab.

To display the range color in the background of the data node by using the color of the metric attribute that you selected in the Base background color on metric attribute list,

click Show range color as object background color.

Set the Colors to Use for a Section

You can set the following colors for a section:

- the foreground and background colors
- the gradient of the background color
- the color of the section border

To set the colors to use:

1. Right-click on the section and select Edit. The applicable Section Properties window appears and displays the Appearance tab.

2. To specify the foreground and background colors, complete the following steps:

   Note:

   - You cannot specify the background color of an image.

   - The Background color field is not available if Show range color as object background is selected on the Contents tab.

   a. Click the ellipses button (…) that is next to the Foreground color or the Background color field and select a color from the palette, or enter a hexadecimal value for the color.

   b. Click OK to save the color setting.

   c. To select a saturation value (transparency), move the Transparency slider that is next to the color field.

3. To specify a gradient in the background color, complete the following steps:

   Note: You cannot specify a gradient for an image.

   a. Click Use gradient.

   b. Click the ellipses button (…) that is next to the Background color2 field and select a color from the palette, or enter a hexadecimal value for the color in the field.

   c. Click OK to save the color setting.

   d. To select a saturation value (transparency), move the Transparency slider that is next to the color field.

   e. Click the button that is next to Gradient. The Pick a Gradient list appears.

   f. Click the image of a gradient pattern to use, and then click OK.
4 To specify the border, complete the following steps:
   a  From the **Border style** list, select a style.
   b  Type the number of pixels in the **Border width** field.
   c  Click the ellipses button (…) that is next to the **Border color** field and select a color from the palette, or enter a hexadecimal value for the color.
   d  Click **OK** to save the color setting.
   e  To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

5 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

### Set the Colors to Use for a Shape or Text

You can set the following colors for a shape or text:

- the foreground and background colors
- the gradient of the background color
- the color of the shapes border

**TIP** The Diagram Editor supports undo and redo when you set properties for shapes or text. You can undo or redo up to ten of these actions.

To set the colors to use:

1 Right-click on the shape or text and select **Edit**. The Shape Properties window appears.

   Note: Some properties might not apply to selected shape or text.

2 Click the **Appearance** tab.

3 To specify the foreground and background colors, complete the following steps:

   Note:

   - You cannot specify the background color of an image.

   - The **Background color** field is not available if **Show range color as object background** is selected on the **Contents** tab.

   a  Click the ellipses button (…) that is next to the **Foreground color** or the **Background color** field and select a color from the palette, or enter a hexadecimal value for the color.

   b  Click **OK** to save the color setting.

   c  To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

4 To specify the border, complete the following steps:

   a  From the **Border style** list, select a style.

   b  Type the number of pixels in the **Border width** field.
Click the ellipses button (…) that is next to the Border color field and select a color from the palette, or enter a hexadecimal value for the color.

d Click OK to save the color setting.

e To select a saturation value (transparency), move the Transparency slider that is next to the color field.

5 To specify a gradient in the background color, complete the following steps:

Note: You cannot specify a gradient for an image.

a Click Use gradient.

b Click the ellipses button (…) that is next to the Background color2 field and select a color from the palette, or enter a hexadecimal value for the color in the field.

c Click OK to save the color setting.

d To select a saturation value (transparency), move the Transparency slider that is next to the color field.

e Click the button that is next to Gradient. The Pick a Gradient list appears.

f Click the image of a gradient pattern to use, and then click OK.

6 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Specify a Border

You can specify the appearance of the border for the following objects:

- nodes
- sections
- shapes and images

TIP The Diagram Editor supports undo and redo when you set border properties. You can undo or redo up to ten of these actions.

To specify the border to use:

1 Open the Properties window for the object.

<table>
<thead>
<tr>
<th>Object</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>Select Elements ➤ Element Type Properties ➤ &lt;element-type&gt;.</td>
</tr>
<tr>
<td></td>
<td>The Element Type Properties window appears.</td>
</tr>
<tr>
<td></td>
<td>Click the Appearance tab.</td>
</tr>
<tr>
<td>Section</td>
<td>Right-click on the section and select Edit. The applicable Section</td>
</tr>
<tr>
<td></td>
<td>Properties window appears and the Appearance tab is displayed.</td>
</tr>
<tr>
<td>Shapes and</td>
<td>Right-click on the object and select Edit. The Shape Properties</td>
</tr>
<tr>
<td>images</td>
<td>window appears.</td>
</tr>
<tr>
<td></td>
<td>Click the Appearance tab.</td>
</tr>
</tbody>
</table>
2 From the **Border style** list, select a style.

3 Enter the number of pixels in the **Border width** field.

4 Click the ellipses button (...) that is next to the **Border color** field and select a color from the palette.

   **TIP** You can also enter a hexadecimal value for the color.

5 Click **OK** to save the color setting.

6 To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

7 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Specify the Appearance of Association Links**

To specify the color, type, style, and width to use:

1 Open the Edit Link Properties window.

   - **To set the appearance for all association links**
     - Select **File** > **Link Settings**.

   - **To set the appearance for an individual association link**
     - Right-click on the origination point or endpoint of the link, and select **Link** > **Properties**.

The Edit Link Properties window appears.

2 To change the color, click the button that is associated with the **Line color** field and select a color from the palette. Click **OK** in the palette window to save the color setting.
Specify the Appearance of the Association Link Connection Points

An association link has two connection points: a source element data node and a target element data node. End A is the source. End Z is the target. The source element data node has an attribute that identifies the target element data node. For example, a diagram contains an element called Sales and another element called Profit. There is an association link between a Sales element data node and a Profit element data node. The Sales element data node is End A. The Profit element data node is End Z. The Sales element data node has an attribute that identifies the Profit element data node as End Z.

To specify the color and appearance to use:

1. Open the Edit Link Properties window.

   | To set the appearance for all connections points | Select File ➤ Link Settings. |
   | To set the appearance for one set of connections points | Right-click on the origination point or endpoint of the link, and select Link ➤ Properties. |

   The Edit Link Properties window appears.

2. To change the color, click the button that is associated with the End A color or End Z color field and select a color from the palette. Click OK in the palette window to save the color setting.

   TIP You can also enter a hexadecimal value for the color.

3. From the End A and End Z lists, specify how to represent the origination point and endpoint of the link.

4. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.
Specify the Position, Alignment, and Depth of an Object

You can specify the position, alignment, and depth of a section, shape, text, or image.

**TIP** The Diagram Editor supports undo and redo when you set these properties. You can undo or redo up to ten of these actions.

To specify the position, alignment, and depth:

1. Right-click on the object and select **Edit**. The Properties window appears.
2. Click the **Position** tab.
3. Complete the following steps for shapes, text, or images:
   - a. In the **Left** field, enter the distance, in pixels, between the left border of the object and the left border of the diagram.
   - b. In the **Top** field, enter the distance, in pixels, between the top border of the object and the top border of the diagram.
4. In the **Width** field, enter the width of the object, in pixels.
   
   **Note:** You cannot specify the width of text.

   **TIP** You can also change the width by dragging the handles of the object.

5. In the **Height** field, enter the height of the object, in pixels.
   
   **Note:** You cannot specify the height of text.

   **TIP** You can also change the height by dragging the handles of the object.

6. To specify the alignment, complete the following steps:
   
   **Note:** You cannot specify the alignment of text.

   - a. From the **X alignment** list, select a value to control the horizontal position of any associated text.
   - b. From the **Y alignment** list, select a value to control the vertical position of any associated text.
   - c. From the **Text orientation** list, select a value to control the orientation of any associated text.

7. To specify the depth, enter an integer value in the **Depth** field.

   **Note:** If an item overlaps another item in a diagram, then the item with the greater depth value is covered by the item that has the lesser depth value.

8. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Specify the Appearance of Lines

To specify the line type, width, style, and depth:

1. Click an endpoint to select it.
2. Right-click on a handle and select **Edit**. The Edit Shape window appears.
3. From the **Line type** list, select the type of line.
4. From the **Line style** list, select the style of line.
5. In the **Line width** field, enter the width of the line, in pixels.
6. To specify the depth, enter an integer value in the **Depth** field.
   
   **Note:** If an item overlaps another item in a diagram, then the item with the greater depth value is covered by the item that has the lesser depth value.

7. Specify the appearance of end A (the end whose handle is marked with a horizontal bar):
   
   a. From the **End A** list, select a shape.
   
   b. Click the button that is next to the **End A color** field, and select a color from the palette.

   **TIP** You can also enter a hexadecimal value for the color. To specify black, leave the field empty.

   **Note:** The color is applied only when the end shape is an arrowhead or a solid circle.

   c. Click **OK** to save the color setting.

8. Specify the appearance of end Z (the end whose handle is marked with a vertical bar):
   
   a. From the **End Z** list, select a shape.
   
   b. Click the button that is next to the **End Z color** field, and select a color from the palette.

   **TIP** You can also enter a hexadecimal value for the color. To specify black, leave the field empty.

   **Note:** The color is applied only when the end shape is an arrowhead or a solid circle.

   c. Click **OK** to save the color setting.

9. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Specify the Appearance of a Correlation

To specify the width and color to use for a line that represents a correlation:


2. Click the Analysis Style tab.

3. Select Line width to specify that the line width varies according to the correlation value. Valid correlation values are in the range -1.0–1.0. A line that represents a value in this range would be 0–10 pixels wide.

4. Select Line colors to specify that the line color varies according to the correlation value. Enter values for the negative and positive correlation values, and set the transparency.

   Note: By default, a negative correlation (-1.0) is red and a positive correlation (+1.0) is green.

5. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Specify the Shape, Size, and Border of a Node

To specify the shape, size, and border for a node:

1. Select Elements ➤ Element Type Properties ➤ <element-type>. The Element Type Properties window appears.

2. Click the Appearance tab.

3. From the Element shape list, select a shape.

4. To select a scalable vector graphic (SVG) drawing to display with the element type, click . The Select Drawing window appears. You can perform the following tasks in this window:
   - To select a drawing, select it from the Drawings list.
   - To add a drawing to the list, click Upload Drawing and navigate to the drawing file.
   - To refresh the list of drawings, click Refresh.
To specify that the nodes be sized to fit in the diagram display, select **Size to fit**.

**TIP** If you select **Size to fit**, you can also select **Override individual sizes** to specify that nodes of that element type be sized to fit the diagram display.

To specify a different size for nodes of this element type, clear **Size to fit** and enter the number of pixels in the **Width (pixels)** and **Height (pixels)** fields.

To specify the border, complete the following steps:

a. From the **Border style** list, select a style.

b. Type the number of pixels in the **Border width** field.

c. Click the ellipses button (…) that is next to the **Border color** field and select a color from the palette, or enter a hexadecimal value for the color.

d. Click **OK** to save the color setting.

e. To select a saturation value (transparency), move the **Transparency** slider that is next to the color field.

Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**Create, Edit, and Select a Style for a Node**

**About Styles**

A style is a collection of settings such as font and background color. You can assign a style to specific element types in a diagram. Styles are stored at the template level so that they are available to all diagrams in all projects that use the template.

**Note:** The **Contents** and **Appearance** tabs are unavailable because the settings in the style override the settings on these tabs.

**Create a Style**

To create a style:

1. Select **Elements** ▶ **Element Type Properties** ▶ `<element-type>`. The Element Type Properties window appears.

2. On the **Styles** tab, click **New**. The Element Type Properties: New Style window appears.

3. Click the **Name** tab and name the style.

4. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**Edit a Style**

To edit a style:

1. Select **Elements** ▶ **Element Type Properties** ▶ `<element-type>`. The Element Type Properties window appears.
2 On the Styles tab, select a style and click Edit. The Element Type Properties: Edit Style window appears.

Note: The Element Type Properties: Edit Style list is identical to the Element Type Properties: New Style list.

3 Click the Name tab and name the style.

4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Select a Style for a Node

1 Select Elements ▶ Element Type Properties ▶ <element-type>. The Element Type Properties window appears.

2 On the Styles tab, select Use style.

3 Select a style.

Note: The style is immediately applied to the element. However, no permanent association is made between the style and the element. If you later change the style, that change is not reflected by this element. You must reset the style setting in order for the changed style to affect this element.

4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Displaying Labels and Other Content

About Diagram Labels and Content

A diagram and its objects can contain many types of content. To improve usability or readability, you might want to control how much content appears in an object.

You can specify whether diagram labels and information are displayed in a diagram. To improve the readability of a diagram, carefully consider how much information you include in a diagram.

Specify Global Content Settings

To specify global settings about the content to display:

1 Select File ▶ Diagram Settings. The Diagram Properties window appears.

2 Click the Display tab.
3 (Optional) Select Indicators to specify that any data node that is associated with a numeric value to which a range is applied shows the image for the subrange that contains the value.

4 (Optional) Select Metric attribute values to specify that any data node that is associated with a numeric value shows that numeric value. If no value exists, a period ("." ) is displayed.

5 (Optional) Select Scorecard information to specify that certain scorecard information is displayed. Select the information to display from the list.

6 (Optional) Select Link labels to display labels on all of the links in the diagram.

7 (Optional) Select Label length to specify the maximum number of characters per line of text in the nodes of the diagram.

The text is wrapped in accordance with this maximum, but the maximum can be exceeded slightly in some cases in order to avoid splitting words. Label length applies only to element nodes for which a width and height have not been explicitly set.

8 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Limiting Data Node Content

To limit data node content, select Elements &gt; Element Type Properties &lt;element-type&gt; . In the Element Type Properties window, click the Contents tab.

- To limit the length of labels in a diagram, select Override global label length.
- To keep text within the boundary lines of the data node, select Crop all text to bounding box.
- In the Show metric attributes list, select the metric attributes to display.

A diagram can display the following icons:

- **Element type icon:** Indicates the type of element.
- **Comments icon:** Indicates that comments are attached to the node.
- **Trend icon:** Indicates that a trend history is available for the node.
To control whether these icons appear:

- To prevent the display of the element type icon, select **Hide element type icon**.
- To display the comment icon if comments exist, select **Show comments icon**.
- To display the trend icon if there is trend history, select **Show trend icon**.

**TIP** The Diagram Editor supports undo and redo when you edit data nodes properties. You can undo or redo up to ten of these actions.

### Display a Path for a Section

For project sections and scorecard sections, you can display a path in the diagram so that users can distinguish duplicate items from different projects and scorecards.

**Note:** This setting is available only for project sections and scorecard sections.

To display a path for the section:

1. Right-click on the section and select **Edit**. The applicable Section Properties window appears and displays the **Appearance** tab.

2. Select **Use full scorecard path**.

3. Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

### Interactive Features in Diagrams

#### Links in Diagrams That Open New Content

*Links* open new content when you click on a part of a diagram. You can add links to diagrams in the following ways:
Apply a link to a node or shape by specifying a default link for a selected element type.

Apply a named link to a node, shape, text, or image in a diagram. The named link must already be defined. For more information, see “Managing Link Definitions” on page 74.

Specify a web address hyperlink to a shape, text, or image.

**Apply a Named Link to a Node**

You can apply a named link to all nodes of an element type or to an individual node. When a user clicks the background of the node, the link opens. You must define a named link before you can apply it to an object. For more information, see “Managing Link Definitions” on page 74.

To apply a named link:

1. Select Elements ➤ Element Type Properties ➤ `<element-type>`. The Element Type Properties window appears.
2. Click the Set Node Link tab.
3. Select Named link.
4. From the Show list, select the type of named link that you want to use.
5. From the Link list, select the named link that you want to use.
6. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

**Apply a Named Link to a Shape, Text, or Image**

You can apply a named link to a shape, text, or image in a diagram. You must define a named link before you can apply it to an object. For more information, see “Managing Link Definitions” on page 74.

To apply a named link:

1. Right-click on the item and select Edit. The Shape Properties window appears.
2. Click the Named Links tab.
3. From the Named link list, select the link to apply to the node.
4. From the Show list, select the type of named link that you want to use.
5. From the Link list, select the named link that you want to use.
6. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.
Disable Element Detail Links in Diagrams

You can choose to disable element detail links for security purposes. If this setting is disabled, element detail links do not open in a diagram. The default setting is enabled.

Note: This setting does not affect hyperlinks that are explicitly set for a shape, text, image.

To disable element detail links:

1. In the Diagram Editor, select File ➤ Diagram Settings.
2. In the Diagram Properties window, click the Security tab.
3. Clear the Enable element details check box.
4. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Add a Hyperlink to a Shape, Text, or Image

You can add a hyperlink to a shape, text, or image in a diagram. When the user clicks on the hyperlink, a web page opens. This hyperlink is explicitly set on the shape, text, or image. The hyperlink definition is not reusable like named links are.

To add a hyperlink:

1. Right-click on the item and select Properties. The Shape Properties window appears.
2. Click the Links tab.
3. Select Hyperlink.
4. In the Web address field, enter a web address to open when the item is clicked.
5. By default, the link opens the web address content in a new browser window. If you want the link to open the web address content in the browser window that contains the diagram, replacing the diagram with the web address content, and then select Same window.
6. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Remove a Hyperlink or Named Link from a Shape, Text, or Image

To remove a hyperlink or named link:

1. Right-click on the object and select Edit. The Shape Properties window appears.
2. Click the Links tab.
3. Select No link.
4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Specify HTML or JavaScript for Use in a Diagram

If you specify JavaScript, the code is active in the displayed diagram. For example, consider the following code:

```javascript
onmouseover="JavaScript: alert('Revenue Growth')"
```

If you specify this code, then the following message appears in a list whenever a user moves the mouse pointer over this shape, text, or image:

Revenue
Growth

To specify HTML or JavaScript code in a shape:

1 Right-click on the shape and select Properties. The Shape Properties window appears.
2 Click the HTML tab.
3 In the HTML field, enter the HTML or JavaScript code.
   Note: You must enclose the right side of the JavaScript expression in double quotation marks.
4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

To specify HTML or JavaScript code in a diagram:

1 Select File ➤ Diagram Settings. The Diagram Properties window appears and the General tab is displayed.
2 In the HTML field, enter the HTML or JavaScript code.
   Note: You must enclose the right side of the JavaScript expression in double quotation marks.
3 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Changing Data

Change Associations

To view and change the associations that are displayed as links in a diagram:

1 Select Elements ➤ Associations. The Edit Associations window appears and displays a list of all of the selectable associations.

TIP The currently selected associations are highlighted.
2 Click any item in the **Association** list to select it or to deselect it.

3 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Edit Element Properties**

To edit an element:

1 Double-click the node that represents the element that you want to edit. The **Edit Element** list appears, showing all the attributes of the element and their current properties. The attributes vary according to the element. The attributes of an objective are shown in the following figure.

![Edit Element](image)

**Note:** Element type attributes are defined in the template for the project.

2 Change the value of any attribute by entering a value or by selecting a value from a list.

3 Click **OK** to save your changes.
The Diagram Editor supports undo and redo when you edit properties for an element. You can undo or redo up to ten of these actions.

Select the Date for an Element

A diagram can contain the same element multiple times, but each element can have a value for a different date.

To select the date for an element:

1. Right-click on an element and select Set Date. The Set Date list appears.
2. Complete the applicable date selection:
   - To specify the current date, select Current date.
   - To specify a specific date, select Specific date and enter a date in the field or click to choose a date from the calendar.
   - To specify a relative period, select Relative period. Then enter or select a positive or negative value.

Set Security in Diagrams

You can control security in diagrams in the following ways:

- You can limit whether a user can view element details in a diagram.
- You can disable the functionality of named links in a diagram.

To set security:

2. Click the Security tab.
3. To control whether element details are shown in the diagram, select Enable element details.
   - Note: This selection affects the functionality of element detail links only.
4. Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Using a Different Language in a Diagram

Diagrams and Language Settings

Additional languages can be defined in the template. For example, a template can specify English as the default language and Spanish as a user-defined alternate language. When a project is created from a template that has user-defined
languages, a diagram that is based on that project can use the same user-defined languages. For more information, see “Working with Language Settings” on page 53.

Select a Language for a Diagram

If you have defined more than one language for a project, you can select the language in which to display the diagram. Select Elements ➤ User Defined Language and select a language.

Specify the Diagram Name in Other Languages

If you have defined other languages for a project, you can specify the name of the diagram in those other languages. A field is available for each language that you have defined in the project. If a diagram name is not specified in the language that is currently set for a project, the diagram name is displayed in the default language.

To specify diagram names in other languages:

1 Select File ➤ Diagram Settings. The Diagram Properties window appears and the General tab is displayed.

2 In the Name for language field, enter the name of the diagram.

3 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Analyzing a Diagram in Order to Validate a Strategy

Overview

When two elements in a SAS Strategy Management model are connected by an association (such that the first element is thought to influence the second element, and both elements have sufficient and overlapping periodic metric attribute data), then it might be useful to calculate the correlation coefficient between the two elements.

The correlation coefficient (correlation analysis) can help determine whether the first element influences the second element. A correlation coefficient is a floating point number in the range -1 to 1, where 1 indicates a positive correlation and -1 means indicates a negative correlation. The value 0 indicates no correlation. The correlation coefficient is calculated to two decimal places.

You can analyze the correlation in a diagram. To perform the analysis, you must select an association in the diagram and a date range. For the association, you must select two metric attributes: a "from" metric attribute and a "to" metric attribute. The "from" metric attribute influences the "to" metric attribute. The "from" and "to" metric attributes do not need to have the same name, but they must be inherently related to each other and mean the same thing.

Note: The Analysis feature might not be available. See your SAS Strategy Management administrator to determine whether this feature is enabled.
For example, it would probably not make sense to compare the metric attribute named Actual against the metric attribute named Performance. Similarly, the metric attributes should probably be of the same scale, such as both values being integers or both values being percentages.

**Note:** The presence or absence of a correlation does not definitively state the influence between the elements, but it merely suggests an influence. Because the influence is merely a suggestion, do not redesign a scorecard based only on the correlation coefficient. For example, do not assume that a negative correlation indicates that there is no influence between the two elements. A negative correlation between expenses and profits indicates only that as expenses go down, profits go up. But expenses certainly have an influence on profits.

The results of the analysis are displayed in the diagram. The results are calculated dynamically from the input choices that you specify, and the results are not saved after you close the editor session. However, you can export the results. For more information, see “Export Analysis Results” on page 221.

**Create an Analysis Definition**

When you create an analysis definition, you specify the properties required for the analysis.

Before you create an analysis, the following conditions must be met:

- You must select an association. Select **Elements** ➤ **Association.** In the Edit Association window, you must select for display the association to use in the analysis.

- You must select the metric attributes on which the analysis is going to be based. In the Diagram Editor, right-click on the element and select **Element Type Properties.** In the Properties window, click the **Contents** tab. In the **Show metric attributes** list, make sure that the attributes that you want to use in the analysis are selected.

To create an analysis definition:

1. Select **Analysis** ➤ **New** The New Analysis wizard appears.

2. Enter the name of the analysis.

3. (Optional) Enter the description.

4. (Optional) Choose whether to copy another analysis to this analysis.

5. Click **Next.**

6. On the **Association and Attribute** page, select an association.
7 Select a metric attribute in the **To attribute** section.

8 Select a metric attribute in the **From attribute** section. Click **Next**.

9 On the **Date Range** page, specify the start and end dates. Click **Next**.

   **TIP** The longer the date range, the more accurate the correlation results.

10 On the **Summary of Selections** page, review your choices. To make changes, click **Back**.

11 Click **Finish** to save your selections and exit. Click **Cancel** to exit without saving your selections.

The analysis definition is saved to the SAS Strategy Management server so that it can be used in the future. You can now run the analysis.

   **TIP** You can also create a new analysis definition in the Manage Correlations and Regressions window. However, only the New Analysis wizard provides the option to copy another analysis to the analysis that you are creating.

---

### Run an Analysis

To run an analysis, select **Analysis** ➤ **Edit**. The Manage Correlations and Regressions window appears. On the **Manage** tab, select the definition and click **Run**.

### View Analysis Results

To view results after you run an analysis in the Manage Correlations and Regressions window, click the **Analysis Results** tab.
To view more detailed information about the results, select **Advanced view**.

### View Input Data Used in the Analysis

To view the input data used in the analysis in the Manage Correlations and Regressions window, click the **Input Data tab**.
Export Analysis Results

You can export the following results:

- all analyses results to a comma-separated value (CSV) file
- the currently displayed analysis results only

**TIP** You must run an analysis before you can export results.

To export all analyses results to a CSV file, in the Manage Correlations and Regressions window, on the Manage tab, click Export.

To export only the currently displayed analysis, in the Manage Correlations and Regressions window, click the Input Data tab and click Export.

Apply an Analysis to a Diagram

To apply the analysis to the diagram that is displayed in the editor, click Apply in the Manage Correlations and Regressions window. The correlation is applied and the output appears.
The changes made to the diagram are saved. When you exit the Diagram Editor, the changes are retained.

**Edit a Correlation and Regression Definition**

To edit a definition, select **Analysis > Edit**. The Manage Correlations and Regressions window appears. On the **Manage** tab, select the definition and click **Edit**.

**Delete a Correlation and Regression Definition**

To delete a correlation and regression definition in the Manage Correlations and Regressions window, select the definition on the **Manage** tab and click **Delete**.

**Analyze the Correlation between Two Elements**

To view the effects of the relationship between two elements:

1. In the diagram, right-click the end of the correlation arrow of the element that you want to analyze, and then click **Show regression slider**. The correlation slider appears.

![Diagram with correlation slider](image)
2. Click on the slider and drag it to the left or right to view the effects that an increase or decrease in the value of the From element has on the value of the To element.

3. Click to view more information about the statistical relationship.

4. When you are finished, click X to remove the slider.

**Add an Analysis Plug-in**

You can write a plug-in to use in the Diagram Editor to meet your specific analysis requirements. For more information, contact your SAS technical support or consultant.

To add an analysis plug-in:

1. Specify the plug-in analysis settings by selecting a metric attribute for analysis.

3 Select the check box next to one or more analysis plug-ins.

4 Click OK. The Add Plug-in window closes, and, if needed, a list of options for the analysis plug-in appears.

**Perform a Multiple Linear Regression Analysis**

Use the multiple linear regression plug-in to perform a multiple linear regression analysis that uses the least squares method.

To perform a multiple linear regression analysis:

1 Hold down the Ctrl key and drag one or more elements into the **Independent input variables** list.

2 Hold down the Ctrl key and drag one element into the **Output variable** list.

3 Specify the start and end dates.

4 Click Run. After the analysis runs, you can view the analysis results and the input data that was used for the analysis.

To investigate the impact of the input variables on the output variable, click the **Explore** tab. Use the controls to adjust the values of the input variables. The impact of the changes is reflected in the output variable, which is displayed above the inputs.
Managing a Diagram

View Diagram Properties

To view the properties of a diagram:

1. Open a project.
2. Select a project or scorecard.
3. Select a project or scorecard name in the hierarchy and click in the toolbar.
4. Click Manage Diagrams.
5. Click that is next to a diagram name in the table, and select Properties. The Diagram Properties page appears.
6. (Optional) Change the name of the diagram.

Copy a Diagram

You can copy a diagram to other scorecards in the same project. You can build a diagram that serves as a master at the top level of the scorecard hierarchy, which is comparable to a slide presentation. You can then copy that diagram to one or more child scorecards.

If you copy a diagram to another scorecard, the diagram might not look exactly like the original. Because diagrams contain nodes that are specific references to elements in the source diagram, elements that have the same name in the default language must exist in the target scorecard. If the elements do not have the same name, that diagram node cannot be copied. Containers can be copied unless they are bound to elements for which a copy does not already exist in the target scorecard.

To copy a diagram:

1. Select File ➤ Copy Diagram. The Select Scorecard for Diagram Copy list appears.
2. In the Name field, enter the name of the copy of the diagram.
3. From the Scorecards list, select the scorecards into which you want to copy the diagram.
4. If you want to replace an existing diagram in a scorecard, click Replace existing.

Save a Diagram

To save the changes that you have made to a diagram, select File ➤ Save in the Diagram Editor.
Revert to the Saved Diagram

If you have not saved your recent changes to a diagram, you can revert to the last saved diagram. Click File ▶ Revert To Saved in the Diagram Editor.

Export a Diagram

To export a diagram as a scalable vector graphic (SVG):

1. Select File ▶ Export. The Save list appears.
2. Navigate to a location.
3. Name the file.
4. Click Save.

**TIP** To quickly save an image of the diagram, you can also make a screen capture of the diagram image.

Delete a Diagram

To delete a diagram:

1. Open a project.
2. Select a project or scorecard.
3. Select a project or scorecard name in the hierarchy and click on the toolbar.
4. Click Manage Diagrams.
5. Click that is next to a diagram name in a table and select Delete.

Viewing a Diagram

**View a Diagram**

To view a diagram:

1. Open a project.
2. Select a project or scorecard name in the hierarchy and click on the toolbar.
3. Click Manage Diagrams.
4. Click the diagram name.
5. To view updates such as changes to metric values click Go, which is next to the zoom controls.
TIP  Diagrams are cached on a per-user, per-date basis; each user must update the diagram view in order to see the most current data. To update the diagram, click 

Note:

1. Elements whose dates fall outside the range that is specified for the diagram are not displayed.

2. If a label in a diagram is not specified in the language that is currently for a project, the label is displayed in the default language.

Change the Position of a Diagram

Note: The project options for the diagram format must be set to show diagrams in scalable vector graphic (SVG) format. For more information, see “Customize Project Content Displayed by Default” on page 65.

To change the position of the diagram in order to view other areas, use the scroll bars and zoom controls provided in the editor.

Locate Elements, Element Types, and Associations

Note: The project options for the diagram format must be set to show diagrams in scalable vector graphic (SVG) format. For more information, see “Customize Project Content Displayed by Default” on page 65.

To locate elements in a diagram:

1. Click 

The Locate Element page appears.

2. Select one or more elements.

3. Click Close. The elements are highlighted by blinking red borders.

Note: To remove the blinking red borders, open the Locate Element page, clear the selected elements, and click Close.

To highlight an element:

1. Click 

The Highlight page appears.
2  Click the element types or associations that you want to highlight.
3  From the list, select one or more items.
4  To reset the highlighting to its default state, click [image]

**View Element Attributes**

To view the attributes of elements that are represented by nodes in a diagram, click on a diagram node. Metric attributes and non-metric attributes are listed for the element on the Element Attributes page.
Creating and Editing Gauge Views

Gauge views, also called dashboard views, are not available in the Builder. However, you can create gauge views in both classic portlets and enhanced-portlet tiles. For more information, see the following topics:

- “Edit a Performance Dashboard Portlet” on page 287.
- “Edit the Gauge View Tile Properties” on page 270.
Chapter 21 / Creating and Editing Gauge (Also Called Dashboard) Views
Creating and Editing Trend Analysis Views

Overview

This trend analysis view uses the Trend Analysis page. This page is accessed by views that are displayed using:

- SAS Strategy Management Builder
- Strategy Management classic-style portlets

For information about other types of trend analysis provided by SAS Strategy Management, see “Trend Analysis” on page 155.

Access Trend Analysis from a Table

To access a trend analysis from a scorecard table, complete the following steps:

1. Open a project. For more information, see “Open a Project” on page 61.
2. Click on the toolbar.
3. Click to the left of an element and click Show Trend Analysis. The Trend Analysis page appears.
4. To close the Trend Analysis page, click Close in the bottom left corner.

Select the Metric Attributes to Analyze

To select one or more metric attributes to analyze, complete the following steps:

1. Expand the left pane of the Trend Analysis page.

The left pane expands.
2 In the **Scorecards** section, select a scorecard.

3 In the **Element Types** section, select an element type.

4 Complete one of the following steps:

   - To analyze all of the metric attributes for an element, drag an element from the **Elements** section onto the graph.

   The metric attribute values appear on the graph.
To analyze specific metric attributes, drag one or more metric attributes from the *Metric Attributes* section onto the graph.

**Note:** The *Current Selection* section displays the items included in the trend analysis.

5 To remove an item from the trend analysis, select the item in the *Current Selection* section and click *Delete*.

---

**Customize the Display of a Metric Attribute**

To customize how a metric attribute is displayed in the graph, complete the following steps in the left pane of the Trend Analysis page:

1 In the *Current Selection* section, select an attribute.

2 Below the *Current Selection* section, specify the line size, type of graph, and color.

**Note:** As you specify each property, the display is updated.

---

**Navigate a Trend Analysis**

To navigate a trend analysis, complete the following steps in the right pane of the Trend Analysis page:

1 To change the start and end dates displayed in the analysis, move the start and end points on the slider below the analysis. The default date range is specified in the project options.
2 To display the underlying data for a data point, pause the mouse pointer over the data point.

3 To reload data for your selected time period, click ![reload_icon] in the upper right corner of the right pane.

4 To save the analysis as an image, click ![save_icon] in the upper right corner of the right pane.

5 To print the analysis, click ![print_icon] in the upper right corner of the right pane.

6 To restore the default value, click ![reset_icon] in the upper right corner of the right pane.

---

**Customize the Trend Analysis**

You can display the trend analysis data as a chart or as a grid, and you can change the display properties.

**Note:** Customized settings are applied only to the current project and the current session.

To customize the trend analysis, complete the following steps in the right pane of the Trend Analysis page:

1 To view the chart as a grid, click ![grid_icon]
2 To return the view to a chart, click 📊.

3 To change the properties of the display, click 📈. The **General Properties** section appears.

4 Choose whether to show the chart legend, ignore missing values, and display a drop shadow for the chart series.

5 Specify values for the line chart series interpolation, date unit interval, and the date label interval.

6 To change the date range, type a date in the field or click 📅 to select the start and end dates.

   **Note:** The default date range is specified in the project options.

7 Click **Update Chart**.

8 To reload data for the selected time period, click 🔄. The customizations are displayed.
# Managing Views

## Specify a Default View

You can specify that a type of view be the default view for a project. When you open the project, the specified view appears automatically. For information about specifying the default view, see “Customize Project Content Displayed by Default” on page 65. You can specify any of the following views to be the default:

- Table
- Aggregate
- Association
- Diagram

## Set Default Options for a View

For each type of view, you can set default options. A view automatically uses these options when you display your data in that type of view. For information about setting default options, see “Customize Project Content Displayed by Default” on page 65. You can set the options for the following types of views:

- Table
- Aggregate
- Association

---

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify a Default View</td>
<td>237</td>
</tr>
<tr>
<td>Set Default Options for a View</td>
<td>237</td>
</tr>
<tr>
<td>Save a View to a Portlet</td>
<td>238</td>
</tr>
<tr>
<td>Set the Default Date for Views</td>
<td>239</td>
</tr>
<tr>
<td>Print a View</td>
<td>239</td>
</tr>
<tr>
<td>Link to a View Using a Web Address</td>
<td>239</td>
</tr>
<tr>
<td>Linking to Information from Within a Scorecard Overview</td>
<td>240</td>
</tr>
<tr>
<td>Link from a Scorecard to a View</td>
<td>240</td>
</tr>
<tr>
<td>Link from a Scorecard to a Document</td>
<td>241</td>
</tr>
</tbody>
</table>
Save a View to a Portlet

If you have a view that you want to use for a portlet, you can create a new portlet for that view and specify the portal page on which to create the portlet.

Note: This feature does not save a data-entry form to a portlet. Instead, it saves a link to a portlet. When clicked the link opens the form in the Strategy Management Builder.

To save a view to a portlet, complete the following steps in that view:

1. Click \( \text{Create a New Portlet} \). The Add to Portlet page appears.

2. To add to an existing portlet, select the portlet from the Portlet list.

   Note: The list includes only those portlets that are of the same type of view as the current view. For example, when you add a portlet from the table view, the Portlet list includes only Performance Table portlets.

3. To create a new portlet and add to that portlet, complete the following steps:
   a. Click \(<\text{Create a New Portlet}>\) from the Portlet list.
   b. Specify the portlet name, description, and keywords.
   c. To specify the page on which the portlet appears, click Add to page and select a page from the list.

      Note: If you do not click Add to page, the portlet is created but is not added to a page. You can search for the portlet later and add it to a page.

4. Click OK.
Set the Default Date for Views

You can set the default date for use by all the views in a project. For information about setting the default date, see “Customize Project Content Displayed by Default” on page 65. This setting affects all the following types of views:

- Table
- Aggregate
- Association
- Diagram

Print a View

You print a view by first displaying a preview of the page in a browser window.

To print a view in Strategy Management Builder, complete the following steps:

1. Open a project or scorecard. See “Open a Project” on page 61 or “Open a Scorecard” on page 84.
2. Display a view.
3. Click A list appears.
4. Type the name and click OK. A new browser window appears.
5. Print the page as you would print any web page in your browser.

Link to a View Using a Web Address

You can display the web address for a view within SAS Strategy Management so that you can copy the web address. You can use the web address in any application that accepts a web address, such as a bookmark in Microsoft Internet Explorer or a desktop shortcut.

The web address contains information that is needed to recreate the view, such as the column selection and the date.

To copy the web address for a view, complete the following steps:

1. Open a project or scorecard. See “Open a Project” on page 61 or “Open a Scorecard” on page 84.
2. Click The Show and Copy URL window appears.
3. To use the specified date when displaying the view, click Always use this date.
Note: This selection adds the date information to the web address. Every time you load the view using this web address, the specified date is used for the view. If you want to load the view using the current date, whatever that date might be, then do not select this option.

4 Click **Copy & Close**.

Note: If you are using the Firefox web browser, the **Copy & Close** function is not supported. Instead, right-click inside the **URL** field, click **Select All**, and then click **Copy**.

If a Microsoft Internet Explorer runtime error message appears, complete the following steps.

Note: These steps might vary depending on your version of Microsoft Internet Explorer.

1 In Microsoft Internet Explorer, click **Tools** ➤ **Internet Options**. The Internet Options list appears.

2 Click the **Advanced** tab.

3 In the **Settings** list, in the **Browsing** category, clear **Disable Script Debugging (Internet Explorer)**.

4 Click **OK**.

5 Refresh the browser window.

---

**Linking to Information from Within a Scorecard**

**Overview**

You can associate links with elements in a scorecard. When these links are clicked, they can open other information, such as documents or SAS Strategy Management views.

**Link from a Scorecard to a View**

Note: Before you can link to a view, you must have the web address for the view. For information about copying the web address for a view, see “Link to a View Using a Web Address” on page 239.

To add a link in a scorecard that opens a view, complete the following steps:

1 Open a project or scorecard. See “Open a Project” on page 61 or “Open a Scorecard” on page 84.

2 For the element that you want to include the link to the view, click **Edit Metric Attributes**. The Metric Values, Ranges, and Links page appears.

3 In the **Metric attribute** list, select the metric attribute to use.

4 In the **metric attribute Links** section, click **metric attribute Link**.
5 From the Link list, select the predefined link that opens the web address. For more information, see “Managing Link Definitions” on page 74.

6 Click OK.

The scorecard appears with the link to the view. When the scorecard is displayed in a portlet, the link to the view is available for business users.

**Link from a Scorecard to a Document**

To add a link in a scorecard that opens a document, such as a report or presentation, complete the following steps:

1 Open a project or scorecard. See “Open a Project” on page 61 or “Open a Scorecard” on page 84.

2 For the element that you want to include the link to the view, click ![Edit Metric Attributes](image) and click **Edit Metric Attributes**. The Metric Values, Ranges, and Links page appears.

3 In the **Metric attribute** list, select the metric attribute to use.

4 In the **metric attribute Links** section, click **metric attribute Link**.

5 From the Link list, select the predefined link that opens a document. For more information, see “Managing Link Definitions” on page 74.

6 Click OK.

The scorecard appears with a link to the document. When the scorecard is displayed in a portlet, the link to the document is available for business users.
Part 4

Creating Portlet Views for Business Users

Chapter 24
  Overview of Portlet Types ........................................ 245

Chapter 25
  Creating a Portlet .................................................... 247

Chapter 26
  The Strategy Management Enhanced Portlet Interface .......... 253

Chapter 27
  Editing a Strategy Management Enhanced Portlet and Its Tiles .. 257

Chapter 28
  Editing Classic-Style Portlets .................................... 279
Overview of Portlet Types

Portlet Types

SAS Strategy Management provides the following portlets:

- SAS Strategy Management classic portlets, which provide features for navigating through and viewing strategy data and other content. Classic portlets provide limited ways for the business user to adjust view properties.

- SAS Strategy Management enhanced portlets and tiles, which provide features for navigating through and viewing strategy data and other content. These portlets and tiles provide enhanced ways for the business user to adjust the view properties.

Note: The trend view implementations differ between the classic and enhanced portlets. For more information, see “Trend Analysis” on page 155.
Creating a Portlet

Overview

A SAS Information Delivery Portal page must exist before you can create a Strategy Management portlet. For information about creating a portal page, see “Create a Page” on page 31.

Create a Portlet

To create and add a portlet to a portal page, complete the following steps:

1. Navigate to the page on which you want to add a portlet.

2. Click Customize ➤ Edit Page ➤ Edit Page Content. The Edit Page Content page appears.
3 Click **Add Portlets**. The Add Portlets to Page page appears.

4 From the **Portlet type** list, select the type of portlet that you want to create:

<table>
<thead>
<tr>
<th>Portlet Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance aggregate table</td>
<td>Aggregate table (classic style)</td>
</tr>
<tr>
<td>Performance association</td>
<td>Association (classic style)</td>
</tr>
<tr>
<td>Performance data entry</td>
<td>Data entry form (classic style)</td>
</tr>
<tr>
<td>Performance diagram</td>
<td>Diagram (classic style)</td>
</tr>
<tr>
<td>Performance dashboard</td>
<td>Dashboard (classic style)</td>
</tr>
<tr>
<td>Performance table</td>
<td>Table (classic style)</td>
</tr>
<tr>
<td>Strategy management</td>
<td>Strategy management (enhanced style)</td>
</tr>
</tbody>
</table>

5 Type the name, description, and keywords, if any.
Click Add.

Note: If you want to add more portlets to the portal page, repeat steps 4, 5, and 6.

7 When you are finished adding portlets, click Done.

8 On the Edit Page Content page, click OK. The new portlet appears on the page.

You must edit the portlet to customize it and make it usable.

- For information about editing enhanced-style portlets, see Chapter 27, “Editing a Strategy Management Enhanced Portlet and Its Tiles,” on page 257.
- For information about editing classic-style portlets, see Chapter 28, “Editing Classic-Style Portlets,” on page 279.

**Change the Layout of Portlets**

To change the layout of the portlets on the portal page, complete the following steps:

1 Navigate to the page from which you want to delete a portlet.

2 Click Customize ➤ Edit Page ➤ Edit Page Content. The Edit Page Content page appears.
3 For the layout, click **By column** to lay out the portlets in columns. Click **By grid** to lay out the portlets using a grid.

*Note:* If you use a grid, you can fit more portlets on a page, especially by stacking a number of small portlets next to a large portlet.

4 Click the number of columns that you want to use.

5 To adjust the width of the columns, type the percentage value that you want to use for each column.

6 Specify the portlet layout in the **Portlet layout** section.

- If you selected **By column**, the layout selections appear in lists. To move a portlet to another column list, click the portlet and click the Right and Left arrows. If you want to move a portlet within a column, click the Up or Down arrows. To delete a portlet, click **X**.

- If you selected **By grid**, the layout selections appear in lists. Select one or more portlets for each row. If you want a portlet to span more than one column, select that portlet in each affected column list for that row. Click **Add Row** to add more rows to the page.
7 Click OK. The new portlet layout is saved.

Delete a Portlet

To delete a portlet from a portal page, complete the following steps:

1 Navigate to the page from which you want to delete a portlet.

2 Click Customize ➤ Edit Page ➤ Edit Page Content. The Edit Page Content page appears.
3 In the **Portlet layout** section, select the portlet to delete and click 

4 Click **OK**. The new portlet is deleted from on the page.
Your First Look at the SAS Strategy Management Enhanced Portlet Interface

When you first create a SAS Strategy Management enhanced portlet, it provides the following interface:

*Figure 26.1 SAS Strategy Management Enhanced Portlet Interface*

1. **Title bar.** It displays a customized portlet title and the Maximize (□) and Restore (□) buttons.
2. **Toolbar.** For more information, see "The Toolbar" on page 254.
3. **Help.**
4. **Content area.** One or more tiles appear in this area.
The Toolbar

You can perform the following actions on the toolbar:

- Click to save the layout configuration of the tiles within the portlet.
- Click to edit the portlet settings. For more information, see “Edit the SAS Strategy Management Enhanced Portlet” on page 257.
  
  Note: This button is not available for business users.
- Click to suggest new elements to include in a project. You can customize whether the portlet accepts element suggestions from business users.
- Click to save the content of the portlet as a SAS Mobile BI report.
- The toolbar also provides a list of available actions.
- Click to change the global date. You can enable business users to change the date. In this example, the date feature is enabled.
- A link that opens the project in Strategy Management Builder. You can customize whether the portlet displays this link to business users.

Your First Look at a Tile

A portlet can contain one or more tiles. A tile is like a window. A tile can contain a view. You can display the following SAS Strategy Management views in a tile:

- table
- aggregate
- association
- diagram
- gauge

In the SAS Strategy Management enhanced portlet, a tile can also display the following information:

- a scorecard hierarchy, which is a hierarchical tree that displays all the scorecards in a project
- a trend analysis in which the business user can drag data from other tiles to analyze trends in the data

When you add a tile, you can customize many of its features for use by your business users.
Figure 26.2  Tile Interface Example

1. Title bar. The title bar displays a customized tile title and the Maximize ( ) and Restore ( ) buttons.

2. The tile control panel. For more information, see “The Tile Control Panel” on page 255.

3. Content area. The tile data appears in this area.

The Tile Control Panel

You can customize whether the tile control panel is open by default. Users can close and open the tile control panel by clicking the tile control panel arrow. Depending on the type of tile, one or more of the following features appear in the tile control panel:

1. The tile toolbar. The toolbar provides the Print and Refresh icons. (The trend analysis tile includes additional icons.) You can customize whether the toolbar is available to business users.

2. The scorecard name. Click this link to open the scorecard in Strategy Management Builder. You can customize whether the scorecard name link is available to business users.

3. Information icon. Click this icon to view a short tip or other information about the tile. This information can include which tiles are synchronized with the scorecard hierarchy and whether the tile uses the global date.
4 Date. You can enable business users to change the date. In this example, the date feature is disabled.

5 **Element type** list. Business users can use this list to control their view of the tile data. You customize whether this list is available for business users, what selections are available in the list, and which selection is the default.

6 **Columns** list. Business users can use this list to control their view of the tile data. You customize whether this list is available for business users, what selections are available in the list, and which selection is the default.
Edit the SAS Strategy Management Enhanced Portlet

When you edit the SAS Strategy Management enhanced portlet, you can add tiles to display in the portlet and specify global settings that affect the tiles. To edit the SAS Strategy Management enhanced portlet:

2 In the **Identification** section, complete the following steps:
   
   a Edit the portlet name.
   
   b Edit the portlet description. A description can make similar portlets easier to identify.
   
   c Edit the keywords. Keywords can make a portlet search successful. Make sure you develop a list of keywords and use the keywords consistently.
   
   d Specify the height of the portlet, in pixels.

   **TIP** If you want the portlet to contain several tiles, be sure to provide enough height to view the tiles easily.

3 In the **Project and Date** section, complete the following steps:

   a In the **Project** list, select the project that you want to view in the portlet.
   
   **Note:** You must specify the project before you can define any tiles.

   b To display the name of the project in the portlet toolbar, select **Display project name**. By default, the project name is a link that opens the project in
Strategy Management Builder. To disable this link, select **Disable the link that opens Strategy Management**.

c To specify the date to use in the portlet, do one of the following:

- To specify the current date, select **Current date**.
- To specify a date relative to the current date, select **Relative period**, type or select a value in the field, and then select a value from the **Type** list.

**TIP** Negative values indicate a date in the past. Positive values indicate a date in the future. For example, if you select –1 and specify the period type of **Month**, the portlet uses a date that is one month in the past relative to the current date.

- To always use a specified date, select **Use this date**. Then enter a date in the field or click 🗓️ to choose a date from the calendar.

d Select **Enable users to change the global date** to give business users a way to change the global date while they are working in the portlet. The date change does not persist from one session to the next.

e Select **Enable users to suggest elements** to give business users a way to communicate suggestions to you about adding elements to the strategy.

**Note:** When you select this check box, the 🇺 logo button appears in the portlet control panel. This button opens the **Suggest New Elements** list.

**Note:** You must also select **Allow Suggested Elements** in the template that is associated with the project that you are using to create this portlet.

4 In the **Tiles** section, complete the following steps to specify which tiles to add, as well as the properties for each tile that you add.

**Note:** You must specify a project in the **Project and Date** section before you can specify tiles.

a Select a tile from the **Available tiles** list, and click ➡️ to add the tile to the **Selected tiles** list.

**Note:** To add all tile types to the portlet, click ➡️.

**Note:** You can add multiple versions of the same tile type to your portlet except for the scorecard hierarchy tile. You can add only one scorecard hierarchy tile to a portlet.

b To change the name of a tile, double-click the tile in the **Selected tiles** list, and enter the new name.

c To change the order of a tile, drag the tile up or down to its new location in the **Selected tiles** list.

d If you want to delete a tile, select the tile in the **Selected tiles** list, and click 🗑️.

**Note:** To remove all the tiles in the **Selected tiles** list, click 🗑️.

e To edit the properties for a tile, select the tile in the **Selected tiles** list, and select **Edit Tile Properties**. For more information, see the following sections:
Edit Tiles for the SAS Strategy Management Enhanced Portlet

Overview

When you edit tile properties, you can configure the following tile features:

- whether table, aggregate, or association tile data is synchronized with any selections that users make when they are navigating in the scorecard hierarchy tile
- the date that is used by the tile
- the exploration controls that are available for your business user, as well as whether the tile control panel and toolbar are displayed
- which buttons are displayed in the tile data
- other tile-specific features

To understand what you can configure and customize, you must understand the features of a tile. For detailed descriptions, see “Your First Look at a Tile” on page 254.

From the Default scorecard tree, select the scorecard that you want to use as the default.

Click Save to save the changes to the portlet properties and exit the page. Click Cancel to exit the page without saving any changes, including any changes to the tile properties.

You can make additional changes to the SAS Strategy Management enhanced portlet from within the portlet itself. For more information, see “Configure the Tile Layout in the Enhanced Portlet” on page 276.
Global Date and Local Date Options

You can customize whether a tile uses its own local date setting or the global date setting from the portlet. If you set a tile to use the global date setting, all other date settings for that tile are disabled and business users cannot change the date setting when they are exploring the data in that tile.

The Scorecard Hierarchy Tile and Synchronization

If you add a scorecard hierarchy tile to the SAS Strategy Management portlet, you can customize any table tile, aggregate tile, association tile, or gauge tile to dynamically synchronize its data with the current selection in the scorecard hierarchy tile. For example, suppose you have a table that displays the data for Distribution, but you want to view data for another scorecard. In the following scorecard hierarchy tile, click Retailers to automatically display the data for Retailers:

![Scorecard Hierarchy]

In order for a tile to synchronize with the scorecard hierarchy tile, you must add a scorecard hierarchy tile to the portlet. The scorecard hierarchy tile does not have any properties to edit so the Edit Tile Properties button is unavailable. However, you must edit the properties for each tile that you want to be synchronized with the scorecard hierarchy tile. For example, if you want a table tile to synchronize with the scorecard hierarchy, you must edit the table tile properties. In the tile properties, click Synchronize this tile with the scorecard hierarchy tile.

Note: This option is available only for table tiles, aggregate tiles, association tiles, and gauge tiles.

Note: A portlet can include only one scorecard hierarchy tile.

**TIP** You can create two identical tiles with the same data, but then customize only one to synchronize. If you synchronize only one tile, business users have a way to compare data between two scorecards.

Edit the Table View Tile Properties

**Note:** To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the Selected tiles list, and click Edit Tile Properties.
To edit the table view tile:

1. In the **Scorecard** section, specify the applicable options:
   - If you do not want the data in this tile to be synchronized with the scorecard hierarchy tile, select the scorecard that you want to view in this tile from the **Scorecard** tree.
   - If you do want the data in this tile to be synchronized with any tiles that you selected in the scorecard hierarchy tile, select **Synchronize this tile with the scorecard hierarchy tile**. For more information, see “The Scorecard Hierarchy Tile and Synchronization” on page 261.
   - If you want the scorecard name to appear in the tile control panel, select **Display scorecard name**. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, select **Disable the link that opens Strategy Management**.

2. In the **Date** section, specify the applicable options:
   - To specify the current date, select **Current date**.
   - To specify a date relative to the current date, select **Relative period**, enter or select a value in the field, and then select a value from the **Type** list.
   - To always use a specified date, select **Use this date**. Then enter a date in the field or click **»** to choose a date from the calendar.
   - To give business users a way to change the date while they are working in the tile, select **Enable users to change the date**. The date change does not persist from one session to the next.
   - If you want the tile to use the date settings that you specified on the Strategy Management portlet Properties page, select **Use global date settings**.
Note: If you select this option, all other date settings for this tile are disabled. For more information, see “Global Date and Local Date Options” on page 261.

3 In the Exploration Controls section, you can specify whether lists of selections are available for business users to control their view of the tile data. The lists appear in the tile control panel.

- In the Default element type list, select the element type that you want to appear as the default selection in the Element type list in the tile control panel.

  Note: If you do not select the Display element type control option, the default element type selection is the only element type that is available for this tile.

- Select Display element type control to display the Element type list in the tile control panel.

- In the Default column selection list, select the column that you want to appear as the default selection in the Columns list in the tile control panel.

  Note: If you do not select the Display column selection control option, the default column selection is the only column selection that is available for this tile.

- If you want the Columns list to appear in the tile control panel for business users, select Display column selection control.

- Click Define Choices to open the Define Choices window. Expand the element types to view the columns that are available for you to select. In the tree, you can select the choices that you want the lists to provide to your business user.

4 In the Additional Display Items section, specify the applicable options:

- In the Thresholds list, select whether you want global threshold indicators, personal threshold indicators, both indicators, or no indicators to appear in the tile content.

- In the Other group, select any other indicators that you want to appear in the tile.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Trend chart        | ![chart](chart.png) | Opens a noninteractive trend chart view of the data. This option uses the date range that is specified in the project options.  
  Note: Do not confuse the noninteractive trend chart with the interactive trend analysis tile. |
| Period             | None | Displays the period of time for which the element data was collected.        |
| Comments action    | ![comment](comment.png) | Provides a way for users to make comments about the data.                    |
| Comments alerts    | ![alert](alert.png) | If comment alerts are set, indicates that comments are available about the data. |
If you want the tile control panel open by default, select **Display an open tile control panel by default**. Business users can collapse the tile control panel if they do not want to view it.

If you want the toolbar to appear in the tile control panel, select **Display the toolbar in the tile control panel**.

**Note:** If you do not display the toolbar, business users do not have access to these tools, including the ability to print.

5 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Edit the Aggregate View Tile Properties**

**Note:** To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the **Selected tiles** list, and click **Edit Tile Properties**.

To edit the aggregate view tile:

1 In the **Scorecard** section, specify the applicable options:
   - If you do not want the data in this tile to be synchronized with the scorecard hierarchy tile, select the scorecard that you want to view in this tile from the **Scorecard** tree.
If you do want the data in this tile to be synchronized with any tiles that you selected in the scorecard hierarchy tile, select *Synchronize this tile with the scorecard hierarchy tile*. For more information, see “The Scorecard Hierarchy Tile and Synchronization” on page 261.

If you want the scorecard name to appear in the tile control panel, select *Display scorecard name*. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, select *Disable the link that opens Strategy Management*.

2 In the **Date** section, specify the applicable options:

- To specify the current date, select **Current date**.

- To specify a date relative to the current date, select **Relative period**, enter or select a value in the field, and then select a value from the **Type** list.

- To always use a specified date, select **Use this date**. Then enter a date in the field or click ⌁ to choose a date from the calendar.

- To give business users a way to change the date while they are working in the tile, select **Enable users to change the date**. The date change does not persist from one session to the next.

- If you want the tile to use the date settings that you specified on the Strategy Management portlet Properties page, select **Use global date settings**.

  **Note**: If you select this option, all other date settings for this tile are disabled. For more information, see “Global Date and Local Date Options” on page 261.

3 In the **Exploration Controls** section, you can specify whether lists of selections are available for business users to control their view of the tile data. The lists appear in the tile control panel.

- In the **Default element type** list, select the element type that you want to appear as the default selection in the **Element type** list in the tile control panel.

  **Note**: If you do not select the **Display element type control** option, the default element type selection is the only element type that is available for this tile.

- Select **Display element type control** to display the **Element type** list in the tile control panel.

- In the **Default column selection** list, select the column that you want to appear as the default selection in the **Columns** list in the tile control panel.

  **Note**: If you do not select the **Display column selection control** option, the default column selection is the only column selection that is available for this tile.

- If you want the **Columns** list to appear in the tile control panel for business users, select **Display column selection control**.

- Click **Define Choices** to open the Define Choices window. Expand the element types to view the columns that are available for you to select. In the tree, you can select the choices that you want the lists to provide to your business user.

4 In the **Additional Display Items** section, specify the applicable options:
In the Thresholds list, select whether you want global threshold indicators, personal threshold indicators, both indicators, or no indicators to appear in the tile content.

If you want the tile control panel open by default, select Display an open tile control panel by default. Business users can collapse the tile control panel if they do not want to view it.

If you want the toolbar to appear in the tile control panel, select Display the toolbar in the tile control panel.

Note: If you do not display the toolbar, business users do not have access to these tools, including the ability to print.

Select whether the default view of the aggregate data is displayed by metric attribute or scorecard.

5 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

**Edit the Association View Tile Properties**

Note: To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the Selected tiles list, and click Edit Tile Properties.
To edit the association view tile:

1. In the **Scorecard** section, specify the applicable options:
   - If you do not want the data in this tile to be synchronized with the scorecard hierarchy tile, select the scorecard that you want to view in this tile from the **Scorecard** tree.
   - If you do want the data in this tile to be synchronized with any tiles that you selected in the scorecard hierarchy tile, select **Synchronize this tile with the scorecard hierarchy tile**. For more information, see “The Scorecard Hierarchy Tile and Synchronization” on page 261.
   - If you want the scorecard name to appear in the tile control panel, select **Display scorecard name**. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, select **Disable the link that opens Strategy Management**.

2. In the **Date** section, specify the applicable options:
   - To specify the current date, select **Current date**.
   - To specify a date relative to the current date, select **Relative period**, enter or select a value in the field, and then select a value from the **Type** list.
   - To always use a specified date, select **Use this date**. Then enter a date in the field or click ☀️ to choose a date from the calendar.
   - To give business users a way to change the date while they are working in the tile, select **Enable users to change the date**. The date change does not persist from one session to the next.
   - If you want the tile to use the date settings that you specified on the Strategy Management portlet Properties page, select **Use global date settings**.
     - **Note:** If you select this option, all other date settings for this tile are disabled. For more information, see “Global Date and Local Date Options” on page 261.

3. In the **Exploration Controls** section, you can specify whether lists of selections are available for business users to control their view of the tile data. The lists appear in the tile control panel.
   - In the **Association** list, select the association that you want to appear as the default selection in the **Association** list in the tile control panel.
   - Click **Display association control** to display the **Association** list in the tile control panel.
   - In the **Default column selection** list, select the column that you want to appear as the default selection in the **Columns** list in the tile control panel.
     - **Note:** If you do not select the **Display column selection control** option, the default column selection is the only column selection that is available for this tile.
   - If you want the **Columns** list to appear in the tile control panel for business users, select **Display column selection control**.
   - Click **Define Choices** to open the Define Choices window. Expand the element types to view the columns that are available for you to select. In the tree, you can select the choices that you want the lists to provide to your business user.
4 In the **Additional Display Items** section, specify the applicable options:

- In the **Thresholds** list, select whether you want global threshold indicators, personal threshold indicators, both indicators, or no indicators to appear in the tile content.
- In the **Other** group, select any other indicators that you want to appear in the tile.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Trend chart        | ![Chart Icon] | Opens a noninteractive trend chart view of the data. This option uses the date range that is specified in the project options.  
                      |      | **Note:** Do not confuse the noninteractive trend chart with the interactive trend analysis tile.                                           |
| Comments action    | ![Speech Bubble] | Provides a way for users to make comments about the data.                                                                                   |
| Comments alerts    | ![Speech Bubble] | If comment alerts are set, indicates that comments are available about the data.                                                             |

- If you want the tile control panel open by default, select **Display an open tile control panel by default**. Business users can collapse the tile control panel if they do not want to view it.
- If you want the toolbar to appear in the tile control panel, select **Display the toolbar in the tile control panel**.

  **Note:** If you do not display the toolbar, business users do not have access to these tools, including the ability to print.

5 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

**Edit the Diagram View Tile Properties**

**Note:** To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the **Selected tiles** list, and click **Edit Tile Properties**.
To edit the Diagram View tile:

1. In the **Scorecard** section, specify the applicable options:
   - If you do not want the data in this tile to be synchronized with the scorecard hierarchy tile, select the scorecard that you want to view in this tile from the **Scorecard** tree.
   - If you do want the data in this tile to be synchronized with any tiles that you selected in the scorecard hierarchy tile, select **Synchronize this tile with the scorecard hierarchy tile**. For more information, see “The Scorecard Hierarchy Tile and Synchronization” on page 261.
   - If you want the scorecard name to appear in the tile control panel, select **Display scorecard name**. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, select **Disable the link that opens Strategy Management**.

2. In the **Date** section, specify the applicable options:
   - To specify the current date, select **Current date**.
   - To specify a date relative to the current date, select **Relative period**, enter or select a value in the field, and then select a value from the **Type** list.
   - To always use a specified date, select **Use this date**. Then enter a date in the field or click to choose a date from the calendar.
   - To give business users a way to change the date while they are working in the tile, select **Enable users to change the date**. The date change does not persist from one session to the next.
If you want the tile to use the date settings that you specified on the Strategy Management portlet Properties page, select Use global date settings.

Note: If you select this option, all other date settings for this tile are disabled. For more information, see “Global Date and Local Date Options” on page 261.

3 In the Diagram section, specify the applicable options:

- To give business users a way to change the diagram while they are working in the tile, select Enable users to select the diagram to view. The diagram selection does not persist from one session to the next.
- In the Diagram list, select the diagram that you want to display in the tile.
- In the Zoom list, select the percentage of magnification that you want to use when the diagram appears in the tile.

4 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.

Edit the Gauge View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the Selected tiles list, and click Edit Tile Properties.
To edit the gauge view tile:

1. In the **Date** section, specify the applicable options:
   - To specify the current date, select **Current date**.
   - To specify a date relative to the current date, select **Relative period**, enter or select a value in the field, and then select a value from the **Type** list.
   - To always use a specified date, select **Use this date**. Then enter a date in the field or click ☀️ to choose a date from the calendar.
   - To give business users a way to change the date while they are working in the tile, select **Enable users to change the date**. The date change does not persist from one session to the next.
If you want the tile to use the date settings that you specified on the Strategy Management portlet Properties page, select **Use global date settings**.

*Note:* If you select this option, all other date settings for this tile are disabled. For more information, see “Global Date and Local Date Options” on page 261.

2 In the **Element type** section, complete the following steps:

   a In the **Element type** list, select the element type that you want the gauge to use.

   b (Optional) In the **Group by attribute** list, select the attribute to use for grouping your gauge data.

      *Note:* If you have specified an association between the element type that you selected in step 2a and another element type, then the second element type is called an attribute of the first element type. You can choose to display your gauge data by this attribute.

   c (Optional) In the **Default attribute value** list, select the default value to use for the attribute that you selected in the previous step.

      *Note:* The attribute that you selected in step 2b is an element type. The values in the **Default attribute value** list are elements that are defined by this element type.

   d (Optional) Click **Show only the default attribute value**.

   e In the **Threshold filter** list, specify how you want to filter the thresholds.

3 In the **Gauges** section, complete the following steps:

   a In the **Gauge type** list, select the type of gauge that you want to display in the tile.

      *Note:* The options that are available in this section vary depending on the gauge type that you selected.

   b In the **Size** list, select whether you want the gauge to be small, medium, or large in size.

   c In the **Display** list, further refine how you want the gauges to appear in the tile.

      *Note:* The available selections vary depending on the gauge type that you selected. For example, for most gauge types, you can select whether the gauges appear in vertical or horizontal layout. However, for speedometers, this selection controls whether the speedometer is a quarter circle, half circle, three-quarter circle, or full circle.

   d In the **Primary indicator** list, select the element that you want to display as the primary indicator.

      *Note:* The primary and secondary indicators must match the range definitions that you set when you created a range in Strategy Management Builder.

   e In the **Secondary indicator** list, select the element that you want to display as the secondary indicator.
In the Skin list, select the skin or display theme that you want the gauge to use.

4 In the Additional Display Items section, specify the applicable options:

- In the Thresholds list, select whether you want global threshold indicators, personal threshold indicators, both indicators, or no indicators to appear in the tile content.
- If you want the gauge to display the lower and upper range values of the gauge, select Range values.
  
  **Note:** You define these values in Strategy Management Builder when you define the range.
- If you want the primary indicator value to appear with the gauge, select Metric values.
- If you want users to view comments and make comments about the gauge, select Comments.
- If you want to provide a noninteractive trend chart view of the data, select Trend chart. This option uses the date range that is specified in the project options.
  
  **Note:** Do not confuse the noninteractive trend chart with the interactive trend analysis tile.
- If you want the scorecard and element names to be appended in the gauge, select Append scorecard name to element name.
- If you want the tile control panel to be open by default, select Display an open tile control panel by default. The user can collapse the tile control panel if they do not want to view it.
- If you want the tile toolbar to appear in the tile, click Display the toolbar in the tile control panel.
  
  **Note:** If you do not display the toolbar, business users do not have access to these tools, including the ability to print.
- If you want the scorecard name to appear in the tile control panel, select Display scorecard name. By default, the scorecard name is a link that opens the scorecard in Strategy Management Builder. To disable this link, select Disable the link that opens Strategy Management.

5 In the Elements section, make the applicable selections:

- If you want all elements to appear in the tile, and you want the tile to synchronize data to synchronize with the scorecard hierarchy tile, select Show all elements and synchronize this tile with the scorecard hierarchy tile.
- If you want only some elements to appear in the tile, click Select Elements. In the Select Elements window, make your selections and click OK.
  
  To remove an element, select the check box in the element row and click Remove Selected Elements. To remove all elements from the table, click the check box in the table heading.

6 Click OK to save your changes and exit. Click Cancel to exit without saving any changes.
Edit the Trend Analysis Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced portlet properties. Select the tile to edit in the Selected tiles list, and click Edit Tile Properties.

To edit the trend analysis tile:

1. In the Date Range section, specify the start date and end date of the trend.
   
   a. To specify the start date, type a date in the Start date field or click to choose a date from the calendar.
   
   b. To specify the end date, type a date in the End date field or click to choose a date from the calendar.
   
   c. (Optional) To give business users a way to change the date while they are working in the tile, select Enable users to change the date. The date change does not persist from one session to the next.

2. In the Additional Display Items section, specify the applicable options:
If you want the tile control panel to be open by default, select **Display an open tile control panel by default**. The user can collapse the tile control panel if they do not want to view it.

If you want the tile toolbar to appear in the tile, select **Display the toolbar in the tile control panel**.

**Note:** If you do not display the toolbar, business users do not have access to these tools, including the ability to print.

3 In the **Graph Options** section, specify how you want the graph to be drawn:

a In the **Graph type** list, select the type of graph that you want to display in the trend analysis. Available selections are **Line**, **Band**, **Bar**, and **Scatter**.

b Select the applicable options for the graph type that you chose. Options vary depending on the graph type that you selected.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>All types</td>
<td>Click the Color icon to select the color of the graph type.</td>
</tr>
<tr>
<td></td>
<td>If you want each data value to be labeled in the graph, select <strong>Show data labels</strong>.</td>
</tr>
<tr>
<td>Line</td>
<td>In the <strong>Style</strong> list, select the style of line that you want to use.</td>
</tr>
<tr>
<td></td>
<td>In the <strong>Dash type</strong> list, select the type of dash that you want to use to form the line.</td>
</tr>
<tr>
<td></td>
<td>If you want the line that is drawn in the graph to break each time a data value is missing, select <strong>Break line drawing for missing data values in line graphs</strong>.</td>
</tr>
<tr>
<td></td>
<td>In the <strong>Line weight</strong> list, select the line thickness to use for the line graph.</td>
</tr>
<tr>
<td></td>
<td>If you want data tips to appear in the line graph, select <strong>Show data tips</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you want markers to appear in the graph, select <strong>Show markers</strong>. You can select the type of marker that you want the graph to use from the <strong>Marker</strong> list.</td>
</tr>
<tr>
<td>Scatter</td>
<td>In the <strong>Marker</strong> list, select the type of marker that you want the graph to use.</td>
</tr>
</tbody>
</table>

4 In the **Global Options** section, specify the applicable options:

a If you want grid lines to appear in the trend analysis, select **Grid lines**.

b If you want to display the legend in the trend analysis, select **Display legend**. When you choose to display the legend, you can also specify whether the legend appears across the width of the tile or is displayed along the height of the tile. In the **Location** list, select the location in the tile to display the legend.

5 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.
Configure the Tile Layout in the Enhanced Portlet

After you create the Strategy Management enhanced portlet and its tiles, you can refine the tile layout in the following ways:

- Resize a tile. Hover on the tile border to display handles. Click a handle and drag to resize the tile.

- Rearrange the tiles in columns or rows. Click the title bar of a tile and drag it within the portlet. A movement icon appears with the mouse pointer, which indicates that you are dragging a tile within the portlet. The following partial display shows the mouse pointer and the accompanying movement icon:

As you drag the tile, gray boxes guide you to rows and columns into which you can drop the tile. When you drop the tile, the other tiles in the portlet automatically accommodate the dropped tile.

For example, if you want to move a tile to create a column on the left side of the portlet, drag the tile left border of the portlet.

Drop the tile near the border, with the mouse pointer hovering within the tile that is currently located in that area. The affected tiles are rearranged to create a column.

**TIP** If you drag the tile too close to the portlet border or outside the border, the movement icon disappears, which indicates that you cannot drop the tile in that location. If you drag the tile into the portlet toolbar, an X in a red circle appears on the movement icon.
Resize a column. Hover between two columns to display handles. Resize the column width for optimal display of strategy content.

Maximize a tile. Click the Maximize button on the title bar. The tile is sized to be as large as possible to fill the portlet, and the other tiles disappear. To return all of the tiles to their previous sizes and locations, click the Restore button in the tile that you maximized.

When your tile layout is complete, click to save the layout configuration. The configured layout is used the next time the portlet is viewed.

Delete a Tile

To delete a tile in the SAS Strategy Management enhanced portlet:

1 Click in the portlet. The Edit Strategy Management Portlet page appears.

2 In the Tiles section, select the tile to delete in the Selected tiles list and click .

   Note: To remove all the tiles in the Selected tiles list, click .

3 Click Save to save the changes to the portlet properties and exit the page.
Overview

The Strategy Management enhanced portlet provides tiles that have the same functionality as the classic-style portlets described in this section. The tiles provide enhanced functionality and interactive features for business users. For more information about the enhanced portlet, its tiles, and their enhanced features, see Chapter 27, “Editing a Strategy Management Enhanced Portlet and Its Tiles,” on page 257.

Edit a Performance Table Portlet

To edit the properties of a Performance Table portlet, complete the following steps:

1. In the portlet, click the . The Edit Performance Table Portlet page appears.
In the **General** section, complete the following steps:

a. Edit the portlet name, description, or keywords.

b. Click **Allow Suggested Elements** to give business users a way to communicate to you any suggestions about adding elements to the strategy. For information about this setting, see “Create a Template” on page 42.

In the **View Selection** section, complete the following steps to specify the parameters that define the table to display:

a. From the **Template** list, select a template.

b. From the **Project** list, select a project.
c From the **Scorecard** list, select a scorecard or a project.

d From the **Element type** list, select an element type.

e From the **Column selection** list, select a column selection.

4 In the **Other Options** section, complete the following steps:

a To specify the number of rows and columns to display in the portlet, in the **Rows and Columns** section, type values in the **Rows** field and the **Columns** field.

b To specify the date, in the **Date** section, complete one of the following steps:

   - To specify the current date, click **Current date**.
   - To specify a date relative to the current date, click **Relative period**, type a value in the field, and then select a value from the **Use relative period type** list.
   - To always show a specified date, click **Always show this date**. Then type a date in the field or click ☐ to choose a date from the calendar.

5 In the **Icons** section, complete the following steps to specify which threshold icons appear in the aggregate table:

a Select an icon from the **Threshold icon** list.

b (Optional) Select one or more additional icon to display.

   **Note:** Selections vary depending on the portlet type.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Trend analysis     | Opens a noninteractive trend chart view of the data. This option uses the date range that is specified in the project options.  
|                    | **Note:** Do not confuse the noninteractive trend chart with the interactive trend analysis tile.                              |
| Comment            | Provides a way for users to make comments about the data.                    |
| Comment alert      | If comment alerts are set, indicates that comments are available about the data.                                         |
| Period             | Displays the period of time for which the element data was collected.        |

6 To specify whether to link to the affected project or scorecard, in the **Project and Scorecard Link** section, complete the following steps:

   - To display the name of the affected project, click **Display project name**. By default, the project name is a link that opens the project in the Strategy Management Builder. To disable this link, click **Disable the link that opens Strategy Management**.

   - To display the name of the affected scorecard, click **Display scorecard name**. By default, the scorecard name is a link that opens the scorecard in
7 In the Portlet Height section, enter the height that you want to use for the portlet.

**TIP** The Firefox web browser cannot automatically resize the height of the portlet. Make sure that you specify a height that accommodates the height of the content that you want to display in this portlet.

8 Click **Save** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Edit a Performance Aggregate Table Portlet**

To edit the properties of a Performance Aggregate Table portlet, complete the following steps:

1 In the portlet, click ![Edit Performance Aggregate Table Portlet](image). The Edit Performance Aggregate Table Portlet page appears.
2. In the General section, complete the following steps:
   
   a. Edit the portlet name, description, or keywords.
   
   b. Click Allow Suggested Elements to give business users a way to communicate to you any suggestions about adding elements to the strategy. For information about this setting, see “Create a Template” on page 42.

3. In the View Selection section, complete the following steps to specify the parameters that define the information to display in the aggregate table:

   a. From the Template list, select a template.
b From the Project list, select a project.

c From the Scorecard list, select a scorecard.

Note: You must select a scorecard that contains child scorecards.

d From the Element type list, select an element type.

e From the Column selection list, select a column selection.

4 In the Other section, complete the following steps:

a To specify the number of rows and columns to display in the portlet, in the Rows and Columns section, type values in the Rows field and the Columns field.

b To specify the date, in the Date section, complete one of the following steps:

- To specify the current date, click Current date.
- To specify a date relative to the current date, click Relative period, type a value in the field, and then select a value from the Use relative period type list.
- To always show a specified date, click Always show this date. Then type a date in the field or click to choose a date from the calendar.

c To specify how to view the aggregate table, in the View By section, complete one of the following steps:

- To display the scorecards as the column headings and the metric attributes as the rows, select View by scorecard.
- To display the metric attributes as the column headings and the scorecards as the rows, select View by metric attributes.

d To specify which threshold icons appear in the aggregate table, in the Threshold section, select the icon from the Threshold icon list.

5 To specify whether to link to the affected project or scorecard, in the Project and Scorecard Link section, complete the following steps:

- To display the name of the affected project, click Display project name. By default, the project name is a link that opens the project in the Strategy Management Builder. To disable this link, click Disable the link that opens Strategy Management.
- To display the name of the affected scorecard, click Display scorecard name. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, click Disable the link that opens Strategy Management.

6 In the Portlet Height section, enter the height that you want to use for the portlet.

TIP The Firefox web browser cannot automatically resize the height of the portlet. Make sure that you specify a height that accommodates the height of the content that you want to display in this portlet.

7 Click Save to save your changes and exit. Click Cancel to exit without saving any changes.
To edit the properties of a Performance Association portlet, complete the following steps:

1. In the portlet, click ![Edit Performance Association Portlet](image). The Edit Performance Association Portlet page appears.

![Edit Performance Association Portlet](image)
2 In the **General** section, complete the following steps:

a  Edit the portlet name, description, or keywords.

b  Click **Allow Suggested Elements** to give business users a way to communicate to you any suggestions about adding elements to the strategy. For information about this setting, see “Create a Template” on page 42.

3 In the **View Selection** section, complete the following steps to specify the parameters that define the table that contains associations to display:

a  From the **Template** list, select a template.

b  From the **Project** list, select a project.

c  From the **Scorecard** list, select a scorecard.

d  From the **Association name** list, select an association.

   **Note:** Associations are not available at the project level.

e  From the **Column selection** list, select a column selection.

4 In the **Icons** section, complete the following steps to specify which threshold icons appear in the aggregate table:

a  Select an icon from the **Threshold icon** list.

b  (Optional) Select one or more additional icon to display.

   **Note:** Selections vary depending on the portlet type.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Trend analysis  | Opens a noninteractive trend chart view of the data. This option uses the date range that is specified in the project options.  
   **Note:** Do not confuse the noninteractive trend chart with the interactive trend analysis tile. |
| Comment         | Provides a way for users to make comments about the data. |
| Comment alert   | If comment alerts are set, indicates that comments are available about the data. |
| Period          | Displays the period of time for which the element data was collected. |

5 To specify the date, in the **Date** section, complete one of the following steps:

- To specify the current date, click **Current date**.

- To specify a date relative to the current date, click **Relative period**, type a value in the field, and then select a value from the **Use relative period type** list.

- To always show a specified date, click **Always show this date**. Then type a date in the field or click ☑ to choose a date from the calendar.
6 To specify whether to link to the affected project or scorecard, in the **Project and Scorecard Link** section, complete the following steps:

- To display the name of the affected project, click **Display project name**. By default, the project name is a link that opens the project in the Strategy Management Builder. To disable this link, click **Disable the link that opens Strategy Management**.

- To display the name of the affected scorecard, click **Display scorecard name**. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, click **Disable the link that opens Strategy Management**.

7 In the **Portlet Height** section, enter the height that you want to use for the portlet.

**TIP** The Firefox web browser cannot automatically resize the height of the portlet. Make sure that you specify a height that accommodates the height of the content that you want to display in this portlet.

8 Click **Save** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Edit a Performance Dashboard Portlet**

To edit the properties of a Performance Dashboard portlet, complete the following steps:

1 **In the portlet, click ![Edit Performance Dashboard Portlet](image) The Edit Performance Dashboard Portlet page appears.**

   The size and style for metric attributes and element names, whether to append scorecard names to element names, and whether to display metric attributes are set on this page.
In the **General** section, complete the following steps:

a. Edit the portlet name, description, or keywords.

b. Click **Allow Suggested Elements** to give business users a way to communicate to you any suggestions about adding elements to the strategy. For information about this setting, see "Create a Template" on page 42.
You can display many scorecard elements from multiple projects within the same template. In the View Selection section, complete the following steps to select a template and element type:

a Click Add. The Add Items to Portlet page appears.

b In the Project name list, select a project. The list contains all of the projects that are associated with the selected template.

c Select the scorecard that contains the elements that you want to add.

d Select the check box for each element to be displayed in the portlet.

e Click Save. The Edit Performance Dashboard Portlet page appears. The elements that you have selected are displayed in the Items to display in portlet table.

To remove an item from the table, select the item check box and click Remove. To remove all of the items from the table, select the check box at the top of the column and click Remove. If you select elements that have a different element type, all elements of the previous element type are removed from the Performance Dashboard portlet.

In the Element Filter section, you can set a filter that displays elements that have or have not met global or personal threshold conditions. For more information about setting thresholds, see “Set a Global or Personal Threshold” on page 112.

To specify the threshold condition, select a filter from the Show list.

In the Graph Type section, select the type of graph to display and its size. Available graph types are dials, sliders, or stoplights.

To specify the number of rows and columns to display in the portlet, in the Rows and Columns section, type values in the Rows field and the Columns field.

In the Indicators section, complete the following steps to change the metric attributes that you use as indicators:

a Select an indicator from the Primary indicator list.

b If you want to display a secondary indicator, click Show secondary indicator and select an indicator from the list.

Note:

- Displaying a secondary indicator is useful only if the secondary indicator is on the same scale as the primary indicator.
- Stoplights do not display secondary indicators.

To specify the date, in the Date section, complete one of the following steps:

- To specify the current date, click Current date.
- To specify a date relative to the current date, click Relative period, type a value in the field, and then select a value from the Use relative period type list.
- To always show a specified date, click Always show this date. Then type a date in the field or click [ ] to choose a date from the calendar.

In the Text section, complete the following steps to specify how text is displayed:
a From the Text size list, select a text size for the element name.
b (Optional) Click Bold to display the element name as bold text.
c (Optional) Click Append scorecard name to element name to append the scorecard name to the element name.
d (Optional) To display the metric attribute or range values, click Display metric attribute or Display range values.
e From the Text size list, select a text size for the metric attribute.
f (Optional) Click Bold to display the element name as bold text.

10 In the Icons section, complete the following steps to specify which threshold icons appear in the aggregate table:

a Select an icon from the Threshold icon list.
b (Optional) Select one or more additional icon to display.

Note: Selections vary depending on the portlet type.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend analysis</td>
<td>Opens a noninteractive trend chart view of the data. This option uses the date range that is specified in the project options.</td>
</tr>
<tr>
<td></td>
<td>Note: Do not confuse the noninteractive trend chart with the interactive trend analysis tile.</td>
</tr>
<tr>
<td>Comment</td>
<td>Provides a way for users to make comments about the data.</td>
</tr>
<tr>
<td>Comment alert</td>
<td>If comment alerts are set, indicates that comments are available about the data.</td>
</tr>
<tr>
<td>Period</td>
<td>Displays the period of time for which the element data was collected.</td>
</tr>
</tbody>
</table>

11 In the Language section, select to use a specific language or the default language. For more information, see “Working with Language Settings” on page 53.

12 In the Portlet Height section, enter the height that you want to use for the portlet.

TIP The Firefox web browser cannot automatically resize the height of the portlet. Make sure that you specify a height that accommodates the height of the content that you want to display in this portlet.

13 Click Save to save your changes and exit. Click Cancel to exit without saving any changes.
Edit a Performance Data-Entry Portlet

To edit the properties of a Performance Data-Entry portlet:

1. In the portlet, click [ ] . The Edit Performance Data-Entry Portlet page appears.

2. On the General tab, enter the portlet name, description, and keywords.

3. From the Project list, select a project.

4. Click Display project name if you want the name displayed in the form.
5 From the Data-Entry Form list, select a form. 
   Note: You must first create the form in Strategy Management Builder. For more information, see Chapter 33, “Creating and Managing Forms,” on page 323.

6 In the Portlet height field, enter the height to use for the portlet, in pixels.

7 If you want to enable the SAS Information Delivery Portal administrator to view the portlet and its form, click Use this portlet as a data-entry portlet for the Portal Administrator.
   Note: Because of the way security is implemented, the portal administrator might not have the required access permissions to view the portlet. If the administrator must be able to view the portlet and form, make this selection.

8 Click the Date tab.

9 To specify the date that the form uses when opened, complete one of the following steps:
   - To specify the current date, click Current date.
   - To specify a date relative to the current date, click Relative period, enter a value in the field, and then select a value from the Period type list.
   - To always show a specified date, click Always show this date. Then, enter a date in the field or click the list box arrow to choose a date from the calendar.

10 To give data-entry form users a way to change the date while they are working in the form, click Enable users to change the date. The data change does not persist from one session to the next.

11 To restrict the dates that the data-entry user can navigate, click Restrict the dates available in the form and then make your selections in the Start and End fields.

   TIP By default, the dates are restricted by the start and end dates of the project.
12 Click Save to save your changes and exit. Click Cancel to exit without saving any changes.

**Edit a Performance Diagram Portlet**

To edit the properties of a Performance Diagram portlet, complete the following steps:

1. In the portlet, click ![Edit Performance Diagram Portlet](image). The Edit Performance Diagram Portlet page appears.

2. In the **General** section, complete the following steps:
   a. Edit the portlet name, description, or keywords.
   b. Click **Allow Suggested Elements** to give business users a way to communicate to you any suggestions about adding elements to the strategy. For information about this setting, see “Create a Template” on page 42.
3 In the View Selection section, complete the following steps to specify the diagram to display in the portlet:
   a From the Template list, select a template.
   b From the Project list, select a project.
   c From the Scorecard list, select a scorecard or a project.
   d From the Diagram list, select a diagram.

4 In the Other Options section, complete the following steps:
   a To specify the date, in the Date section, complete one of the following steps:
      ■ To specify the current date, click Current date.
      ■ To specify a date relative to the current date, click Relative period, type a value in the field, and then select a value from the Use relative period type list.
      ■ To always show a specified date, click Always show this date. Then type a date in the field or click to choose a date from the calendar.
   b To specify the diagram height, type the height in the Height field.

5 To specify whether to link to the affected project, scorecard, or diagram, in the Project, Scorecard and Diagram Link section, complete the following steps:
   ■ To display the name of the affected project, click Display project name. By default, the project name is a link that opens the project in the Strategy Management Builder. To disable this link, click Disable the link that opens Strategy Management.
   ■ To display the name of the affected scorecard, click Display scorecard name. By default, the scorecard name is a link that opens the scorecard in the Strategy Management Builder. To disable this link, click Disable the link that opens Strategy Management.
   ■ To display the name of the affected diagram, click Display diagram name. By default, the diagram name is a link that opens the diagram in the Strategy Management Builder. To disable this link, click Disable the link that opens Strategy Management.

6 Click Save to save your changes and exit. Click Cancel to exit without saving any changes.
Part 5

Viewing and Navigating Content in Portlets

Chapter 29
Access Your Strategy Management Portlets ........................................ 297

Chapter 30
Navigating and Viewing the Strategy Management Enhanced Portlet and Its Tiles ................................................ 299

Chapter 31
Navigating and Viewing Classic-Style Portlets .................................. 315
Access Your Strategy Management Portlets

Log On to the SAS Information Delivery Portal

Log Off from the SAS Information Delivery Portal

Log On to the SAS Information Delivery Portal

To access your SAS Strategy Management portlets:

1. Open your browser and type the web address for the SAS Information Delivery Portal.

   Note: To obtain the web address, contact your portal administrator.

   The Log On page appears.

2. Enter your user ID and password.
3 Click Log On. Your personal portal appears. Your portal might have multiple pages. Click the page tabs to view the pages in your portal. Each page can contain one or more portlets, including SAS Strategy Management portlets.

---

**Log Off from the SAS Information Delivery Portal**

To log off from your SAS Strategy Management portlets, click Log Off in the upper right corner of the user interface.

Note: If your session is inactive longer than the SAS Information Delivery Portal time-out value, you are automatically logged off.
Navigating and Viewing the Strategy Management Enhanced Portlet and Its Tiles

Your First Look at the SAS Strategy Management Enhanced Portlet ........................................... 300
Access Help ................................................................................................................................. 302
Change the Layout of the Tiles ................................................................................................. 302
Open and Close the Tile Control Panel ..................................................................................... 303
Print a Tile ................................................................................................................................... 303
Reset Tile Data ........................................................................................................................... 304
Suggest a New Element to Add to the Strategy ......................................................................... 304
Change the Date .......................................................................................................................... 304
Change the Element Type .......................................................................................................... 305
Change the Column Selection ..................................................................................................... 305
Change the Association .............................................................................................................. 305
View the Scorecard in Strategy Management Builder ................................................................. 305
Sort Columns .............................................................................................................................. 306
Rearrange Columns .................................................................................................................... 306
Synchronize Tile Data with the Scorecard Hierarchy Tile .......................................................... 306
View Threshold Conditions ....................................................................................................... 307
View and Create Comments ....................................................................................................... 307
Reply to a Comment .................................................................................................................... 309
Search Comments ...................................................................................................................... 309
Display a Trend Chart ............................................................................................................... 309
Select Data for a Trend Analysis ............................................................................................... 310
Remove Data from a Trend Analysis ........................................................................................ 310
Reset the Data ........................................................................................................................... 310
Save the Trend Analysis as an Image ........................................................................................ 310
Change Trend Analysis Property Settings ................................................................................. 310
View and Filter Gauges ............................................................................................................... 312
Your First Look at the SAS Strategy Management Enhanced Portlet

The SAS Strategy Management enhanced portlet appears on your portal page.

Figure 30.1  SAS Strategy Management Enhanced Portlet

1 Title bar. Click the X to remove the portlet from the page or click the Minimize button to minimize the portlet.

2 Toolbar. The portlet toolbar provides the ■ and ◆ buttons. For more information, see “Suggest a New Element to Add to the Strategy” on page 304.

The toolbar also provides the Help icon. Click  to view the SAS Strategy Management: Enhanced Portlet Quick Start Guide.

3 Portlet content area

A SAS Strategy Management portlet can contain one or more tiles. A scorecard modeler can customize the interface of each tile. The following example describes the available features for a tile. However, due to customization, your tiles might not have all of these features.
The tile title bar provides the Maximize ( ) and Restore ( ) buttons.

The tile control panel. For more information, see “Open and Close the Tile Control Panel” on page 303.

The tile toolbar. Due to customization, the tile might not display the toolbar.

Date. For more information, see “Change the Date” on page 304.

The scorecard name. For more information, see “View the Scorecard in Strategy Management Builder” on page 305.

Element type list. For more information, see “Change the Element Type” on page 305.

Columns list. For more information, see “Change the Column Selection” on page 305.

Information icon. Click this icon to view a short tip or other information about the tile. This information can include which tiles are synchronized with the scorecard hierarchy and whether the tile uses global date.

Content area. The tile data appears in this area.

Icons. Depending on how the tile is customized, one or more of the following icons might be available:

- Trend chart . For more information, see “Display a Trend Chart” on page 309.

Note: Do not confuse the noninteractive trend chart with the interactive analysis tile.

- Threshold (either global or personal ). Click this icon to view the threshold conditions for an element. For more information, see “View Threshold Conditions” on page 307.

- Comments action . Click this icon to make comments about the information. For more information, see “View and Create Comments” on page 307.

- Comment alerts . This icon indicates that comments are available.
Access Help

The toolbar provides the Help icon.

Click to view the SAS Strategy Management: Enhanced Portlet Quick Start Guide.

Change the Layout of the Tiles

When you view a SAS Strategy Management enhanced portlet and its tiles, you can change their layout in the following ways:

- Resize a tile. Hover on the tile border to display handles. Click a handle and drag to resize the tile.

- Rearrange the tiles in columns or rows. Click the title bar of a tile and drag it within the portlet. A movement icon appears with the mouse pointer, which indicates that you are dragging a tile within the portlet. The following partial display shows the mouse pointer and the accompanying movement icon:

As you drag the tile, gray boxes guide you to rows and columns into which you can drop the tile. When you drop the tile, the other tiles in the portlet automatically accommodate the dropped tile.

For example, if you want to move a tile to create a column on the left side of the portlet, drag the tile left border of the portlet.

Drop the tile near the border, with the mouse pointer hovering within the tile that is currently located in that area. The affected tiles are rearranged to create a column.
TIP If you drag the tile too close to the portlet border or outside the border, the movement icon disappears, which indicates that you cannot drop the tile in that location. If you drag the tile into the portlet toolbar, an X in a red circle appears on the movement icon.

- Resize a column. Hover between two columns to display handles. Resize the column width for optimal display of strategy content.

- Maximize a tile. Click the Maximize button on the title bar. The tile is sized to be as large as possible to fill the portlet, and the other tiles disappear. To return all of the tiles to their previous sizes and locations, click the Restore button in the tile that you maximized.

When your tile layout is complete, click to save the layout configuration. The configured layout is used the next time the portlet is viewed.

Open and Close the Tile Control Panel

To close the tile control bar, click. The tile control bar closes.

To open the tile control bar, click. The tile control bar opens.

Print a Tile

Note: Due to customization, a tile might not display a toolbar. In this case, the Print button is not available.

To print a tile:

1. Click in the tile toolbar. The Print Tile window appears.
2. (Optional) Type the header text to use on the printed page.
3. (Optional) Adjust the margin settings.
4 If you do not want to print the tile control bar and its buttons and controls, select **Do not print tile control bar**.

5 If you want to print information identifying the scorecard, select **Print the scorecard header information**.

6 Click **OK** to save your changes and exit. Click **Cancel** to exit without saving any changes.

---

**Reset Tile Data**

To reset the tile data to its initial setting when you opened the portlet, click 🔄 in the tile toolbar.

**Note:** Due to customization, a tile might not display a toolbar. In this case, the 🔄 button is not available. To refresh your data, click your web browser **Refresh** button.

---

**Suggest a New Element to Add to the Strategy**

**Note:** Due to customization, a tile might not display a toolbar. In this case, the 🔄 button is not available. Also, the tile might be customized to not accept element suggestions.

You can suggest that new elements be added to the strategy. Your suggestions are implemented by the scorecard modeler. To suggest that one or more new elements be added to a strategy:

1 In the tile toolbar, click 🔄.

2 In the **Suggest New Elements** list, type a name. A description is optional.

3 Select the scorecards in which to include the element.

4 Select the type of period, the start period, and the end period.

5 Click 🔄. A new row is added to the table.

6 To suggest more elements, repeat steps 2 through 5.

---

**Change the Date**

Depending on how your portlet and tiles are customized, you can change the date for the portlet or the tile. The portlet date setting is called the **global date setting**. The tile date setting is called the **local date setting**. If a tile has its own **Date** field, the tile, or local, date setting is independent of the global date setting. Tiles that do not have their own date setting use the global date setting.
To change the global date setting, type a date in the **Date** field or click 🕒 in the portlet toolbar. Any tiles that use the global date setting update their data to reflect the new date. Tiles that have their own local date setting do not change.

To change the local date setting that a tile uses, type a date in the **Date** field or click 🕒 in the tile control bar. The data for only that tile is updated to reflect the new date.

**Note:** The date selections do not persist after you close the portal session.

**Note:** Due to customization, the **Date** field might not be enabled in the portlet or in a tile.

---

### Change the Element Type

To change the element type selection, click the **Element type** list to make a new selection.

**Note:** Due to customization, the **Element type** list might not be available.

---

### Change the Column Selection

To change the column selection, click the **Column** list to make a new selection.

**Note:** Due to customization, the **Column** list might not be available.

---

### Change the Association

To change the association in an association tile, click the **Association** list to make a new selection.

**Note:** Due to customization, the **Association** list might not be available.

---

### View the Scorecard in Strategy Management Builder

The tile control bar provides a link to the scorecard.

When you click the scorecard name in the tile control bar, the scorecard opens in Strategy Management Builder.
To return to the portal and your portlet view, click **Portal** in the upper left corner of **Strategy Management Builder**.

**Note:** Due to customization, the scorecard name link might not be available.

---

### Sort Columns

When a tile displays its data in columns, you can click the column headings to sort the data.

---

### Rearrange Columns

You can change the order of the columns in a table. Click a column heading, drag the column to the new location, and then drop the column.

---

### Synchronize Tile Data with the Scorecard Hierarchy Tile

The scorecard hierarchy tile provides a way to dynamically change the scorecard data in one or more tiles. This feature is called **synchronization**.
For example, suppose a table tile displays data for Distribution. If you click Retailers in the scorecard hierarchy tile, the table tile displays data for Retailers.

If a portlet contains a scorecard hierarchy tile, remember the following considerations:

- You can synchronize only table tiles, aggregate tiles, association tiles, and gauge tiles with the scorecard hierarchy tile. Synchronization does not affect analysis tiles.
- Synchronization is a customizable feature. A tile might not be customized to synchronize its data with the scorecard hierarchy tile.

### View Threshold Conditions

**Note:** Due to customization, threshold icons might not be available.

- If a global 🔄 or personal 🔺 threshold is set and the threshold conditions are met or exceeded, the applicable threshold icon appears in the tile data.
- To view the threshold conditions for an element, click the threshold icon. The Threshold window appears.

![Threshold window](image)

- If the scorecard in which the threshold flag is set is available in a scorecard tile, you can click the scorecard name to view the scorecard in the tile.
- The threshold flag is set on a specific metric attribute. A defined link can be assigned to a metric attribute. If the metric attribute has a defined link, you can click the metric attribute in the Threshold window and the link opens.
- To close the Threshold window, click Close.

**Note:** Thresholds can also generate alerts. You can receive alerts as individual e-mail, as a compiled digest of alerts in an e-mail, as Short Message Service (SMS) text messages, or in a shared alert portlet on a portal page.

### View and Create Comments

**Note:** Due to customization, the comment feature and comment alerts might not be available.

**Note:** You cannot delete comments. If a comment requires deleting, contact your SAS administrator.

- If the 📝 icon appears in the tile content, you can make a comment about that data. When a new comment or a reply is posted, a comment alert 📝 icon appears with the affected data.

To make a comment:
1 In the applicable row, click 🅿️. The Comments window appears.

![Image of the Comments window]

- If this element has existing comments, the comments appear in this window. By default, only one line of the comment is displayed. Double-click the comment to expand the entire comment. To collapse the comment, double-click it again.

- If a topic contains many comments, Show All Comments appears below the topic name. Click Show All Comments to display all of the comments in the topic. To collapse the view, click Minimize View.

- If a comment belongs to you, you can click 🅿️ to edit the comment.

2 To make a comment about a new topic, enter the name of the topic in the field above the comments. The comment field appears below topic field.

3 Enter your comment in the comment field.

4 (Optional) Click 📁 to attach a file to the comment. Select one or more files to attach and click Open. The attachment appears below the comment.

   Note: To delete the attachment from the comment, click ✗ next to the attachment.

5 Click Post to save and post your comment. When you post a comment, it is added to a topic thread of comments about that element. After you post a comment, other users can reply to it. Their comments are also added to the topic thread of comments.
Reply to a Comment

Note: Due to customization, the comment feature might not be available.

Note: You cannot delete comments. If a comment requires deleting, contact your SAS administrator.

To reply to a comment:

1 In the applicable row, click 

2 In the Comments window, expand the topic thread of comments.

3 Enter your reply in the comment field at the bottom of the thread.

4 (Optional) Click to attach a file to the comment. Select one or more files to attach and click Open. The attachment appears below the comment.

   Note: To delete the attachment from the comment, click next to the attachment.

5 Click Post to save and post your reply. The reply is added to the thread of comments.

Search Comments

Note: Due to customization, the comment feature might not be available.

Note: You cannot delete comments. If a comment requires deleting, contact your SAS administrator.

To search comments:

1 In the Comments window, type one or more characters in the Search field.

2 Click . Any comments that include the search string appear in a results list.

3 To view the Comments window again, click the X in the Search field.

Display a Trend Chart

Note: Due to customization, trend charts might not be available.

The trend chart is a noninteractive chart of historical trend data. The data that is displayed in the chart is specified by your scorecard modeler. The trend chart icon appears in a tile when this view is available in a tile.

To view the trend chart, click .

To close trend charts, click Close.
Select Data for a Trend Analysis

To select data for a trend analysis, click an element and drag it onto the trend analysis tile. You can select data in a table view tile, aggregate view tile, association view tile, or gauge view tile for use in a trend analysis.

Remove Data from a Trend Analysis

To remove an element from a trend analysis, in the tile control bar, click ⬅️.  
Note: Due to customization, a tile might not display a toolbar.

In the Graph Properties window, the top section lists the elements in the trend analysis. Click ⬅️ next to the element that you want to remove from the trend analysis.

Reset the Data

To reset the data to its initial setting, click ⬅️ in the tile toolbar.  
Note: Due to customization, a tile might not display a toolbar.

Save the Trend Analysis as an Image

To save the trend analysis using the image format PNG:

1. Click ⬅️ in the tile toolbar.  
   Note: Due to customization, a tile might not display a toolbar.

2. A Save list appears. Navigate to the location where you want to save the file.

3. Type a name in the File name field.

4. Click Save.

Change Trend Analysis Property Settings

To change the style setting in a trend analysis tile:

1. In the tile control bar, click ⬅️. The Graph Properties window appears.  
   Note: Due to customization, a tile might not display a toolbar.
2 In the list at the top of the window, click the value that you want to edit. Any changes that you make are applied to this value.

Note: You can also delete the value by clicking \( \text{Trash Can} \).

3 In the Graph Options section, specify how you want the graph to be drawn:

a In the Graph type list, select the type of graph that you want to display in the trend analysis. Available selections are Line, Band, Bar, and Scatter.

b Select the applicable options for the graph type that you chose. Options vary depending on the graph type that you selected.

<table>
<thead>
<tr>
<th>Graph Type</th>
<th>Available Options</th>
</tr>
</thead>
</table>
| All types  | - Click the Color icon to select the color of the graph type.  
|            | - If you want each data value to be labeled in the graph, select Show data labels. |
| Line       | - In the Style list, select the style of line that you want to use.  
|            | - In the Dash type list, select the type of dash that you want to use to form the line.  
|            | - If you want the line that is drawn in the graph to break each time a data value is missing, select Break line drawing for missing data values in line graphs.  
|            | - In the Line weight list, select the line thickness to use for the line graph.  
|            | - If you want data tips to appear in the line graph, select Show data tips.  
|            | - If you want markers to appear in the graph, select Show markers.  
|            | You can select the type of marker that you want the graph to use from the Marker list. |
| Scatter    | - In the Marker list, select the type of marker that you want the graph to use. |

4 In the Global Options section, specify the applicable options:

- If you want grid lines to appear in the trend analysis, select Grid lines.

- If you want to display the legend in the trend analysis, select Display legend.  
When you choose to display the legend, you can also specify whether the legend appears across the width of the tile or is displayed along the height of the tile. In the Location list, select the location in the tile to display the legend.

5 Click Apply to save and apply the new settings.

Note: If you do not click Apply, the settings are not saved.

6 Edit the properties for another value or click Close to exit.
View and Filter Gauges

In a gauge tile, every element is represented as a gauge. In the tile control bar, you can filter the gauges by their relationship to each other as defined by associations. From the Supported perspective list, select an association.

View Information Provided for a Gauge

If the element name of a gauge is linked, you can click the link to view information provided for that element.

View Details about an Element in a Diagram

To view element details in a diagram, expand the Element Details pane to the right of the diagram. Then, click an element in the diagram. The details for the element appear in the Element Details pane.

Change the Diagram to View

Note: Due to customization, the Diagram list might not provide other selections.

To view another diagram, select a new diagram from the Diagram list.

Reset the Zoom for a Diagram

To reset the zoom for a diagram, select the Reset Zoom check box.

Save the Portlet as a SAS Mobile BI Report

You can save the content of the Strategy Management enhanced portlet and its tiles as a SAS Mobile BI report. A SAS Mobile BI report can be viewed by using a mobile device such as an iPad or an Android tablet. The SAS Mobile BI app must be installed on the tablet. For information about this app, see the SAS Visual Analytics product page at http://support.sas.com/software/products/va/index.html.

Note: Some features of the content in the tiles might not display the same way on a tablet. Some features can also appear differently on different types of tablets.
To save the portlet content as a SAS Mobile BI report:

1. Click ![ ] in the portlet toolbar.

2. In the Create Mobile Report window, in the **Name** field, enter a name for the report.

3. In the **Description** field, enter a description for the report.

   **TIP** The SAS Mobile BI app displays the description as part of the subscription information for the report. A thoughtfully written description can help users decide whether to subscribe to the report.

4. Navigate to the location where you want to save the report.

5. Click **Yes** to save the report.
Navigating and Viewing Classic-Style Portlets

Overview

Depending on how a portlet is customized, the following options might be available in classic-style portlets.

Link to Other Documents, Web Addresses, or Views

Values in tables or diagrams can be customized to provide a link to documents, web addresses, or other views. Click the link to display the information.

View a Trend Analysis

If the icon appears in a view, you can click the icon to display the Trend Analysis page in the SAS Strategy Management Builder. For more information about the Trend Analysis page, see Chapter 22, “Creating and Editing Trend Analysis Views,” on page 231.

Note: This option is supported in the table, association, and dashboard views. However, the Trend Analysis icon might not be available in a view. The scorecard modeler specifies whether to display these icons when customizing the view.
Viewing and Making Comments

If the icon appears in a view, you can click the icon to open the Comment Manager page.

On this page you can:

- View comments about the data.
- Make comments about the data.
- Respond to comments about the data.

To learn more about the Comment Manager, click Help ▶ Help on This Page to display the Comment Manager help.

Note: This option is supported in the table, association, and dashboard views. However, the icon might not be available in a view. The scorecard modeler specifies whether to display these icons when customizing the view.

View Threshold Data

If the or icons appear in a view, you can click the icon to open the Threshold Condition page.

Note: This option is supported in the table, aggregate, association, and dashboard views. However, the threshold icons might not be available in a view. The scorecard modeler specifies whether to display these icons when customizing the view.
View Underlying Data (Dashboard View Only)

If the element contains data for the specified time period, a graph is displayed in the Performance Dashboard Portlet for each element that is specified in the portlet properties. Click on the link in each graph to view the underlying data table.

Note: If the range for the element contains fewer than two intervals, a graph for the element is not displayed.
Part 6

Entering Data into Projects

Chapter 32
  Overview of Data Entry Methods ........................................... 321

Chapter 33
  Creating and Managing Forms ............................................... 323

Chapter 34
  Entering Data Manually ....................................................... 333

Chapter 35
  Importing Data into a Strategy Management Project ................. 337
Overview of Data Entry Methods

Data-Entry Methods

SAS Strategy Management provides different ways to enter data depending on the quantity of data that you want to enter.

When your organization needs to manually enter data or your data-entry process requires workflow control, create a data-entry form in SAS Strategy Management Builder and display the form in the data-entry portlet. By entering data in this way, you can control the workflow of the data-entry process. For more information, see Chapter 33, “Creating and Managing Forms,” on page 323. For information about entering and approving data, see Chapter 34, “Entering Data Manually,” on page 333.

To create data in SAS Strategy Management by using Microsoft Excel spreadsheets or SAS data sets, use the Import wizard. For information, see Chapter 35, “Importing Data into a Strategy Management Project,” on page 337.

To enter an existing project and its data, export and import a SAS package from one SAS Strategy Management installation to another. You can use this method to copy a project, migrate a project, or back up a project. For more information, see the SAS Strategy Management: System Administration Guide.
Creating and Managing Forms

Forms and Workflow .......................................................... 323
  Designing Forms .......................................................... 323
  Designing the Workflow of a Form ................................... 323
  Prerequisites ..................................................................... 324
Create a Form and Workflow ............................................. 324
Edit or View the Properties of a Form ................................. 329
Copy a Form ....................................................................... 329
Delete a Form ...................................................................... 329
Start a Workflow .................................................................. 330
Set the Workflow to Stop After the Cycle Completes ............ 330
Immediately Stop the Workflow and Delete All Work ........... 330
Create and Edit a Performance Data-Entry Portlet ................ 331

Forms and Workflow

Designing Forms

You can create a form in which data-entry users enter data into a SAS Strategy Management project. Users access the form by using a data-entry portlet on a portal page. Forms are a useful way to enter data that does not exist in your SAS Strategy Management project.

Designing the Workflow of a Form

Specifying a workflow for a data-entry form is a way to guarantee that the data that is entered is accurate before the data is published to the production system.

The workflow of a form affects two groups of users: data-entry users and approvers. In the workflow, the form is assigned to a data-entry user who is responsible for entering some or all of the data into the form. You can specify one or more data-entry users to enter data.

After the data is entered and the data-entry user submits the form, the data can be approved. In the workflow, you specify an approver who is responsible for reviewing and approving the data that was entered into the form. You can specify one or more
approvers. You can also specify the order in which approvers must approve the form.

When you specify a workflow, you get the following benefits:

- Collaboration is ensured when everyone agrees on the submitted data.
- Mistakes are reduced before the data is generally available.
- Consistent business processes are enforced.
- Efficiency and productivity can be improved by automating and tracking the process within the SAS Strategy Management software.

Prerequisites

Before you create a data-entry form, consider the following prerequisites:

- You can design a form such that the value that is entered into a cell is evaluated by a rule. You can define a rule and then associate the rule with metric attributes. You select the metric attribute when you create the column selection. For more information, see Chapter 10, “Defining Rules,” on page 119.

- When you create a data-entry form, you specify a column selection to use in that form. Before you can specify the column selection, you must create it. For more information, see “Create a Column Selection for Use in a Data-Entry Form” on page 141.

- You can specify that a link be available in a form. Before you can specify the link, you must create the link definition. For more information, see “Managing Link Definitions” on page 74.

- For information about the user roles and capabilities required for creating a form, entering data, and approving data, see the SAS Strategy Management: System Administration Guide.

- For information about customizing the workflow, see the SAS Strategy Management: System Administration Guide.

Create a Form and Workflow

On the Project page, complete the following steps:

1. Select Project ➤ Manage Data Entry Forms. The Manage Forms page appears.

2. Click . The Properties section appears below the Forms list.
3 On the **Identification** tab, complete the following steps:

a In the **Name** field, enter a unique name for the form.

b (Optional) In the **Description** field, enter an optional description of the form.

c (Optional) From the **Link** list, select a link that will appear at the top of the form in the portlet. The link that you select is associated with the form.

Note: For more information, see “Managing Link Definitions” on page 74.

**TIP** You can click **Save** at any time in the **Properties** section. Doing so saves a draft of the form. The draft appears in the **Forms** list above the **Properties** section. The draft contains the selections that you made before you clicked **Save**. If you continue working in the **Properties** section but do not click **Save**, any subsequent settings can be lost.

4 Click the **Elements** tab.
To select the elements for which you want to collect data, complete the following steps:

a. From the **Element type** list, select the element type.
   
   **Note:** A form can have only one element type.

b. In the **Elements** tree, expand the tree and select one or more elements for which you want to collect data. To select all of the elements in a scorecard, click the check box next to the scorecard.

5. Click the **Columns** tab.

Column selections are collections of predefined columns to use in the form. Read-Write and Read-Only controls for each column are also defined in column selections. For more information, see “Create a Column Selection for Use in a Data-Entry Form” on page 141.

**TIP** When columns are Read-Only, data-entry users cannot enter data in the cells. Read-Only columns are useful when a user needs to see historical or forecasted values or needs some information for data entry, but should not need to change the values.

To specify column selections for inclusion in the form:

a. From the **Column selection** list, select the column selection that you want to use in the form.

b. View the **Preview** table to make sure that your selection is correct for the form.

6. Click the **Workflow** tab.
In the Workflow section, specify whether you want a workflow and how you want the workflow to repeat.

- By default, a form does not have a workflow. To specify a workflow, clear the No workflow required check box. By default, the workflow occurs only once.
- To specify that a workflow repeat, click Repeat this workflow each time the workflow is completed.

In the Assignees section, specify the behavior of the form for those users who are assigned to enter data into the form in the workflow.

- To notify the users that a form is available for work, click Send notification that a form is available.

  Note: If you want a user to receive e-mail notifications, the user name must have e-mail enabled. This user name setting must be set in SAS Management Console. Also, these users must be members of the SAS Strategy Management Users Group and the SAS Strategy Management Data Entry Group.

- From the Assignees list, select a user and click Add. The selected user is added to the Assignees table below the list.
  
  If you want to remove a user, click the X next to the user in the table. To remove all users from the table, click the X next to the table heading.

- Specify whether one or all of the users must submit the form for the workflow to proceed. If one user is sufficient, click Any user can submit the form. Otherwise, click All users must submit the form.

In the Approvers section, specify the behavior of the form for those users that approve the form in the workflow.
Specify whether one or all of the users must approve the form. If one user is sufficient, click **Any approver can approve the form**. Otherwise, click **Each approver must approve the form in the assigned order**.

To notify the approvers that a form is available, click **Send notification that a form is available for approval**.

**Note:** If you want a user to receive e-mail notifications, the user name must have e-mail enabled. This user name setting must be set in SAS Management Console. Also, these users must be members of the SAS Strategy Management Users Group and the SAS Strategy Management Data Entry Approver Group.

From the **Approvers** list, select a user and click **Add**. The selected user is added to the **Approvers** table below the list.

If you want to remove a user, click the X next to the user in the table. To remove all users from the table, click the X next to the table heading.

**TIP** To change the order of users in the table, drag a row and drop it in a new location in the table.

7 Click **Save** to save your selections. The form appears in the **Forms** list above the **Properties** section. Click **Cancel** to exit the **Properties** section without saving your selections.

**Note:** If you click the column headings in the **Forms** list to sort items in the list, the feature does not sort the items correctly in languages other than English.
Edit or View the Properties of a Form

Note: If ☐ and ☐ are the only buttons available on the toolbar, the role and capability settings that are associated with your user name are limited to viewing only. If you require expanded access to SAS Strategy Management, contact your SAS Strategy Management administrator.

To edit the properties of a form, complete the following steps on the Manage Forms page:

1. Double-click the form that you want to edit. The Properties section appears below the Forms list.
2. Change the applicable settings in the form as described in “Create a Form and Workflow” on page 324.
3. Click Save to save your selections. Click Cancel to exit the Properties section without saving your selections.

Copy a Form

To copy a form, complete the following steps on the Manage Forms page:

1. Select the form that you want to copy and click ☐. The copied form appears in the list. A number is appended to the form’s name.
2. To edit the copied form, double-click its name. The Properties section appears below the Forms list.
3. Change the applicable settings in the form as described in “Create a Form and Workflow” on page 324.
4. Click Save to save your selections. Click Cancel to exit the Properties section without saving your selections.

Delete a Form

To delete a form, complete the following steps on the Manage Forms page:

1. Select the form that you want to delete and click ☐. Note: If you want to delete multiple forms at once, use the Shift key or the Ctrl key when you click your selections.
2. A confirmation message appears. Click Yes to delete the form.
Start a Workflow

After you create a data-entry form and define its workflow, you can start the workflow process for the form.

To start the workflow for a form, complete the following steps on the Manage Forms page:

1. Select the form that contains the workflow that you want to start and click ►.

2. A confirmation message appears. Click Start to start the workflow. The status for the form changes to Awaiting data entry.

For the workflow to continue, the users that you specified as assignees must enter the applicable data into the form and then submit their changes.

Set the Workflow to Stop After the Cycle Completes

You can set a data-entry form to stop its workflow cycle after the form has been submitted and approved by all of the applicable users.

To set the workflow to stop at the end of a cycle, complete the following steps on the Manage Forms page:

1. Select the form that contains the workflow that you want to stop and click ■.

2. A confirmation message appears. Click Stop. When the form has been submitted and approved by all of the applicable users, the workflow stops.

You must click ► to start the form’s workflow again.

Immediately Stop the Workflow and Delete All Work

You can stop the workflow of a data-entry form immediately. All of the data that has been entered and submitted, as well as any approvals, are deleted.

CAUTION! You cannot undo an immediate workflow stoppage. All of the work that has been submitted or approved in the workflow is permanently deleted.

To immediately stop the workflow, complete the following steps on the Manage Forms page:

1. Select the form that contains the workflow that you want to stop and click ■.

2. A confirmation message appears. Click Stop. The workflow stops and the status for the form changes to Workflow not started.
You must click ➤ to start the form’s workflow again.

Create and Edit a Performance Data-Entry Portlet

For users to access the data-entry form, you must create a Performance Data-Entry portlet. To create a portlet, see Chapter 25, “Creating a Portlet,” on page 247.

For information about editing and customizing the portlet, see “Edit a Performance Data-Entry Portlet” on page 291.
Entering Data Manually

Data-Entry Form Considerations

When you are using a data-entry portlet, remember the following considerations:

- It is possible to have multiple data-entry portlets on a portlet page.
- The same data entry form can appear in multiple portlets on a portal page.
- Data entered in one instance of the portlet might not be immediately reflected in another instance of the portlet.

Enter Data in a Form without a Workflow

You can use the data-entry portlet to enter scorecard data for a date or for period of time.

To enter data in a data-entry portlet:

1. Access the portal page that includes the data-entry portlet.
2. In the Date field, select the date for which you want to enter data.
   
   Note: Due to customization, this field might not be enabled.
3. From the Period type list, select the period type for which you want to enter data.
4. From the Scorecard list, select the scorecard for which you want to enter data.
5. Click to enter comments about the form. For more information about making comments, see the SAS Information Delivery Portal help.
6 Enter values in the cells in the form. When you enter data, remember the following considerations:
   - The column headings indicate whether its cells are text or numeric.
   - When you click in a Read-Only cell, the cell appears gray.
   - Percentages, commas, inline formulas, currency, or any other notation are not supported in data-entry forms.

7 To save the data entered into a form, click Submit.

---

Enter Data in a Form with a Defined Workflow

If a form has a defined workflow, all of the affected data-entry users must enter and submit the data in the form. To enter data:

1 Access the portal page that includes the data-entry portlet.

2 In the Date field, select the date for which you want to enter data.
   Note: Due to customization, this field might not be enabled.

3 From the Period type list, select the period type for which you want to enter data.

4 From the Scorecard list, select the scorecard for which you want to enter data.

5 Enter values in the fields in the data-entry table.

6 If you want to enter comments about the form, click . For more information about making comments, see the SAS Information Delivery Portal help.

7 If you want to clear the form of any unsaved changes, click Discard Changes.

8 To save the data entered into a form, click Save. You can return to the form and make further updates.

9 When your work in the form is complete, click Submit.
   Note: You can no longer access the form after you submit it. To access the form again, the workflow must start again.

---

Approve Data

If a form has a defined workflow, the form is submitted by the data-entry users after all of the data is entered. Then, the workflow starts the approval process. Depending on how the workflow is defined, one or more approvers must review and approve the data. Also, approvers might have to approve the data in a specified order.

To approve data that was entered by one or more data-entry users:

1 Access the portal page that includes the data-entry portlet.
If you want to approve the data that was submitted only by a specific data-entry user, make sure that the user is selected in the Submitter list. Otherwise, if you want to approve the data that was submitted by all of the data-entry users, make sure that (all) is selected in the Submitter list.

3 Click Approve.

4 A confirmation message appears. Click Approve again. The data is stored in the system and is available for viewing.

If the form has completed the specified workflow process, the following message appears: The form has completed the approval process. The form does not require any further actions.

If the form has not completed the specified workflow process, the following message appears: The form is partially approved. Other approvers must complete the approval process. You have completed your actions for this form.

---

Reject Data

To reject data that was entered by one or more data-entry users:

1 Access the portal page that includes the data-entry portlet.

2 If you want to reject the data that was submitted only by a specific data-entry user, make sure that the user is selected in the Submitter list. Otherwise, if you want to reject the data that was submitted by all of the data-entry users, make sure that (all) is selected in the Submitter list.

3 Click Reject.

4 A confirmation message appears. You can enter comments to the data-entry user in the text field.

5 Click Reject. The form is made available to the affected user so that the user can make corrections.
Importing Data into a Strategy Management Project

Importing Data by Using the Import Wizard

Overview

SAS Strategy Management provides an Import wizard that you can use to import data into a SAS Strategy Management project. The project and its template must already exist in SAS Strategy Management. You can define the project by using either Strategy Management Builder or the Batch Maintenance Facility (BMF). After you define the project, you can define how to import your data by using the Import wizard. You can import a scorecard hierarchy, but you cannot import content for the scorecards. Alternatively, you can import content into a pre-existing scorecard hierarchy. In the wizard, you select the source data file to use. Then, you specify...
how the columns of data in the source file map to the new hierarchy or to columns in SAS Strategy Management scorecards.

For more information about Strategy Management Builder, see “Part 2. Describing and Building Your Strategy” in this User’s Guide. For more information about the BMF, see the SAS Strategy Management: System Administration Guide.

Types of Imports

You can import data in one of two ways:

- use a hierarchy configuration that creates the scorecard hierarchies only
  
  When you run the hierarchy configuration, the hierarchy that is specified in the source data file is imported into the SAS Strategy Management project as scorecards. You can populate the scorecard hierarchy by using the content configuration or the Batch Maintenance Facility.

- use a content configuration that creates element data and cell data for the scorecards
  
  The content configuration requires that a scorecard hierarchy already exist in the project. The hierarchy might contain other data as well. When you run the content configuration, the data in the source data file is imported into the SAS Strategy Management scorecards as element and cell data, or as project-level elements.

Supported Source Data Files

You can import data from the following types of source files:

- SAS data sets
- Microsoft Excel files

These data source files must be either registered or unregistered.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Data Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unregistered</td>
<td>Indicates that the file is located on a file system that is accessible to the middle tier. For more information, see “Local Microsoft Excel Files and Shared Directories” on page 339.</td>
<td>Excel spreadsheet files</td>
</tr>
<tr>
<td>Registered</td>
<td>Indicates that the file is registered in the SAS Metadata Repository. To register a file, contact your SAS Strategy Management administrator. For more information, see “Registering Files” in the SAS Strategy Management: System Administration Guide.</td>
<td>Excel spreadsheet files, SAS data sets</td>
</tr>
</tbody>
</table>

Remember the following limitations when you use Excel spreadsheet files:

- Excel files from version 2007 or later are supported.
SAS Strategy Management cannot read an Excel spreadsheet if that spreadsheet is currently open in Excel. Excel locks the file when the file is open.

You cannot register or read an Excel spreadsheet that is located on a server that is running UNIX. Excel spreadsheets use a data structure that is specific to Microsoft. The Import wizard uses Microsoft technology to read the spreadsheet. This technology does not currently exist on UNIX. However, you can register and read SAS data sets that are located on servers that are running UNIX.

SAS Strategy Management cannot read Excel spreadsheets that are located on a different network domain than the domain where the middle tier is located. This limitation applies to registered and unregistered spreadsheets.

## Registering Source Data Files

To import data that is located in SAS data sets, the data sets must be registered. Excel files can be registered also. Contact your SAS system administrator to determine whether a SAS data set or Excel spreadsheet is registered. For more information, see “Registering Files” in the *SAS Strategy Management: System Administration Guide*.

## Local Microsoft Excel Files and Shared Directories

If you want to use unregistered Excel spreadsheet files, the files must be located where the middle-tier server can access them. That is, the files must be local and must be in a shared directory.

The spreadsheet file location must meet the following criteria:

- The file must be on a Windows system (not UNIX).
- The file must be in a directory whose permissions grant Read access to the Java Virtual Machine on the middle-tier server.

  **Note:** Your system administrator can confirm that these permissions are set.

- The file must be on the same network domain as the middle-tier server.

Typically, the file system of the middle-tier server satisfies these requirements. If you locate the spreadsheet file on a different file server, you must provide the full Universal Naming Convention (UNC) file path to the spreadsheet file when you specify your local Excel source data.

## Source Data Organization

### Overview

In order to successfully import your data into SAS Strategy Management, the data must meet certain criteria.
SAS data sets and Excel spreadsheets store data in different ways:

- SAS organizes data into variables and stores the variable as either character or numeric data only.
- Excel organizes data into cells that you can format by using a variety of data types. To see these data types, right-click in a cell and select **Format cells**.

You can express any item as a character string in both SAS and Excel data. In SAS, you can store the numeric value 64.35 as the character value `64.35` in a SAS data set:

```
data temp;
  input value $8;
cards;
  64.35
;
```

In Excel, you can create a worksheet, type `64.35` in a cell, and then format the cell as character data by using the General cell format provided by Excel. Both of these formatting techniques affect how SAS Strategy Management imports the data.

The two formatting techniques especially affect date values. The following sections describe both data file types, SAS and Excel, and what to consider when you create them.

### Data-Column Naming Requirements for Excel Files

The Import wizard views the input data as a table (a series of rows and columns of values). The rows are referred to by number. The first row of data values is row 1. Each column has a name. SAS software and Excel assign names differently:

- SAS software automatically bases the name of each column on the name of the variable with which the column is associated.
- Excel automatically uses ascending letters of the alphabet to name each column.

The Import wizard cannot use the Excel method of naming columns. For Excel files, you must create column names in row 1. **CAUTION!** If you omit this change, the Import wizard uses the first row of data as the column names.

When the Import wizard displays the data columns in the **Preview** fields or lists, you might notice that the column names differ from the actual text values that you specified. For example, if you used the underscore character, it is converted to a blank. This type of change does not affect the way the Import wizard processes the column names.

### Date Representation Considerations

#### Overview

By default, the Import wizard expects date values to be stored as numeric values in SAS data sets and as date-formatted cells in Excel. When you select **Use as defined in source**, you accept this default way that the Import wizard expects SAS and Excel to create date values. The **Use as defined in source** check box is located in the **Source date format** list in the Import wizard.
Numeric Dates in SAS

The following code is an example of a SAS program:

```sas
data dsets.measuresdates;
  input sccode $ element $ startperiod : mmddyy8. endperiod : mmddyy8. value period : mmddyy8.;
cards;
code1 element1  11-01-11 11-30-11 36.3 11-01-11
code2 element2  12-01-11 12-31-11 43.2 12-01-11
;
```

The variables `startperiod`, `endperiod`, and `period` are numeric variables. The SAS informat `mmddyy8.` is associated with each them. If you run this program and invoke the PRINT procedure on the results, you receive the following output:

The SAS System

<table>
<thead>
<tr>
<th>Obs</th>
<th>sccode</th>
<th>element</th>
<th>startperiod</th>
<th>endperiod</th>
<th>value</th>
<th>period</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>code1</td>
<td></td>
<td></td>
<td>18932</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>code2</td>
<td></td>
<td>18962</td>
<td>18992</td>
<td>43.2</td>
<td>18962</td>
</tr>
</tbody>
</table>

The date value 11-01-11 appears as the numeric value 18932. This is the date value when SAS stores it as a numeric value.

Date-Formatted Cells in Excel

In an Excel spreadsheet, you can type a date value in the first cell, and then right-click the cell and select **Format Cells**. The following figure shows that Excel has applied a date format to the value by default.

Note: You can also manually specify **Date** in this window.
Dates as Character Values in SAS and Excel

The following SAS program reads the date value as a character string:

```sas
data dsets.measuresdates;
  input sccode $ element $ startperiod $ endperiod $ value period $;
cards;
  code1 element1 11-01-11 11-30-11 36.3 11-01-11
  code2 element2 12-01-11 12-31-11 43.2 12-01-11
;
```

The variables `startperiod`, `endperiod`, and `period` are character variables. If you run this program and invoke the PRINT procedure on the results, you receive the following output:

```
Obs sccode element startperiod endperiod value period
  1 code1 element1 11-01-11 11-30-11 36.3 11-01-11
  2 code2 element2 12-01-11 12-31-11 43.2 12-01-11
```

The date value 11–01–11 appears as the character value 11–01–11. This is the date value when SAS stores it as a character value.

On the Number tab in the Format Cells window in Excel, you can select General as the format of the cell.

**CAUTION! Do not store dates in the Text format.** For the import to succeed when using Excel data, dates can be stored only in the General or Date format.

Both of these methods create a date value as a character string. The Import wizard cannot read these values correctly by using the default setting. Instead, you must
select a source date format in the Import wizard that matches the format that you used to create the date value. For the Excel example, select the MM/dd/yyyy format.

Changing Source Data Files and Its Consequences

After you create an import configuration, an association exists between the configuration and your source data file. Because of this association, you must avoid making certain changes to the source data file.

<table>
<thead>
<tr>
<th>Change Affects Only Data Values</th>
<th>Change Affects Data Structure or Mapping Associations</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following changes affect the data values, but not the structure of the data:</td>
<td>The following changes affect the structure of the data or the data mapping associations between the source data file and the import configuration:</td>
</tr>
<tr>
<td>- adding rows of data</td>
<td>- adding columns</td>
</tr>
<tr>
<td>- deleting rows of data</td>
<td>- deleting columns</td>
</tr>
<tr>
<td>- changing values in a cell</td>
<td>- renaming column headings</td>
</tr>
</tbody>
</table>

You cannot make structural changes to the source data file without updating the configuration. If the source data file is registered, you must update the metadata of the source data file by using SAS Management Console.

For example, suppose you define a configuration that uses an unregistered Excel spreadsheet and a worksheet called MySheet$. Then, you edit the Excel spreadsheet and rename the worksheet to DifferentSheet$. Because of this change, you must edit the content configuration. On the Select Source Data page, you must select the new worksheet name.

Note: This correction does not work for a registered Excel spreadsheet. Instead, in the SAS Management Console Data Library Manager, you must delete the old table named MySheet$ and register the renamed worksheet.

As another example, suppose a SAS data set is associated with a configuration and you add a new column to the data set. After you save the changes, you must delete the old table and register the changed data set in the SAS Management Console Data Library Manager.

**TIP** If the file does not successfully import after you reregister it, consider creating a new import configuration.
Define How to Import Data from a Source File

The content configuration requires that a scorecard hierarchy already exist in the project. The hierarchy might contain other data as well. When you run the content configuration, the data in the source data file is imported into the SAS Strategy Management scorecards as element and cell data, or as project-level elements.

To define how SAS Strategy Management imports data from a source file:

**CAUTION! In the following procedure, do not select the same column from your source data more than once.** The column mappings must be one-to-one. Otherwise, the import configuration fails when you run it.

1. In an open scorecard, select **Project » Manage Import Options**. The Import page appears.

2. In the toolbar, click 📚 and then click **New Content Import Configuration**. The Import Content wizard appears.

3. On the Identification page, type a name that is unique within this SAS Strategy Management project. A description is optional.

4. Click **Next**.

5. On the Select Source Data page, select the type of data that you want to import.
Local source data  If your source file is located on your local system, select Local Excel source data. Typically, you select this option if you are importing a Microsoft Excel file that is unregistered.

In the File path field, type the file path and click Retrieve.

Note: The file path must include the computer name. In the following example, the system is called MYCOMPUTER. If the file is located on a system that is running Windows, an example file path is `\MYCOMPUTER\spreadsheets\monthly_reports.xlsx`. For more information, see “Local Microsoft Excel Files and Shared Directories” on page 339.

From the Worksheet list, select the Excel worksheet that contains the data that you want to use.

SAS server source data  If you want to import a SAS data set or Excel spreadsheet, select SAS server source data.

Note: SAS data sets or Excel spreadsheets must be registered before you can use them. For more information, see “Registering Source Data Files” on page 339.

In the Select window, navigate to the table that you want to import and select it. Then, click OK.

6  A preview table appears in the wizard. In this table, view the data that is contained in the file that you selected.

7  Click Next.

8  On the Map Element Types page, select the element type name to use when the source data is imported.
| **Element type** | If you want to import all of the data by using the same element type name or if the source data does not include the element type name to use, select the element type from the **Element type** list.  
**Note:** The selections in this list are the element types that are already defined in the current SAS Strategy Management template. |
| **Element type column** | If your source data includes the element type information, select the column that provides the element type information. The data that the column contains appears in the **Preview** field so that you can verify your selection.  
**Note:** The selections in this list are the columns that are in the source data. Select the column name that contains the elements to import. |

**Note:** Element type names in the source data must match the element type names that are defined in the Strategy Management template.

9 Click **Next**.

10 On the Map to Hierarchy page, map the content in the source data to an existing scorecard in a SAS Strategy Management project. When you define this mapping, you implicitly map your data to the hierarchy in which the scorecard exists in the project. Alternatively, you can map the content to elements of a project.

**TIP** A hierarchy represents the levels in your scorecard tree. You can have a root level, parent levels, and child levels. The following hierarchy of scorecards is an example: worldwide, division, department, and group. Worldwide is the root level. Division is a child of worldwide and a parent of department, and so on.

| **Identifier column** | These selections are the columns that are in the source data. Select the column name that contains the unique scorecard identifiers that are already defined in the SAS Strategy Management project. The data that the column contains appears in the **Preview** field so that you can verify your selection.  
**Note:** If you have already selected a column in the Import wizard, do not select it again. |
| **Hierarchy levels** | From the **Available items** list, select columns from the source data to map to the scorecard hierarchy in your SAS Strategy Management project. You can change the order of the levels in the **Selected items** list.  
**Note:** A best practice is to map the same number of levels that you are importing. For example, if you are importing two levels of data, then map only two levels of the hierarchy.  
**Note:** If you have already selected a column in the Import wizard, do not select it again. |

| **Import as project-level elements** | If the project has project-level element types defined, use this selection to create project-level elements from your source data. |
11 On the Map Elements page, map the element column in the source data to the elements that are in the scorecards of the SAS Strategy Management project. If the source data contains elements that are not in the project, you can create them. Complete the following steps:

a If you want the import process to create elements that exist in the source data but that do not exist in the project, click **Create elements that do not exist**.

b From the **Element column** list, select the column name in the source data that contains the elements to import. The data that the column contains appears in the **Preview** field so that you can verify your selection.

Note: If you have already selected a column in the Import wizard, do not select it again.

c If the source data contains start and end dates for the elements, specify the date format and select the applicable columns from the source data. For more information, see “Date Representation Considerations” on page 340.

- If the date values are stored as numeric values in your source data, click **Use as defined in source**.
- If the date values are stored as character values in your source data, select the format from the **Source date format** list that matches the format of your date character values.

**CAUTION! Do not store dates in the Text format.** For the import to succeed when using Excel data, dates can be stored only in the General or Date format.

- From the **Start date column** list, select the column to use for the start dates.

  **TIP** Select **Float** to specify that the affected dates are always valid for that selection.

  Note: If you have already selected a column in the Import wizard, do not select it again.

- From the **End date column** list, select the column to use for the end dates.

  **TIP** Select **Float** to specify that the affected dates are always valid for that selection.

  Note: If you have already selected a column in the Import wizard, do not select it again.

12 Click **Next**.

13 On the Map Attributes page, map the source data to the metric attributes content that is defined in SAS Strategy Management. Complete the following steps:

a If you are importing source data into scorecards that contain metric attributes that already contain manually entered values, click **Overwrite cells that contain manually-entered values**. Selecting this option ensures that the imported data overwrites the pre-existing data in the scorecards. Otherwise, the imported data for the affected metric attributes is ignored.
b If you are importing source data into scorecards that contain metric attributes that already contain formulas, click Overwrite cells that contain formulas. Selecting this option ensures that the imported data overwrites the pre-existing formulas in the scorecards. Otherwise, the imported data for the affected metric attributes is ignored.

c Choose the mapping option that matches the organization of your source data:

**Metric attributes are in one row**
The source data typically has only one row for each element. An element might have one or more metric attributes, such as Actual and Target. The row contains columns that describe the value, text, and link for one or more metric attributes. The following table provides an example:

<table>
<thead>
<tr>
<th>element</th>
<th>actual</th>
<th>target</th>
<th>Link actual</th>
<th>Link target</th>
</tr>
</thead>
<tbody>
<tr>
<td>grow</td>
<td>1</td>
<td>2</td>
<td>finance numbers</td>
<td>future</td>
</tr>
<tr>
<td>prosper</td>
<td>1</td>
<td>2</td>
<td>google finance</td>
<td>future</td>
</tr>
</tbody>
</table>

**Each metric attribute is in its own row**
The source data has multiple rows for an element. Each row can define the value, text, link, or rule for one metric attribute. For example, one row defines the value, text, or link for the metric attribute called Actual, and another row defines the value, text, or link for the metric attribute called Target. The following table provides an example:

<table>
<thead>
<tr>
<th>element</th>
<th>metric attribute</th>
<th>value</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>grow</td>
<td>actual</td>
<td>1</td>
<td>finance numbers</td>
</tr>
<tr>
<td>grow</td>
<td>target</td>
<td>2</td>
<td>future</td>
</tr>
<tr>
<td>prosper</td>
<td>actual</td>
<td>1</td>
<td>google finance</td>
</tr>
<tr>
<td>prosper</td>
<td>target</td>
<td>2</td>
<td>future</td>
</tr>
</tbody>
</table>

Note: To use rules with the Import wizard, the rule definitions must already exist in the project. Then the Import wizard can apply the rules to the metric attributes. For more information, see Chapter 10, “Defining Rules,” on page 119.

For more information, see “Source Data Organization” on page 339.

14 Click **Next**.

15 On the Map Time page, map the column in the source data that contains date values. The date values must map to time periods that are defined in SAS Strategy Management. The metric attribute value, text, and link are associated with these date values. Complete the following steps:

a From the **Time period column** list, select the column that provides the time period for your data. The data that the column contains appears in the **Preview** field so that you can verify your selection.

Note: If you have already selected a column in the Import wizard, do not select it again.

b From the **Period type** list, select the type of time period (for example, month or year) that the date values use.

16 Click **Next**.
On the Preview Mappings page, preview a sample of the specified mappings that you want to use for your data. When you are satisfied, click **Finish** to save and run the import configuration.

**TIP** If you want to save the import configuration but you do not want to run it, click **Save as Draft**. The import configuration is saved to the selection list. When you want to run it, select the import configuration and click.

The Import selection list appears and includes the new import configuration. The **Status** column indicates whether the configuration ran successfully. If the status icon indicates that errors occurred, click that icon to view the error log.

**Define How to Import a Hierarchy from a Source File**

When you run the hierarchy configuration, the hierarchy that is specified in the source data file is imported into the SAS Strategy Management project as scorecards. You can populate the scorecard hierarchy by using the content configuration or the Batch Maintenance Facility. To define how SAS Strategy Management imports data from a source file:

1. In an open scorecard, select **Project > Manage Import Options**. The Import page appears.

2. In the toolbar, click and then click **New Hierarchy Import Configuration**. The Import wizard appears.
3 In the **Identification** section, type a name that is unique within this SAS Strategy Management project. A description is optional.

4 Expand the **Select Source Data** section.

5 Select the type of data that you want to import.

| **Local source data** | If your source file is located on your local system, select **Local Excel source data**. Typically, you select this option if you are importing a Microsoft Excel file that is unregistered.  
In the **File path** field, type the file path and click **Retrieve**.  
Note: The file path must include the computer name. In the following example, the system is called MYCOMPUTER. If the file is located on a system that is running Windows, an example file path is `\MYCOMPUTER\spreadsheets\monthly_reports.xlsx`. For more information, see “Local Microsoft Excel Files and Shared Directories” on page 339.  
From the **Worksheet** list, select the Excel worksheet that contains the data that you want to use. |
| **SAS server source data** | If you want to import a SAS data set or Excel spreadsheet, select **SAS server source data**.  
Note: SAS data sets or Excel spreadsheets must be registered before you can use them. For more information, see “Registering Source Data Files” on page 339.  
In the Select window, navigate to the table that you want to import and select it. Then, click **OK**. |

6 A preview table appears in the wizard. In this table, view the data contained in the file that you selected.
7 Expand the **Map to Hierarchy** section.

8 Define the order of the hierarchy levels in the source data and specify their relationship for use in scorecards. SAS Strategy Management uses this information to build the scorecard hierarchy in the project.

From the **Available items** list, select columns from the source data to map to the scorecard hierarchy in your SAS Strategy Management project. You can change the order of the levels in the **Selected items** list.

**TIP** A best practice is to map the same number of levels that you are importing. For example, if you are importing two levels of data, then map only two levels of the hierarchy.
A hierarchy represents the levels in your scorecard tree. You can have a root level, parent levels, and child levels. The following hierarchy of scorecards is an example: worldwide, division, department, and group. Worldwide is the root level. Division is a child of worldwide and a parent of department, and so on.

(Tip) From the Unique scorecard identifiers list, select a column from the source data that provides unique scorecard identifiers. The data that the column contains appears in the Preview field so that you can verify your selection.

Click Save to save the import configuration. The Import selection list appears and includes the new import configuration.

Open an Import Configuration

To open an import configuration, double-click the configuration in the selection list or select the configuration from the selection list and then click Open.

Run an Import Configuration

To run an import configuration, select the configuration from the selection list and then click Run. The configuration runs, and its status is reported in the Status column of the selection list.

Note: Do not run more than one configuration at a time. This is especially true if a content configuration requires that its hierarchy already be created by a hierarchy configuration.

View the Import Configuration Error Log

If a configuration did not run successfully, you can view its error log. Double-click the status icon in the Status column of the selection list.

Copy an Import Configuration

To copy an import configuration, select the configuration from the Import selection list and then click Copy. A copy of the import configuration is created, which you can then edit.
Delete an Import Configuration

To delete an import configuration, select the configuration from the import selection list and then click the delete button. The import configuration is deleted.

Delete an Import Configuration
Part 7

Creating Reports

Chapter 36
Creating Reports Using SAS Information Maps .......................... 357

Chapter 37
Viewing Strategy Management Reports in Microsoft Office ............. 359

Chapter 38
Accessing Strategy Management Data from Microsoft Excel .......... 361
Creating Reports Using SAS Information Maps

You can create reports using SAS Information Maps. Information maps can be used in many SAS products, including the following:

- SAS Information Map Studio
- SAS BI Dashboard
- SAS Web Report Studio

For more information, see the documentation for these products. For information about saving a scorecard as a SAS Information Map, see “Save a Scorecard as a SAS Information Map” on page 85.
Overview

By using the SAS Add-In for Microsoft Office plug-in with SAS Strategy Management, you can view SAS Strategy Management reports in the following Microsoft applications:

- Excel
- Outlook
- PowerPoint
- Word

To determine whether SAS Add-in for Microsoft Office is installed, open any of these Microsoft Office applications. If the tabs for the ribbon bar across at the top of the window include a **SAS** tab, the plug-in is installed. For information about installation, see the SAS Add-in for Microsoft Office documentation at [http://support.sas.com/documentation/onlinedoc/addin/index.html](http://support.sas.com/documentation/onlinedoc/addin/index.html).

Creating a SAS Strategy Management Report

To create a SAS Strategy Management report that you can view in Microsoft Office:

1. In Strategy Management Builder, open a project.

2. Select **Scorecard** ➤ **Save As SAS ROM Report**. The New Report wizard appears.

3. On the Location page, navigate to the location where you want to save the report and select the folder. Click **Next**.
On the Properties page, type a name for the report. A description is optional. Click Next.

Review the Summary page. When you are satisfied, click Finish to exit the wizard. The report is saved to the location that you selected. A message appears, which states that the report was created.

**Viewing a SAS Strategy Management Report**


The following restrictions apply to the specified Microsoft Office applications:

- (PowerPoint only) You cannot view SAS Strategy Management diagrams or icons that were included with diagrams by using PowerPoint. An error message appears if you attempt to do so.
- (Excel only) Columns that contain time periods do not display the time periods the same as in Outlook or in the Strategy Management Builder.
- (Excel, PowerPoint, and Word only) Columns that contain e-mail addresses and web addresses do not provide active links. The links are active in Outlook.
- (All Microsoft Office applications) Links that are specified for metric attributes are not active when you view SAS Strategy Management reports in any Microsoft Office application.

### Enable Colors for Ranges

Reports that include range icons and colors might fail to display the colors. To enable the color display in ranges:

1. On the Microsoft Office application Ribbon, select **SAS** ▶ **Tools** ▶ **Options**. The SAS Options window appears.
2. Click the **Results** tab.
3. In the **Format** list, select **SAS Report**.
4. Select **Always apply the SAS style to the results**.
5. Select **sasweb** from the style list.
6. Click **OK** to save the settings.
Accessing Strategy Management Data from Microsoft Excel

You can access the value of a scorecard element metric attribute from within Microsoft Excel. Using the following function, you can place the value directly into a cell or use the value as part of a formula.

Note:
- To access the data in SAS Strategy Management, you must be logged on to SAS Strategy Management, and have Read access permission to the numeric attribute.
- Each name in an argument must match the name that is used with the default language for the template.
- No validation is performed on the values of the arguments. If any problems arise with the values, the function returns an empty string.

The function uses the following syntax:

```
GETSPMCELLVALUE(Template, Project, Scorecard, Element-Type, Element, Metric-Attribute, Date)
```

This function uses the following arguments:
- `Template` is a quoted string that represents the template name.
- `Project` is a quoted string that represents the project name.
- `Scorecard` is a quoted string that represents the scorecard name.
- `Element-Type` is a quoted string that represents the element type name.
- `Element` is a quoted string that represents the element name.
- `Metric-Attribute` is a quoted string that represents the metric attribute name.
- `Date` is a quoted string that represents a valid date. This is the specific date for which to return the value of the metric attribute. The format can be any recognizable date format.
Appendix

Appendix 1
  Strategy Management Function Dictionary .......................... 365

Appendix 2
  Configuring Java ............................................................... 383

Appendix 3
  View SAS Strategy Management Data in SAS BI Dashboard ........ 387
Appendix 1

Strategy Management Function Dictionary

Functions for Use in Formulas .................................................. 365
Get the Value of an Element ..................................................... 381
Specify a Current or Relative Period in a Function .................. 381
Specify a Range in a Function .................................................. 381
Specify a Full Reference to an Element or Attribute .............. 382

**Functions for Use in Formulas**

The following functions are specific to SAS Strategy Management. These functions are available for selection on the Functions tab of the Formula Editor.

**Note:**

- The case that you choose to use for a function does not affect that function in a formula. Uppercase, lowercase, and mixed case are all valid.

- Both parentheses and square brackets are valid in formulas. The examples in the following table use parentheses.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS</td>
<td>Returns the absolute value of its only argument.</td>
<td>ABS(-20) returns 20.</td>
</tr>
<tr>
<td>Syntax:</td>
<td>ABS(value)</td>
<td>value is a numeric value.</td>
</tr>
<tr>
<td>ACOS</td>
<td>Returns the arccosine, in radians, of its only argument.</td>
<td>ACOS(-0.5) returns 2.094395.</td>
</tr>
<tr>
<td>Syntax:</td>
<td>ACOS(value)</td>
<td>value is a numeric value between –1 and +1, inclusive.</td>
</tr>
<tr>
<td>ASIN</td>
<td>Returns the arcsine, in radians, of its only argument.</td>
<td>ASIN(-0.5) returns -0.52360.</td>
</tr>
<tr>
<td>Syntax:</td>
<td>ASIN(value)</td>
<td>value is a numeric value between –1 and +1, inclusive.</td>
</tr>
<tr>
<td>ATAN</td>
<td>Returns the arctangent, in radians, of its only argument.</td>
<td>ATAN(1) returns 0.78540.</td>
</tr>
<tr>
<td>Syntax:</td>
<td>ATAN(value)</td>
<td>value is a numeric value.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>attribute</td>
<td>Returns the string representation of the value of an attribute.</td>
<td>attribute(ELE=current(&quot;ELE&quot;))(ATTR=&quot;Status&quot;) returns the text value of the attribute Status for the current element.</td>
</tr>
<tr>
<td>Syntax: attribute(element) (attribute) (period)</td>
<td></td>
<td>attribute(ELE=current(&quot;ELE&quot;))(ATTR=&quot;End Date&quot;) returns the attribute value of the attribute End Date for the current element. The returned value is the SAS numeric Date value representing the number of days since January 1, 1960 to the value of End Date.</td>
</tr>
<tr>
<td>attributeIsMe</td>
<td>Selects the elements that are associated to the current element. Typically this function is used to provide input to another function.</td>
<td>SUM( ATTRIBUTEISME(ATTR=&quot;Initiative</td>
</tr>
<tr>
<td>Syntax: ATTRIBUTEISME(element) (attribute) (period)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CEIL</td>
<td>Returns the smallest integer that is greater than or equal to its only argument.</td>
<td>CEIL(5.3) returns 6</td>
</tr>
<tr>
<td>Syntax: CEIL(value)</td>
<td></td>
<td>CEIL(5.0) returns 5</td>
</tr>
</tbody>
</table>

The combination of these arguments identifies the string value of an attribute. The value must be one of the following types:
- Text
- E-mail address
- Date
- Web address (URL)
- Element type
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| CHILDREN | Returns an array of values for the immediate children of the specified element. Use this function to provide input to other functions that use a list of values as input (for example, MEAN). | ```
SUM ( CHILDREN ( ELE=Current( "ELE" ) ) ( COL=Current( "COL" ) ) ( PER = Current( "PER" ) ) )
``` |
| COMPRESS | Returns a string that is formed by removing certain characters from an input string. You can use this function with either one argument or two arguments. | ```
COMPRESS ( ' A B C D ' ) returns the string `ABCD`
COMPRESS ( ' A+B-C=D' , ' +-= ' ) returns the string `ABCD`
``` |
| COS | Returns the cosine of its only argument. | ```
COS ( 0.5 ) returns 0.87758.
``` |
| Current | Returns the current dimension member, given the dimension type. This function is typically used as part of a relative reference within a time hierarchy. | ```
CURRENT ( "ELE" ) return the current element.
``` |
| DATE | Returns the SAS integer representation of the date on which it is evaluated. | ```
On January 1, 1960, DATE ( ) returns 1.
On January 2, 1960, DATE ( ) returns 2.
On February 1, 1960, DATE ( ) returns 32.
```
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATETIME</td>
<td>Returns the number of seconds that have elapsed since the beginning of January 1, 1960.</td>
<td>You can use the PUTN function to convert the value returned by the DATETIME function to a readable exact time, as follows: PUTN(DATETIME(), &quot;DATETIME.&quot;)</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: DATETIME()</td>
<td></td>
</tr>
<tr>
<td>DAYOFMONTH</td>
<td>Returns the sequence number of the day on which it is evaluated within the month in which it is evaluated.</td>
<td>On the twelfth day of any month DAYOFMONTH() returns 12.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: DAYOFMONTH()</td>
<td></td>
</tr>
<tr>
<td>DAYOFWEEK</td>
<td>Returns the sequence number of the day on which it is evaluated within the week in which it is evaluated, starting with Sunday as day 1.</td>
<td>On any Thursday DAYOFWEEK() returns 5.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: DAYOFWEEK()</td>
<td></td>
</tr>
<tr>
<td>DAYOFYEAR</td>
<td>Returns the sequence number of the day on which it is evaluated within the year in which it is evaluated, starting with January 1 as day 1.</td>
<td>On February 10 of any year DAYOFYEAR() returns 41.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: DAYOFYEAR()</td>
<td></td>
</tr>
<tr>
<td>EXP</td>
<td>Returns the result of raising e to the power that is specified in its only argument. e is the base of the natural logarithms, which is approximately 2.718.</td>
<td>EXP(LOG(2.65)) returns 2.65.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: EXP(value)</td>
<td>The EXP function is the inverse of the LOG function.</td>
</tr>
<tr>
<td></td>
<td>value is a numeric value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The EXP function is the inverse of the LOG function.</td>
<td></td>
</tr>
<tr>
<td>FLOOR</td>
<td>Returns the largest integer that is less than or equal to its only argument.</td>
<td>FLOOR(5.3) returns 5.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: FLOOR(value)</td>
<td>FLOOR(5.0) returns 5.</td>
</tr>
<tr>
<td></td>
<td>value is a numeric value.</td>
<td></td>
</tr>
<tr>
<td>ForAll</td>
<td>Returns Boolean true when all values in an array of values satisfy a logical condition.</td>
<td>ForAll(children((ELE=&quot;Revenue&quot;) (COL=&quot;Actual&quot;) (PER=current(&quot;PER&quot;) ) &gt; 0.5 returns true when all of the children of element Revenue have a value greater than 0.5.</td>
</tr>
<tr>
<td></td>
<td><strong>Syntax</strong>: ForAll(value1, value2, ..., value_n)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value1, value2, and value_n are numeric values in an array of values.</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ForAny</td>
<td>Returns Boolean true when any value in an array of values satisfy a logical condition.</td>
<td><code>ForAny(children((ELE=&quot;Revenue&quot;) (COL=&quot;Actual&quot;) (PER=current(&quot;PER&quot;)) &gt; 0.5)</code> returns true when any of the children of element Revenue have a value greater that 0.5.</td>
</tr>
<tr>
<td>ForNone</td>
<td>Returns Boolean true when no values in an array of values satisfy a logical condition.</td>
<td><code>ForNone(children((ELE=&quot;Revenue&quot;) (COL=&quot;Actual&quot;) (PER=current(&quot;PER&quot;)) &gt; 0.5)</code> returns true when none of the children of element Revenue have a value greater than 0.5.</td>
</tr>
<tr>
<td>IF</td>
<td>Returns a value that depends on the truth value of a Boolean expression.</td>
<td><code>IF(&quot;A&quot;=&quot;B&quot;,&quot;right&quot;,&quot;wrong&quot;)</code> returns 1.</td>
</tr>
<tr>
<td>INDEX</td>
<td>Returns an integer that indicates the starting position of a specified substring within a longer string.</td>
<td><code>INDEX(&quot;herewego&quot;,&quot;we&quot;)</code> returns 5.</td>
</tr>
<tr>
<td></td>
<td>where:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>boolean expression is a Boolean expression. If boolean is true, the IF function returns the value of expression1.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If boolean is false, the IF function returns the value of expression2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Boolean expression can contain two character values or two numeric values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Within the Boolean expression, you can use any of the Boolean operators and comparison operators that are available on the symbol toolbar.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>expression1 and expression2 are expressions of any kind. These expressions must be of the same data type. They must both yield numeric values, or they must both yield string values, or they must both yield Boolean values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>string1 and string2 are strings of any kind. They must both yield string values, or they must both yield Boolean values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>string2 is a potential substring in string1. If string2 occurs more than once in string1, then the INDEX function returns the starting position of the first occurrence of string2.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If string2 does not occur in string1, then the INDEX function returns 0.</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| INDEXC  | Returns an integer that indicates the first position in an input string that contains any character in a specified set of characters. **Syntax**: INDEXC(string1, string2) where:  
  - `string1` is a string to search.  
  - `string2` is a set of characters to search for in `string1`.  
If any of the characters specified in `string2` occur in `string1`, then the INDEX function returns the first position of the occurrence in `string1`.  
If none of the characters specified in `string2` occur in `string1`, then the INDEX function returns 0. |  
  - INDEXC("education","aeiou") returns 1.  
  - INDEXC("school","aeiou") returns 4.  
  - INDEXC("jklmn","aeiou") returns 0. |
| INPUTVALUE | When a data-entry user enters a value into a form, INPUTVALUE passes the value into a formula for evaluation. By passing in the value, this function enables the formula to test the value against a rule and to ensure that the value is valid in the form. **Note**: This function is supported only when you are specifying formula-based rules. For more information, see Chapter 10, "Defining Rules," on page 119. |  
if (inputvalue() / 100 > .7) is an example of a rule that evaluates the value that a user enters in a data-entry form. If the value is divided by 100 and is greater than 0.7, then the value passes the rule and is valid for the form. |
| LEFT | Returns a string that is formed by removing all the leading spaces from an input string. **Syntax**: LEFT(string)  
`string` is a character string. | LEFT(" abc") returns the string `abc`. |
| LENGTH | Returns the length of an input string. It takes one argument, which must have a character value. **Syntax**: LENGTH(string)  
`string` is a character string. | LENGTH("January") returns 7. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| LOG | Computes the natural logarithm of a number.  
**Syntax:** `LOG(value)`  
`value` is a numeric value greater than zero.  
**Note:** The LOG function is the inverse of the EXP function. | `LOG(EXP(2.65))` returns **2.65**. |
| LOWCASE | Returns a character string that is formed from an input character string by converting each uppercase letter to the corresponding lowercase letter.  
**Syntax:** `LOWCASE(string)`  
`string` is a character string. | `LOWCASE("HIGH5")` returns **high5**. |
| MAX | Returns the value of the argument that has the largest value.  
**Syntax:** `MAX(value1, value2, ..., value_n)`  
`value1, value2, and value_n` are numeric values in an array of values. This function can have any number of arguments.  
You can also specify ranges of values in this function. See “Specify a Range in a Function” on page 381. | `MAX(-5, -2.1, 0.3, 1.1, 1.3)` returns **1.3**. |
| MEAN | Returns the mean of the values of all its arguments. The mean is the sum of all the values, divided by the number of values.  
**Syntax:** `MEAN(value1, value2, ..., value_n)`  
`value1, value2, and value_n` are numeric values in an array of values. This function can have any number of arguments.  
You can also specify ranges of values in this function. See “Specify a Range in a Function” on page 381. | `MEAN(1, 2, 3, 3, 16)` returns **5**. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MIN</strong></td>
<td>Returns the value of the argument that has the smallest value.</td>
<td><strong>Example</strong>: MIN(−5, −2.1, 0.3, 1.1, 1.3) returns −5.</td>
</tr>
<tr>
<td>Syntax: <strong>MIN(value1, value2, ..., value_n)</strong></td>
<td>value1, value2, and value_n are numeric values in an array of values. This function can have any number of arguments. You can also specify ranges of values in this function. See “Specify a Range in a Function” on page 381.</td>
<td></td>
</tr>
</tbody>
</table>

| **MOD** | Returns the remainder after dividing value1 by value2. | **Example**: MOD(5, 2) returns 1. |
| Syntax: **MOD(value1, value2)** | value1 and value2 are numeric values. |

<p>| <strong>myAttribute</strong> | Selects the elements that are associated from the current element. | <strong>Example</strong>: SUM( MYATTRIBUTE( ( ATTR=&quot;MeasureSupported&quot; ) ( COL=&quot;Actual&quot; ) ( PER=current( &quot;PER&quot; ) ) ) ) |
| Syntax: <strong>myAttribute((element)(attribute)(period))</strong> | element is an element. attribute is a metric attribute associated with the element. period is the period of time associated with the element and its attribute. The combination of these arguments identifies an attribute of the element to which the formula is assigned. |</p>
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| NESTIF   | Returns the value of the first even-numbered argument that is associated with a true Boolean expression. **Note:** The NESTIF function accepts an even number of arguments, which are arranged in pairs. There is no limit to the number of arguments that the NESTIF function can accept. However, the number must be even. **Syntax:** NESTIF(boolean_expression, expression)  
  - boolean_expression is a Boolean expression that is associated with expression. It is the first argument of each pair (the odd-numbered arguments of the function). Within the Boolean expression, you can use any of the Boolean operators and comparison operators that are available on the symbol toolbar.  
  - expression is an expression whose value might be returned. It is the second argument of each pair (the even-numbered arguments of the function).  
  For even-numbered arguments (expression), all the even-numbered arguments must be of the same data type. They must all yield numeric values, or they must all yield character-string values, or they must all yield Boolean values.  
  For odd-numbered arguments (boolean_expression), if all the Boolean expressions in the odd-numbered arguments are false, then NESTIF returns a default value that depends, in the following way, on the data type of the even-numbered arguments:  
    - Numeric data type — SAS missing value  
    - Character-string data type — zero-length empty string  
    - Boolean data type — Boolean FALSE.  
  | NESTIF(1=2, "first", 1=1, "second") returns **second**.  
  | NESTIF(1=1, "first", 1=1, "second") returns **first**. |
| POW      | Returns the result of raising its first argument to the power that is given by its second argument. **Syntax:** POW(value1, value2)  
  - value1 is a numeric value.  
  - value2 is a numeric value that specifies a power by which to raise value1.  
  | POW(2, 4) returns **16**.  
  | POW(9, 0.5) returns **3**.  
<p>| POW(3, -2) returns <strong>1/9</strong> or <strong>0.11111...</strong> |</p>
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PUTC</strong></td>
<td>Returns the result of applying a specified SAS character format to a specified character value.</td>
<td>PUTC(LOWCASE(&quot;HELLO&quot;), &quot;$QUOTE.&quot;) returns &quot;hello&quot;.</td>
</tr>
<tr>
<td><strong>Syntax</strong></td>
<td>PUTC(value, format)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value is the character value to format.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>format is the SAS character format to apply to value.</td>
<td></td>
</tr>
<tr>
<td><strong>PUTN</strong></td>
<td>Returns the result of applying a specified SAS numeric format to a specified numeric value.</td>
<td>You can use the PUTN function to convert the value returned by the DATETIME function to a readable exact time by using the following syntax: PUTN(DATETIME(), &quot;DATETIME.&quot;)</td>
</tr>
<tr>
<td><strong>Syntax</strong></td>
<td>PUTN(value, format)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value is the numeric value to format.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>format is the SAS numeric format to apply to value.</td>
<td></td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>Returns the normalized value for an element. The normalized value is set in the range for each interval. If a range does not exist on the metric attribute, RANGE returns the value of the metric attribute.</td>
<td>If the value of element M2's Actual attribute is 99.85, range((ELE=&quot;M2&quot;) (COL=&quot;Actual&quot;) (PER=current(&quot;PER&quot;))) returns 3.75.</td>
</tr>
<tr>
<td><strong>Syntax</strong></td>
<td>RANGE((element)(attribute)(period))</td>
<td></td>
</tr>
<tr>
<td></td>
<td>element is an element.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>attribute is a metric attribute associated with the element.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>period is the period of time associated with the element and its attribute.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The combination of these arguments identifies a specific attribute value of the element in the project.</td>
<td></td>
</tr>
<tr>
<td><strong>REPEAT</strong></td>
<td>Returns a string that is formed from an input string by appending the input string to itself a specified number of times.</td>
<td>REPEAT(no, 1) returns no. REPEAT(ha, 2) returns hahaha.</td>
</tr>
<tr>
<td><strong>Syntax</strong></td>
<td>REPEAT(string, repetition)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>string is the input string.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>repetition is the number of times to append string to itself, beyond the first occurrence.</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>REVERSE</td>
<td>Returns a string that is formed by reversing the character sequence of an input string.</td>
<td>REVERSE(&quot;nuts&quot;) returns <strong>stun</strong>.</td>
</tr>
<tr>
<td><strong>Syntax</strong>: REVERSE(string)</td>
<td></td>
<td>string is a character string.</td>
</tr>
<tr>
<td>RIGHT</td>
<td>Returns a string that is formed by removing all the trailing spaces from an input string.</td>
<td>RIGHT(&quot;abc    &quot;) returns the character string <strong>abc</strong>.</td>
</tr>
<tr>
<td><strong>Syntax</strong>: RIGHT(string)</td>
<td></td>
<td>string is a character string.</td>
</tr>
<tr>
<td>ROUND</td>
<td>Returns the integer that is closest to a specified number. If the specified number is exactly midway between two integers, then the larger integer is returned.</td>
<td></td>
</tr>
<tr>
<td><strong>Syntax</strong>: ROUND(value)</td>
<td></td>
<td>value is a numeric value.</td>
</tr>
<tr>
<td>SCAN</td>
<td>Returns a segment of an input string that is selected by a standard set of delimiters and a specified numeric position.</td>
<td>SCAN(&quot;12+34–56+78&quot;,4) returns <strong>78</strong>.</td>
</tr>
<tr>
<td><strong>Syntax</strong>: SCAN(string, position)</td>
<td></td>
<td>string is the input string.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>position is the numeric position of the desired substring. Positions are counted from the beginning of string if position is positive, and from the end of string if position is negative. The following characters are treated as delimiters that divide string into countable segments: &lt; ( + &amp; $ * ) ; ^ ^ / , %</td>
</tr>
<tr>
<td>SIN</td>
<td>Returns the sine of its only argument.</td>
<td>SIN(0.5) returns <strong>0.47943</strong>.</td>
</tr>
<tr>
<td><strong>Syntax</strong>: SIN(value)</td>
<td></td>
<td>value is a numeric value, which represents an angle measured in radians.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>SQRT</td>
<td>Returns the square root of its only argument.</td>
<td>SQRT(81) returns 9.</td>
</tr>
<tr>
<td></td>
<td>Syntax: SQRT(value)</td>
<td>value is a nonnegative numeric value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUBSTR</td>
<td>Returns a substring of an input string.</td>
<td>SUBSTR(&quot;reiterate&quot;,3,2) returns it. SUBSTR(&quot;reiterate&quot;,3) returns iterate.</td>
</tr>
<tr>
<td></td>
<td>Syntax: SUBSTR(string, position)</td>
<td>string is an input string. position is the numeric position in string of the first character of the returned substring. length is an optional argument that specifies the length of the returned substring. If length is not specified, then the returned substring runs to the end of the input string.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUM</td>
<td>Returns the sum of its arguments.</td>
<td>SUM(1, 2, 3, 3, 16) returns 25.</td>
</tr>
<tr>
<td></td>
<td>Syntax: SUM(value1, value2, ..., value_n)</td>
<td>value1, value2, and value_n are all numeric values. SUM can accept any number of arguments. You can also specify ranges of values in this function. See “Specify a Range in a Function” on page 381.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This function must always be used within another function.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TABLEC</td>
<td>Returns a character value that it retrieves from a specified table.</td>
<td>TABLEC(&quot;stmtable.sas_data&quot;, &quot;id1=1 and id2=11&quot;, “animal”) returns Dog.</td>
</tr>
<tr>
<td></td>
<td>Syntax: TABLEC(tableName, whereClause, columnName)</td>
<td>tableName is the name of a registered data table. whereClause identifies a row in the specified table. columnName is the name of the column that contains the value to return.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Before you can use this function, the Strategy Management administrator must register the referenced table. For more information, see the SAS Strategy Management: System Administration Guide.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>TABLEN</td>
<td>Returns a numeric value that it retrieves from a specified table.</td>
<td>TABLEN(&quot;stmtable.sas_data&quot;, &quot;id1=3 and id2=33&quot;, &quot;sales&quot;) returns 61.</td>
</tr>
<tr>
<td>Syntax: TABLEN(tableName, whereClause, columnName)</td>
<td>Note: Before you can use this function, the Strategy Management administrator must register the referenced table. For more information, see the SAS Strategy Management: System Administration Guide.</td>
<td>When the stmtable.sas_data table contains the following data:</td>
</tr>
<tr>
<td></td>
<td>tableName is the name of a registered data table.</td>
<td>id1</td>
</tr>
<tr>
<td></td>
<td>whereClause identifies a row in the specified table.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>columnName is the name of the column that contains the value to return.</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>TAN</td>
<td>Returns the tangent of its only argument.</td>
<td>TAN(0) returns 0.0000.</td>
</tr>
<tr>
<td>Syntax: TAN(value)</td>
<td>value is a numeric value, which represents an angle measured in radians.</td>
<td></td>
</tr>
<tr>
<td>TIME</td>
<td>Returns the current clock time in military format, to the nearest second.</td>
<td>If TIME is executed at exactly noon, the function returns 12:00:00.</td>
</tr>
<tr>
<td>Syntax: TIME()</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TODAY</td>
<td>Returns the SAS integer representation of the current date.</td>
<td>January 1, 1960 is 1.</td>
</tr>
<tr>
<td>Syntax: TODAY()</td>
<td>January 2, 1960 is 2.</td>
<td></td>
</tr>
<tr>
<td>Note: The DATE function and the TODAY function are equivalent.</td>
<td>February 1, 1960 is 32.</td>
<td></td>
</tr>
<tr>
<td>TRANSLATE</td>
<td>Returns a character string that is formed by replacing certain characters in an input string with designated substitution characters.</td>
<td>TRANSLATE(&quot;bone&quot;, &quot;iw&quot;, &quot;ob&quot;) returns wine.</td>
</tr>
<tr>
<td>Syntax: TRANSLATE(string, substitutes, replace)</td>
<td>If required, you can spread the translation instructions over additional pairs of arguments. For example, TRANSLATE(&quot;bone&quot;, &quot;i&quot;, &quot;o&quot;, &quot;w&quot;, &quot;b&quot;) also returns wine.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>string is an input string to translate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>substitutes lists one or more substitution characters.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>replace lists the characters to replace, in a sequence that corresponds to the sequence of substitution characters.</td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>TRIM</strong></td>
<td>Returns a character string that is formed by removing all the leading spaces and all the trailing spaces from an input character string.</td>
<td>TRIM(&quot;   abc   &quot;) returns the character string abc.</td>
</tr>
<tr>
<td><strong>UPCASE</strong></td>
<td>Returns a character string that is formed from an input character string by converting each lowercase letter to the corresponding uppercase letter.</td>
<td>UPCASE(&quot;they8it&quot;) returns THEY8IT.</td>
</tr>
<tr>
<td><strong>VAL</strong></td>
<td>Provides a quick way to refer to a cell in a scorecard. Typically this function is used to provide input to another function. For example, if you want to refer to element O3_Month, attribute Total in the current period, you previously had to use the following syntax:</td>
<td>VAL(&quot;O3_Month&quot;, &quot;Total&quot;, &quot;current-2&quot;)&lt;br&gt;VAL(&quot;O3_Month&quot;, &quot;Total&quot;, &quot;current+2&quot;)&lt;br&gt;VAL(&quot;O3_Month&quot;, &quot;Total&quot;, &quot;sep_2012&quot;)</td>
</tr>
</tbody>
</table>

**Syntax**:
- **TRIM(string)**<br>
  value is a character string.
- **UPCASE(string)**<br>
  value is a character string.
- **VAL(element, attribute, period)**
  - element is an element.<br>
  - attribute is a metric attribute associated with the element.<br>
  - period is the period of time associated with the element and its attribute.<br>

When you specify period, you can use any of the following methods:<br>
- the CURRENT function<br>
- relative offsets combined with the CURRENT function<br>
- specific time periods
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>VERIFY</td>
<td>Checks whether one or more characters are present in one or more strings. If every character in the first argument is found in at least one subsequent argument, then VERIFY returns the numeric value 0. Otherwise, VERIFY returns the numeric position of the first character that is not found in any subsequent string. <strong>Note:</strong> This function can accept any number of arguments. <strong>Syntax:</strong> <code>VERIFY(characters, string, ..., string_n)</code>  - <code>characters</code> is a list of characters to check for in the other arguments.  - <code>string</code> and <code>string_n</code> are strings to check for <code>characters</code>.</td>
<td>- <code>VERIFY(&quot;aeiou&quot;, &quot;state&quot;, &quot;union&quot;)</code> returns 0 because each vowel is found in at least one of the words.  - <code>VERIFY(&quot;aeiou&quot;, &quot;state&quot;,&quot;onion&quot;)</code> returns 5 because neither word contains <code>u</code>.</td>
</tr>
<tr>
<td>YTD</td>
<td>Returns all of the data values to date for the current year from a specified cell. <strong>Syntax:</strong> <code>YTD(element, attribute, period)</code>  - <code>element</code> is an element.  - <code>attribute</code> is a metric attribute associated with the element.  - <code>period</code> is the period of time associated with the element and its attribute. <strong>Note:</strong> This function must always be used within another function.</td>
<td>- <code>YTD(&quot;03_Month&quot;, &quot;Total&quot;, &quot;sep_2012&quot;)</code> returns all of the values for a specific cell during the current year-to-date.</td>
</tr>
</tbody>
</table>
Get the Value of an Element

Several functions require as input the value of an element. This value is the intersection of an element, its metric attribute, and a point in time. The combination of these arguments identifies a specific value of an element. To specify this value in a function, use either of the following syntaxes:

Short form

vals(“CURRENT”, “CURRENT”, “CURRENT”)

Note: For more information about the VAL function, see its entry in “Functions for Use in Formulas” on page 365.

Long form

\[
\begin{align*}
\text{[ELEMENT} & = \text{CURRENT(“element”)}] \\
\text{[COLUMN} & = \text{CURRENT(“column”)}] \\
\text{[PERIOD} & = \text{CURRENT(“period”)}]
\end{align*}
\]

- **element** is an element.
- **column** is a metric attribute associated with the element.
- **period** indicates the specific period of time associated with the element and its attribute. For more information, see “Specify a Current or Relative Period in a Function” on page 381.

Specify a Current or Relative Period in a Function

You can specify the current period by using the following function:

```
current(‘PER’)
```

You can also specify a relative period by using a numeric offset, for example:

```
current(‘PER’)-1
```

If the current period is June, this example returns May.

Specify a Range in a Function

When using the MAX, MEAN, MIN, and SUM functions, you can specify a range of location values by using a colon (:) as in the following example:

```
SUM([ELE='Interest'][COL='Actual'][PER='JAN2005':[ELE='Interest']
[COL='Actual'][PER='JUN2005'])
```

When specifying a range of locations, the following requirements must be met:

- The first and last periods must be at the same level in the hierarchy of variation
- The elements and columns must be the same
- The first period must be before the second period
The specified range in the above example includes only periods at that one level, in order to avoid double counting. The example also specifies a six-period range at the month level of a time hierarchy.

Also, you can exclude certain numbers—for example, \texttt{EXCLUDE(-4, 4, 2.3)}.

---

**Specify a Full Reference to an Element or Attribute**

When you specify a formula for a formula-based range, you must refer to elements and attributes in the formula by using a full reference. Because a range is created at the project level, the range has no context for a scorecard or element type. The full reference acts like a path for the range, and provides the missing context.

For example, if you want to reference the element Pers1, you must enter the full reference to that element in the formula:

\[
[ELE='\text{Basketball} | \text{Basketball Scorecard}1974 \text{ Scorecard} | \text{Perspectives} | \text{Pers1}']
[COL='Actual']
[PER='NOV2008_Default']
\]

When you use the \texttt{ATTRIBUTE} function, you must specify the element type by using a full reference to the attribute. For example, if you want to reference the Start Date attribute value for elements of the Task element type, you must also reference the Task element type in the formula:

\[
\text{attribute}([ELE=\text{current('ELE')}] [ATTR='\text{Task}\text{|Start Date}'])
\]
Configure Java for Use with SAS Strategy Management

When you first use the Diagram Editor or the Formula Editor, you must configure your system to run Java. SAS Strategy Management requires the Java 2 Runtime Environment (J2RE) version 1.5 or later. The configuration steps vary depending on your installation:

- For version 1.5 or later
  1. "Delete the Java Plug-In Cache" on page 384
  2. "Delete Temporary Internet Files" on page 384

- Any earlier versions or no JRE installed
  1. "Install the Java 2 Runtime Environment" on page 383
  2. "Delete the Java Plug-In Cache" on page 384
  3. "Delete Temporary Internet Files" on page 384

Install the Java 2 Runtime Environment

SAS Strategy Management requires the Java 2 Runtime Environment (J2RE) version 1.5 or later. If you do not have version 1.5 installed, complete one of the following steps:
For JRE 1.6 or later

If you have a version of the JRE installed that is later than the required version, a message might appear asking if you want to use your version. Click Yes.

Note: The following security message might appear: Java has discovered application components that could indicate a security concern. Click No to continue.

For versions earlier than JRE 1.5 or no JRE installed

If you do not have the required version of the JRE installed, a message prompts you to install it. After the installation is complete, restart your computer.

Delete the Java Plug-In Cache

To delete the Java plug-in cache, complete the following steps:

Note: The names of the controls in the Java Control Panel might differ from the names shown here. Also, these steps might vary depending on your operating system installation.

1. Open the Windows Control Panel.
2. Double-click Java to open the Java Control Panel.
3. On the General tab, in the Temporary Internet Files section, click Settings. The Temporary Files Settings list appears.
4. Click Delete Files. The Delete Temporary Files list appears.
5. Click Applications and Applets and Trace and Log Files.
6. Click OK. Then click OK to exit the Temporary Files Settings list. Click OK to exit the Java Control Panel.

Delete Temporary Internet Files

If you are using SAS Strategy Management on more than one server, you must delete the temporary Internet files in Internet Explorer to ensure correct installation and operation of the editor. To do so, complete the following steps.

Note: These steps might vary depending on your version of Microsoft Internet Explorer.

1. In Internet Explorer, click Tools » Delete Browsing History. The Delete Browsing History list appears.
2. Click Preserve Favorites website data.
3. Click Temporary Internet files.
4. Click Delete.
Enable Java in the Web Browser

Enable Java in Firefox

You must ensure that Java is enabled for use in your web browser.

Note: These steps might vary depending on your version of Firefox.

To enable your web browser to use Java:

1. Click Tools ▶ Add-ons. The Add-ons page opens.
2. Click Plug-ins.
3. Locate the entry for your Java plug-in and click Enable.

Enable Java in Microsoft Explorer

You must ensure that Java is enabled for use in your web browser.

Note: These steps might vary depending on your version of Microsoft Explorer.

To enable your web browser to use Java:

1. Click Tools ▶ Add-ons. The Add-ons window appears.
2. Click Toolbars and Extensions.
3. Locate and select the entry for your Java plug-in.
4. Click Enable.
5. Click Close to exit the window.

To create new SAS Strategy Management indicator data in SAS BI Dashboard, complete the following steps:

1. Open the SAS BI Dashboard designer.

2. Select Manage Dashboards.

3. In the workspace, click New Indicator Data.

4. In the Create Indicator Data window, enter a name to use for the indicator data in the Name field.

5. Click OK. A tab with the specified name appears in the workspace.

6. From the Data source list, select SAS Strategy Management 5.x.
   
   **CAUTION!** The default maximum number of rows returned by any data source is 10,000. If the source data contains more than 10,000 rows, an error message about making an adjustment appears. If possible, aggregate the data in order to reduce the number of rows to return.

7. In the Scorecard Server URL field, enter the host name and port name for the server running the SAS Strategy Management web application.

   Note: The resulting web address points to the location of the SAS Strategy Management web application.

8. Click Set Server.

9. Select the template, project, and scorecard for your data.
   
   a. From the Scorecard Template list, select the template that you want to use.
   
   b. From the Scorecard Project list, select the project that you want to use. The scorecard hierarchy appears.
   
   c. In the Scorecard hierarchy, select the scorecard that you want to use.

10. Select the element type, elements, and attributes that you want to display in the dashboard.
   
   a. From the Element Type list, select the element type that you want to use.
b From the **Element** list, select one or more elements that you want to use.

c From the **Attributes** list, select one or more attributes that you want to use.

11 **Define the formatting that you want to use in the dashboard.**

a Specify the start date and end date.

<table>
<thead>
<tr>
<th>Date Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No selection</td>
<td>Enables you to specify a start or end date by clicking</td>
</tr>
<tr>
<td>Any date</td>
<td>Returns all data for the element start date or end date.</td>
</tr>
<tr>
<td>Today</td>
<td>Displays the current date.</td>
</tr>
</tbody>
</table>

The following examples show how the date options interact:

- If **Start Date** is set to **Any date** and **End Date** is set to **Today**, the system returns all past data and today’s results.
- If **Start Date** is set to **Today** and **End Date** is set to **Any date**, the system returns today’s results and any data that is defined for the future.
- If **Start Date** and **End Date** are both set to **Any date**, the system returns all available data for the selection.

b In the **Name Format** field, define a label for your dashboard artifact.

**Note:** SAS Strategy Management keywords are used to define the format. When these keywords are displayed, the keywords are replaced with actual values from the strategy, which ensures that labels contain meaningful information.

c In the **Value Format** field, call metric values and set SAS formats for display in the dashboard.

**TIP** Use `Metric_Value` to substitute the actual metric value for a measure.

12 Click **Submit**. In the Preview Dashboard window, the specified SAS Strategy Management data appears.

13 To save the SAS Strategy Management indicator data, click the **Save** icon in the toolbar.

The following additional steps are required to complete setting up a dashboard:

- Set up a new range.
- Create a new indicator.
- Create a new dashboard.

For information about these steps, see the *SAS BI Dashboard 4.31 User’s Guide, Second Edition*. 
alert
an automatic notification of an electronic event that is of interest to the recipient.

Alerts portlet
a portlet that lists alert messages that have been issued to the user.

attribute
a property of an object, component, or other entity. Examples of attributes include name, size, or color.

audit
the formal examination and evaluation of an organization's controls to ensure organizational compliance.

dashboard
a view that displays ranges of data in a graphical format. Key performance indicators (KPIs) or any element can be displayed in a dashboard. Each element is represented by a gauge that displays the data ranges that are defined. Links to comments, trend data, and element properties can also be provided.

data node
a diagram component that contains all the data and metadata that are associated with an element, such as its labels, attributes, associations, and values.

data tier
in a SAS business intelligence system, the architectural layer in which SAS runs data-handling programs (including the logical servers for workspace and stored process servers). The data tier includes transformations, error tables, and jobs.

dimension
a data element that categorizes values in a data set into non-overlapping categories that can be used to group, filter, and label the data in meaningful ways. Hierarchies within a dimension typically represent different groupings of information that pertain to a single concept. For example, a Time dimension might consist of two hierarchies: (1) Year, Month, and Date, and (2) Year, Week, and Day.

element
a unit of data that is represented in a row in a scorecard table. Each element belongs to an element type. For example, the element type "Objective" might contain the elements "Expenses", "Create New Products", and "Profitability".

group
See user group

identity
See metadata identity
information map
a collection of data items and filters that provides a user-friendly view of a data source. When you use an information map to query data for business needs, you do not have to understand the structure of the underlying data source or know how to program in a query language.

key performance indicator
a measurement that shows whether an organization is progressing toward its stated goals. Short form: KPI.

KPI
See key performance indicator

locale
a setting that reflects the language, local conventions, and culture for a geographic region. Local conventions can include specific formatting rules for paper sizes, dates, times, and numbers, and a currency symbol for the country or region. Some examples of locale values are French_Canada, Portuguese_Brazil, and Chinese_Singapore.

metadata
descriptive data about data that is stored and managed in a database, in order to facilitate access to captured and archived data for further use.

metadata identity
a metadata object that represents an individual user or a group of users in a SAS metadata environment. Each individual and group that accesses secured resources on a SAS Metadata Server should have a unique metadata identity within that server.

metadata repository
a collection of related metadata objects, such as the metadata for a set of tables and columns that are maintained by an application.

metadata server
a server that provides metadata management services to one or more client applications.

metric
any standard of measurement that is used as a basis for evaluation or comparison. For example, ROI (return on investment) is a metric that is commonly used by businesses as a basis for making decisions, and bytes per second throughput is a common performance metric.

metric attribute
a value type that measures, groups, or tracks strategy results. A strategy uses metric attributes as a basis for evaluation and comparison of results. Actual, Target, and Status are examples of metric attributes.

middle tier
in a SAS business intelligence system, the architectural layer in which Web applications and related services execute. The middle tier receives user requests, applies business logic and business rules, interacts with processing servers and data servers, and returns information to users.
**performance management framework**  
a management system that is supported by measures of performance. The framework can combine financial and nonfinancial measures of performance, as well as leading and lagging indicators. The framework enables optimization and testing of strategies, and evaluation of results.

**permission**  
the type of access that a user or group has to a resource. The permission defines what the user or group can do with the resource. Examples of permissions are ReadMetadata and WriteMetadata.

**portal**  
a Web application that enables users to access Web sites, data, documents, applications, and other digital content from a single, easily accessible user interface. A portal's personalization features enable each user to configure and organize the interface to meet individual or role-based needs.

**role**  
a set of capabilities. In some applications, certain actions are available only to users or groups that have a particular role.

**rollback**  
a data recovery process that restores a database after a hardware or software failure, or that returns it to a state before changes were made.

**SAS Stored Process**  
a SAS program that is stored on a server and defined in metadata, and which can be executed by client applications. Short form: stored process.

**scorecard**  
a collection of content or information about a specific topic, such as a business unit or product. A scorecard tracks internal business processes and external outcomes as an aid to planning a strategy for an organization.

**source system**  
the type of database from which operational loss data originates or to which it is being exported.

**stored process**  
See SAS Stored Process

**template**  
a collection of information that describes the key parts of a strategy. A template consists of element types, metric attributes, and a language setting. A template can be associated with one or more projects.

**Time dimension**  
a dimension that divides time into levels such as Year, Quarter, Month, and Day.

**time period level**  
a grouping of one or more time periods. For example, the time period level Day consists of the time periods Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, and Sunday.

**time period set**  
in a template or project, a grouping of one or more time period levels.
trend
a long-term consistent change, as measured by time series values.

**Unicode Transformation Format 8**
See UTF-8

**universal unique identifier**
a number that is used to uniquely identify information in distributed systems without significant central coordination. There are 32 hexadecimal digits in a UUID, and these are divided into five groups with hyphens between them as follows: 8-4-4-4-12. Altogether the 16-byte (128 bit) canonical UUID has 32 digits and 4 hyphens, or 36 characters.

**user group**
an organization of user roles within an entity organization. User groups contain the roles and access rights for the individuals assigned to the group.

**user role**
See role

**UTF-8**
a method for converting 16-bit Unicode characters to 8-bit characters. This format supports all of the world's languages, including those that use non-Latin 1 characters. Short form: UTF-8.

**UUID**
See universal unique identifier
## Special Characters

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>BLANK</em></td>
<td>(special constant in formulas)</td>
<td>127</td>
</tr>
<tr>
<td><em>ERROR</em></td>
<td>(special constant in formulas)</td>
<td>127</td>
</tr>
<tr>
<td>.</td>
<td>(special constant in formulas)</td>
<td>127</td>
</tr>
<tr>
<td>#NUM!</td>
<td></td>
<td>123, 126, 129, 132, 133</td>
</tr>
</tbody>
</table>

## A

<table>
<thead>
<tr>
<th>Function</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS function</td>
<td>366</td>
</tr>
<tr>
<td>access permissions</td>
<td></td>
</tr>
<tr>
<td>administer</td>
<td>146</td>
</tr>
<tr>
<td>set for multiple objects</td>
<td>146</td>
</tr>
<tr>
<td>ACOS function</td>
<td>366</td>
</tr>
<tr>
<td>address</td>
<td></td>
</tr>
<tr>
<td>copy address of a view</td>
<td>239</td>
</tr>
<tr>
<td>administer access permissions</td>
<td>146</td>
</tr>
<tr>
<td>aggregate tables</td>
<td></td>
</tr>
<tr>
<td>and column selections</td>
<td>138</td>
</tr>
<tr>
<td>column selections</td>
<td>140</td>
</tr>
<tr>
<td>customize view</td>
<td>68</td>
</tr>
<tr>
<td>definition</td>
<td>21, 153</td>
</tr>
<tr>
<td>metric attributes</td>
<td>68</td>
</tr>
<tr>
<td>opening</td>
<td>165</td>
</tr>
<tr>
<td>sorting rows</td>
<td>166</td>
</tr>
<tr>
<td>viewing data by metric attribute</td>
<td>166</td>
</tr>
<tr>
<td>viewing data by scorecard</td>
<td>166</td>
</tr>
<tr>
<td>analysis</td>
<td></td>
</tr>
<tr>
<td>correlation</td>
<td>217</td>
</tr>
<tr>
<td>create definition</td>
<td>218</td>
</tr>
<tr>
<td>ASIN function</td>
<td>366</td>
</tr>
<tr>
<td>associated projects</td>
<td>9</td>
</tr>
<tr>
<td>listing with templates</td>
<td>55</td>
</tr>
<tr>
<td>association links</td>
<td></td>
</tr>
<tr>
<td>adding to a diagram</td>
<td>182</td>
</tr>
<tr>
<td>definition</td>
<td>177</td>
</tr>
<tr>
<td>deleting</td>
<td>186</td>
</tr>
<tr>
<td>in diagrams</td>
<td>177</td>
</tr>
<tr>
<td>association tables</td>
<td></td>
</tr>
<tr>
<td>customize view</td>
<td>68</td>
</tr>
<tr>
<td>association views</td>
<td></td>
</tr>
<tr>
<td>customizing</td>
<td>161</td>
</tr>
<tr>
<td>associations</td>
<td></td>
</tr>
<tr>
<td>and analysis</td>
<td>217</td>
</tr>
</tbody>
</table>

## B

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced Scorecard template</td>
<td>11</td>
</tr>
<tr>
<td>Batch Maintenance Facility</td>
<td></td>
</tr>
<tr>
<td>Import wizard</td>
<td>337</td>
</tr>
<tr>
<td>links</td>
<td>74</td>
</tr>
<tr>
<td>blank cells</td>
<td>133</td>
</tr>
</tbody>
</table>

## C

<table>
<thead>
<tr>
<th>Feature</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache</td>
<td></td>
</tr>
<tr>
<td>diagram</td>
<td>69, 70</td>
</tr>
<tr>
<td>CEIL function</td>
<td>367</td>
</tr>
<tr>
<td>Children function</td>
<td>368</td>
</tr>
<tr>
<td>collection portlet</td>
<td></td>
</tr>
<tr>
<td>adding links</td>
<td>33</td>
</tr>
<tr>
<td>column selections</td>
<td></td>
</tr>
<tr>
<td>and aggregate tables</td>
<td>138, 140</td>
</tr>
<tr>
<td>and associations</td>
<td>141</td>
</tr>
<tr>
<td>and tables</td>
<td>140</td>
</tr>
<tr>
<td>copying</td>
<td>140</td>
</tr>
<tr>
<td>creating</td>
<td>138, 141</td>
</tr>
<tr>
<td>deleting</td>
<td>140</td>
</tr>
<tr>
<td>editing properties of forms</td>
<td>141</td>
</tr>
<tr>
<td>in scorecard tables</td>
<td>159, 166</td>
</tr>
<tr>
<td>listing</td>
<td>137</td>
</tr>
<tr>
<td>columns</td>
<td></td>
</tr>
<tr>
<td>formatting</td>
<td>110</td>
</tr>
<tr>
<td>COMPRESSION function</td>
<td>368</td>
</tr>
<tr>
<td>copying and pasting</td>
<td></td>
</tr>
</tbody>
</table>
diagram objects 188
analyze 217
correlation analysis 217
association links 177
COS function 368
cache 69, 70
cURRENT function 368
changing position of 227
curved lines 193
copying 225
customizing 177
creating 177
customize view 69
deleting 226
data layer 176
data node properties 176
definition of 22, 154, 175
data nodes 176
deleting 226
deleting association links 186
deleting data nodes 186
deleting elements 186
deleting images 186
deleting lines 186
deleting sections 186
deleting shapes 186
deleting text 186
dividing into sections 183
editing 178
editing links 214
editing scorecards with 176
exporting as SVG drawings 226
grids 187
image location 186
lines 177
locating associations in 227
locating element types in 227
locating elements in 227
moving data nodes 189
panning 227
properties 225
reverting to saved 226
saving 225
sections 177
shape layer 176
shapes, text, images 177
showing and hiding data nodes 181
showing and hiding 181
viewing 226
viewing properties 225
zooming 187
Directive 74
Document Manager
See import a document
documents, importing 80

dashboard View
definition of 22, 154
dashboards
displaying in Performance Dashboard Portlet 317
data layer 176
data nodes
adding and removing 181
definition of 176
deleting 186
grouping 192
grouping with sections 190, 191
in diagrams 176
moving 189
showing and hiding 181
data-entry forms
column selections 138, 141
links 74
using to enter data 333
data-entry portlet
See Performance Data-Entry Portlet
DATE function 368
dates
default in project views 66
in scorecard tables 159, 166, 169
DATETIME function 369
DAV content 74, 80
See also import a document
DAV server 70
DAYOFMONTH function 369
day
DAYOFWEEK function 369
DAYOFYEAR function 369
DBCS character limitations 185
delete access permission 146
deleting
diagram objects 186
Diagram Editor
diagram objects
copying and pasting 188
deleting 186
diagrams
adding association links 182
adding objects 181
deployment 74
element details 74
element types
changing order in a project 48
locating in diagrams 227
Index 395

elements
adding to a diagram 181
comment notification 145
copying 106
copying properties of 104
creating 93
definition of 15
deleting 107, 186
editing metric attributes 95
editing multiple 100
editing properties of 97
in enhanced gauge tile 22, 154
in Performance Dashboard Portlet 22, 154
linking 103
linking from 103
links 74
locating in diagrams 227
manage suggested new 64
moving 107, 189
resizing 189
suggest new 63
unlinking 103
ellipse
See shapes
EXP function 369

files
importing 80
registered in SAS 74
Firefox web browser
and portlets 282, 284, 287, 290
Copy Web Address 240
FLOOR function 369
font
of table cells 107
of table columns 110
ForAll function 369
ForAny function 370
format
of table cells 107
of table columns 110
forms
column selections 141
entering data with 333
Numeric icon 333
Text icon 333
Formula Editor functions
See functions
formula icon 68
formulas
_ERROR_ (special constant) 127
_ (special constant) 127
#NUM! 123, 126, 129, 132, 133
applying to columns 123
calculating for projects 129
cell reference 379
editing 125
ranges based on 132, 133
ForNone function 370
functions 365
ABS 366
ACOS 366
ASIN 366
ATAN 366
attribute 367
attributeIsMe 367
CEIL 367
Children 368
COMPRESS 368
COS 368
CURRENT 368
DATE 368
DATETIME 369
DAYOFMONTH 369
DAYOFWEEK 369
DAYOFYEAR 369
EXP 369
FLOOR 369
ForAll 369
ForAny 370
ForNone 370
IF 370
INDEX 370
INDEXC 371
INPUTVALUE 371
LEFT 371
LENGTH 371
LOG 372
LOWCASE 372
MAX 372
MEAN 372
MIN 373
MOD 373
myAttribute 373
NESTIF 374
POW 374
PUTC 375
PUTN 375
Range 375
REPEAT 375
REVERSE 376
RIGHT 376
ROUND 376
SCAN 376
SIN 376
SQRT 377

F
G

Gauge View
  definition of 22, 154
getSPMCellValue function 361
global thresholds
  editing 115
  in Performance Dashboard Portlet 289
  setting 112
grids
  arranging objects with 187

H

historical trends
  customizing 235

I

IF function 370
images
  adding to a diagram 185
  copying and pasting 188
  deleting 186
  in diagrams 177
  moving 189
  resizing 189
  selecting and deselecting 188
  to contain other items 192
import a document 80
Import wizard 337
  links 74
INDEX function 370
INDEXC function 371
information maps 74
INPUTVALUE function 371

internationalization 185

K

key performance indicators
  in enhanced gauge tile 22, 154
  in Performance Dashboard Portlet 22, 154
KPI template 11

L

languages
  creating a user defined 53
  definition of 9
  deleting in templates 55
  listing in templates 54
  renaming in templates 54
  setting the default 54
  used in a project 67
LEFT function 371
LENGTH function 371
lines
  adding and removing segments 193
  adding to a diagram 184
  copying and pasting 188
  definition of 177
  deleting 186
  in diagrams 177
  moving 189
  straight and curved 193
linking elements 103
links
  applied to elements 103
  applied to metric attributes 97
  definitions 75
  editing 214
  in scorecards 74
  to SAS Stored process 79
  to web pages 78
  types 74
LOG function 372
log off 35, 298
log on 31, 297
LOWCASE function 372

MAX function 372
MEAN function 372
metric attributes
definition of 9
deleting in templates 53
displayed in aggregated tables 68
ing in aggregate tables 166
linking from 97
links 74
listing in templates 52
renaming in templates 53
return value to Microsoft Excel 361
Microsoft Excel
  accessing the value of a metric attribute 361
Microsoft Office
  troubleshooting 360
missing values
  in ranges 133
mobile support 58, 312
MOD function 373
myAttribute function 373

N

NESTIF function 374
nodes
  See also data nodes
    grouping with sections 190, 191
number format
  of table cells 107
Numeric icon
  in forms 333

P

Performance Aggregate Table Portlet
  editing properties of 282
Performance Association Portlet
  editing properties of 285
Performance Dashboard Portlet
  editing properties of 287
  threshold conditions 289
  viewing 317
Performance Data-Entry Portlet
  editing properties of 291
Performance Diagram Portlet
  editing properties of 293
Performance Table Portlet
  editing properties of 279
period-based text
  editing metric attributes 97
  editing multiple elements 102
  in forms 333
personal column selections (definition) 138
personal thresholds
  editing 115
  in Performance Dashboard Portlet 289
  setting 112
polygon
  See also shapes
  rotating 190
portal pages 74
POW function 374
predefined templates
  editing properties of 57
project element types
  changing order 48
  copying in templates 48
  definition of 9
  deleting in templates 48
  editing properties of 45
  listing in templates 45
projects
  access permissions 63
  associated 9
  calculate 129
  copying 71
  creating 60
  default date for views 66
  default language 67
  default scorecard 65
  default trend chart 70, 71
  default view 65
  definition of 12
  deleting 73
  manage suggested new elements 64
  name 62, 72
  opening 61
  opening by using a link 74
  options 65
  printing 239
  properties 62
  registering 61
  suggest new element 63
PUTC function 375
PUTN function 375

R

range colors
  in Microsoft Office 360
Range function 375
ranges
  #NUM! 133
  applying to columns 135
INDEX

blank cells 133

copying 134
creating 132
definition of 17
deleting 135
editing 134
formula-based 132, 133
intervals 132
missing values 133
unresolved values 133
read access permission 146
rectangle
See shapes
REPEAT function 375
reports 58, 312
REVERSE function 376
RIGHT function 376
ROUND function 376
rows
sorting in aggregate tables 166
sorting in scorecard tables 160
rules 371

trend analysis 231
viewing data by column selection 159, 166
viewing data by date 159, 166, 169
scorecards
adding to a portlet 72, 88
changing order 86
copying 89
creating 83
default displayed in project 65
definition of 13
deleting 91
editing in a diagram 176
moving 89
opening 84
printing 239
setting default preferences 91
sections
copying and pasting 188
definition of 177
deleting 186
dividing diagrams 183
grouping data nodes 190, 191
in diagrams 177
moving 189
resizing 189
shape layer 176
shapes
adding to a diagram 184
connecting 194
copying and pasting 188
deleting 186
disconnecting 194
grouping nodes 192
in diagrams 177
moving 189
resizing 189
selecting and deselecting 188
to contain other items 192
shared column selections (definition) 138
SIN function 376
SQRT function 377
Stored Process
linking to 79
stored processes 74
Strategy Management Portlet
editing properties of 257
SUBSTR function 377
SUM function 377
SVG 185
SVG drawings
exporting diagrams as 226

S

SAS Content Server 74, 80
SAS Financial Management 74
SAS Information Delivery Portal
log off 35, 298
log on 31, 297
SAS Information Map
create from scorecard 85
SAS Mobile BI app 58, 312
SAS Strategy Management server
images for diagrams 186
SAS Visual Analytics 35
SAS Visual Analytics 58, 312
SAS Web Report Studio 74
SCAN function 376
scorecard
calculate 84
linking from 74
save as SAS Information Map 85
scorecard element types
copying in templates 48, 52
definition of 9
deleting in templates 52
editing properties of 49
listing in templates 49
scorecard tables
customizing 161
definition of 20, 152
opening 159
sorting rows 160

SAS Strategy Management server
images for diagrams 186
SAS Visual Analytics 35
SAS Visual Analytics 58, 312
SAS Web Report Studio 74
SCAN function 376
scorecard
calculate 84
linking from 74
save as SAS Information Map 85
scorecard element types
copying in templates 48, 52
definition of 9
deleting in templates 52
editing properties of 49
listing in templates 49
scorecard tables
customizing 161
definition of 20, 152
opening 159
sorting rows 160

SAS Strategy Management Portlet
editing properties of 257
SUBSTR function 377
SUM function 377
SVG 185
SVG drawings
exporting diagrams as 226
TABLEC function 377
TABLEN function 378

tables
  cell format 107
  column format 110
  column selections 140
  customize view 67
  customizing 161
  definition of 20, 152
  opening 159
  sorting rows 160, 166

tablet support
  See mobile support

TAN function 378

templates
  associated projects 9
  Balanced Scorecard 11
  copying 58
  copying element types 48
  copying projects 71
  copying scorecard element types 52
  creating 42
  creating user-defined language 53
  definition of 9
  deleting 58
  deleting languages 55
  deleting metric attributes 53
  deleting project element types 48
  deleting scorecard element types 52
  editing 45
  editing project element type properties 45
  editing properties of predefined 57
  editing properties of user-defined 55
  editing scorecard element type properties 49

KPI 11
  listing associated projects 55
  listing languages 54
  listing metric attributes 52
  listing project element types 45
  listing scorecard element types 49
  metric attributes 9
  predefined 11
  project element types 9
  properties in diagrams 176
  renaming languages 54
  renaming metric attributes 53
  scorecard element types 9
  setting the default language 54
  viewing 45

text
  adding to a diagram 185
  copying and pasting 188
  deleting 186
  in diagrams 177
  moving 189
  selecting and deseleting 188
  to contain other items 192

Text icon
  in forms 333

thresholds
  editing global 115
  editing personal 115
  in Performance Dashboard Portlet 289
  setting global 112
  setting personal 112
  viewing 117

thresholds, global 68
thresholds, personal 68

TIME function 378
TODAY function 378
TRANSLATE function 378


trend analysis
  definition of 23, 155

trend charts
  date range 71
  default content 70
  Y-axis labels 70

trends
  analyzing 231

TRIM function 379

ununlinking elements 103

unresolved values
  in ranges 133

UPCASE function 379

URL
  copy for a view 239

user-defined templates
  editing properties of 55

VAL function 379

VERIFY function 380

view
  copy address of 239

views
  adding to a portlet 238

association table 68

customizing 67
default date  66
default displayed in project  65
diagram  69
setting default options  237
setting the default date  239
specifying a default  239
table  67
trend  70, 71

Visual Analytics
See SAS Visual Analytics

Y

YTD function  380

W

web page